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     [bookmark: pgfId-1011684][bookmark: 19731]Preface 
      
      
 
     
 
 
    [bookmark: pgfId-1011719]This preface describes the audience, organization, and conventions of the Cisco DCNM Fundamentals Configuration Guide, Release 4.x. It also provides information on how to obtain related documentation.
 
    [bookmark: pgfId-1011721]This preface includes the following topics:
 
     
     	 [bookmark: pgfId-1011725]Audience
 
     	 [bookmark: pgfId-1011729]Document Organization
 
     	 [bookmark: pgfId-1011733]Document Conventions
 
     	 [bookmark: pgfId-1014427]Related Documentation
 
     	 [bookmark: pgfId-1011745]Obtaining Documentation and Submitting a Service Request
 
    
 
     
      [bookmark: pgfId-1011747][bookmark: 92162]Audience
 
     [bookmark: pgfId-1011690]This publication is for experienced network administrators who configure and maintain Cisco NX-OS devices.
 
    
 
     
      [bookmark: pgfId-1011691][bookmark: 94390]Document Organization
 
     [bookmark: pgfId-1011844]This document is organized into the following chapters:
 
     [bookmark: pgfId-1011899]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1011847]Chapter 
          
  
         	 
           
           [bookmark: pgfId-1011849]Description 
          
  
        
 
         
         	[bookmark: pgfId-1013784]Chapter 1, “Overview”
  
         	[bookmark: pgfId-1013786]Provides an overview of what you need to do to start using Cisco Data Center Network Manager (DCNM).
  
        
 
         
         	[bookmark: pgfId-1013790]Chapter 2, “Installing and Launching the Cisco DCNM Server”
  
         	[bookmark: pgfId-1013793]Describes how to install and set up the Cisco DCNM server, which is required for using the Cisco DCNM client.
  
        
 
         
         	[bookmark: pgfId-1013797]Chapter 3, “Installing and Launching the Cisco DCNM Client”
  
         	[bookmark: pgfId-1013800]Describes how to install and set up the Cisco DCNM client.
  
        
 
         
         	[bookmark: pgfId-1013805]Chapter 4, “Using the Cisco DCNM Client”
  
         	[bookmark: pgfId-1013807]Introduces the Cisco DCNM client and explains how to use it.
  
        
 
         
         	[bookmark: pgfId-1013812]Chapter 5, “Administering DCNM Authentication Settings”
  
         	[bookmark: pgfId-1013814]Describes how to administer Cisco DCNM server user accounts.
  
        
 
         
         	[bookmark: pgfId-1013819]Chapter 6, “Administering Device Discovery”
  
         	[bookmark: pgfId-1013821]Describes how to use the Device Discovery feature.
  
        
 
         
         	[bookmark: pgfId-1013826]Chapter 7, “Administering Devices and Credentials”
  
         	[bookmark: pgfId-1013828]Describes how to use the Devices and Credentials feature.
  
        
 
         
         	[bookmark: pgfId-1013832]Chapter 8, “Administering DCNM Licensed Devices”
  
         	[bookmark: pgfId-1013835]Describes how to use the DCNM Licensed Devices feature.
  
        
 
         
         	[bookmark: pgfId-1013840]Chapter 9, “Working with Topology”
  
         	[bookmark: pgfId-1013842]Describes how to use the Topology feature.
  
        
 
         
         	[bookmark: pgfId-1013847]Chapter 10, “Managing Events”
  
         	[bookmark: pgfId-1013849]Describes how to use the Event Browser and feature-specific Events tabs.
  
        
 
         
         	[bookmark: pgfId-1013854]Chapter 11, “Working with Inventory”
  
         	[bookmark: pgfId-1013856]Describes how to use the Inventory feature.
  
        
 
         
         	[bookmark: pgfId-1013861]Chapter 12, “Configuring SPAN”
  
         	[bookmark: pgfId-1013863]Describes how to use the Switched Port Analyzer (SPAN) feature.
  
        
 
         
         	[bookmark: pgfId-1013868]Chapter 13, “Managing Device Operating Systems”
  
         	[bookmark: pgfId-1013870]Describes how to use the Device OS Management feature.
  
        
 
         
         	[bookmark: pgfId-1013874]Chapter 14, “Working with Configuration Change Management”
  
         	[bookmark: pgfId-1013877]Describes how to use the Configuration Change Management feature.
  
        
 
         
         	[bookmark: pgfId-1013881]Chapter 15, “Administering Auto-Synchronization with Devices”
  
         	[bookmark: pgfId-1013884]Describes how to use the Auto-Synchronization with Devices feature.
  
        
 
         
         	[bookmark: pgfId-1013888]Chapter 16, “Administering Statistical Data Collection”
  
         	[bookmark: pgfId-1013891]Describes how to control statistical data collection.
  
        
 
         
         	[bookmark: pgfId-1013895]Chapter 17, “Administering DCNM Server Log Settings”
  
         	[bookmark: pgfId-1013898]Describes how to control Cisco DCNM server logs.
  
        
 
         
         	[bookmark: pgfId-1013948]Chapter 18, “Maintaining the Cisco DCNM Database”
  
         	[bookmark: pgfId-1013950]Explains how to maintain the Cisco DCNM database.
  
        
 
         
         	[bookmark: pgfId-1013903]Chapter 19, “Troubleshooting Cisco DCNM”
  
         	[bookmark: pgfId-1013905]Explains how to resolve problems that you might encounter with Cisco DCNM.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1011901][bookmark: 94077]Document Conventions
 
     [bookmark: pgfId-1011188]This document uses the following conventions:
 
      
       
     
 
     
 
     [bookmark: pgfId-1011189]Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1011190] 
      Caution Means 
      reader be careful. In this situation, you might do something that could result in equipment damage or loss of data. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1014655][bookmark: 73656][bookmark: marker-1014653]Related Documentation[bookmark: marker-1014654]
 
     [bookmark: pgfId-1014656]Cisco DCNM documentation is available at the following URL:
 
     [bookmark: pgfId-1014658]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
     [bookmark: pgfId-1014659]The documentation set for Cisco DCNM includes the following documents:
 
      
       [bookmark: pgfId-1014660]Release Notes
 
      [bookmark: pgfId-1014663]Cisco DCNM Release Notes, Release 4.x
 
     
 
      
       [bookmark: pgfId-1014665]DCNM Configuration Guides
 
      [bookmark: pgfId-1014668]Cisco DCNM Getting Started with Virtual Device Contexts, Release 4.x
 
      [bookmark: pgfId-1014672]Cisco DCNM Fundamentals Configuration Guide, Release 4.x
 
      [bookmark: pgfId-1014676]Cisco DCNM Interfaces Configuration Guide, Release 4.x
 
      [bookmark: pgfId-1014680]Cisco DCNM Layer 2 Switching Configuration Guide, Release 4.x
 
      [bookmark: pgfId-1014684]Cisco DCNM Web Services API Guide, Release 4.x
 
      [bookmark: pgfId-1014688]Cisco DCNM Security Configuration Guide, Release 4.x
 
      [bookmark: pgfId-1014692]Cisco DCNM Unicast Routing Configuration Guide, Release 4.x
 
      [bookmark: pgfId-1014704]Cisco DCNM Virtual Device Context Configuration Guide, Release 4.x
 
     
 
    
 
     
      [bookmark: pgfId-1013649][bookmark: 30878]Obtaining Documentation and Submitting a Service Request
 
     [bookmark: pgfId-1014643]For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:
 
     [bookmark: pgfId-1014645]http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
 
     [bookmark: pgfId-1014646]Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS Version 2.0.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1072913][bookmark: 17492]Overview 
      
      
 
     
 
 
    [bookmark: pgfId-1072914]This chapter provides a brief overview of Cisco Data Center Network Manager (DCNM). It also includes general Cisco DCNM deployment steps and details about preparing Cisco NX-OS devices for management and monitoring by Cisco DCNM.
 
    [bookmark: pgfId-1055569]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1055582]Information About Cisco DCNM
 
     	 [bookmark: pgfId-1055602]Deploying Cisco DCNM
 
     	 [bookmark: pgfId-1068501]Cisco NX-OS Device Configuration Requirements
 
     	 [bookmark: pgfId-1055609]Cisco NX-OS System-Message Logging Requirements
 
    
 
   
 
    
     [bookmark: pgfId-1055537][bookmark: 95644]Information About Cisco DCNM[bookmark: marker-1056963]
 
    [bookmark: pgfId-1056104]Cisco DCNM is a management solution that maximizes overall data center infrastructure uptime and reliability, which improves business continuity. Focused on the management requirements of the data center network, Cisco DCNM provides a robust framework and rich feature set that fulfills the switching needs of present and future data centers. In particular, Cisco DCNM automates the provisioning process.
 
    [bookmark: pgfId-1070659]Cisco DCNM is a solution designed for Cisco NX-OS-enabled hardware platforms. Cisco NX-OS provides the foundation for the Cisco Nexus product family. For information about the specific Cisco Nexus products supported by Cisco DCNM, see the Cisco DCNM Release Notes, Release 4.x.
 
    [bookmark: pgfId-1070660]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1056497]Cisco DCNM Client and Server
 
     	 [bookmark: pgfId-1059927]Features in Cisco DCNM, Release 4.x
 
     	 [bookmark: pgfId-1068350]Cisco DCNM Licensing
 
     	 [bookmark: pgfId-1056513]Documentation About Cisco DCNM
 
    
 
     
      [bookmark: pgfId-1056322][bookmark: 11201]Cisco DCNM Client and Server
 
     [bookmark: pgfId-1056389]Cisco DCNM is Java-based client-server application. For Java requirements, server system requirements, and client system requirements, see the Cisco DCNM Release Notes, Release 4.x.
 
     [bookmark: pgfId-1056482]Figure 1-1 shows the Cisco DCNM client-server environment. The Cisco DCNM client communicates with the Cisco DCNM server only, never directly with managed Cisco NX-OS devices. The Cisco DCNM server uses the XML management interface of Cisco NX-OS devices to manage and monitor them. The XML management interface is a programmatic method based on the NETCONF protocol that complements the command-line interface (CLI) functionality. For more information, see the Cisco NX-OS XML Management Interface User Guide, Release 4.x.
 
     [bookmark: pgfId-1057939]Figure 1-1 [bookmark: 59647]Cisco DCNM Client-Server Environment
 
     [bookmark: pgfId-1056232]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1056128][bookmark: 91012]Features in Cisco DCNM, Release 4.x
 
     [bookmark: pgfId-1056208]Cisco DCNM Release 4.x supports the configuration and monitoring of the following Cisco NX-OS features:
 
      
      	 [bookmark: pgfId-1056129]Ethernet switching
 
     
 
     [bookmark: pgfId-1056130] – Physical ports
 
     [bookmark: pgfId-1068057] – Port channels and virtual port channels (vPCs)
 
     [bookmark: pgfId-1056131] – Loopback and management interfaces
 
     [bookmark: pgfId-1066026] – VLAN network interfaces (sometimes referred to as switched virtual interfaces or SVIs)
 
     [bookmark: pgfId-1056132] – VLAN and private VLAN (PVLAN)
 
     [bookmark: pgfId-1056133] – Spanning Tree Protocol, including Rapid Spanning Tree (RST) and Multi-Instance Spanning Tree Protocol (MST)
 
     [bookmark: pgfId-1078252] – Fabric Extender
 
     [bookmark: pgfId-1078174] – Link-state tracking
 
     [bookmark: pgfId-1078249] – Serial Over LAN
 
     [bookmark: pgfId-1078250] – Chassis Internal Network
 
      
      	 [bookmark: pgfId-1056134]Ethernet routing
 
     
 
     [bookmark: pgfId-1078254] – Gateway Load Balancing Protocol (GLBP), object tracking, and keychain management
 
     [bookmark: pgfId-1067976] – Hot Standby Router Protocol (HSRP)
 
      
      	 [bookmark: pgfId-1067971]Network security
 
     
 
     [bookmark: pgfId-1056135] – Access control lists
 
     [bookmark: pgfId-1056136] – IEEE 802.1X
 
     [bookmark: pgfId-1056137] – Authentication, authorization, and accounting (AAA)
 
     [bookmark: pgfId-1056138] – Role-based access control
 
     [bookmark: pgfId-1056139] – Dynamic Host Configuration Protocol (DHCP) snooping
 
     [bookmark: pgfId-1056140] – Dynamic Address Resolution Protocol (ARP) inspection
 
     [bookmark: pgfId-1056141] – IP Source Guard
 
     [bookmark: pgfId-1056142] – Traffic storm control
 
     [bookmark: pgfId-1056143] – Port security
 
     [bookmark: pgfId-1068052] – Keychain management
 
      
      	 [bookmark: pgfId-1056144]General
 
     
 
     [bookmark: pgfId-1056145] – Virtual Device Context
 
     [bookmark: pgfId-1056147] – Hardware resource utilization with Ternary Content Addressable Memory (TCAM) statistics
 
     [bookmark: pgfId-1056148] – Switched Port Analyzer (SPAN)
 
     [bookmark: pgfId-1056149]Cisco DCNM includes the following features for assistance with management of your network:
 
      
      	 [bookmark: pgfId-1056150]Topology viewer
 
      	 [bookmark: pgfId-1056151]Event browser
 
      	 [bookmark: pgfId-1068068]Configuration Change Management
 
      	 [bookmark: pgfId-1068063]Device OS Management
 
      	 [bookmark: pgfId-1056152]Hardware inventory
 
     
 
     [bookmark: pgfId-1056153]Cisco DCNM includes the following administrative features:
 
      
      	 [bookmark: pgfId-1056154]Cisco DCNM server user accounts
 
      	 [bookmark: pgfId-1056155]Device discovery, including support for Cisco Discovery Protocol
 
      	 [bookmark: pgfId-1056156]Automatic synchronization with discovered devices
 
      	 [bookmark: pgfId-1056157]Statistical data collection management
 
      	 [bookmark: pgfId-1059556]Cisco DCNM server and client logging
 
     
 
    
 
     
      [bookmark: pgfId-1070502][bookmark: 27472]Cisco DCNM Licensing
 
     [bookmark: pgfId-1070506]Many of the features of Cisco DCNM, Release 4.x, do not require a license; however, some features that support only Cisco Nexus 7000 Series devices do require a license. The following features are enabled in Cisco DCNM only after you have installed a LAN Enterprise license:
 
      
      	 [bookmark: pgfId-1068263]vPCs
 
      	 [bookmark: pgfId-1068337]802.1X
 
      	 [bookmark: pgfId-1068264]Gateway load-balancing protocol (GLBP)
 
      	 [bookmark: pgfId-1068265]Object tracking
 
      	 [bookmark: pgfId-1068266]Keychain management
 
      	 [bookmark: pgfId-1068267]DHCP snooping
 
      	 [bookmark: pgfId-1068268]Dynamic ARP Inspection
 
      	 [bookmark: pgfId-1068269]ARP access control lists (ACLs)
 
      	 [bookmark: pgfId-1068270]IP Source Guard
 
      	 [bookmark: pgfId-1068271]Traffic storm control
 
      	 [bookmark: pgfId-1068272]Port security
 
      	 [bookmark: pgfId-1068273]IP tunnels
 
      	 [bookmark: pgfId-1068274]Virtual Device Contexts (VDCs)
 
      	 [bookmark: pgfId-1068275]Logical vPC view of the Topology feature
 
      	 [bookmark: pgfId-1068276]Display of historical statistical data
 
     
 
     [bookmark: pgfId-1069335]For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
 
    
 
     
      [bookmark: pgfId-1059559][bookmark: 37356]Documentation About Cisco DCNM
 
     [bookmark: pgfId-1059635]The documentation for Cisco DCNM includes several configuration guides and other documents. For more information about the Cisco DCNM documentation, see the “$paratext>” section.
 
    
 
   
 
    
     [bookmark: pgfId-1059567][bookmark: 70404]Deploying Cisco DCNM[bookmark: marker-1059558]
 
    [bookmark: pgfId-1059560]You can deploy Cisco DCNM to manage and monitor supported network devices. This procedure provides the general steps that you must take to deploy Cisco DCNM and links to more detailed procedures to help you with each general step.
 
     
      [bookmark: pgfId-1051438]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1051478]Determine which computer will run the Cisco DCNM server software. This computer should meet the system requirements for the Cisco DCNM server. For details about system requirements, see the Cisco DCNM Release Notes, Release 4.x.
 
    
 
     
      [bookmark: pgfId-1051456]DETAILED STEPS
 
     [bookmark: pgfId-1070018]To deploy Cisco DCNM, follow these steps:
 
     
 
     [bookmark: pgfId-1051420]Step 1 Prepare the computer that you want to install the Cisco DCNM server on. For more information, see the “Prerequisites for Installing the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1051544]Step 2 Download Cisco DCNM. For more information, see the “Downloading the Cisco DCNM Server Software” section.
 
     [bookmark: pgfId-1051670]Step 3 Install the Cisco DCNM server software. For more information, see the “Installing the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1051671]Step 4 Start the Cisco DCNM server. For more information, see the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1051689]Step 5 (Optional) Install the license on the Cisco DCNM server. For more information, see the “Installing Licenses” section
 
     [bookmark: pgfId-1051545]Step 6 Install the Cisco DCNM client. For more information, see Chapter3, “Downloading and Launching the Cisco DCNM Client”
 
     [bookmark: pgfId-1051547]Step 7 Prepare each Cisco NX-OS device that you want to manage and monitor by using Cisco DCNM. For more information, see the “Preparing a Cisco NX-OS Device for Management by Cisco DCNM” section.
 
      
       
     
 
     
 
     [bookmark: pgfId-1064863]Note If you are preparing a physical device that supports virtual device contexts (VDCs), remember that Cisco DCNM considers each VDC to be a device. You must perform the steps in “Preparing a Cisco NX-OS Device for Management by Cisco DCNM” section for each VDC that you want to manage and monitor with Cisco DCNM.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1051552]Step 8 Perform device discovery for one or more devices. For more information, see the “Administering Device Discovery” section.
 
     [bookmark: pgfId-1051568]Step 9 (Optional) If you installed a license, enable Cisco DCNM to use licensed features on specific devices by adding managed devices to the license. For more information, see the “Administering DCNM Licensed Devices” section.
 
     [bookmark: pgfId-1059485]Step 10 Begin using Cisco DCNM to configure and monitor the managed devices. For more information about using Cisco DCNM, see the Cisco DCNM configuration guides.
 
     [bookmark: pgfId-1051591]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1051238][bookmark: 49962]Cisco NX-OS Device Configuration Requirements[bookmark: marker-1056965]
 
    [bookmark: pgfId-1051243]This section provides information about device configuration requirements and configuration tasks you must perform on Cisco NX-OS devices that you want to manage and monitor by using Cisco DCNM. You must perform the configuration tasks by using a method other than Cisco DCNM, such as the CLI.
 
     
      
    
 
    
 
    [bookmark: pgfId-1051248]Note For up-to-date information about Cisco network device operating systems and hardware supported by Cisco DCNM, see the Cisco DCNM Release Notes, Release 4.x.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1051266]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1051268]Preparing a Cisco NX-OS Device for Management by Cisco DCNM
 
     	 [bookmark: pgfId-1051354]Cisco NX-OS System-Message Logging Requirements
 
    
 
     
      [bookmark: pgfId-1051273][bookmark: 88318]Preparing a Cisco NX-OS Device for Management by Cisco DCNM[bookmark: marker-1056966]
 
     [bookmark: pgfId-1051278]Before you perform device discovery with Cisco DCNM, you should perform the following procedure on each Cisco NX-OS device that you want to manage and monitor with Cisco DCNM. This procedure helps ensure that device discovery succeeds and that Cisco DCNM can effectively manage and monitor the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1071138]Note If you are preparing a physical device that supports virtual device contexts (VDCs), remember that Cisco DCNM considers each VDC to be a device. You must perform the steps in “Preparing a Cisco NX-OS Device for Management by Cisco DCNM” section for each VDC that you want to manage and monitor with Cisco DCNM.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1051320]DETAILED STEPS
 
     [bookmark: pgfId-1057948]To successfully discover a Cisco NX-OS device, Cisco DCNM requires that you configuring the following items in each VDC that you want to manage and monitor with Cisco DCNM:
 
     
 
     [bookmark: pgfId-1057949]Step 1 Log into the CLI of the Cisco NX-OS device.
 
     [bookmark: pgfId-1060621]Step 2 Use the configure terminal command to access global configuration mode.
 
     [bookmark: pgfId-1057952]Step 3 Ensure that an RSA or DSA key exists so that secure shell (SSH) connections can succeed. To do so, use the show ssh key rsa or show ssh key dsa command.
 
     [bookmark: pgfId-1059085]If you need to generate a key, use the ssh key command.
 
      
       
     
 
     
 
     [bookmark: pgfId-1057953]Note You must disable the SSH server before you can generate a key. To do so, use the no feature ssh command.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1057954]Step 4 Ensure that the SSH server is enabled. To do so, use the show ssh server command.
 
     [bookmark: pgfId-1057955]If the SSH server is not enabled, use the feature ssh command to enable it.
 
     [bookmark: pgfId-1057958]Step 5 Ensure that CDP is enabled globally and on the interface that Cisco DCNM uses to connect to the device. Use the show run cdp all command to see whether CDP is enabled.
 
     [bookmark: pgfId-1051943]Step 6 Ensure that the Cisco NX-OS device meets the system-message logging requirements of Cisco DCNM. For more information, see the “Cisco NX-OS System-Message Logging Requirements” section.
 
     [bookmark: pgfId-1051937]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1070693][bookmark: 90242]Cisco NX-OS System-Message Logging Requirements[bookmark: marker-1070692]
 
    [bookmark: pgfId-1070694]To monitor and manage devices, Cisco DCNM depends partly on system messages for some Cisco NX-OS features. To ensure that Cisco DCNM receives the messages that it needs, you must ensure that all Cisco NX-OS devices managed and monitored by Cisco DCNM meet the logging requirements described in this section.
 
    [bookmark: pgfId-1053003]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1054640]Interface Link-Status Events Logging Requirement
 
     	 [bookmark: pgfId-1054647]Logfile Requirements
 
     	 [bookmark: pgfId-1054654]Logging Severity-Level Requirements
 
     	 [bookmark: pgfId-1054667]Configuring a Device to Meet Cisco DCNM Logging Requirements
 
    
 
     
      [bookmark: pgfId-1053996][bookmark: 38785]Interface Link-Status Events Logging Requirement
 
     [bookmark: pgfId-1065391]You must configure the device to log system messages about interface link-status change events. This requirement ensures that Cisco DCNM receives information about interface link-status changes. The following two commands must be present in the running configuration on the device:
 
     [bookmark: pgfId-1065436]logging event link-status enable
 
     [bookmark: pgfId-1065480]logging event link status default
 
     [bookmark: pgfId-1065501]To ensure that these commands are configured on the device, perform the steps in the “Configuring a Device to Meet Cisco DCNM Logging Requirements” section.
 
    
 
     
      [bookmark: pgfId-1065393][bookmark: 26916]Logfile Requirements
 
     [bookmark: pgfId-1054026]You must configure the device to store system messages that are severity level 6 or lower in the log file.
 
     [bookmark: pgfId-1066188]Although you can specify any name for the log file, we recommend that you do not change the name of the log file. When you change the name of the log file, the device clears previous system messages. The default name of the log file is “messages”.
 
     [bookmark: pgfId-1066224]If you use the default name for the log file, the following command must be present in the running configuration on the device:
 
     [bookmark: pgfId-1065598]logging logfile messages 6
 
     [bookmark: pgfId-1065691]To ensure that this command is configured on the device, perform the steps in the “Configuring a Device to Meet Cisco DCNM Logging Requirements” section.
 
    
 
     
      [bookmark: pgfId-1054017][bookmark: 10581]Logging Severity-Level Requirements
 
     [bookmark: pgfId-1065817]All enabled features on a Cisco NX-OS have a default logging level. For features supported by Cisco DCNM, Cisco DCNM requires the logging severity levels set to a specific level depending on the feature. The logging level required varies from feature to feature. Cisco DCNM cannot configure logging levels on the managed Cisco NX-OS devices. We plan to enhance Cisco DCNM to configure logging levels in a future release; however, with Cisco DCNM Release 4.2, you must ensure that any Cisco NX-OS device that you want to manage and monitor with Cisco DCNM is configured with logging levels that meet the logging-level requirements.
 
     [bookmark: pgfId-1065788]When evaluating the logging-level configuration of a device, consider the following:
 
      
      	 [bookmark: pgfId-1054291]Cisco DCNM has logging-level requirements for only the features listed in the following tables:
 
     
 
     [bookmark: pgfId-1072641] – For Nexus 7000 Series devices, see Table 1-1.
 
     [bookmark: pgfId-1072656] – For Nexus 5000 Series devices, see Table 1-2.
 
     [bookmark: pgfId-1078112] – For Nexus 4000 Series devices, see Table 1-3.
 
     [bookmark: pgfId-1072661]If a Cisco NX-OS logging facility does not appear in Table 1-1, Table 1-2, or Table 1-3, then you do not need to configure a logging level in order for Cisco DCNM to successfully manage and monitor the device.
 
      
      	 [bookmark: pgfId-1054720]The default Cisco NX-OS logging level for some facilities is not high enough to support management of the feature by Cisco DCNM. Be sure that you raise the logging level for a facility when its default level is not high enough to satisfy the Cisco DCNM logging-level requirement. In  Table 1-1 ,  Table 1-2 , and  Table 1-3 , Cisco DCNM logging levels that exceed the default logging level appear in  bold text.
 
      	 [bookmark: pgfId-1054380]You can set a logging level higher than the Cisco DCNM requirement. The maximum logging severity level is 7. If a logging level exceeds the Cisco DCNM requirement, you do not need to lower the logging level.
 
      	 [bookmark: pgfId-1063800]Cisco NX-OS does not support logging-level configuration for disabled features. If you disable a feature, any nondefault logging level configuration is lost and is not restored if you reenable the feature later. When you enable a feature, perform the steps in the “Configuring a Device to Meet Cisco DCNM Logging Requirements” section to ensure that the logging level configuration for the feature meets Cisco DCNM requirements.
 
      	 [bookmark: pgfId-1066329]When you create a new VDC, its running configuration includes only the default logging levels. For each VDC that you create, perform the steps in the “Configuring a Device to Meet Cisco DCNM Logging Requirements” section to ensure that the logging level configuration in each VDC meets Cisco DCNM requirements.
 
     
 
     [bookmark: pgfId-1065743]To ensure that logging severity levels are correctly configured on the device, perform the steps in the “Configuring a Device to Meet Cisco DCNM Logging Requirements” section.
 
     [bookmark: pgfId-1063765]
 
      
       
        
        [bookmark: pgfId-1073174]Table 1-1 [bookmark: 29915]Cisco Nexus 7000 NX-OS Logging Levels per Cisco DCNM Feature 
 
        
        
         
         	 
           
           [bookmark: pgfId-1073188]Cisco DCNM Feature 
          
  
         	 
           
           [bookmark: pgfId-1073190]Cisco Nexus 7000 NX-OS Logging Facility 
          
  
         	 
           
           [bookmark: pgfId-1073192]Enabled by Default? 
          
  
         	 
           
           [bookmark: pgfId-1073194]Logging Facility Keyword 
          
  
         	 
           
           [bookmark: pgfId-1073196]Cisco NX-OS Default Logging Level 
          
  
         	 
           
           [bookmark: pgfId-1073198]Minimum Cisco DCNM- 
          
 
           
           [bookmark: pgfId-1073199]Required Logging Level 
           1 
          
  
         	 
           
           [bookmark: pgfId-1073204]Your Current Logging Level 
          
  
        
 
         
         	 [bookmark: pgfId-1073206]AAA
  
         	[bookmark: pgfId-1073208]AAA
  
         	[bookmark: pgfId-1073210]Yes
  
         	[bookmark: pgfId-1073212]aaa
  
         	[bookmark: pgfId-1073214]3
  
         	[bookmark: pgfId-1073216]5
  
         	[bookmark: pgfId-1073218] 
  
        
 
         
         	[bookmark: pgfId-1073222]RADIUS
  
         	[bookmark: pgfId-1073224]Yes
  
         	[bookmark: pgfId-1073226]radius
  
         	[bookmark: pgfId-1073228]3
  
         	[bookmark: pgfId-1073230]5
  
         	[bookmark: pgfId-1073232] 
  
        
 
         
         	[bookmark: pgfId-1073236]TACACS+
  
         	[bookmark: pgfId-1073238]No
  
         	[bookmark: pgfId-1073240]tacacs+
  
         	[bookmark: pgfId-1073242]3
  
         	[bookmark: pgfId-1073244]5
  
         	[bookmark: pgfId-1073246] 
  
        
 
         
         	[bookmark: pgfId-1073248]Device Discovery
  
         	 [bookmark: pgfId-1073250]CDP
  
         	 [bookmark: pgfId-1073252]Yes
  
         	 [bookmark: pgfId-1073254]cdp
  
         	 [bookmark: pgfId-1073256]2
  
         	 [bookmark: pgfId-1073258]6
  
         	 [bookmark: pgfId-1073260] 
  
        
 
         
         	[bookmark: pgfId-1073262]Topology
  
        
 
         
         	[bookmark: pgfId-1073276]DHCP snooping
  
         	 [bookmark: pgfId-1073278]DHCP snooping
  
         	 [bookmark: pgfId-1073280]No
  
         	 [bookmark: pgfId-1073282]dhcp
  
         	 [bookmark: pgfId-1073284]2
  
         	 [bookmark: pgfId-1073286]6
  
         	 [bookmark: pgfId-1073288] 
  
        
 
         
         	[bookmark: pgfId-1073290]Dynamic ARP Inspection
  
        
 
         
         	[bookmark: pgfId-1073304]IP Source Guard
  
        
 
         
         	[bookmark: pgfId-1073318]Dot1X
  
         	[bookmark: pgfId-1073320]802.1X
  
         	[bookmark: pgfId-1073322]No
  
         	[bookmark: pgfId-1073324]dot1x
  
         	[bookmark: pgfId-1073326]2
  
         	[bookmark: pgfId-1073328]5
  
         	[bookmark: pgfId-1073330] 
  
        
 
         
         	[bookmark: pgfId-1077582]Ethernet Interfaces
  
         	 [bookmark: pgfId-1077584]Ethernet port manager
  
         	 [bookmark: pgfId-1077586]Yes
  
         	 [bookmark: pgfId-1077588]ethpm
  
         	 [bookmark: pgfId-1077590]5
  
         	 [bookmark: pgfId-1077592]5
  
         	 [bookmark: pgfId-1077594] 
  
        
 
         
         	[bookmark: pgfId-1077596]Traffic Storm Control
  
        
 
         
         	[bookmark: pgfId-1073360]Gateway Load Balancing Protocol (GLBP)
  
         	[bookmark: pgfId-1073362]GLBP
  
         	[bookmark: pgfId-1073364]No
  
         	[bookmark: pgfId-1073366]glbp
  
         	[bookmark: pgfId-1073368]3
  
         	[bookmark: pgfId-1073370]6
  
         	[bookmark: pgfId-1073372] 
  
        
 
         
         	[bookmark: pgfId-1073374]Hot Standby Router Protocol (HSRP)
  
         	[bookmark: pgfId-1073376]HSRP engine
  
         	[bookmark: pgfId-1073378]No
  
         	[bookmark: pgfId-1073380]hsrp
  
         	[bookmark: pgfId-1073382]3
  
         	 
        
 
         
         	 [bookmark: pgfId-1073388]Inventory
  
         	[bookmark: pgfId-1073390]Module
  
         	[bookmark: pgfId-1073392]Yes
  
         	[bookmark: pgfId-1073394]module
  
         	[bookmark: pgfId-1073396]5
  
         	[bookmark: pgfId-1073398]5
  
         	[bookmark: pgfId-1073400] 
  
        
 
         
         	[bookmark: pgfId-1073404]Platform
  
         	[bookmark: pgfId-1073406]Yes
  
         	[bookmark: pgfId-1073408]platform
  
         	[bookmark: pgfId-1073410]5
  
         	[bookmark: pgfId-1073412]5
  
         	[bookmark: pgfId-1073414] 
  
        
 
         
         	[bookmark: pgfId-1073418]System manager
  
         	[bookmark: pgfId-1073420]Yes
  
         	[bookmark: pgfId-1073422]sysmgr
  
         	[bookmark: pgfId-1073424]3
  
         	[bookmark: pgfId-1073426]3
  
         	[bookmark: pgfId-1073428] 
  
        
 
         
         	[bookmark: pgfId-1073430]Object Tracking
  
         	[bookmark: pgfId-1073432]Object tracking
  
         	[bookmark: pgfId-1073434]Yes
  
         	[bookmark: pgfId-1073436]track
  
         	[bookmark: pgfId-1073438]3
  
         	[bookmark: pgfId-1073440]6
  
         	[bookmark: pgfId-1073442] 
  
        
 
         
         	[bookmark: pgfId-1073444]Port-Channel Interfaces
  
         	[bookmark: pgfId-1073446]Port-channel interfaces
  
         	[bookmark: pgfId-1073448]Yes
  
         	[bookmark: pgfId-1073450]port-channel
  
         	[bookmark: pgfId-1073452]5
  
         	[bookmark: pgfId-1073454]6
  
         	[bookmark: pgfId-1073456] 
  
        
 
         
         	[bookmark: pgfId-1073458]Port security
  
         	[bookmark: pgfId-1073460]Port security
  
         	[bookmark: pgfId-1073462]No
  
         	[bookmark: pgfId-1073464]port-security
  
         	[bookmark: pgfId-1073466]2
  
         	[bookmark: pgfId-1073468]5
  
         	[bookmark: pgfId-1073470] 
  
        
 
         
         	[bookmark: pgfId-1073472]SPAN
  
         	[bookmark: pgfId-1073474]SPAN
  
         	[bookmark: pgfId-1073476]Yes
  
         	[bookmark: pgfId-1073478]monitor
  
         	[bookmark: pgfId-1073480]3
  
         	[bookmark: pgfId-1073482]6
  
         	[bookmark: pgfId-1073484] 
  
        
 
         
         	[bookmark: pgfId-1073500]Spanning Tree
  
         	[bookmark: pgfId-1073502]Spanning tree
  
         	[bookmark: pgfId-1073504]Yes
  
         	[bookmark: pgfId-1073506]spanning-tree
  
         	[bookmark: pgfId-1073508]3
  
         	[bookmark: pgfId-1073510]6
  
         	[bookmark: pgfId-1073512] 
  
        
 
         
         	[bookmark: pgfId-1078260]Unidirectional Link Detection (UDLD)
  
         	[bookmark: pgfId-1078262]UDLD
  
         	[bookmark: pgfId-1078286]No
  
         	[bookmark: pgfId-1078288]udld
  
         	[bookmark: pgfId-1078290]5
  
         	[bookmark: pgfId-1078292]5
  
         	[bookmark: pgfId-1078294] 
  
        
 
         
         	[bookmark: pgfId-1073514]Virtual Device Contexts (VDCs)
  
         	[bookmark: pgfId-1073516]VDC manager
  
         	[bookmark: pgfId-1073518]Yes
  
         	[bookmark: pgfId-1073520]vdc_mgr
  
         	[bookmark: pgfId-1073522]6
  
         	[bookmark: pgfId-1073524]6
  
         	[bookmark: pgfId-1073526] 
  
        
 
         
         	[bookmark: pgfId-1073528]Virtual Port Channel (vPC)
  
         	[bookmark: pgfId-1073530]VPC
  
         	[bookmark: pgfId-1073532]No
  
         	[bookmark: pgfId-1073534]vpc
  
         	[bookmark: pgfId-1073536]2
  
         	[bookmark: pgfId-1073538]6
  
         	[bookmark: pgfId-1073540] 
  
        
 
         
         	[bookmark: pgfId-1073542]VLAN Network Interfaces
  
         	[bookmark: pgfId-1073544]Interface VLAN
  
         	[bookmark: pgfId-1073546]No
  
         	[bookmark: pgfId-1073548]interface-vlan
  
         	[bookmark: pgfId-1073550]2
  
         	[bookmark: pgfId-1073552]5
  
         	[bookmark: pgfId-1073554] 
  
        
 
        
      
 
     
 
      
       
        
        	 1.[bookmark: pgfId-1073202]Minimum Cisco DCNM logging levels appear in bold text for Cisco Nexus 7000 NX-OS logging facilities that have a default logging level that is too low.
  
       
 
       
     
 
     [bookmark: pgfId-1072446]
 
      
       
        
        [bookmark: pgfId-1077083]Table 1-2 [bookmark: 54017]Cisco Nexus 5000 NX-OS Logging Levels per Cisco DCNM Feature 
 
        
        
         
         	 
           
           [bookmark: pgfId-1077097]Cisco DCNM Feature 
          
  
         	 
           
           [bookmark: pgfId-1077099]Cisco Nexus 5000 NX-OS Logging Facility 
          
  
         	 
           
           [bookmark: pgfId-1077101]Enabled by Default? 
          
  
         	 
           
           [bookmark: pgfId-1077103]Logging Facility Keyword 
          
  
         	 
           
           [bookmark: pgfId-1077105]Cisco NX-OS Default Logging Level 
          
  
         	 
           
           [bookmark: pgfId-1077107]Minimum Cisco DCNM- 
          
 
           
           [bookmark: pgfId-1077108]Required Logging Level 
           2 
          
  
         	 
           
           [bookmark: pgfId-1077113]Your Current Logging Level 
          
  
        
 
         
         	 [bookmark: pgfId-1077115]AAA
  
         	[bookmark: pgfId-1077117]AAA
  
         	[bookmark: pgfId-1077119]Yes
  
         	[bookmark: pgfId-1077121]aaa
  
         	[bookmark: pgfId-1077123]3
  
         	[bookmark: pgfId-1077125]5
  
         	[bookmark: pgfId-1077127] 
  
        
 
         
         	[bookmark: pgfId-1077131]RADIUS
  
         	[bookmark: pgfId-1077133]Yes
  
         	[bookmark: pgfId-1077135]radius
  
         	[bookmark: pgfId-1077137]3
  
         	[bookmark: pgfId-1077139]5
  
         	[bookmark: pgfId-1077141] 
  
        
 
         
         	[bookmark: pgfId-1077145]TACACS+
  
         	[bookmark: pgfId-1077147]No
  
         	[bookmark: pgfId-1077149]tacacs+
  
         	[bookmark: pgfId-1077151]3
  
         	[bookmark: pgfId-1077153]5
  
         	[bookmark: pgfId-1077155] 
  
        
 
         
         	[bookmark: pgfId-1077157]Device Discovery
  
         	 [bookmark: pgfId-1077159]CDP
  
         	 [bookmark: pgfId-1077161]Yes
  
         	 [bookmark: pgfId-1077163]cdp
  
         	 [bookmark: pgfId-1077165]2
  
         	 [bookmark: pgfId-1077167]6
  
         	 [bookmark: pgfId-1077169] 
  
        
 
         
         	[bookmark: pgfId-1077171]Topology
  
        
 
         
         	[bookmark: pgfId-1078334]Ethernet Interfaces
  
         	 [bookmark: pgfId-1077215]Ethernet port manager
  
         	 [bookmark: pgfId-1077217]Yes
  
         	 [bookmark: pgfId-1077219]ethpm
  
         	 [bookmark: pgfId-1077221]5
  
         	 [bookmark: pgfId-1077223]5
  
         	 [bookmark: pgfId-1077225] 
  
        
 
         
         	[bookmark: pgfId-1077227]Traffic Storm Control
  
        
 
         
         	[bookmark: pgfId-1077241]Fabric Extender
  
         	[bookmark: pgfId-1077243]FEX
  
         	[bookmark: pgfId-1077245]Yes
  
         	[bookmark: pgfId-1077247]fex
  
         	[bookmark: pgfId-1077249]5
  
         	[bookmark: pgfId-1077251]5
  
         	[bookmark: pgfId-1077253] 
  
        
 
         
         	 [bookmark: pgfId-1077255]Inventory
  
         	[bookmark: pgfId-1077257]System manager
  
         	[bookmark: pgfId-1077259]Yes
  
         	[bookmark: pgfId-1077261]sysmgr
  
         	[bookmark: pgfId-1077263]3
  
         	[bookmark: pgfId-1077265]3
  
         	[bookmark: pgfId-1077267] 
  
        
 
         
         	[bookmark: pgfId-1078027]Platform
  
         	[bookmark: pgfId-1078029]Yes
  
         	[bookmark: pgfId-1078031]pfm
  
         	[bookmark: pgfId-1078033]5
  
         	 
        
 
         
         	[bookmark: pgfId-1078013]NOHMS
  
         	[bookmark: pgfId-1078015]Yes
  
         	[bookmark: pgfId-1078017]nohms
  
         	[bookmark: pgfId-1078019]2
  
         	 
        
 
         
         	[bookmark: pgfId-1077269]Port-Channel Interfaces
  
         	[bookmark: pgfId-1077271]Port-channel interfaces
  
         	[bookmark: pgfId-1077273]Yes
  
         	[bookmark: pgfId-1077275]port-channel
  
         	[bookmark: pgfId-1077277]5
  
         	[bookmark: pgfId-1077279]6
  
         	[bookmark: pgfId-1077281] 
  
        
 
         
         	[bookmark: pgfId-1077283]SPAN
  
         	[bookmark: pgfId-1077285]SPAN
  
         	[bookmark: pgfId-1077287]Yes
  
         	[bookmark: pgfId-1077289]monitor
  
         	[bookmark: pgfId-1077291]3
  
         	[bookmark: pgfId-1077293]6
  
         	[bookmark: pgfId-1077295] 
  
        
 
         
         	[bookmark: pgfId-1077297]Spanning Tree
  
         	[bookmark: pgfId-1077299]Spanning tree
  
         	[bookmark: pgfId-1077301]Yes
  
         	[bookmark: pgfId-1077303]spanning-tree
  
         	[bookmark: pgfId-1077305]3
  
         	[bookmark: pgfId-1077307]6
  
         	[bookmark: pgfId-1077309] 
  
        
 
         
         	[bookmark: pgfId-1078318]Unidirectional Link Detection (UDLD)
  
         	[bookmark: pgfId-1078320]UDLD
  
         	[bookmark: pgfId-1078322]No
  
         	[bookmark: pgfId-1078324]udld
  
         	[bookmark: pgfId-1078326]5
  
         	[bookmark: pgfId-1078328]5
  
         	[bookmark: pgfId-1078330] 
  
        
 
         
         	[bookmark: pgfId-1077325]Virtual Port Channel
  
         	[bookmark: pgfId-1077327]VPC
  
         	[bookmark: pgfId-1077329]No
  
         	[bookmark: pgfId-1077331]vpc
  
         	[bookmark: pgfId-1077333]2
  
         	[bookmark: pgfId-1077335]6
  
         	[bookmark: pgfId-1077337] 
  
        
 
         
         	[bookmark: pgfId-1077339]VLAN Network Interfaces
  
         	[bookmark: pgfId-1077341]Interface VLAN
  
         	[bookmark: pgfId-1077343]No
  
         	[bookmark: pgfId-1077345]interface-vlan
  
         	[bookmark: pgfId-1077347]2
  
         	[bookmark: pgfId-1077349]5
  
         	[bookmark: pgfId-1077351] 
  
        
 
        
      
 
     
 
      
       
        
        	 2.[bookmark: pgfId-1077111]Minimum Cisco DCNM logging levels appear in bold text for Cisco Nexus 5000 NX-OS logging facilities that have a default logging level that is too low.
  
       
 
       
     
 
     [bookmark: pgfId-1074178]
 
      
       
        
        [bookmark: pgfId-1077640]Table 1-3 [bookmark: 58169]Cisco Nexus 4000 NX-OS Logging Levels per Cisco DCNM Feature 
 
        
        
         
         	 
           
           [bookmark: pgfId-1077654]Cisco DCNM Feature 
          
  
         	 
           
           [bookmark: pgfId-1077656]Cisco Nexus 4000 NX-OS Logging Facility 
          
  
         	 
           
           [bookmark: pgfId-1077658]Enabled by Default? 
          
  
         	 
           
           [bookmark: pgfId-1077660]Logging Facility Keyword 
          
  
         	 
           
           [bookmark: pgfId-1077662]Cisco NX-OS Default Logging Level 
          
  
         	 
           
           [bookmark: pgfId-1077664]Minimum Cisco DCNM- 
          
 
           
           [bookmark: pgfId-1077665]Required Logging Level 
           3 
          
  
         	 
           
           [bookmark: pgfId-1077670]Your Current Logging Level 
          
  
        
 
         
         	 [bookmark: pgfId-1077672]AAA
  
         	[bookmark: pgfId-1077674]AAA
  
         	[bookmark: pgfId-1077676]Yes
  
         	[bookmark: pgfId-1077678]aaa
  
         	[bookmark: pgfId-1077680]3
  
         	[bookmark: pgfId-1077682]5
  
         	[bookmark: pgfId-1077684] 
  
        
 
         
         	[bookmark: pgfId-1077688]RADIUS
  
         	[bookmark: pgfId-1077690]Yes
  
         	[bookmark: pgfId-1077692]radius
  
         	[bookmark: pgfId-1077694]3
  
         	[bookmark: pgfId-1077696]5
  
         	[bookmark: pgfId-1077698] 
  
        
 
         
         	[bookmark: pgfId-1077702]TACACS+
  
         	[bookmark: pgfId-1077704]No
  
         	[bookmark: pgfId-1077706]tacacs+
  
         	[bookmark: pgfId-1077708]3
  
         	[bookmark: pgfId-1077710]5
  
         	[bookmark: pgfId-1077712] 
  
        
 
         
         	[bookmark: pgfId-1077714]Device Discovery
  
         	 [bookmark: pgfId-1077716]CDP
  
         	 [bookmark: pgfId-1077718]Yes
  
         	 [bookmark: pgfId-1077720]cdp
  
         	 [bookmark: pgfId-1077722]2
  
         	 [bookmark: pgfId-1077724]6
  
         	 [bookmark: pgfId-1077726] 
  
        
 
         
         	[bookmark: pgfId-1077728]Topology
  
        
 
         
         	[bookmark: pgfId-1078426]Ethernet Interfaces
  
         	 [bookmark: pgfId-1077760]Ethernet port manager
  
         	 [bookmark: pgfId-1077762]Yes
  
         	 [bookmark: pgfId-1077764]ethpm
  
         	 [bookmark: pgfId-1077766]5
  
         	 [bookmark: pgfId-1077768]5
  
         	 [bookmark: pgfId-1077770] 
  
        
 
         
         	[bookmark: pgfId-1077772]Traffic Storm Control
  
        
 
         
         	[bookmark: pgfId-1077800]Inventory
  
         	[bookmark: pgfId-1077802]System manager
  
         	[bookmark: pgfId-1077804]Yes
  
         	[bookmark: pgfId-1077806]sysmgr
  
         	[bookmark: pgfId-1077808]3
  
         	[bookmark: pgfId-1077810]3
  
         	[bookmark: pgfId-1077812] 
  
        
 
         
         	[bookmark: pgfId-1077914]Link State Tracking
  
         	[bookmark: pgfId-1077916]LST
  
         	[bookmark: pgfId-1077918]No
  
         	[bookmark: pgfId-1077920]lstsvc
  
         	[bookmark: pgfId-1077922]2
  
         	[bookmark: pgfId-1077924]4
  
         	[bookmark: pgfId-1077926] 
  
        
 
         
         	[bookmark: pgfId-1077814]Port-Channel Interfaces
  
         	[bookmark: pgfId-1077816]Port-channel interfaces
  
         	[bookmark: pgfId-1077818]Yes
  
         	[bookmark: pgfId-1077820]port-channel
  
         	[bookmark: pgfId-1077822]5
  
         	[bookmark: pgfId-1077824]6
  
         	[bookmark: pgfId-1077826] 
  
        
 
         
         	[bookmark: pgfId-1077828]SPAN
  
         	[bookmark: pgfId-1077830]SPAN
  
         	[bookmark: pgfId-1077832]Yes
  
         	[bookmark: pgfId-1077834]monitor
  
         	[bookmark: pgfId-1077836]3
  
         	[bookmark: pgfId-1077838]6
  
         	[bookmark: pgfId-1077840] 
  
        
 
         
         	[bookmark: pgfId-1077842]Spanning Tree
  
         	[bookmark: pgfId-1077844]Spanning tree
  
         	[bookmark: pgfId-1077846]Yes
  
         	[bookmark: pgfId-1077848]spanning-tree
  
         	[bookmark: pgfId-1077850]3
  
         	[bookmark: pgfId-1077852]6
  
         	[bookmark: pgfId-1077854] 
  
        
 
         
         	[bookmark: pgfId-1078340]Unidirectional Link Detection (UDLD)
  
         	[bookmark: pgfId-1078342]UDLD
  
         	[bookmark: pgfId-1078344]No
  
         	[bookmark: pgfId-1078346]udld
  
         	[bookmark: pgfId-1078348]5
  
         	[bookmark: pgfId-1078350]5
  
         	[bookmark: pgfId-1078352] 
  
        
 
         
         	[bookmark: pgfId-1077870]VLAN Network Interfaces
  
         	[bookmark: pgfId-1077872]Interface VLAN
  
         	[bookmark: pgfId-1077874]No
  
         	[bookmark: pgfId-1077876]interface-vlan
  
         	[bookmark: pgfId-1077878]2
  
         	[bookmark: pgfId-1077880]5
  
         	[bookmark: pgfId-1077882] 
  
        
 
        
      
 
     
 
      
       
        
        	 3.[bookmark: pgfId-1077668]Minimum Cisco DCNM logging levels appear in bold text for Cisco Nexus 4000 NX-OS logging facilities that have a default logging level that is too low.
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-1061956][bookmark: 55380]Configuring a Device to Meet Cisco DCNM Logging Requirements
 
     [bookmark: pgfId-1061957]When you are preparing a device for management and monitoring by Cisco DCNM, you can perform an initial logging configuration. If you later enable a feature that was previously disabled, we recommend that you perform this procedure again to ensure that logging configuration on the device meets Cisco DCNM requirements.
 
     [bookmark: pgfId-1066436]You should also perform this procedure when you create a VDC on a Cisco Nexus 7000 Series device. Regardless of whether you used Cisco DCNM to create the VDC or whether you used the CLI, the logging configuration of a new VDC is only the default configuration and must be configured to support management and monitoring by Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1052010]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1063950]Consider printing Table 1-1, Table 1-2, or Table 1-3, as needed. You can use the Your Current Logging Level column to make notes about logging level configuration on the device.
 
    
 
     
      [bookmark: pgfId-1052021]DETAILED STEPS
 
     [bookmark: pgfId-1055487]To perform the initial Cisco NX-OS logging configuration, follow these steps:
 
     
 
     [bookmark: pgfId-1052017]Step 1 Log into the Cisco NX-OS device.
 
     [bookmark: pgfId-1065113]Step 2 Access the global configuration mode.
 
      
      [bookmark: pgfId-1065114]switch# configure terminal 
     
 
      
      [bookmark: pgfId-1065115]switch(config)# 
     
 
      
      [bookmark: pgfId-1065122] 
     
 
     [bookmark: pgfId-1052035]Step 3 Verify that the logging event link-status default and logging event link-status enable commands are configured.
 
      
      [bookmark: pgfId-1061210]switch(config)# show running-config all | include "logging event link-status" 
     
 
      
      [bookmark: pgfId-1061211]logging event link-status default 
     
 
      
      [bookmark: pgfId-1061171]logging event link-status enable 
     
 
      
      [bookmark: pgfId-1061227] 
     
 
     [bookmark: pgfId-1061259]If either command is missing, enter it to add it to the running configuration.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065157]Note The logging event link-status enable is included in the default Cisco NX-OS configuration. The show running-config command displays the default configuration only if you use the all keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1054177]Step 4 Verify that the device is configured to log system messages that are severity 6 or lower.
 
      
       
     
 
     
 
     [bookmark: pgfId-1066678]Note The default name of the log file is “messages”; however, we recommend that you use the log-file name currently configured on the device. If you change the name of the log file, the device clears previous system messages.
 
      
      
 
     
 
     
 
      
      [bookmark: pgfId-1066650]switch(config)# show running-config all | include logfile 
     
 
      
      [bookmark: pgfId-1066651]logging logfile logfile-name 6 
     
 
      
      [bookmark: pgfId-1066652] 
     
 
     [bookmark: pgfId-1064787]If the logging logfile command does not appear or if the severity level is less than 6, configure the logging logfile command.
 
      
      [bookmark: pgfId-1064774]switch(config)# logging logfile logfile-name 6 
     
 
      
      [bookmark: pgfId-1054795] 
     
 
     [bookmark: pgfId-1054176]Step 5 Determine which nondefault features are enabled on the device.
 
      
      [bookmark: pgfId-1063612]switch(config)# show running-config | include feature 
     
 
      
      [bookmark: pgfId-1063614]feature feature1 
     
 
      
      [bookmark: pgfId-1065142]feature feature2 
     
 
      
      [bookmark: pgfId-1065146]feature feature3 
     
 
      
      [bookmark: pgfId-1063626]. 
     
 
      
      [bookmark: pgfId-1065155]. 
     
 
      
      [bookmark: pgfId-1065156]. 
     
 
      
      [bookmark: pgfId-1065140] 
     
 
     [bookmark: pgfId-1063576]Step 6 [bookmark: 26062]View the logging levels currently configured on the device. The show logging level command displays logging levels only for features that are enabled. The Current Session Severity column lists the current logging level.
 
      
      [bookmark: pgfId-1063858]switch(config)# show logging level 
     
 
      
      [bookmark: pgfId-1063878]Facility Default Severity Current Session Severity 
     
 
      
      [bookmark: pgfId-1063879]-------- ---------------- ------------------------ 
     
 
      
      [bookmark: pgfId-1063880]aaa 3 5 
     
 
      
      [bookmark: pgfId-1063881]aclmgr 3 3 
     
 
      
      [bookmark: pgfId-1063890]. 
     
 
      
      [bookmark: pgfId-1063903]. 
     
 
      
      [bookmark: pgfId-1063904]. 
     
 
      
      [bookmark: pgfId-1063917] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1063860]Tip You can use the show logging level command with the facility name when you want to see the logging level of a single logging facility, such as show logging level aaa.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1064175]Step 7 Determine which logging levels on the device are below the minimum Cisco DCNM-required logging levels. To do so, compare the logging levels displayed in Step 6 to the minimum Cisco DCNM-required logging levels that are listed in the applicable table, as follows:
 
      
       
       	 [bookmark: pgfId-1072735]For a Nexus 7000 Series device, see  Table 1-1 .
 
       	 [bookmark: pgfId-1078104]For a Nexus 5000 Series device, see  Table 1-2 .
 
       	 [bookmark: pgfId-1072744]For a Nexus 4000 Series device, see  Table 1-3 .
 
      
 
     
 
     [bookmark: pgfId-1063700]Step 8 For each logging facility with a logging level that is below the minimum Cisco DCNM-required logging level, configure the device with a logging level that meets or exceeds the Cisco DCNM requirement.
 
      
      [bookmark: pgfId-1054922]switch(config)# logging level facility severity-level 
     
 
      
      [bookmark: pgfId-1055430] 
     
 
     [bookmark: pgfId-1055434]The facility argument is the applicable logging-facility keyword from Table 1-1, Table 1-2, or Table 1-3, and severity-level is the applicable minimum Cisco DCNM-required logging level or higher (up to 7).
 
     [bookmark: pgfId-1063663]Step 9 Use the show logging level command to verify your changes to the configuration.
 
     [bookmark: pgfId-1064227]Step 10 Copy the running configuration to the startup configuration to save your changes.
 
      
      [bookmark: pgfId-1063690]switch(config)# copy running-config startup-config 
     
 
      
      [bookmark: pgfId-1063691][########################################] 100% 
     
 
      
      [bookmark: pgfId-1063683]switch(config)# 
     
 
      
      [bookmark: pgfId-1067678] 
     
 
     [bookmark: pgfId-1067679]
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1050709][bookmark: 50487]Installing and Launching the Cisco DCNM Server 
      
      
 
     
 
 
    [bookmark: pgfId-1056264]This chapter describes how to install and launch the Cisco Data Center Network Manager (DCNM) server.
 
    [bookmark: pgfId-1089282]When you install the Cisco DCNM server, you initially install the software without applying a license. You can use many of the product features without using a license, but if you try to use a feature that requires a license, Cisco DCNM displays a message saying that a license is required for that feature. To use that feature and any other licensed feature, you must purchase and install the Cisco DCNM Enterprise LAN license.
 
    [bookmark: pgfId-1061610]If the server system is running the Windows Server 2003 operating system, the Cisco DCNM server runs as a Windows service. By default, the Cisco DCNM server starts automatically when you boot up the server system. You can manually stop, start, or pause this service. You can also change the startup instructions for Cisco DCNM to automatically start up when you start the operating system, start up manually, or be disabled from starting.
 
    [bookmark: pgfId-1051419]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1094607]Cisco Fabric Manager Support
 
     	 [bookmark: pgfId-1096881]Database Support
 
     	 [bookmark: pgfId-1109435]Prerequisites for Installing the Cisco DCNM Server
 
     	 [bookmark: pgfId-1096874]Server Ports
 
     	 [bookmark: pgfId-1051428]Downloading the Cisco DCNM Server Software
 
     	 [bookmark: pgfId-1051957]Installing the Cisco DCNM Server
 
     	 [bookmark: pgfId-1051433]Starting the Cisco DCNM Server
 
     	 [bookmark: pgfId-1051438]Installing Licenses
 
     	 [bookmark: pgfId-1064507]Upgrading the Cisco DCNM Server
 
     	 [bookmark: pgfId-1051722]Downgrading the Cisco DCNM Server
 
     	 [bookmark: pgfId-1101021]Reinstalling the Cisco DCNM Server
 
     	 [bookmark: pgfId-1078689]Stopping the Cisco DCNM Server
 
     	 [bookmark: pgfId-1089636]Additional References
 
     	 [bookmark: pgfId-1051439]Feature History for Installing and Launching the Cisco DCNM Server
 
    
 
   
 
    
     [bookmark: pgfId-1094460][bookmark: 99095]Cisco Fabric Manager Support
 
    [bookmark: pgfId-1094461]Beginning with Cisco DCNM Release 4.2(1), Cisco DCNM supports installing the Cisco DCNM server on a server system that has an installation of Cisco Fabric Manager Release 4.2(1) and later releases. If you install the Cisco DCNM server on a server system that already has an installation of Cisco Fabric Manager Release 4.2(1) and later releases, the Cisco DCNM installer detects the Fabric Manager installation, which has the following effects on the installation:
 
     
     	 [bookmark: pgfId-1094488]The installation folder is determined by the installer and cannot be configured.
 
     	 [bookmark: pgfId-1094548]The database that the installer configures the Cisco DCNM server to use is the database that Fabric Manager is configured to use. You cannot choose a database other than the database used by Fabric Manager.
 
     	 [bookmark: pgfId-1094588]The installer resolves port conflicts between the ports in use by Fabric Manager and the default ports that the Cisco DCNM server uses.
 
    
 
   
 
    
     [bookmark: pgfId-1094238][bookmark: 43117]Database Support
 
    [bookmark: pgfId-1095539]Cisco DCNM supports the following databases:
 
     
     	 [bookmark: pgfId-1095579]PostgreSQL 8.1
 
     	 [bookmark: pgfId-1095583]PostgreSQL 8.2
 
     	 [bookmark: pgfId-1095592]Oracle Database 10g
 
     	 [bookmark: pgfId-1095623]Oracle Database 11g
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1097441]Note If you plan to use an Oracle database, ensure that the Oracle database meets the prerequisites listed in the “Prerequisites for Installing the Cisco DCNM Server” section.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1095668]If the Cisco DCNM installer does not find a previous installation of a supported database, it can install PostgreSQL 8.2 for you.
 
   
 
    
     [bookmark: pgfId-1105551][bookmark: 83605]Prerequisites for Installing the Cisco DCNM Server
 
    [bookmark: pgfId-1105553][bookmark: marker-1105552]Before you can install the Cisco DCNM server, ensure that the Cisco DCNM server system meets the following prerequisites:
 
     
     	 [bookmark: pgfId-1096739]The server system  must meet the server system requirements published in the  Cisco DCNM Release Notes, Release 4.x , available online at the following URL:
 
    
 
    [bookmark: pgfId-1105643]http://www.cisco.com/en/US/docs/switches/datacenter/sw/4_2/dcnm/release/notes/
dcnm_4_2_relnotes.html 
 
     
     	 [bookmark: pgfId-1096741]If you plan to use an Oracle 10g database, configure the Oracle database as follows:
 
    
 
    [bookmark: pgfId-1096985] – Increase the SYSTEM tablespace to 2 GB from the default 1 GB of space. For more information, see the “Increasing the SYSTEM Tablespace” section.
 
    [bookmark: pgfId-1097069] – Increase the number of sessions and process to 150 each from the default of 50. For more information, see the “Increasing the Number of Sessions and Processes” section.
 
    [bookmark: pgfId-1097088] – Increase the number of open cursors to 1000 from the default of 50. For more information, see the “Increasing the Number of Open Cursors” section.
 
     
     	 [bookmark: pgfId-1097141]If you plan to use an Oracle 11g database, configure the Oracle database as follows:
 
    
 
    [bookmark: pgfId-1097146] – Increase the number of sessions and process to 150 each from the default of 50. For more information, see the “Increasing the Number of Sessions and Processes” section.
 
    [bookmark: pgfId-1097150] – Increase the number of open cursors to 1000 from the default of 300. For more information, see the “Increasing the Number of Open Cursors” section.
 
     
     	 [bookmark: pgfId-1096742]For RHEL 4 AS, the maximum shared memory size must be 128 MB or more. To configure the maximum shared memory to 128 MB, use the following command:
 
    
 
     
     [bookmark: pgfId-1096743]sysctl -w kernel.shmmax=134217728 
    
 
     
     [bookmark: pgfId-1096744] 
    
 
    [bookmark: pgfId-1096745]This setting, kernel.shmmax=134217728, should be saved in the /etc/sysctl.conf file. If this setting is not present or if it is less than 134217728, the Cisco DCNM server will fail after the server system is rebooted. For more information, see the following URL:
 
    [bookmark: pgfId-1096747]http://www.postgresql.org/docs/8.2/interactive/kernel-resources.html
 
     
     	 [bookmark: pgfId-1096748]The IP address of the server system should be statically assigned. The Cisco DCNM server binds to an IP address that you specify during installation. If the IP address of the server system changes after you install the Cisco DCNM server, Cisco DCNM clients are unable to connect to the Cisco DCNM server and you must stop and reinstall the Cisco DCNM server so that you can reconfigure the IP address.
 
     	 [bookmark: pgfId-1096749]The server system must be registered with the DNS servers.
 
     	 [bookmark: pgfId-1107380]A Perl environment must already be installed on the server system. We recommend Active Perl version 5.8.9.827. You can download ActivePerl for your server operating system from the following location:
 
    
 
    [bookmark: pgfId-1107382]http://www.activestate.com/activeperl/downloads/
 
     
     	 [bookmark: pgfId-1096750]The path to the Perl executable must be defined in the server system PATH environment variable.
 
     	 [bookmark: pgfId-1096752]Ensure that no other programs are running on the server, except for Cisco Fabric Manager Release 4.2(1) and later releases and the database software used by Fabric Manager.
 
    
 
   
 
    
     [bookmark: pgfId-1109077][bookmark: 42932]Server Ports[bookmark: marker-1109076]
 
    [bookmark: pgfId-1109078]A Cisco DCNM server must be able to receive the network traffic from Cisco DCNM clients on a number of ports. Any network gateway device that controls the traffic sent from a Cisco DCNM client to a Cisco DCNM server must permit the traffic sent to the ports that the Cisco DCNM server is configured to use.
 
    [bookmark: pgfId-1109082]Table 2-1 lists the default ports that services on a Cisco DCNM server listen to for client communications. You can configure two ports during installation. If a default port is already in use on the server system, the Cisco DCNM server installer resolves the port conflict automatically by assigning a different port to the service.
 
    [bookmark: pgfId-1109187]
 
     
      
       
       [bookmark: pgfId-1109089]Table 2-1 [bookmark: 69620]Default TCP Ports for Client Communications 
 
       
       
        
        	 
          
          [bookmark: pgfId-1109095]Service Name 
         
  
        	 
          
          [bookmark: pgfId-1109097]Default Port 
         
  
        	 
          
          [bookmark: pgfId-1109099]Configurable? 
         
  
       
 
        
        	[bookmark: pgfId-1109110]RMI
  
        	[bookmark: pgfId-1109112]1098
  
        	[bookmark: pgfId-1109114]No
  
       
 
        
        	[bookmark: pgfId-1109116]Naming Service
  
        	[bookmark: pgfId-1109118]1099
  
        	[bookmark: pgfId-1109120]During installation
  
       
 
        
        	[bookmark: pgfId-1109134]EJB
  
        	[bookmark: pgfId-1109136]3873
  
        	[bookmark: pgfId-1109138]No
  
       
 
        
        	[bookmark: pgfId-1109140]Server Bind 1
  
        	[bookmark: pgfId-1109142]4445
  
        	[bookmark: pgfId-1109144]No
  
       
 
        
        	[bookmark: pgfId-1109146]Server Bind 2
  
        	[bookmark: pgfId-1109148]4446
  
        	[bookmark: pgfId-1109150]No
  
       
 
        
        	[bookmark: pgfId-1109152]Syslog (system message) Receiver
  
        	[bookmark: pgfId-1109154]5445
  
        	[bookmark: pgfId-1109156]No
  
       
 
        
        	[bookmark: pgfId-1109158]AJP Connector
  
        	[bookmark: pgfId-1109160]8009
  
        	[bookmark: pgfId-1109162]No
  
       
 
        
        	[bookmark: pgfId-1109164]Web Server
  
        	[bookmark: pgfId-1109166]8080
  
        	[bookmark: pgfId-1109168]During installation
  
       
 
        
        	[bookmark: pgfId-1109170]Web Service
  
        	[bookmark: pgfId-1109172]8083
  
        	[bookmark: pgfId-1109174]No
  
       
 
        
        	[bookmark: pgfId-1109176]JMS
  
        	[bookmark: pgfId-1109178]8093
  
        	[bookmark: pgfId-1109180]No
  
       
 
        
        	[bookmark: pgfId-1109182]RMI Object
  
        	[bookmark: pgfId-1109184]14444
  
        	[bookmark: pgfId-1109186]No
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1095489][bookmark: 25149]Downloading the Cisco DCNM Server Software
 
    [bookmark: pgfId-1051272][bookmark: marker-1058727]This section explains how to download the Cisco DCNM server software from Cisco.com. The file that you download is in tape archive (TAR) format. It contains the following files:
 
     
      
      	 [bookmark: pgfId-1074539]dcnm-k9. release .exe—Installation file for the supported Windows operating system.
 
      	 [bookmark: pgfId-1074540]dcnm-k9. release .bin—Installation file for the supported Linux operating system.
 
     
 
    
 
     
      [bookmark: pgfId-1053859]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1102185]Downloading the Cisco DCNM server software requires a Cisco.com user account. If you do not have a Cisco.com user account, go to http://www.cisco.com/ and create one before you attempt to download the software.
 
    
 
     
      [bookmark: pgfId-1102176]DETAILED STEPS
 
     [bookmark: pgfId-1051287]To download the Cisco DCNM server software, follow these steps:
 
     
 
     [bookmark: pgfId-1106771]Step 1 Open a web browser and go to the following website:
 
     [bookmark: pgfId-1106773]http://www.cisco.com/
 
     [bookmark: pgfId-1106774]The Cisco web page opens.
 
     [bookmark: pgfId-1106775]Step 2 From the Support menu, choose Download Software.
 
     [bookmark: pgfId-1106776]The Download Software page appears.
 
     [bookmark: pgfId-1106777]Step 3 Under Select a Software Product Category, choose Network Management.
 
     [bookmark: pgfId-1106778]Step 4 If the Log In page appears now, enter your Cisco.com username and password, and then click Log In.
 
     [bookmark: pgfId-1106779]The Tools & Resources Download Software web page displays a tree of Cisco devices.
 
     [bookmark: pgfId-1106780]Step 5 From the tree, choose Data Center Management > Cisco Data Center Network Manager.
 
     [bookmark: pgfId-1106781]Step 6 If the Log In page appears now, enter your Cisco.com username and password, and then click Log In.
 
     [bookmark: pgfId-1106782]A tree of Cisco DCNM releases appears.
 
     [bookmark: pgfId-1106783]Step 7 From the tree, choose the Cisco DCNM release that you need.
 
     [bookmark: pgfId-1106784]To the right of the tree, the Download Now button appears beside the filename and information for the Cisco DCNM release that you chose.
 
     [bookmark: pgfId-1106785]Step 8 Click Download Now.
 
     [bookmark: pgfId-1106786]The Download Cart web page lists the Cisco DCNM release that you chose.
 
     [bookmark: pgfId-1106787]Step 9 Click Proceed with Download.
 
     [bookmark: pgfId-1106788]The browser lists a link to the software license agreement and the software download rules.
 
     [bookmark: pgfId-1106789]Step 10 Read the software license agreement and the rules, and then click Agree.
 
     [bookmark: pgfId-1106790]Step 11 Click Non Java Download Option.
 
     [bookmark: pgfId-1106791]A download list appears in a new browser window.
 
     [bookmark: pgfId-1106792]Step 12 Click the Download link that appears to the right of the Cisco DCNM release that you chose.
 
     [bookmark: pgfId-1106793]The download begins.
 
     [bookmark: pgfId-1106794]Step 13 After the download completes, extract the files from the downloaded TAR file by doing one of the following:
 
      
      	 [bookmark: pgfId-1106795]For Microsoft Windows, use a file archive utility, such as WinZip, to extract the contents of the TAR file.
 
      	 [bookmark: pgfId-1106796]For RHEL, use the following command to extract the contents of the TAR file:
 
     
 
      
      [bookmark: pgfId-1106797]tar -xvf dcnm-k9.release.tar
 
     
 
     [bookmark: pgfId-1106798]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1066016][bookmark: 49014]Installing the Cisco DCNM Server
 
    [bookmark: pgfId-1063617]Use this procedure to install the Cisco DCNM server on a server system that does not have a previous installation of the Cisco DCNM server.
 
    [bookmark: pgfId-1092521]On server systems that run the Windows Server 2003 operating system, the installer adds the Cisco DCNM server as a Windows service.
 
    [bookmark: pgfId-1098598]By default, the Cisco DCNM server service automatically starts when you start the server operating system. 
 
     
      [bookmark: pgfId-1061449]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1092499]Ensure that the server system satisfies the prerequisites. For more information, see the “Prerequisites for Installing the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1104653]Download the Cisco DCNM server software. See the “Downloading the Cisco DCNM Server Software” section.
 
      
       
     
 
     
 
     [bookmark: pgfId-1104655]Note Disable antivirus and instruction detection software on the server system. In general, disable any security software or feature that may interfere with the installation of the Cisco DCNM server software. After you have completed the installation, reenable the software or features.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1104571]DETAILED STEPS
 
     [bookmark: pgfId-1092327][bookmark: marker-1092326]To install the Cisco DCNM server software, follow these steps:
 
     
 
     [bookmark: pgfId-1092328]Step 1 Log into the server with a user account that has the required privileges, as follows: 
 
      
       
       	 [bookmark: pgfId-1087231]For Windows Server 2003, the user account must be a member of the local administrators group. 
 
       	 [bookmark: pgfId-1087232]For RHEL 4 AS, the user account must be root.
 
      
 
     
 
     [bookmark: pgfId-1104735]Step 2 Go to the directory where you downloaded the Cisco DCNM server software and run one of the following files:
 
      
       
       	 [bookmark: pgfId-1051989]For Windows Server 2003, run the dcnm-k9. release .exe file.
 
       	 [bookmark: pgfId-1051991]For RHEL 4 AS, use the following  sh command:
 
      
 
     
 
      
      [bookmark: pgfId-1058916]sh dcnm-k9.release.bin 
     
 
      
      [bookmark: pgfId-1074720] 
     
 
     [bookmark: pgfId-1051986]After the installer prepares the installation, the Introduction step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1092516]Step 3 Click Next.
 
     [bookmark: pgfId-1092517]Step 4 If the Choose Install Folder step appears in the Cisco DCNM installer window, do the following:
 
      
       
     
 
     
 
     [bookmark: pgfId-1093926]Note If the Cisco DCNM installer detects an installation of Cisco Fabric Manager Release 4.2(1) and later releases on the server system, the Choose Install Folder step does not appear.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1092518] a. (Optional) If you want to change the default installation folder, type or choose the desired installation folder.
 
     [bookmark: pgfId-1090171] b. [bookmark: 53090]Click Next.
 
     [bookmark: pgfId-1052398]The Database Options step appears in the Cisco DCNM installer window. You can use an exiting PostgreSQL installation, an existing Oracle installation, or if PostgreSQL is not installed on the server system, you can use the Cisco DCNM installer to add a PostgreSQL installation.
 
      
       
     
 
     
 
     [bookmark: pgfId-1093729]Note If the Cisco DCNM installer detects an installation of Cisco Fabric Manager Release 4.2(1) and later releases on the server system, the only database option that is available is the database that Fabric Manager is configured to use.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1053057]Step 5 If you want to install PostgreSQL, do the following:
 
     [bookmark: pgfId-1053058] a. Next to RDBMS, click Install PostgreSQL.
 
     [bookmark: pgfId-1092551]If your server system runs RHEL 4 AS, the System User dialog box appears.
 
     [bookmark: pgfId-1092552] b. (RHEL 4 AS only) In the System User dialog box, type the username for the user account that should be used to run the PostgreSQL software. This user account should not have administrator or root privileges.
 
     [bookmark: pgfId-1092556] c. In the DB Admin User field, type the username of a database administrator account. The installer will create the administrator account that you specify.
 
     [bookmark: pgfId-1092557] d. In the DB Admin Password field, type the password for the database administrator username that you specified.
 
     [bookmark: pgfId-1092558] e. In the DCNM DB User field, type the username that Cisco DCNM should use to access the database. The default username is dcnmuser. The installer will create the user account that you specify.
 
     [bookmark: pgfId-1092559] f. In the DCNM DB Password field, type the password for the database user account that you specified.
 
     [bookmark: pgfId-1092560] g. In the Confirm DCNM DB Password field, retype the password for the database user account that you specified.
 
     [bookmark: pgfId-1092652] h. (Optional) If you want to change the default PostgreSQL database installation folder, in the Install Location field, type or choose the desired installation folder.
 
     [bookmark: pgfId-1053052]Step 6 If you want to use an existing relational database management system (RDBMS) installation, do the following:
 
     [bookmark: pgfId-1052079] a. Next to RDBMS, click one of the following:
 
     [bookmark: pgfId-1090216] – Use existing PostgreSQL 8.1/8.2
 
     [bookmark: pgfId-1090229] – Use existing Oracle 10g/11g
 
     [bookmark: pgfId-1053110]If the Cisco DCNM installer detected an existing RDBMS installation, the DB URL field shows the URL to the database.
 
      
       
     
 
     
 
     [bookmark: pgfId-1090387]Note If the Cisco DCNM installer detects an installation of Cisco Fabric Manager Release 4.2(1) and later releases on the server system, the DB URL field shows the URL of the Fabric Manager database and cannot be configured.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1093787] b. If the DB URL field does not have the correct URL to the database, type the correct URL.
 
     [bookmark: pgfId-1090388] c. In the DB Admin User field, type the username of a database user account that has permissions to create the Cisco DCNM database schema and user account.
 
     [bookmark: pgfId-1090328] d. In the DB Admin Password field, type the password for the database administrator username that you specified.
 
     [bookmark: pgfId-1052084] e. In the DCNM DB User field, type the username that Cisco DCNM should use to access the database.
 
     [bookmark: pgfId-1098015]The installer will use the Cisco DCNM admin user that you specified to create the Cisco DCNM database user account.
 
     [bookmark: pgfId-1090462] f. In the DCNM DB Password field, type the password for the database user account that you specified.
 
     [bookmark: pgfId-1052089] g. In the Confirm DCNM DB Password field, retype the password for the database user account that you specified.
 
     [bookmark: pgfId-1080160]Step 7 Click Next.
 
     [bookmark: pgfId-1090519]Step 8 If the Choose Database (PostgreSQL/Oracle) Root Folder step appears in the Cisco DCNM installer window, do the following:
 
     [bookmark: pgfId-1090728] a. Type or choose the folder that contains the BIN directory for the existing RDBMS that you specified. The installer lists the default installation paths for the supported databases.
 
     [bookmark: pgfId-1090482] b. Click Next.
 
     [bookmark: pgfId-1090483]The Configuration Options step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1080893]Step 9 From the Server IP Address list, choose the IP address that you want to use for the Cisco DCNM server. The list shows only the IP addresses currently assigned to network interfaces on the server system.
 
      
       
     
 
     
 
     [bookmark: pgfId-1087604]Note The IP address of the server system should be statically assigned. The Cisco DCNM server binds to an IP address that you specify during installation. If the IP address of the Cisco DCNM server changes, Cisco DCNM clients are unable to connect to the Cisco DCNM server and you must reinstall the Cisco DCNM server so that you can reconfigure the IP address.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1079321]Step 10 If you want to change the port that the Cisco DCNM web server listens to, enter the new port number in the Web Server Port box. By default, the Cisco DCNM web server listens to TCP port 8080.
 
      
       
     
 
     
 
     [bookmark: pgfId-1079382]Note If you change the web server port number, it affects the URL that Cisco DCNM users use to download the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1079422]Step 11 If you want to change the port that the Cisco DCNM server accepts Cisco DCNM client connections on, enter the new port number in the Naming Service Port box. By default, the Cisco DCNM server accepts connections from Cisco DCNM clients on TCP port 1099.
 
      
       
     
 
     
 
     [bookmark: pgfId-1080916]Note If you change the Cisco DCNM server port number, it affects the port that Cisco DCNM users specify when they log into the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1079536]Step 12 Click Next.
 
     [bookmark: pgfId-1079580]The Choose Archive Folder step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1081016]Step 13 (Optional) If you want to change the archive folder, type or choose the desired archive folder.
 
     [bookmark: pgfId-1091208]Step 14 Click Next.
 
     [bookmark: pgfId-1091243]The Local User Credentials step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1091323]Step 15 In the Local Admin Username field, type a name for a Cisco DCNM server user. The installer will create the Cisco DCNM server user and assign the Administrator role to it.
 
     [bookmark: pgfId-1091351]Step 16 In the Password field, type a password for the user, and then in the Confirm Password field, type the password again.
 
      
       
     
 
     
 
     [bookmark: pgfId-1091428]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1091278]Step 17 Click Next.
 
     [bookmark: pgfId-1091279]The Authentication Settings step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1091511]Choose the authentication method that the Cisco DCNM server should use to authenticate users who log into the Cisco DCNM client. You can choose one of the following:
 
      
       
       	 [bookmark: pgfId-1091516]Local—Cisco DCNM client users will be authenticated by the Cisco DCNM server user accounts only.
 
       	 [bookmark: pgfId-1091544]RADIUS—Cisco DCNM client users will be authenticated by a RADIUS server.
 
       	 [bookmark: pgfId-1091572]TACACS+—Cisco DCNM client users will be authenticated by a TACACS+ server.
 
      
 
     
 
     [bookmark: pgfId-1091629]For RADIUS or TACACS+, you can specify up to three servers.
 
     [bookmark: pgfId-1091659]Step 18 If you chose RADIUS or TACACS+, for each server that you want to specify, do the following:
 
     [bookmark: pgfId-1091698] a. In the server address field, type the IPv4 address of the server in dotted-decimal format.
 
     [bookmark: pgfId-1091703] b. In the secret key field, type the shared secret of the server.
 
     [bookmark: pgfId-1091704] c. (Optional) If you want to ensure that Cisco DCNM can communicate with the server, click Verify.
 
     [bookmark: pgfId-1091699]Step 19 Click Next.
 
     [bookmark: pgfId-1091700]If you are using Windows Server 2003, the installer asks you to specify a shortcut to the application. If you are using RHEL 4 AS, the installer asks you to specify a link folder.
 
     [bookmark: pgfId-1053202]Step 20 Choose the shortcut or link options that you want.
 
     [bookmark: pgfId-1091881]Step 21 (Optional) If you want the installer to create the shortcuts for all users who can log into the server system, check the Create Icons for All Users check box.
 
     [bookmark: pgfId-1091854]Step 22 Click Next.
 
     [bookmark: pgfId-1053238]The Pre-Installation Summary step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1052137]Step 23 Carefully review the summary of your choices. If you need to change anything, click Previous until the the Cisco DCNM installer window displays the step that you need to change.
 
     [bookmark: pgfId-1067126]Step 24 When you are ready to install the Cisco DCNM server software, click Next.
 
     [bookmark: pgfId-1091042]The installer installs the Cisco DCNM server software.
 
     [bookmark: pgfId-1098909]The Start DCNM Server dialog box appears.
 
     [bookmark: pgfId-1098910]Step 25 [bookmark: 19038]Choose whether you want to start the Cisco DCNM server now. If you start the Cisco DCNM server now, a splash screen appears while the server starts.
 
     [bookmark: pgfId-1082135]The Install Complete step appears in the Cisco DCNM installer window, which also shows a Cisco DCNM instance ID number.
 
     [bookmark: pgfId-1053338]Step 26 (Optional) If you plan to install a license for Cisco DCNM, record the instance ID number. The licensing process requires that you enter that number.
 
      
       
     
 
     
 
     [bookmark: pgfId-1082753]Note You can begin using Cisco DCNM without a licence but some features are not available unless you purchase and install a license and apply the license to managed devices that you want to use licensed features with.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1052145]Step 27 Click Done.
 
     [bookmark: pgfId-1092185]If you chose in Step 25 to start the Cisco DCNM server after installation, a splash screen appears while the server starts.
 
     [bookmark: pgfId-1092154]Step 28 (Optional) If you need to start the Cisco DCNM server, see the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1082923]Step 29 (Optional) If you want to install a Cisco DCNM license, see the “Installing Licenses” section.
 
     [bookmark: pgfId-1082897]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1082902][bookmark: 86941]Starting the Cisco DCNM Server[bookmark: marker-1088402]
 
    [bookmark: pgfId-1061985]You can manually start the Cisco DCNM server. The manual procedures for starting the Cisco DCNM server differ for systems using the Windows Server 2003 and RHEL 4 AS operating systems, as described in the following topics:
 
     
     	 [bookmark: pgfId-1067326]Starting the Cisco DCNM Server (Windows Server 2003)
 
     	 [bookmark: pgfId-1067338]Starting the Cisco DCNM Server (RHEL 4 AS)
 
    
 
     
      [bookmark: pgfId-1067343][bookmark: 87974]Starting the Cisco DCNM Server (Windows Server 2003)
 
     [bookmark: pgfId-1067447]On a server system running Windows Server 2003, you can start the Cisco DCNM server through the Windows services or by clicking the Start Cisco DCNM Server icon.
 
    
 
     
      [bookmark: pgfId-1066730]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1066734]You must have installed the Cisco DCNM server (see the “Installing the Cisco DCNM Server” section).
 
    
 
     
      [bookmark: pgfId-1053835]DETAILED STEPS
 
     [bookmark: pgfId-1051359]To manually launch the Cisco DCNM server on a system running the Windows Server 2003 operating system, follow these steps:
 
     
 
     [bookmark: pgfId-1053424]Step 1 Open the Control Panel window and choose Administrative Tools > Services.
 
     [bookmark: pgfId-1068638]The Services window opens.
 
     [bookmark: pgfId-1068647]Step 2 Right-click Cisco DCNM Server and choose Start.
 
      
       
     
 
     
 
     [bookmark: pgfId-1078536]Note Alternatively, you can choose Start > All Programs > Cisco DCNM Server > Start DCNM Server; however, the location of shortcuts depends upon the choices you made when you installed the Cisco DCNM server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1068956]A splash screen opens while the Cisco DCNM server starts. This screen closes once the Cisco DCNM server is running.
 
     [bookmark: pgfId-1068942]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067270][bookmark: 11170]Starting the Cisco DCNM Server (RHEL 4 AS)
 
     [bookmark: pgfId-1088310]You can start the Cisco DCNM server on a RHEL 4 AS server system by using the Start_DCNM_Server command.
 
    
 
     
      [bookmark: pgfId-1067391]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1067395]The Cisco DCNM server must be installed (see the “Installing the Cisco DCNM Server” section).
 
    
 
     
      [bookmark: pgfId-1067396]DETAILED STEPS
 
     [bookmark: pgfId-1067389][bookmark: marker-1067269]To manually launch the Cisco DCNM server on a system running the RHEL 4 AS operating system, follow this step:
 
     
 
     [bookmark: pgfId-1067271]Step 1 Use the Start_Cisco DCNM_Server script to start the Cisco DCNM server. 
 
      
      [bookmark: pgfId-1067789]sh Start_DCNM_Server
 
     
 
     [bookmark: pgfId-1072242]You can find this script in your home folder or the folder that you specified when setting up the link folder during your installation of Cisco DCNM.
 
     [bookmark: pgfId-1067277]The Cisco DCNM server opens a server console window and displays the processes it runs to start the server. The server is running when you see a “Started in Xm:XXs:XXXms” message.
 
     [bookmark: pgfId-1067278]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1060422][bookmark: 76916]Installing Licenses
 
    [bookmark: pgfId-1053616][bookmark: marker-1058730]To use the licensed Cisco DCNM server features, you must purchase and install Cisco DCNM Enterprise LAN licenses for each managed device that works with those features. To purchase a license, submit the Cisco DCNM Instance ID number and the number of devices to license to the Cisco Technical Assistance Team (TAC). TAC will e-mail you the license file that you need for installing the license.
 
    [bookmark: pgfId-1065357]After you install a license, you must specify which managed devices that it applies to. For more information, see Chapter 8, “Administering DCNM Licensed Devices”.
 
     
      [bookmark: pgfId-1066695]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1066700]You must have installed the Cisco DCNM server.
 
     [bookmark: pgfId-1072084]Ensure that there are no executable files in the folder where you plan to install the licenses file.
 
    
 
     
      [bookmark: pgfId-1053825]DETAILED STEPS
 
     [bookmark: pgfId-1053622]To install the Cisco DCNM Enterprise LAN license, follow these steps:
 
     
 
     [bookmark: pgfId-1053623]Step 1 Copy the Cisco DCNM Instance ID number by doing one of the following:
 
      
       
       	 [bookmark: pgfId-1055411]When you finish installing the server, copy the number when it is displayed at the end of the Cisco DCNM installation process.
 
       	 [bookmark: pgfId-1053628]When running the Cisco DCNM client, choose  Help > Show DCNM Instance ID .
 
      
 
     
 
     [bookmark: pgfId-1053629]Step 2 Contact TAC and purchase one or more Cisco DCNM licenses. Present the Cisco DCNM Instance ID number and specify the number of devices that you want to license.
 
     [bookmark: pgfId-1058723]TAC will send you a license pack file that you can use for each installation that you ordered.
 
     [bookmark: pgfId-1083763]Step 3 Log into the server system that runs the Cisco DCNM server.
 
     [bookmark: pgfId-1053648]Step 4 Download the license pack file into a directory on the server system.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1072097] 
      Caution Make sure that there are no other executable files in the directory where you download the license pack file. Having other files in the directory where you download the license pack file can disrupt the installation of the licenses. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1083210]Step 5 Go to the directory where you downloaded the Cisco DCNM server software and run one of the following files:
 
      
       
       	 [bookmark: pgfId-1083211]For Windows Server 2003, run the dcnm-k9. release .exe file.
 
       	 [bookmark: pgfId-1083212]For RHEL 4 AS, use the following  sh command:
 
      
 
     
 
      
      [bookmark: pgfId-1083213]sh dcnm-k9.release.bin 
     
 
      
      [bookmark: pgfId-1083466] 
     
 
     [bookmark: pgfId-1083467]When the Cisco DCNM installer starts, a warning dialog box indicates that the existing installation of the Cisco DCNM server was found.
 
     [bookmark: pgfId-1083516]Step 6 Click OK.
 
     [bookmark: pgfId-1083536]The Reinstall step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1053740]Step 7 Choose License Install and click Next.
 
     [bookmark: pgfId-1083601]The Choose DCNM License Folder step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1053753]Step 8 In the Please Choose a Folder field, type or choose the folder that contains the license file, and then click Next.
 
     [bookmark: pgfId-1083799]The Pre-Installation Summary step appears in the Cisco DCNM installer window. The License files(s) field shows the licenses that the Cisco DCNM installer found in the folder that you specified.
 
     [bookmark: pgfId-1054809]Step 9 Click Next.
 
     [bookmark: pgfId-1055677]The Installation Complete step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1055779]Step 10 Click Done.
 
     [bookmark: pgfId-1084091]You can now specify the managed devices that you want to use licensed Cisco DCNM features with. For more information, see Chapter8, “Administering DCNM Licensed Devices”
 
     [bookmark: pgfId-1055808]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1062288][bookmark: 82522][bookmark: 28899]Upgrading the Cisco DCNM Server
 
    [bookmark: pgfId-1104315]You can upgrade the DNCM server. The upgrade process requires that you stop the Cisco DCNM server before you begin the upgrade.
 
     
      
    
 
    
 
    [bookmark: pgfId-1106141]Note Data migration is not supported if you are upgrading to Cisco DCNM Release 4.2 from any release prior to Release 4.2. The Release 4.2 installer includes the option to back up the database prior to cleaning the database during the upgrade.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1062385]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1095792]Ensure that the server system satisfies the prerequisites. For more information, see the “Prerequisites for Installing the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1084573]Download the updated Cisco DCNM server software by following the procedure listed in the “Downloading the Cisco DCNM Server Software” section.
 
     [bookmark: pgfId-1062390]Stop the Cisco DCNM server. The upgrade cannot proceed until you stop the Cisco DCNM server. For more information, see the applicable topic:
 
      
      	 [bookmark: pgfId-1084301]Stopping the Cisco DCNM Server (Windows Server 2003)
 
      	 [bookmark: pgfId-1084377]Stopping the Cisco DCNM Server (RHEL 4 AS)
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1104667]Note Disable antivirus and instruction detection software on the server system. In general, disable any security software or feature that may interfere with the installation of the Cisco DCNM server software. After you have completed the installation, reenable the software or features.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1062398]DETAILED STEPS
 
     [bookmark: pgfId-1062410]To upgrade the Cisco DCNM server software, follow these steps:
 
     
 
     [bookmark: pgfId-1084673]Step 1 Log into the server with a user account that has the required privileges, as follows: 
 
      
       
       	 [bookmark: pgfId-1084674]For Windows Server 2003, the user account must be a member of the local administrators group. 
 
       	 [bookmark: pgfId-1084675]For RHEL 4 AS, the user account must be root.
 
      
 
     
 
     [bookmark: pgfId-1084719]Step 2 If you have not already done so, stop the Cisco DCNM server.
 
     [bookmark: pgfId-1088083]Step 3 Go to the directory where you downloaded the updated Cisco DCNM server software and run one of the following files:
 
      
       
       	 [bookmark: pgfId-1084720]For Windows Server 2003, run the dcnm-k9. release .exe file.
 
       	 [bookmark: pgfId-1084721]For RHEL 4 AS, use the following  sh command:
 
      
 
     
 
      
      [bookmark: pgfId-1084722]sh dcnm-k9.release.bin 
     
 
      
      [bookmark: pgfId-1084723] 
     
 
     [bookmark: pgfId-1084724]When the Cisco DCNM installer starts, a warning dialog box indicates that the existing installation of the Cisco DCNM server was found.
 
     [bookmark: pgfId-1084725]Step 4 Click OK.
 
     [bookmark: pgfId-1084772]If the Choose PostgreSQL Folder step appears in the Cisco DCNM installer window, the installer could not locate the PostgreSQL database files.
 
     [bookmark: pgfId-1085546]Step 5 If the Choose PostgreSQL Folder step appears, type or choose the path to the folder that contains the PostgreSQL database files and then click Next.
 
     [bookmark: pgfId-1101226]The Database Options step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1101227]Step 6 Specify the database administrator username and password. To do so, follow these steps:
 
     [bookmark: pgfId-1101228] a. In the DB Admin User field, follow these guidelines:
 
      
      	 [bookmark: pgfId-1101267]If you are upgrading from a release of Cisco DCNM earlier than Cisco DCNM Release 4.2(1), type the username for a new database administrator account. The installer will create the administrator account that you specify.
 
      	 [bookmark: pgfId-1101303]If you are upgrading from Cisco DCNM Release 4.2(1) or a later release, type the username of the existing database administrator account.
 
     
 
     [bookmark: pgfId-1101069] b. In the DB Admin Password field, type the password for the database administrator username that you specified.
 
     [bookmark: pgfId-1101091] c. Click Next.
 
     [bookmark: pgfId-1101039]The Local User Credentials step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1092699]Step 7 In the Local Admin Username field, type a name for a Cisco DCNM server user. The installer will create the Cisco DCNM server user and assign the Administrator role to it.
 
     [bookmark: pgfId-1092700]Step 8 In the Password field, type a password for the user, and then in the Confirm Password field, type the password again.
 
      
       
     
 
     
 
     [bookmark: pgfId-1092701]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1084797]Step 9 Click Next.
 
     [bookmark: pgfId-1092752]The Authentication Settings step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1092753]Choose the authentication method that the Cisco DCNM server should use to authenticate users who log into the Cisco DCNM client. You can choose one of the following:
 
      
       
       	 [bookmark: pgfId-1092754]Local—Cisco DCNM client users will be authenticated by the Cisco DCNM server user accounts only.
 
       	 [bookmark: pgfId-1092755]RADIUS—Cisco DCNM client users will be authenticated by a RADIUS server.
 
       	 [bookmark: pgfId-1092756]TACACS+—Cisco DCNM client users will be authenticated by a TACACS+ server.
 
      
 
     
 
     [bookmark: pgfId-1092757]For RADIUS or TACACS+, you can specify up to three servers.
 
     [bookmark: pgfId-1092758]Step 10 If you chose RADIUS or TACACS+, for each server that you want to specify, do the following:
 
     [bookmark: pgfId-1092759] a. In the server address field, type the IPv4 address of the server in dotted-decimal format.
 
     [bookmark: pgfId-1092760] b. In the secret key field, type the shared secret of the server.
 
     [bookmark: pgfId-1092761] c. (Optional) If you want to ensure that Cisco DCNM can communicate with the server, click Verify.
 
     [bookmark: pgfId-1092762]Step 11 Click Next.
 
     [bookmark: pgfId-1084810]The Pre-Installation Summary step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1089441]Step 12 Carefully review the summary of your choices. If you need to change anything, click Previous until the the Cisco DCNM installer window displays the step that you need to change.
 
     [bookmark: pgfId-1084812]Step 13 When you are ready to install the Cisco DCNM server software, click Next.
 
     [bookmark: pgfId-1104296]If you are upgrading from a release prior to Release 4.2(0), the DB Migration dialog box appears. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1104297]Note Upgrading Cisco DCNM from a release prior to Release 4.2(0) is not supported.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1104298]Step 14 If the DB Migration dialog box appears, choose whether you want the installer to back up the database.
 
     [bookmark: pgfId-1092995]If you are upgrading from a release prior to Release 4.2(0), the installer backs up the database if you chose to do so. The installer then clears all data from the database.
 
     [bookmark: pgfId-1092915]If you are upgrading from Release 4.2 to a later version of Release 4.2, the installer migrates the database from the previous installation to the new installation.
 
     [bookmark: pgfId-1092949]After database migration is complete, the installer installs but does not start the Cisco DCNM server software.
 
     [bookmark: pgfId-1084841]The Install Complete step appears in the Cisco DCNM installer window, which also shows a Cisco DCNM instance ID number.
 
     [bookmark: pgfId-1084845]Step 15 Click Done.
 
     [bookmark: pgfId-1092950]The Cisco DCNM server is not running.
 
     [bookmark: pgfId-1084846]Step 16 If you need to start the Cisco DCNM server, do one of the following:
 
      
       
       	 [bookmark: pgfId-1084847]If you are using Windows Server 2003, see the “Starting the Cisco DCNM Server (Windows Server 2003)” section.
 
       	 [bookmark: pgfId-1084851]If you are using RHEL 4 AS, see the “Starting the Cisco DCNM Server (RHEL 4 AS)” section.
 
      
 
     
 
     [bookmark: pgfId-1084856]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1100797][bookmark: 72345]Downgrading the Cisco DCNM Server
 
    [bookmark: pgfId-1100798]The Cisco DCNM installer does not support downgrading to earlier releases.
 
    [bookmark: pgfId-1100847]To downgrade the Cisco DCNM server, follow these steps:
 
    
 
    [bookmark: pgfId-1100856]Step 1 Uninstall the Cisco DCNM server that you want to downgrade from.
 
    [bookmark: pgfId-1100885]Step 2 Install and deploy the earlier release of the Cisco DCNM server that you want to downgrade to. For more information, see the “Deploying Cisco DCNM” section.
 
    [bookmark: pgfId-1100951]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1100800][bookmark: 24048]Reinstalling the Cisco DCNM Server
 
    [bookmark: pgfId-1085976]You can[bookmark: marker-1085975] reinstall the Cisco DCNM server and the download service for the Cisco DCNM client. When you reinstall the Cisco DCNM server, you must choose one of the following types of reinstallation:
 
     
     	 [bookmark: pgfId-1085977]Custom—Reinstalls the components that you select, without allowing you to change anything that you specified when you previously installed the Cisco DCNM server. Choose this reinstallation type when you want to do any of the following:
 
    
 
    [bookmark: pgfId-1086039] – Reinstall the Cisco DCNM server without changing database or configuration options.
 
    [bookmark: pgfId-1086058] – Reinstall the Cisco DCNM client download service.
 
    [bookmark: pgfId-1086063] – Reinstall the Cisco DCNM license, either from the same folder that previously contained the Cisco DCNM license file or from a different folder.
 
     
     	 [bookmark: pgfId-1085978]Full Reinstall—Reinstalls the Cisco DCNM server and the Cisco DCNM client download service. Choose this reinstallation type when you want to do any of the following:
 
    
 
    [bookmark: pgfId-1099622] – Perform password recovery for the local administrator account.
 
    [bookmark: pgfId-1099623] – Change Cisco DCNM server authentication settings.
 
    [bookmark: pgfId-1085828] – Create a PostgreSQL installation.
 
    [bookmark: pgfId-1085862] – Change the database URL, database username, or database password for the existing PostgreSQL installation.
 
    [bookmark: pgfId-1085874] – Change the Cisco DCNM server IP address.
 
     
      
    
 
    
 
    [bookmark: pgfId-1088110]Note If you are using RHEL 4 AS and you change the Cisco DCNM server IP address, you must also manually change the IP address in the INSTALL_DIR/bin/stopDCNM.sh script.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1085879] – Change the port that the Cisco DCNM web server listens to.
 
     
      
    
 
    
 
    [bookmark: pgfId-1085912]Note If you change the web server port number, it affects the URL that Cisco DCNM users use to download the Cisco DCNM client.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1085895] – Change the port that the Cisco DCNM server accepts Cisco DCNM client connections on.
 
     
      
    
 
    
 
    [bookmark: pgfId-1085934]Note If you change the Cisco DCNM server port number, it affects the port that Cisco DCNM users specify when they log into the Cisco DCNM client.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1095815]Neither reinstallation type allows you to change the installation folder or archive folder.
 
     
      [bookmark: pgfId-1053793]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1085372]Stop the Cisco DCNM server. The upgrade cannot proceed until you stop the Cisco DCNM server. For more information, see the applicable topic:
 
      
      	 [bookmark: pgfId-1085376]Stopping the Cisco DCNM Server (Windows Server 2003)
 
      	 [bookmark: pgfId-1085380]Stopping the Cisco DCNM Server (RHEL 4 AS)
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1104689]Note Disable antivirus and instruction detection software on the server system. In general, disable any security software or feature that may interfere with the installation of the Cisco DCNM server software. After you have completed the installation, reenable the software or features.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1053803]DETAILED STEPS
 
     [bookmark: pgfId-1053804]To reinstall the Cisco DCNM server, set up a web start copy of the Cisco DCNM client, or do both, follow these steps:
 
     
 
     [bookmark: pgfId-1085384]Step 1 Log into the server with a user account that has the required privileges, as follows: 
 
      
       
       	 [bookmark: pgfId-1085385]For Windows Server 2003, the user account must be a member of the local administrators group. 
 
       	 [bookmark: pgfId-1085386]For RHEL 4 AS, the user account must be root.
 
      
 
     
 
     [bookmark: pgfId-1085387]Step 2 If you have not already done so, stop the Cisco DCNM server.
 
     [bookmark: pgfId-1088070]Step 3 Go to the directory that contains the Cisco DCNM installer software and run one of the following files:
 
      
       
       	 [bookmark: pgfId-1085388]For Windows Server 2003, run the dcnm-k9. release .exe file.
 
       	 [bookmark: pgfId-1085389]For RHEL 4 AS, use the following  sh command:
 
      
 
     
 
      
      [bookmark: pgfId-1085390]sh dcnm-k9.release.bin 
     
 
      
      [bookmark: pgfId-1085391] 
     
 
     [bookmark: pgfId-1085392]When the Cisco DCNM installer starts, a warning dialog box indicates that the existing installation of the Cisco DCNM server was found.
 
     [bookmark: pgfId-1085393]Step 4 Click OK.
 
     [bookmark: pgfId-1085404]The Reinstall step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1085417]Step 5 Choose the type of reinstallation that you to perform by doing one of the following:
 
      
      	 [bookmark: pgfId-1085418]If you want to reinstall both the Cisco DCNM server and the Cisco DCNM client download service, click  Full Reinstall .
 
      	 [bookmark: pgfId-1085443]If you want to reinstall only the Cisco DCNM server or only the Cisco DCNM client download service, click  Custom .
 
     
 
     [bookmark: pgfId-1086083]Step 6 If you chose Custom, follow these steps:
 
     [bookmark: pgfId-1086110] a. Click Next.
 
     [bookmark: pgfId-1086156]The Reinstall Cisco DCNM step appears in the Cisco DCNM installer window. Under Install Set, check boxes for the components that you can reinstall appear.
 
     [bookmark: pgfId-1086143] b. Check the check boxes for the components that you want to reinstall and click Next.
 
     [bookmark: pgfId-1086324]If you chose the License component, the Choose DCNM License Folder step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1086311] c. If the Choose DCNM License Folder step appears, type or choose the path to the folder that contains the Cisco DCNM license file, and then click Next.
 
     [bookmark: pgfId-1086367]The Pre-Installation Summary step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1086406] d. Skip to Step 25.
 
     [bookmark: pgfId-1086437]Step 7 If you chose Full Reinstall, click Next.
 
     [bookmark: pgfId-1086507]The Database Options step appears in the Cisco DCNM installer window. You can use the existing PostgreSQL installation or you can use the Cisco DCNM installer to add a PostgreSQL installation.
 
     [bookmark: pgfId-1086617]Step 8 Next to RDBMS, click the option for the existing database that you want to use.
 
     [bookmark: pgfId-1086618]If the Cisco DCNM installer detected the existing database installation, the DB URL field shows the URL to the database.
 
      
       
     
 
     
 
     [bookmark: pgfId-1094203]Note If the Cisco DCNM installer detects that the existing installation of Cisco DCNM shares a database system with an installation of Cisco Fabric Manager Release 4.2(1) and later releases, the DB URL field shows the URL of the Fabric Manager database and cannot be configured.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086619]Step 9 If the DB URL field does not have the correct URL to the Cisco DCNM database, type the correct URL. If you previously used the Cisco DCNM installer to create a PostgreSQL installation, the URL is typically as follows:
 
      
      [bookmark: pgfId-1086647]jdbc:postgresql://localhost:5432/dcnmdb 
     
 
      
      [bookmark: pgfId-1093225] 
     
 
     [bookmark: pgfId-1086662]where 5432 is the default PostgreSQL server port number and dcnmdb is the default database name that the Cisco DCNM installer creates.
 
     [bookmark: pgfId-1093358]Step 10 In the DB Admin User field, type the username of a database user account that has administrator permissions in the database.
 
     [bookmark: pgfId-1093359]Step 11 In the DB Admin Password field, type the password for the database administrator username that you specified.
 
     [bookmark: pgfId-1093360]Step 12 In the DCNM DB User field, type the username that Cisco DCNM should use to access the database.
 
     [bookmark: pgfId-1093361]Step 13 In the DCNM DB Password field, type the password for the database user account that you specified.
 
     [bookmark: pgfId-1093362]Step 14 In the Confirm DCNM DB Password field, retype the password for the database user account that you specified.
 
     [bookmark: pgfId-1086521]Step 15 Click Next.
 
     [bookmark: pgfId-1086522]The Configuration Options step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1086523]Step 16 From the Server IP Address list, choose the IP address that you want to use for the Cisco DCNM server. The list shows only the IP addresses currently assigned to network interfaces on the server system.
 
      
       
     
 
     
 
     [bookmark: pgfId-1087690]Note The IP address of the server system should be statically assigned. The Cisco DCNM server binds to the IP address that you specify. If the IP address of the server system changes after you install the Cisco DCNM server, Cisco DCNM clients are unable to connect to the Cisco DCNM server and you must stop and reinstall the Cisco DCNM server so that you can reconfigure the IP address.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086524]Step 17 If you want to change the port that the Cisco DCNM web server listens to, enter the new port number in the Web Server Port box. By default, the Cisco DCNM web server listens to TCP port 8080.
 
      
       
     
 
     
 
     [bookmark: pgfId-1086525]Note If you change the web server port number, it affects the URL that Cisco DCNM users use to download the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086526]Step 18 If you want to change the port that the Cisco DCNM server accepts Cisco DCNM client connections on, enter the new port number in the Naming Service Port box. By default, the Cisco DCNM server accepts connections from Cisco DCNM clients on TCP port 1099.
 
      
       
     
 
     
 
     [bookmark: pgfId-1086527]Note If you change the Cisco DCNM server port number, it affects the port that Cisco DCNM users specify when they log into the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086528]Step 19 Click Next.
 
     [bookmark: pgfId-1093467]The Local User Credentials step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1093468]Step 20 In the Local Admin Username field, type a name for a Cisco DCNM server user. The installer will create the Cisco DCNM server user and assign the Administrator role to it.
 
     [bookmark: pgfId-1093469]Step 21 In the Password field, type a password for the user, and then in the Confirm Password field, type the password again.
 
      
       
     
 
     
 
     [bookmark: pgfId-1093470]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1093471]Step 22 Click Next.
 
     [bookmark: pgfId-1093472]The Authentication Settings step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1093473]Choose the authentication method that the Cisco DCNM server should use to authenticate users who log into the Cisco DCNM client. You can choose one of the following:
 
      
       
       	 [bookmark: pgfId-1093474]Local—Cisco DCNM client users will be authenticated by the Cisco DCNM server user accounts only.
 
       	 [bookmark: pgfId-1093475]RADIUS—Cisco DCNM client users will be authenticated by a RADIUS server.
 
       	 [bookmark: pgfId-1093476]TACACS+—Cisco DCNM client users will be authenticated by a TACACS+ server.
 
      
 
     
 
     [bookmark: pgfId-1093477]For RADIUS or TACACS+, you can specify up to three servers.
 
     [bookmark: pgfId-1093478]Step 23 If you chose RADIUS or TACACS+, for each server that you want to specify, do the following:
 
     [bookmark: pgfId-1093479] a. In the server address field, type the IPv4 address of the server in dotted-decimal format.
 
     [bookmark: pgfId-1093480] b. In the secret key field, type the shared secret of the server.
 
     [bookmark: pgfId-1093481] c. (Optional) If you want to ensure that Cisco DCNM can communicate with the server, click Verify.
 
     [bookmark: pgfId-1093482]Step 24 Click Next.
 
     [bookmark: pgfId-1086455]Step 25 [bookmark: 81887]Carefully review the summary of your choices. If you need to change anything, click Previous and return to the applicable step, above.
 
     [bookmark: pgfId-1086456]Step 26 When you are ready to install the Cisco DCNM server software, click Next.
 
     [bookmark: pgfId-1086700]The installer installs the Cisco DCNM server software.
 
     [bookmark: pgfId-1086701]The Start DCNM Server dialog box appears.
 
     [bookmark: pgfId-1086702]Step 27 [bookmark: 59970]Choose whether you want to start the Cisco DCNM server now. If you start the Cisco DCNM server now, a splash screen appears while the server starts.
 
     [bookmark: pgfId-1086703]The Install Complete step appears in the Cisco DCNM installer window.
 
     [bookmark: pgfId-1086706]Step 28 Click Done.
 
     [bookmark: pgfId-1086707]Step 29 If you need to start the Cisco DCNM server, see the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1088224]Step 30 (RHEL 4 AS only) If you are using RHEL 4 AS and you changed the Cisco DCNM server IP address during the reinstallation, open the INSTALL_DIR/bin/stopDCNM.sh script in a text editor and change the IP address to the new Cisco DCNM server IP address.
 
     [bookmark: pgfId-1086720]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1060174][bookmark: 43098]Stopping the Cisco DCNM Server[bookmark: marker-1088378]
 
    [bookmark: pgfId-1067945]You can manually stop the Cisco DCNM server. The manual procedures for stopping the Cisco DCNM server differ for systems using the Windows Server 2003 and RHEL 4 AS operating systems, as described in the following topics:
 
     
     	 [bookmark: pgfId-1067949]Stopping the Cisco DCNM Server (Windows Server 2003)
 
     	 [bookmark: pgfId-1067953]Stopping the Cisco DCNM Server (RHEL 4 AS)
 
    
 
     
      [bookmark: pgfId-1067955][bookmark: 62300]Stopping the Cisco DCNM Server (Windows Server 2003)
 
     [bookmark: pgfId-1067956]On a server system running Windows Server 2003, you can stop the Cisco DCNM server through the Windows services or by clicking the Stop DCNM Server icon.
 
    
 
     
      [bookmark: pgfId-1067962]DETAILED STEPS
 
     [bookmark: pgfId-1087070]To manually stop the Cisco DCNM server on a system running the Windows Server 2003 operating system, follow these steps:
 
     
 
     [bookmark: pgfId-1087071]Step 1 Open the Control Panel window and choose Administrative Tools > Services. 
 
     [bookmark: pgfId-1087072]A window opens listing the Windows services.
 
     [bookmark: pgfId-1086925]Step 2 Right-click Cisco DCNM Server and choose Stop.
 
      
       
     
 
     
 
     [bookmark: pgfId-1087102]Note Alternatively, you can choose Start > All Programs > Cisco DCNM Server > Stop DCNM Server; however, the location of shortcuts depends upon the choices you made when you installed the Cisco DCNM server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086926]A splash screen opens while the Cisco DCNM server begins to shut down. When the Cisco DCNM server has stopped, the splash screen closes.
 
     [bookmark: pgfId-1074007]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067980][bookmark: 11662]Stopping the Cisco DCNM Server (RHEL 4 AS)
 
     [bookmark: pgfId-1087108]On a server system running RHEL 4 AS, you can stop the Cisco DCNM server with the Stop_DCNM_Server command.
 
    
 
     
      [bookmark: pgfId-1067986]DETAILED STEPS
 
     [bookmark: pgfId-1071878]To manually stop the Cisco DCNM server on a system running the RHEL 4 AS operating system, follow this step:
 
     
 
     [bookmark: pgfId-1071879]Step 1 Use the Stop_Cisco DCNM_Server script to stop the server on a RHEL operating system. 
 
      
      [bookmark: pgfId-1071880]sh Stop_DCNM_Server
 
     
 
     [bookmark: pgfId-1072334]You can find this script in your home folder or the folder that you specified when setting up the link folder during your installation of Cisco DCNM.
 
     [bookmark: pgfId-1068129]The Cisco DCNM server opens a server console window and displays the processes that it runs to start the server. The server is running when you see a “Stopped at Xm:XXs:XXXms” message.
 
     [bookmark: pgfId-1093447]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1093449][bookmark: 24180]Additional References
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1089544]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1089546]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1089548]Overview of the Cisco DCNM environment
  
        	[bookmark: pgfId-1089553]Information About Cisco DCNM
  
       
 
        
        	[bookmark: pgfId-1089555]The process of deploying Cisco DCNM in your organization
  
        	[bookmark: pgfId-1089560]Deploying Cisco DCNM
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1089563][bookmark: 55398]Standards
 
    [bookmark: pgfId-1089573]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1089566]Standards 
         
  
        	 
          
          [bookmark: pgfId-1089568]Title 
         
  
       
 
        
        	[bookmark: pgfId-1089570]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
        	[bookmark: pgfId-1089572]—
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1089529][bookmark: 92503]Feature History for Installing and Launching the Cisco DCNM Server
 
     
      
       
       [bookmark: pgfId-1078564]Table 2-2 [bookmark: 50557]Feature History for Installing and Launching the Cisco DCNM Server 
 
       
       
        
        	 
          
          [bookmark: pgfId-1078570]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1078572]Releases 
         
  
        	 
          
          [bookmark: pgfId-1078574]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1078576]Support for shared server system with Cisco Fabric Manager Release 4.2(1) and later releases.
  
        	[bookmark: pgfId-1078578]4.2(1)
  
        	[bookmark: pgfId-1078580]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1078582]Support for Oracle 10g and 11g databases.
  
        	[bookmark: pgfId-1078584]4.2(1)
  
        	[bookmark: pgfId-1078586]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1078588]Cisco DCNM server installer
  
        	[bookmark: pgfId-1078590]4.2(1)
  
        	[bookmark: pgfId-1078592]This feature was preexisting.
  
       
 
        
        	[bookmark: pgfId-1110151]Server installer includes a step for configuring the DCNM server IP address, web server listening port, and DCNM server listening port
  
        	[bookmark: pgfId-1110153]4.1(2)
  
        	[bookmark: pgfId-1110166]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1110145]Server installer includes a step for choosing an archive folder
  
        	[bookmark: pgfId-1110200]4.1(2)
  
        	[bookmark: pgfId-1110168]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1110139]DCNM server installer
  
        	[bookmark: pgfId-1110214]4.1(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1051635][bookmark: 28199]Installing and Launching the Cisco DCNM Client 
      
      
 
     
 
 
    [bookmark: pgfId-1052681]This chapter describes how to install and launch the Cisco Data Center Network Manager (DCNM) client. The Cisco DCNM client is a web-based application that you install on systems running Microsoft Windows XP Professional. When you finish installing the Cisco DCNM client on your system, the Cisco DCNM client automatically starts. After installing the Cisco DCNM client, whenever you need to restart the Cisco DCNM client, use the Cisco DCNM client software image on your system for the quickest start. If a more recent version of the Cisco DCNM client is available, the Cisco DCNM client automatically downloads that version to your system. 
 
    [bookmark: pgfId-1055690]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1055717]Prerequisites for Installing and Using the Cisco DCNM Client
 
     	 [bookmark: pgfId-1062922]Default Administrator Credentials
 
     	 [bookmark: pgfId-1055741]Downloading and Launching the Cisco DCNM Client
 
     	 [bookmark: pgfId-1055761]Restarting the Cisco DCNM Client
 
     	 [bookmark: pgfId-1055782]Uninstalling the Cisco DCNM Client
 
     	 [bookmark: pgfId-1063176]Additional References
 
     	 [bookmark: pgfId-1060497]Feature History for Installing and Launching the Cisco DCNM Client
 
    
 
   
 
    
     [bookmark: pgfId-1051337][bookmark: 25282]Prerequisites for Installing and Using the Cisco DCNM Client
 
    [bookmark: pgfId-1062910]Installing and using the Cisco DCNM client have the following prerequisites:
 
     
     	 [bookmark: pgfId-1062912][bookmark: marker-1062911]Your system must be running the Microsoft Windows XP Professional operating system to install and use the Cisco DCNM client software. For more information about client system requirements, see the  Cisco DCNM Release Notes, Release 4.x .
 
     	 [bookmark: pgfId-1065255]Downloading the Cisco DCNM client requires the use of one of the following supported web browsers:
 
    
 
    [bookmark: pgfId-1065256] – Microsoft Internet Explorer 7
 
    [bookmark: pgfId-1065260] – Mozilla Firefox 3.0
 
     
     	 [bookmark: pgfId-1062639]The installation process uses Java version 1.5.0_11. If your system does not have that version of Java, the installation process will install it to your system.
 
    
 
    [bookmark: pgfId-1065011]The Cisco DCNM client installer requires Internet access to download the Java version 1.5.0_11 JRE. If the system cannot access the Internet, use another system to download the Java installer and copy it to the system that you want to install the Cisco DCNM client on. You can download Java version 1.5.0_11 JRE from the Java[tm] Technology Products Download web site, at http://java.sun.com/products/archive. The Java version 1.5.0_11 JRE is listed as JRE 5.0 Update 11.
 
    [bookmark: pgfId-1065100]If your network environment requires a proxy connection to permit the download of the Java installer, ensure that the proxy settings are configured in Internet Options, available from the Control Panel. For more information, see http://java.sun.com/j2se/1.5.0/proxy_note.html.
 
     
     	 [bookmark: pgfId-1059866]Some Cisco DCNM features require a license. Before you can use licensed features, install the Cisco DCNM license. For detailed steps for the license installation, see the “Installing Licenses” section. For more information about licensed features, see the “Cisco DCNM Licensing” section.
 
    
 
   
 
    
     [bookmark: pgfId-1059887][bookmark: 15213]Default Administrator Credentials[bookmark: marker-1061763]
 
    [bookmark: pgfId-1061106]When you install Cisco DCNM, you specify the default administrator account, which is a Cisco DCNM local user. If you use RADIUS or TACACS+ authentication servers to control access to the Cisco DCNM client, the default administrator account provides you access if no authentication servers for the current authentication mode are reachable.
 
    [bookmark: pgfId-1064098]If no one has administrative access to Cisco DCNM, you can reset the local administrator account or change Cisco DCNM server authentication settings by reinstalling the Cisco DCNM server software. For more information, see the “Reinstalling the Cisco DCNM Server” section.
 
   
 
    
     [bookmark: pgfId-1061068][bookmark: 98882]Downloading and Launching the Cisco DCNM Client
 
    [bookmark: pgfId-1051352]You can download and launch the Cisco DCNM client from the web server included on the Cisco DCNM server.
 
    [bookmark: pgfId-1061962][bookmark: marker-1053740]When you download and launch the Cisco DCNM client, it automatically saves an image of the software on your local system and starts the Cisco DCNM client. Later on, when you start the Cisco DCNM client, you can quickly start it by using the image on your local system.
 
     
      [bookmark: pgfId-1061952]DETAILED STEPS
 
     [bookmark: pgfId-1051425]To download and launch the Cisco DCNM client, follow these steps:
 
     
 
     [bookmark: pgfId-1051426]Step 1 On the computer that you want to use the Cisco DCNM client on, open a web browser and go to the following address:
 
     [bookmark: pgfId-1051427]http://server_IP_address_or_DNS_name:web_server_port/dcnm-client/index.html 
 
     [bookmark: pgfId-1051436]For example, if the Cisco DCNM server IP address is 172.0.2.1 and the web server port is 8080, use the following address:
 
      
      [bookmark: pgfId-1054581]http://172.0.2.1:8080/dcnm-client/index.html
 
     
 
     [bookmark: pgfId-1054645]The browser shows the Cisco DCNM client page. 
 
     [bookmark: pgfId-1051453]Step 2 Click Launch Cisco DCNM Client.
 
     [bookmark: pgfId-1054688]The Cisco DCNM server sends the dcnm.jnlp file to the browser. This file should be opened with the Java Web Start Launcher.
 
     [bookmark: pgfId-1064532]Step 3 If the browser prompts you, choose to open the dcnm.jnlp file. You do not need to save the file.
 
     [bookmark: pgfId-1064850]The Cisco DCNM client installer verifies that Java is already installed on your system. If the installer does not find the supported version of Java on the computer, the installer prompts to you to install Java version 1.5.0_11.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065147]Note The Cisco DCNM client installer requires Internet access to download the Java version 1.5.0_11 JRE. If the system cannot access the Internet, use another system to download the Java installer, copy it to the system that you want to install the Cisco DCNM client on, install Java, and restart the Cisco DCNM client installation. You can download Java version 1.5.0_11 JRE from the Java[tm] Technology Products Download web site, at http://java.sun.com/products/archive. The Java version 1.5.0_11 JRE is listed as JRE 5.0 Update 11.

If your network environment requires a proxy connection to permit the download of the Java installer, ensure that the proxy settings are configured in Internet Options, available from the Control Panel. For more information, see http://java.sun.com/j2se/1.5.0/proxy_note.html.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1064852]Step 4 If the installer prompts you to install Java version 1.5.0_11, follow these steps:
 
     [bookmark: pgfId-1064597] a. Click OK to begin installing the supported version of Java.
 
     [bookmark: pgfId-1064617] b. If a security warning notifies you that the Java installer was digitally signed by an expired certificate, click Run to continue the installation.
 
     [bookmark: pgfId-1064666] c. Complete the Java installation wizard.
 
      
       
     
 
     
 
     [bookmark: pgfId-1064759]Tip To specify whether the supported version of Java is the default version used by browsers installed on the computer, choose Custom setup on the License Agreement dialog box. Later in the Java installation, on the Browser Registration dialog box, you can specify the browsers that should use the Cisco DCNM-supported Java version.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1064748]The Cisco DCNM client installs on the computer.
 
      
       
     
 
     
 
     [bookmark: pgfId-1061775]Note You might need to wait a minute or longer while the installer installs the software.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1055027]The Cisco DCNM client login window opens. 
 
     [bookmark: pgfId-1051486]Step 5 In the Cisco DCNM client login window, do the following:
 
     [bookmark: pgfId-1051724] a. In the DCNM Server box, type the hostname or the IP address of the Cisco DCNM server.
 
     [bookmark: pgfId-1064809]By default, the DCNM Server box contains the IP address of the Cisco DCNM server that you downloaded the Cisco DCNM client from.
 
     [bookmark: pgfId-1061452] b. In the Username box, enter your Cisco DCNM username. If you are logging into Cisco DCNM for the first time after installing the server, enter the local administrator name that you specified during the server installation. For more information, see the “Default Administrator Credentials” section.
 
     [bookmark: pgfId-1061453] c. In the Password box, enter the password for the Cisco DCNM username that you specified.
 
     [bookmark: pgfId-1056862] d. (Optional) If you need to change the Cisco DCNM server port, click More and enter the port number in the Port box. The default Cisco DCNM server port number is 1099; however, you can specify a different port number when you install or reinstall the Cisco DCNM server.
 
     [bookmark: pgfId-1061616] e. Click Login.
 
     [bookmark: pgfId-1061620]The Cisco DCNM client opens.
 
     [bookmark: pgfId-1061925]If you are deploying Cisco DCNM for the first time, see the “Deploying Cisco DCNM” section.
 
     [bookmark: pgfId-1061935]For information on how to use the Cisco DCNM client, see Chapter4, “Using the Cisco DCNM Client”
 
     [bookmark: pgfId-1062055]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1061927][bookmark: 68786]Restarting the Cisco DCNM Client
 
    [bookmark: pgfId-1061928]If you have previously downloaded and launched the Cisco DCNM client on a computer, you can later start the Cisco DCNM client by using the desktop shortcut or the Start menu command for the Cisco DCNM client.
 
    [bookmark: pgfId-1062129]When you start the Cisco DCNM client, it connects to the Cisco DCNM server and checks if the Cisco DCNM client that is available on the Cisco DCNM server is a newer version than the locally installed Cisco DCNM client. How the Cisco DCNM client starts varies depending upon the result of the version check, as follows:
 
     
     	 [bookmark: pgfId-1063055]If the locally installed Cisco DCNM client is the same version as the Cisco DCNM client that is available on the Cisco DCNM server, the Cisco DCNM client window opens quickly.
 
     	 [bookmark: pgfId-1063069]If the locally installed Cisco DCNM client is older than the version of the Cisco DCNM client that is available on the Cisco DCNM server, the Cisco DCNM client automatically downloads from the Cisco DCNM server and replaces the locally installed Cisco DCNM client before the Cisco DCNM client window opens.
 
    
 
     
      [bookmark: pgfId-1055435]DETAILED STEPS
 
     [bookmark: pgfId-1055306]To restart the Cisco DCNM client, follow these steps:
 
     
 
     [bookmark: pgfId-1055315]Step 1 Click the desktop icon for the Cisco DCNM client or choose Start > Programs > Cisco DCNM Client > Cisco DCNM Client.
 
     [bookmark: pgfId-1055360]The Cisco DCNM client login window. 
 
     [bookmark: pgfId-1062301]Step 2 In the Cisco DCNM client login window, do the following:
 
     [bookmark: pgfId-1062302] a. In the Cisco DCNM Server box, type the hostname or the IP address of the Cisco DCNM server. By default, this window lists the IP address specified the last time you logged into Cisco DCNM. You can use the host name for the Cisco DCNM server in place of the IP address.
 
     [bookmark: pgfId-1062303] b. In the Username box, enter your Cisco DCNM username.
 
     [bookmark: pgfId-1062307] c. In the Password box, enter your Cisco DCNM password.
 
     [bookmark: pgfId-1062308] d. (Optional) If you need to change the Cisco DCNM server port, click More and enter the port number in the Port box. The default Cisco DCNM server port number is 1099; however, you can specify a different port number when you install or reinstall the Cisco DCNM server.
 
     [bookmark: pgfId-1062309] e. Click Login.
 
     [bookmark: pgfId-1062310]The Cisco DCNM client opens. For information on how to use the Cisco DCNM client, see Chapter4, “Using the Cisco DCNM Client”
 
     [bookmark: pgfId-1064493]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1064495][bookmark: 94590]Uninstalling the Cisco DCNM Client
 
    [bookmark: pgfId-1064496]You can uninstall the Cisco DCNM client from a computer.
 
     
      [bookmark: pgfId-1051773]DETAILED STEPS
 
     [bookmark: pgfId-1063096]To uninstall the Cisco DCNM client, follow these steps:
 
     
 
     [bookmark: pgfId-1051793]Step 1 [bookmark: marker-1053764]Click Start > Control Panel > Java.
 
     [bookmark: pgfId-1051799]The Java Control Panel dialog box opens.
 
     [bookmark: pgfId-1051804]Step 2 In the General tab, under Temporary Internet Files, click Settings.
 
     [bookmark: pgfId-1062394]The Temporary File Settings dialog box appears.
 
     [bookmark: pgfId-1062385]Step 3 Click View Applications.
 
     [bookmark: pgfId-1051805]The Java Application Cache Viewer dialog box opens.
 
     [bookmark: pgfId-1051806]Step 4 Select the Cisco DCNM Client application and click Remove Selected Application.
 
     [bookmark: pgfId-1051807]Java uninstalls the Cisco DCNM client image from your computer.
 
     [bookmark: pgfId-1051808]Step 5 Close the Java Application Cache Viewer.
 
     [bookmark: pgfId-1051809]Step 6 On the Temporary File Settings dialog box, click OK.
 
     [bookmark: pgfId-1062451]Step 7 On the Java Control Panel dialog box, click OK.
 
     [bookmark: pgfId-1051810]Step 8 If you want to reinstall the Cisco DCNM client, see the “Downloading and Launching the Cisco DCNM Client” section.
 
     [bookmark: pgfId-1052045]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1063101][bookmark: 24180]Additional References
 
    [bookmark: pgfId-1063102]For additional information related to installing and launching the Cisco DCNM client, see the following sections:
 
     
     	 [bookmark: pgfId-1063106]Related Documents
 
     	 [bookmark: pgfId-1063110]Standards
 
    
 
     
      [bookmark: pgfId-1063112][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1063132]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1063115]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1063117]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1063119]Installing and launching the Cisco DCNM server
  
         	[bookmark: pgfId-1063124]Chapter 2, “Installing and Launching the Cisco DCNM Server”
  
        
 
         
         	[bookmark: pgfId-1063126]The process of deploying Cisco DCNM in your organization
  
         	[bookmark: pgfId-1063131]Deploying Cisco DCNM
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1063134][bookmark: 55398]Standards
 
     [bookmark: pgfId-1063144]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1063137]Standards 
          
  
         	 
           
           [bookmark: pgfId-1063139]Title 
          
  
        
 
         
         	[bookmark: pgfId-1063141]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1063143]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1060421][bookmark: 92503]Feature History for Installing and Launching the Cisco DCNM Client
 
    [bookmark: pgfId-1060425]Table 3-1 lists the release history for this feature.
 
    [bookmark: pgfId-1060461]
 
     
      
       
       [bookmark: pgfId-1060432]Table 3-1 [bookmark: 50557]Feature History for Installing and Launching the Cisco DCNM Client 
 
       
       
        
        	 
          
          [bookmark: pgfId-1060438]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1060440]Releases 
         
  
        	 
          
          [bookmark: pgfId-1060442]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1060456]Cisco DCNM client installation
  
        	[bookmark: pgfId-1060458]4.2(1)
  
        	[bookmark: pgfId-1063642]No change from Release 4.1
  
       
 
        
        	[bookmark: pgfId-1065891]Port number in URL for downloading the DCNM client is configurable
  
        	[bookmark: pgfId-1065893]4.1(2)
  
        	[bookmark: pgfId-1065895]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1065885]DCNM client installation
  
        	[bookmark: pgfId-1065887]4.1(2)
  
        	[bookmark: pgfId-1065889]This feature was preexisting.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1060415]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1075455][bookmark: 85688]Using the Cisco DCNM Client 
      
      
 
     
 
 
    [bookmark: pgfId-1075456]This chapter describes the user interface of the Cisco Data Center Network Manager (DCNM) client and how to use common features.
 
    [bookmark: pgfId-1142937]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1142941]Introducing the Cisco DCNM Client
 
     	 [bookmark: pgfId-1142945]Opening the Cisco DCNM Client
 
     	 [bookmark: pgfId-1142949]Closing the Cisco DCNM Client
 
     	 [bookmark: pgfId-1142953]Deploying Changes
 
     	 [bookmark: pgfId-1142957]Working with Statistics and Charts
 
     	 [bookmark: pgfId-1142961]Configuring Global Preferences
 
     	 [bookmark: pgfId-1142965]Using Online Help
 
     	 [bookmark: pgfId-1142969]Additional References
 
     	 [bookmark: pgfId-1142973]Feature History for Using the Cisco DCNM Client
 
    
 
   
 
    
     [bookmark: pgfId-1142975][bookmark: 72509]Introducing the Cisco DCNM Client
 
    [bookmark: pgfId-1142976]This section describes the Cisco DCNM client and its parts.
 
    [bookmark: pgfId-1142977]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1142981]User Interface
 
     	 [bookmark: pgfId-1142985]Feature Selector Pane
 
     	 [bookmark: pgfId-1142989]Contents Pane
 
     	 [bookmark: pgfId-1142993]Summary Pane
 
     	 [bookmark: pgfId-1142997]Details Pane
 
     	 [bookmark: pgfId-1143001]Association Pane
 
     	 [bookmark: pgfId-1143005]Menus
 
     	 [bookmark: pgfId-1143009]Toolbars
 
     	 [bookmark: pgfId-1143013]Keyboard Commands
 
    
 
     
      [bookmark: pgfId-1075519][bookmark: 30384]User Interface
 
     [bookmark: pgfId-1079831]The Cisco DCNM client user interface, shown in Figure 4-1, presents device status information and provides configuration tools that allow you to manage devices. It is divided into the panes shown in Figure 4-1. When you want to view information about a specific object in a managed device or want to perform a configuration task, you use the panes in the order shown in Figure 4-1.
 
     [bookmark: pgfId-1143085]Figure 4-1 [bookmark: 71839]Cisco DCNM Client User Interface
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1075550]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1079624]1 
          
  
         	[bookmark: pgfId-1079626]Feature Selector pane
  
         	 
           
           [bookmark: pgfId-1079628]2 
          
  
         	[bookmark: pgfId-1079630]Contents pane
  
        
 
         
         	 
           
           [bookmark: pgfId-1079632]3 
          
  
         	[bookmark: pgfId-1079634]Summary pane
  
         	 
           
           [bookmark: pgfId-1079636]4 
          
  
         	[bookmark: pgfId-1079638]Details pane
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1075555][bookmark: 43742]Feature Selector Pane
 
     [bookmark: pgfId-1075559]The Feature Selector pane, shown in Figure 4-1, allows you to see features grouped by categories and to choose the feature that you want to use or configure. The bottom section of the Feature Selector pane displays buttons for feature categories. When you choose a category, the top section of the Feature Selector pane displays a tree of features within the chosen category.
 
     [bookmark: pgfId-1075563]In Figure 4-1, the Interfaces category is chosen, so the tree shows features that allow you to configure the interfaces of managed devices.
 
     [bookmark: pgfId-1075564]The documentation and online help for Cisco DCNM includes many procedures that begin with choosing the applicable feature from the Feature Selector pane. For example, a procedure about configuring an Ethernet interface would start with the following step:
 
     [bookmark: pgfId-1075565] From the Feature Selector pane, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1075566]After you choose a feature on the tree, the Contents pane displays information about the feature.
 
    
 
     
      [bookmark: pgfId-1075568][bookmark: 94698]Contents Pane
 
     [bookmark: pgfId-1075572]The Contents pane, shown in Figure 4-1, displays information about the currently selected feature and provides fields for configuring that feature. The Contents pane contains two smaller panes: the Summary pane and the Details pane.
 
    
 
     
      [bookmark: pgfId-1075574][bookmark: 10367]Summary Pane
 
     [bookmark: pgfId-1075578]The Summary pane, shown in Figure 4-1, displays an organized set of objects that you can view information about or perform actions on. The type of objects that appear depends upon the currently selected feature.
 
     [bookmark: pgfId-1075579]For example, if you choose Interfaces > Physical > Ethernet from the Feature Selector pane, the Summary pane shows a table of devices. You can expand the managed devices to view the slots that contain network interface cards. You can expand the slots to view the interfaces they contain and key information about the status of the interfaces, such as the port mode, administrative status, and operational status. For most features, the title bar for the Summary pane shows what you have selected.
 
     [bookmark: pgfId-1075580]After you choose the object that you want to view or configure, the Details pane displays information about the selected object, such as an Ethernet interface.
 
     [bookmark: pgfId-1119748]Exporting the Summary Pane
 
     [bookmark: pgfId-1119757]You can export the data shown in the Summary pane to a spreadsheet in Microsoft Excel 97-2003 format. To do so, click the green arrow in the upper-right corner of the Summary pane and specify the filename and location for the spreadsheet.
 
     [bookmark: pgfId-1075581]Filtering the Summary Pane
 
     [bookmark: pgfId-1119744]For many features, you can filter the objects that appear in the Summary pane. If filtering is supported for the feature that you selected, you can enable filtering from the menu bar by choosing View > Filter. In the Summary pane, the columns that you can use to filter the objects become drop-down lists. To filter the Summary pane, use the drop-down column heading lists to limit the objects that appear.
 
    
 
     
      [bookmark: pgfId-1075583][bookmark: 61634]Details Pane
 
     [bookmark: pgfId-1075587]The Details pane, shown in Figure 4-1, shows information and configuration fields that are specific to the object that you selected in the Summary pane. The Details tab is often further divided into tabs. You can click on a tab to view its contents.
 
     [bookmark: pgfId-1143226]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1143230]Tabs
 
      	 [bookmark: pgfId-1143234]Sections
 
     
 
    
 
     
      [bookmark: pgfId-1075588][bookmark: 12139]Tabs
 
     [bookmark: pgfId-1075592]Tabs organize related fields and information. For example, as shown in Figure 4-1, when you select an Ethernet interface, four tabs appears in the Details pane, such as the Port Details tab.
 
     [bookmark: pgfId-1075593]The following two special tabs often appear in the Details pane for many of the types of objects that you can choose from the Summary pane:
 
      
      	 [bookmark: pgfId-1075594]Statistics—You can use this tab to work with statistics and charts related to the selected object. For more information, see the “Working with Statistics and Charts” section.
 
      	 [bookmark: pgfId-1075598]Events—You can use this tab to view feature-specific events about the selected object. For more information, see the “Viewing Events on an Events Tab” section.
 
     
 
    
 
     
      [bookmark: pgfId-1075602][bookmark: 25012]Sections
 
     [bookmark: pgfId-1075603]Sections provide further organization of related fields and information. The Cisco DCNM client allows you to expand and collapse sections so that you can show or hide fields and information as needed. For example, as shown in Figure 4-1, on the Port Details tab, the Basic Settings section is expanded but the Port Mode Settings section is collapsed.
 
    
 
     
      [bookmark: pgfId-1075608][bookmark: 14032]Association Pane
 
     [bookmark: pgfId-1075609]The Cisco DCNM client also includes the Association pane, which allows you to access objects that you have configured in features that are associated with the currently selected feature. Figure 4-2 shows the Association pane.
 
     [bookmark: pgfId-1079961]When tabs appear on the right side of the Cisco DCNM client, you can click on them to access the Association pane. For example, as shown in Figure 4-2, if you are configuring an Ethernet interface, you can use the Association pane to access the IPv4 ACLs that you can apply to the interface. If you right-click on an IPv4 ACL in the Association pane, you can choose to apply the ACL to the interface or to go to the IPv4 ACLs feature and configure the ACL.
 
     [bookmark: pgfId-1143333]Figure 4-2 [bookmark: 68552]Association Pane
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1080739]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1080736]1 
          
  
         	[bookmark: pgfId-1080738]Association pane
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1075629][bookmark: 63051]Menus
 
     [bookmark: pgfId-1075630]The menu bar in the Cisco DCNM client includes the following standard menus that appear:
 
    
 
     
      [bookmark: pgfId-1109411]File Menu
 
      
      	 [bookmark: pgfId-1109566]New—Allows you to create new objects. The types of objects that you can create depends upon the currently selected feature. In some cases, the object selected in the Summary pane also affects what you can create.
 
      	 [bookmark: pgfId-1109415]Deploy—Saves your changes to the Cisco DCNM server and deploys configuration changes to managed devices.
 
      	 [bookmark: pgfId-1109419]Exit—Closes the Cisco DCNM client.
 
     
 
    
 
     
      [bookmark: pgfId-1109590]View Menu
 
      
      	 [bookmark: pgfId-1109594]Toolbars—Allows you to show or hide the toolbars that are available for the currently selected feature. For more information, see the “Toolbars” section.
 
      	 [bookmark: pgfId-1109601]Refresh—Forces the Cisco DCNM client to retrieve updated information from the Cisco DCNM server.
 
      	 [bookmark: pgfId-1109605]Filter—Enables or disables the filtering option for the Summary pane.
 
     
 
    
 
     
      [bookmark: pgfId-1109616]Tools Menu
 
      
      	 [bookmark: pgfId-1109620]Preferences—Opens the Global Preferences dialog box. For more information, see the “Configuring Global Preferences” section.
 
      	 [bookmark: pgfId-1109627]Debug—Opens the Cisco DCNM Client Logging dialog box, which allows you to configure the logging level for the Cisco DCNM client.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1109630]Note We recommend that you use the default client logging level unless you are troubleshooting a specific problem or are asked to change client logging levels by the Cisco technical support staff.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1109645]Go Menu
 
      
      	 [bookmark: pgfId-1109649]Topology—Selects the Topology button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109653]Inventory—Selects the Inventory button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109657]Virtual Devices—Selects the Virtual Devices button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109661]Interfaces—Selects the Interfaces button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1110182]Switching—Selects the Switching button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1110184]Routing—Selects the Routing button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109673]Security—Selects the Security button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109677]DCNM Server Administration—Selects the DCNM Server Administration button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109681]Configuration Change Management—Selects the Configuration Change Management button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109685]Device OS Management—Selects the Device OS Management button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1110694]Event Browser—Selects the Event Browser button on the Feature Selector pane.
 
     
 
    
 
     
      [bookmark: pgfId-1110695]Actions Menu
 
     [bookmark: pgfId-1110830]The items on the Actions menu reflect what you can do, depending upon the feature you are using and the object that is selected in the Summary pane. For some features, such as Inventory, the Actions menu does not appear in the menu bar.
 
    
 
     
      [bookmark: pgfId-1110791]Help Menu
 
      
      	 [bookmark: pgfId-1110696]Help Contents—Opens the online help system to the Welcome page.
 
      	 [bookmark: pgfId-1109746]Context Help—Opens the online help system to a page that applies to the feature currently selected in the Feature Selector pane.
 
      	 [bookmark: pgfId-1109750]Show DCNM Instance ID—Opens a dialog box that displays the license ID for your Cisco DCNM server. For more information, see the “Installing Licenses” section.
 
      	 [bookmark: pgfId-1109754]View Licenses—Opens a dialog box that displays information about license files currently installed with your Cisco DCNM server.
 
      	 [bookmark: pgfId-1109758]About Data Center Network Manager—Opens a dialog box that displays information about your Cisco DCNM server, including the software version and implementation version.
 
     
 
    
 
     
      [bookmark: pgfId-1075813][bookmark: 41994]Toolbars
 
     [bookmark: pgfId-1075814]The Cisco DCNM client provides several standard toolbars plus additional, feature-specific toolbars that are available only when you have selected the applicable feature. The following table lists actions that you can take to configure toolbars.
 
     [bookmark: pgfId-1108667]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1108648]Action 
          
  
         	 
           
           [bookmark: pgfId-1108650]How To 
          
  
        
 
         
         	[bookmark: pgfId-1108652]Show or hide a toolbar
  
         	[bookmark: pgfId-1108654]Right-click on the toolbar area and then choose the toolbar that you want to show or hide.
  
        
 
         
         	[bookmark: pgfId-1108656]Rearrange toolbars
  
         	[bookmark: pgfId-1108658]On a toolbar that you want to move, click on the left end of the toolbar and drag it to where you want it.
  
        
 
         
         	[bookmark: pgfId-1108660]Float a toolbar
  
         	[bookmark: pgfId-1108662]On the toolbar that you want to float, click on the left end of the toolbar and drag it off of the toolbar area.
  
        
 
         
         	[bookmark: pgfId-1108664]Control whether a toolbar can be hidden, rearranged, or floated
  
         	[bookmark: pgfId-1108666]Right-click on the toolbar area and then choose the option that you want to control.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1075845][bookmark: 53794]Keyboard Commands
 
     [bookmark: pgfId-1075846]You can use the keyboard to perform many of the commands that you can perform with menu items or toolbars. The menus show the keyboard equivalent of most menu items. For example, the following list shows some common menu items and the matching keyboard command:
 
      
      	 [bookmark: pgfId-1075847]Deploy—Ctrl + S
 
      	 [bookmark: pgfId-1075848]Refresh—F5
 
      	 [bookmark: pgfId-1075849]Filter—Ctrl + F
 
      	 [bookmark: pgfId-1075850]Online help—F1
 
      	 [bookmark: pgfId-1075851]Exit—Ctrl + Q
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1067715][bookmark: 61376]Opening the Cisco DCNM Client
 
    [bookmark: pgfId-1058778]You can open the Cisco DCNM client after you have installed the Cisco DCNM client on the computer that you are using.
 
     
      [bookmark: pgfId-1060471]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1062361]Install the Cisco DCNM client on the computer that you are using. For more information about installing the Cisco DCNM client, see Chapter3, “Installing and Launching the Cisco DCNM Client”
 
    
 
     
      [bookmark: pgfId-1060472]DETAILED STEPS
 
     [bookmark: pgfId-1055920]To open the Cisco DCNM client, follow these steps:
 
     
 
     [bookmark: pgfId-1060533]Step 1 From the start menu, choose All Programs > Cisco DCNM Client > Cisco DCNM Client.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060534]Note If the Cisco DCNM client is not available on the All Programs menu, you can launch the Cisco DCNM client from the Cisco DCNM server website. For more information, see Chapter3, “Installing and Launching the Cisco DCNM Client”
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1095996]A dialog box displays login fields.
 
     [bookmark: pgfId-1095997]Step 2 In the Cisco DCNM Server field, enter the IP address or hostname of the Cisco DCNM server. You can use the hostname only if your DNS server has an entry for the Cisco DCNM server hostname.
 
      
       
     
 
     
 
     [bookmark: pgfId-1096004]Tip If you have previously logged into the server with the current client installation, you may be able to choose the IP address or hostname from the drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1058573]Step 3 In the Username field, enter the name of the Cisco DCNM server user account that you want to use to access the Cisco DCNM client.
 
     [bookmark: pgfId-1058581]Step 4 In the Password field, enter the password for the user account that you specified.
 
     [bookmark: pgfId-1058582]Step 5 If your Cisco DCNM server uses a port number other than 1099, click More and enter the port number for your Cisco DCNM server in the Port field.
 
     [bookmark: pgfId-1058594]Step 6 Click Login.
 
     [bookmark: pgfId-1058603]The Cisco DCNM client user interface appears.
 
     [bookmark: pgfId-1059205]If a dialog box displays a message about device credentials, you have not configured device credentials for the user account that you specified.
 
     [bookmark: pgfId-1059208]Step 7 If a dialog box shows a message that your device credentials are not set, do one of the following:
 
      
      	 [bookmark: pgfId-1059217]If you want to set device credentials now, click  Yes .
 
      	 [bookmark: pgfId-1059295]If you do not want to set device credentials now, click  No .
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1059312]Note For information about setting device credentials, see the “Administering Devices and Credentials” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1059296]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1062229][bookmark: 72623]Closing the Cisco DCNM Client
 
    [bookmark: pgfId-1056229]You can close the Cisco DCNM client when you are done using it.
 
     
      [bookmark: pgfId-1060451]DETAILED STEPS
 
     [bookmark: pgfId-1060422]To close the Cisco DCNM client, follow these steps:
 
     
 
     [bookmark: pgfId-1058880]Step 1 From the menu bar, choose File > Exit.
 
     [bookmark: pgfId-1058881]A dialog box displays a confirmation message.
 
     [bookmark: pgfId-1058882]Step 2 (Optional) If you have not deployed your changes, do one of the following:
 
      
       
       	 [bookmark: pgfId-1058910]If you want to save your changes, including deploying configuration changes to managed devices, check  Save pending changes .
 
       	 [bookmark: pgfId-1058943]If you want to discard your changes, uncheck  Save pending changes .
 
      
 
     
 
     [bookmark: pgfId-1058955]Step 3 Click Yes.
 
     [bookmark: pgfId-1058969]If you started any statistical data collection processes during the Cisco DCNM client session, a dialog box displays the collection processes.
 
     [bookmark: pgfId-1060233]Step 4 If a dialog box displays the statistical data collection processes that you started, do the following:
 
     [bookmark: pgfId-1060278] a. Decide which statistical collection processes that you want to stop.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060362]Note We recommend that you stop any unnecessary statistical collection processes when you log out of the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1060300] b. Check the collection processes that you want to stop. If you want to stop all of your collection processes, click Select All.
 
     [bookmark: pgfId-1060395] c. Click Ok.
 
     [bookmark: pgfId-1062335]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1062337][bookmark: 22215]Deploying Changes
 
    [bookmark: pgfId-1118477]When you use the Cisco DCNM client to make configuration changes to managed devices or to the Cisco DCNM server, you may need to deploy the changes or the Cisco DCNM client may deploy them automatically, depending upon what changes you have made.
 
     
     	 [bookmark: pgfId-1119400]Automatic deployment—If the Cisco DCNM client deploys a change automatically, the “Deploying configuration” message appears briefly. For example, if you delete an access rule from an ACL, the Cisco DCNM client immediately deploys this configuration change to the managed device that has the ACL.
 
     	 [bookmark: pgfId-1118449]Manual deployment—If the Cisco DCNM client is storing a configuration change, on the toolbar, the Deploy button is available. For example, if you change the sequence number of an access rule of an ACL, the Cisco DCNM client stores this configuration change until you manually deploy it to the managed device that has the ACL.
 
    
 
    [bookmark: pgfId-1119500]To remind you of the necessity to deploy changes that the Cisco DCNM client is storing, the procedures in the Cisco DCNM documentation set include a deployment step.
 
    [bookmark: pgfId-1067089]Deploying server changes saves your changes on the Cisco DCNM server. For example, if you add a Cisco DCNM server user account, deploying your changes adds the user account to the Cisco DCNM server and does not affect managed devices.
 
    [bookmark: pgfId-1067183]Deploying configuration changes to a managed device causes the Cisco DCNM server to update the running configuration of the device.
 
     
      
    
 
    
 
    [bookmark: pgfId-1067202]Note Cisco DCNM does not update the startup configuration of a managed device. When you want to replace the startup configuration of a managed device with the running configuration, you can log into the command-line interface of the device and copy the running configuration to the startup configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1067098]When you close the Cisco DCNM client and you have not deployed your changes, you can deploy them without canceling the process of closing the Cisco DCNM client. For more information, see the “Closing the Cisco DCNM Client” section.
 
   
 
    
     [bookmark: pgfId-1067038][bookmark: 34593]Working with Statistics and Charts
 
    [bookmark: pgfId-1143432]This section describes how to use the statistical charts available on a Statistics tab.
 
    [bookmark: pgfId-1143433]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1143437]Information about Statistics and Charts
 
     	 [bookmark: pgfId-1143441]Licensing Requirements for Statistics and Charts
 
     	 [bookmark: pgfId-1143445]Accessing a Chart
 
     	 [bookmark: pgfId-1143449]Starting Statistical Monitoring for a Chart
 
     	 [bookmark: pgfId-1143453]Stopping Statistical Monitoring for a Chart
 
     	 [bookmark: pgfId-1143457]Using a Chart
 
     	 [bookmark: pgfId-1143461]Using an Overview Chart
 
     	 [bookmark: pgfId-1143465]Exporting a Chart
 
    
 
     
      [bookmark: pgfId-1143467][bookmark: 57802]Information about Statistics and Charts
 
     [bookmark: pgfId-1061114]You can use a Statistics tab to start and stop statistical monitoring for an object and to work with charts of statistical data about the selected object. For each chart, the Cisco DCNM client also provides overview charts, which allow you to see historical trends and to control the time scale of the standard chart.
 
     [bookmark: pgfId-1061198]When you start monitoring for a new chart, Cisco DCNM creates a new statistical collection process that appears in the Statistical Data Collection feature. For more information, see the “Administering Statistical Data Collection” section.
 
    
 
     
      [bookmark: pgfId-1143473][bookmark: 91493]Licensing Requirements for Statistics and Charts
 
     [bookmark: pgfId-1143474]The following table shows the licensing requirements for this feature:
 
     [bookmark: pgfId-1143491]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1143477]Product 
          
  
         	 
           
           [bookmark: pgfId-1143479]License Requirement 
          
  
        
 
         
         	[bookmark: pgfId-1143481]Cisco DCNM
  
         	[bookmark: pgfId-1143483]Real-time monitoring requires no license.
 [bookmark: pgfId-1143484]Cisco DCNM requires a LAN Enterprise license for the following features:
 
           
           	 [bookmark: pgfId-1143485]Maintaining a history of statistical data
 
           	 [bookmark: pgfId-1143486]Using overview charts
 
          
 [bookmark: pgfId-1143489]For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1055435][bookmark: 27556]Accessing a Chart
 
     [bookmark: pgfId-1062747]You can access any chart. The charts that are available for a particular Statistics tab depend upon the feature and object selected.
 
    
 
     
      [bookmark: pgfId-1062721]DETAILED STEPS
 
     [bookmark: pgfId-1062523]To access a chart, follow these steps:
 
     
 
     [bookmark: pgfId-1062659]Step 1 From the Feature Selector pane, choose the feature for which you want to use a statistical chart.
 
     [bookmark: pgfId-1062524]For example, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1062525]Step 2 From the Summary pane, select an object.
 
     [bookmark: pgfId-1062526]The Statistics tab appears in the Details pane. In the Statistics tab, one or more charts may appear.
 
      
       
     
 
     
 
     [bookmark: pgfId-1062527]Note If no Statistics tab appears, then Cisco DCNM does not provide a statistical chart for the object that you selected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1062598]Step 3 If the chart for the data that you want to monitor does not appear, from the toolbar, choose New Chart and then choose the chart that you want.
 
     [bookmark: pgfId-1062528]Step 4 Click the title bar of the chart that you want to work with.
 
     [bookmark: pgfId-1063395]The chart status appears in the lower left corner of the chart pane. If the chart is not active, you must start statistical monitoring for the chart before you can use it. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1062512]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1062502][bookmark: 21265]Starting Statistical Monitoring for a Chart[bookmark: marker-1055278]
 
     [bookmark: pgfId-1055280]You can start statistical monitoring for a chart in the Statistics tab for any of the device configuration features that support statistical monitoring.
 
      
       
     
 
     
 
     [bookmark: pgfId-1055281]Note Each time that you start monitoring for a new chart, Cisco DCNM creates a new statistical collection process that appears in the Statistical Data Collection feature.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055282]DETAILED STEPS
 
     [bookmark: pgfId-1055283]To start statistical monitoring for a chart, follow these steps:
 
     
 
     [bookmark: pgfId-1055284]Step 1 Access the chart for which you want to start statistical monitoring. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1055293]Step 2 From the chart pane, click Select Parameters, check at least one statistical parameter that you want to appear in the chart, and click Select Parameters again.
 icon to start the collection process. 
     
 
     [bookmark: pgfId-1055298]Step 4 The chart starts graphing the selected parameters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1055307]Note When you close the Cisco DCNM client without stopping the statistical collection processes that you started, a dialog box prompts you to decide whether to stop the statistical collections or let them continue. We recommend that you stop any unnecessary statistical collection processes when you log out of the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1055308]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1060004][bookmark: 80346]Stopping Statistical Monitoring for a Chart[bookmark: marker-1060003]
 
     [bookmark: pgfId-1060727]You can stop statistical monitoring for a chart in the Statistics tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060728]Note When you stop monitoring for a chart, Cisco DCNM stops the corresponding statistical collection process that appears in the Statistical Data Collection feature.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1060687]DETAILED STEPS
 
     [bookmark: pgfId-1060688]To stop statistical monitoring for a chart, follow these steps:
 
     
 
     [bookmark: pgfId-1063142]Step 1 Access the chart for which you want to stop statistical monitoring. For more information, see the “Accessing a Chart” section.
 icon. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1060029]Note If the chart that you want to stop does not appear, use the Statistical Data Collection feature to stop the collection process. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1060034]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055366][bookmark: 42626]Using a Chart
 
     [bookmark: pgfId-1059411]The Cisco DCNM client provides the following options for using a chart:
 
      
      	 [bookmark: pgfId-1060863]Changing parameters
 
      	 [bookmark: pgfId-1060880]Setting the charting frequency
 
      	 [bookmark: pgfId-1060889]Controlling the magnification of the chart data
 
      	 [bookmark: pgfId-1060894]Showing, moving, and hiding threshold lines
 
      	 [bookmark: pgfId-1061527]Tearing the chart away from the Cisco DCNM client window
 
     
 
     [bookmark: pgfId-1060904]This procedure provides basic instructions for using each of these options.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060943]Note For information about using an overview chart, see the “Using an Overview Chart” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059439]DETAILED STEPS
 
     [bookmark: pgfId-1059446]To use a chart, follow these steps:
 
     
 
     [bookmark: pgfId-1063226]Step 1 Access the chart that you want to use. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1063503]Step 2 If the chart is not active, you must start statistical monitoring for the chart before you can use it. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1061457]Step 3 (Optional) To change parameters, click Select Parameters, check the statistics parameters that you want to collect, and click Select Parameters again.
 
     [bookmark: pgfId-1061531]Step 4 (Optional) To set the frequency with which Cisco DCNM retrieves statistical data for the selected object, from the Select Frequency drop-down list on the Monitor tool bar, choose the new frequency.
 
     [bookmark: pgfId-1061650]Step 5 (Optional) To control the magnification, or zoom, of the chart, do one of the following:
 
      
       
       	 [bookmark: pgfId-1061731]To zoom in on a portion of the chart, position the mouse pointer at one end of the portion, click and hold the left mouse button, drag the mouse pointer to the other end of the portion, and release the mouse button.
 
       	 [bookmark: pgfId-1066974]To zoom in on a portion of the chart, position the mouse pointer at one end of the portion and then click and drag the mouse pointer to the other end of the portion.
 
       	 [bookmark: pgfId-1066978]To change to the previous zoom, click the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1066979]To change to the next zoom, click the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1061732]To reset the zoom to the default magnification, click the 
 
      
 
      [image: ] icon. 
     
 
     [bookmark: pgfId-1067002]Step 6 (Optional) To show, move, or hide threshold lines, do one of the following:
 
      
       
       	 [bookmark: pgfId-1067003]To show or hide threshold lines, on the Monitor tool bar, click the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1067007]To move the lower threshold line, click and drag the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1061781]To move the lower threshold line, click and drag the 
 
      
 
      [image: ] icon. 
     
 
     [bookmark: pgfId-1061782]Step 7 (Optional) To tear the chart away from the Cisco DCNM client window, click on the red line that appears below the chart title.
 
     [bookmark: pgfId-1059427]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055515][bookmark: 79408]Using an Overview Chart
 
     [bookmark: pgfId-1059432]You can use an overview chart to view the historical trend of the statistical data of the current chart and to set the time scale of the standard chart.
 
    
 
     
      [bookmark: pgfId-1143628]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1143629]Ensure that any device with data that you want to view on an overview chart is included on the list of Cisco DCNM-licensed devices. For more information, see the “Licensing Requirements for Statistics and Charts” section.
 
    
 
     
      [bookmark: pgfId-1059501]DETAILED STEPS
 
     [bookmark: pgfId-1059517]To use an overview chart, follow these steps:
 
     
 
     [bookmark: pgfId-1063286]Step 1 Access the chart that contains the overview chart that you want to use. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1063517]Step 2 If the chart is not active, you must start statistical monitoring for the chart before you can use its overview chart. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1061922]Step 3 Click Show Overview Chart.
 
     [bookmark: pgfId-1059503]In a new window, the overview chart displays the historical trends of the charted data.
 
     [bookmark: pgfId-1061935]Step 4 To set the time scale of the chart, at the bottom of the overview chart window, click the desired time scale button. The time scale buttons are as follows:
 
      
       
       	 [bookmark: pgfId-1061943]RT—Real time
 
       	 [bookmark: pgfId-1061979]1d—One day
 
       	 [bookmark: pgfId-1062029]2d—Two days
 
       	 [bookmark: pgfId-1062030]5d—Five days
 
       	 [bookmark: pgfId-1062031]15d—Fifteen days
 
       	 [bookmark: pgfId-1061991]1m—One month
 
       	 [bookmark: pgfId-1061992]3m—Three months
 
      
 
     
 
     [bookmark: pgfId-1062095]Step 5 To close the overview chart, click Show Overview Chart again.
 
     [bookmark: pgfId-1059398]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059468][bookmark: 49875]Exporting a Chart
 
     [bookmark: pgfId-1059469]You can export a chart as an JPG image or as a comma-separated value (CSV) file.
 
     [bookmark: pgfId-1066948]When you export a chart as a JPG image, the image is of the chart as it appears when you export the image.
 
     [bookmark: pgfId-1066958]When you export a chart as a CSV file, the file contains all data from the statistical collection for the chart.
 
    
 
     
      [bookmark: pgfId-1059482]DETAILED STEPS
 
     [bookmark: pgfId-1059475]To export an image of a chart, follow these steps:
 
     
 
     [bookmark: pgfId-1063321]Step 1 Access the chart that you want to use. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1063535]Step 2 If the chart is not active, you must start statistical monitoring for the chart before you can export an image of it. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1062135]Step 3 If you want to export an image, configure the chart to show the data that you want to appear in the image. For more information, see the “Using a Chart” section.
 
     [bookmark: pgfId-1062140]Step 4 Right-click on the chart.
 
     [bookmark: pgfId-1062142]Step 5 Choose one of the following:
 
      
       
       	 [bookmark: pgfId-1062183]Export as CSV
 
       	 [bookmark: pgfId-1062197]Export as JPG
 
      
 
     
 
     [bookmark: pgfId-1062178]Step 6 Specify the location and filename, and then click Save.
 
     [bookmark: pgfId-1062143]The Cisco DCNM client exports the chart in the file format that you specified.
 
     [bookmark: pgfId-1059407]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1096340][bookmark: 67866]Configuring Global [bookmark: marker-1096338]Preferences
 
    [bookmark: pgfId-1096341]Using the Global Preferences dialog box, you can configure several preferences for how the Cisco DCNM client displays data and fields. The four sections on the Global Preferences are as follows:
 
     
     	 [bookmark: pgfId-1096342]Monitoring—Controls the default frequency of statistical data retrieval from managed devices. For more information, see the “Configuring the Default Frequency of Statistical Data Retrieval” section.
 
     	 [bookmark: pgfId-1096346]Events—Controls the maximum age of events that the Cisco DCNM client fetches from the Cisco DCNM server when you start the Cisco DCNM client. For more information, see the “Configuring the Maximum Age of Events Fetched from the Server” section.
 
     	 [bookmark: pgfId-1096354]Pre Provision—Controls whether the Cisco DCNM client displays some settings only when other settings are made or whether the Cisco DCNM client always displays all settings. For more information, see the “Configuring Preprovisioning” section.
 
    
 
     
      [bookmark: pgfId-1096360][bookmark: 33821]Configuring the Default Frequency of Statistical Data Retrieval[bookmark: marker-1096359]
 
     [bookmark: pgfId-1096361]You can configure the default frequency for statistical data retrieval from monitored devices. The default frequency for statistical data retrieval is 30 seconds. This frequency determines the initial data retrieval frequency for a new chart. Users can override the default frequency by configuring the chart-specific setting.
 
    
 
     
      [bookmark: pgfId-1096362]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1096363]Determine how often you want Cisco DCNM to retrieve statistical data by default. Consider how important it is to your organization that charts update frequently. If very current charting data is important to your organization, consider using a short data retrieval frequency.
 
    
 
     
      [bookmark: pgfId-1096364]DETAILED STEPS
 
     [bookmark: pgfId-1096365]To configure the default frequency of statistical data retrieval, follow these steps:
 
     
 
     [bookmark: pgfId-1096366]Step 1 From the menu bar, choose Tools > Preferences.
 
     [bookmark: pgfId-1096367]The Global Preferences dialog box appears. Under Monitoring, the Default Monitoring Frequency drop-down list displays the current frequency for statistical data retrieval.
 
     [bookmark: pgfId-1096368]The default polling frequency is 30 seconds.
 
     [bookmark: pgfId-1096369]Step 2 From the Default Monitoring Frequency drop-down list, choose the new data retrieval frequency.
 
     [bookmark: pgfId-1096370]Step 3 Click Ok.
 
     [bookmark: pgfId-1096371]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1096391][bookmark: 76706]Configuring the Maximum Age of Events Fetched from the Server[bookmark: marker-1096390]
 
     [bookmark: pgfId-1096392]You can configure the maximum age of events that the Cisco DCNM client fetches from the Cisco DCNM server when you start the Cisco DCNM client. This setting affects how old the events are that the Cisco DCNM client displays in the Event Browser and on feature-specific Events tabs. By default, the Cisco DCNM client fetches events that occurred up to 1 hour prior to the Cisco DCNM client startup. You can configure the Cisco DCNM client to fetch events that are up to 24 hours old.
 
    
 
     
      [bookmark: pgfId-1096393]DETAILED STEPS
 
     [bookmark: pgfId-1096394]To configure the maximum age of events that the Cisco DCNM client fetches from the server, follow these steps:
 
     
 
     [bookmark: pgfId-1096395]Step 1 From the menu bar, choose Tools > Preferences.
 
     [bookmark: pgfId-1096396]The Global Preferences dialog box appears. Under Events, the Fetch events before drop-down list displays the current maximum age of events.
 
     [bookmark: pgfId-1096397]Step 2 From the Fetch events before drop-down list, choose the new maximum age of events.
 
      
       
     
 
     
 
     [bookmark: pgfId-1096398]Note To prevent the Cisco DCNM client from fetching any old events, choose zero (0) hours as the maximum age of events. When you choose zero hours, the Cisco DCNM client shows only the events that the Cisco DCNM server receives after you start the Cisco DCNM client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1096399]Step 3 Click Ok.
 
     [bookmark: pgfId-1096400]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1096449][bookmark: 59306]Configuring Preprovisioning[bookmark: marker-1096448]
 
     [bookmark: pgfId-1096450]Preprovisioning refers to configuring a managed device with settings for modes or protocols that are not enabled. The preprovisioning preference affects the following sections of the Cisco DCNM client interface:
 
      
      	 [bookmark: pgfId-1096451]Interfaces > Physical > Ethernet > Device > Slot > Interface, Port Details tab, Port Mode Settings section
 
     
 
     [bookmark: pgfId-1096452]When you enable preprovisioning, the Cisco DCNM client displays all port mode fields regardless of the setting in the Mode drop-down list. When you disable preprovisioning, the Cisco DCNM client displays only the port mode settings that are relevant to the currently selected port mode. For example, if preprovisioning is disabled and you choose Trunk from the Mode drop-down list, the Cisco DCNM client displays only the Trunk settings and hides the Access, PVLAN Host, and PVLAN Promiscuous fields.
 
     [bookmark: pgfId-1101274]Additionally, the dialog boxes for configuring the Access VLAN field and the Native VLAN field include the Create in the Device check box. When you enable preprovisioning, you can uncheck this check box if you want Cisco DCNM to configure the device to refer to a VLAN that is not currently configured. When you disable preprovisioning, this check box is always checked and Cisco DCNM creates the VLAN specified, if it does not already exist.
 
      
      	 [bookmark: pgfId-1096453]Switching > Spanning Tree > Device, Configuration tab, Global Settings section
 
     
 
     [bookmark: pgfId-1096454]When you enable preprovisioning, the Cisco DCNM client displays MST settings regardless of the settings in the Protocol drop-down list. When you disable preprovisioning, the Cisco DCNM client displays the MST Setting fields unless you choose MST from the Protocol drop-down list.
 
    
 
     
      [bookmark: pgfId-1096455]DETAILED STEPS
 
     [bookmark: pgfId-1096456]To configure preprovisioning, follow these steps:
 
     
 
     [bookmark: pgfId-1096457]Step 1 From the menu bar, choose Tools > Preferences.
 
     [bookmark: pgfId-1096458]The Global Preferences dialog box appears. Under Pre Provision, the Pre Provision check box appears.
 
     [bookmark: pgfId-1096459]Step 2 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1096460]If you want to enable preprovisioning, ensure that the  Pre Provisio n check box is checked.
 
       	 [bookmark: pgfId-1096461]If you want to disable preprovisioning, ensure that the  Pre Provision check box is unchecked.
 
      
 
     
 
     [bookmark: pgfId-1096462]Step 3 Click Ok.
 
     [bookmark: pgfId-1096463]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1143754][bookmark: 28776]Using Online Help
 
    [bookmark: pgfId-1143755]Online help has the following features:
 
     
     	 [bookmark: pgfId-1143756]Contents—The organization of Cisco DCNM online help is shown in the Contents tab of the online help window. When a topic has subtopics, the book icon appears to the left of the topic in the contents.
 
    
 
    [bookmark: pgfId-1143757]You can expand and collapse individual topics in the contents. You can also collapse or expand all topics.
 
     
     	 [bookmark: pgfId-1143758]Index—Cisco DCNM online help includes an index, which allows you to look up subjects alphabetically and open related topics directly from the index.
 
     	 [bookmark: pgfId-1143759]Favorites—Cisco DCNM online help allows you to add specific topics to the Favorites tab. Favorites are stored locally on the computer that you use to access online help.
 
    
 
    [bookmark: pgfId-1143760]To access the welcome page in online help, from the menu bar, choose Help > Help Contents.
 
    [bookmark: pgfId-1143761]Cisco DCNM online help includes context-sensitive help. 
 
    [bookmark: pgfId-1143762]To access context-sensitive help for a feature, follow these steps:
 
    
 
    [bookmark: pgfId-1143763]Step 1 Select a specific feature from the Feature Selector pane in the Cisco DCNM client. For example, choose Security > Access Control > IPv4 ACL.
 
    [bookmark: pgfId-1143764]Step 2 Do one of the following:
 
     
     	 [bookmark: pgfId-1143765]Press  F1 .
 
     	 [bookmark: pgfId-1143766]From the toolbar, click the question mark icon.
 
    
 
    [bookmark: pgfId-1143767]Online help for the selected feature appears in a browser window. Cisco DCNM uses the default browser application on the computer that runs the Cisco DCNM client.
 
    [bookmark: pgfId-1143768]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1143770][bookmark: 24180]Additional References
 
    [bookmark: pgfId-1143771]For additional information related to using the Cisco DCNM client, see the following sections:
 
     
     	 [bookmark: pgfId-1143775]Related Documents
 
     	 [bookmark: pgfId-1143779]Standards
 
    
 
     
      [bookmark: pgfId-1143781][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1143801]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1143784]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1143786]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1143788]Installing and launching the Cisco DCNM client
  
         	[bookmark: pgfId-1143793]Chapter 3, “Installing and Launching the Cisco DCNM Client”
  
        
 
         
         	[bookmark: pgfId-1143795]Information about using specific Cisco DCNM features
  
         	[bookmark: pgfId-1143800]Related Documentation, page xxiii
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1143803][bookmark: 55398]Standards
 
     [bookmark: pgfId-1143813]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1143806]Standards 
          
  
         	 
           
           [bookmark: pgfId-1143808]Title 
          
  
        
 
         
         	[bookmark: pgfId-1143810]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1143812]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1143815][bookmark: 92503]Feature History for Using the Cisco DCNM Client
 
    [bookmark: pgfId-1143819]Table 4-1 lists the release history for this feature.
 
    [bookmark: pgfId-1143849]
 
     
      
       
       [bookmark: pgfId-1143826]Table 4-1 [bookmark: 50557]Feature History for Installing and Launching the Cisco DCNM Client 
 
       
       
        
        	 
          
          [bookmark: pgfId-1143832]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1143834]Releases 
         
  
        	 
          
          [bookmark: pgfId-1143836]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1143838]Exporting the summary pane
  
        	[bookmark: pgfId-1143840]4.2(1)
  
        	[bookmark: pgfId-1143842]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1143844]Deploying changes
  
        	[bookmark: pgfId-1143846]4.2(1)
  
        	[bookmark: pgfId-1143848]Information was added about automatic deployment and manual deployment.
  
       
 
        
        	[bookmark: pgfId-1146236]Go menu
  
        	[bookmark: pgfId-1146238]4.1(2)
  
        	[bookmark: pgfId-1146240]The Go menu was updated to include following new features: 
 
          
          	 [bookmark: pgfId-1146277]Device OS Management 
 
          	 [bookmark: pgfId-1146282]Configuration Change Management 
 
         
  
       
 
        
        	[bookmark: pgfId-1146230]Action menu
  
        	[bookmark: pgfId-1146232]4.1(2)
  
        	[bookmark: pgfId-1146234]The Action menu replaced the feature-specific menus that appeared in Cisco DCNM, Release 4.0.
  
       
 
        
        	[bookmark: pgfId-1146224]Global Preferences
  
        	[bookmark: pgfId-1146226]4.1(2)
  
        	[bookmark: pgfId-1146228]The Administration section on the Global Preferences dialog box was removed. You can configure the polling frequency by using the Auto-Synchronization with Devices feature.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1116492]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1415805][bookmark: 86468]Administering [bookmark: marker-1415804]DCNM Authentication Settings 
      
      
 
     
 
 
    [bookmark: pgfId-1415795]This chapter describes how to administer Cisco Data Center Network Manager (DCNM) authentication settings.
 
    [bookmark: pgfId-1413493]This chapter includes the following topics:
 
     
     	 [bookmark: pgfId-1413497]Information About Administering DCNM Authentication Settings
 
     	 [bookmark: pgfId-1413501]Licensing Requirements for Administering DCNM Authentication Settings
 
     	 [bookmark: pgfId-1413505]Prerequisites for Administering DCNM Authentication Settings
 
     	 [bookmark: pgfId-1413509]Guidelines and Limitations for Administering DCNM Authentication Settings
 
     	 [bookmark: pgfId-1413513]Configuring DCNM Authentication Settings
 
     	 [bookmark: pgfId-1413517]Viewing Cisco DCNM Local Users
 
     	 [bookmark: pgfId-1413521]Field Descriptions for DCNM Authentication Settings
 
     	 [bookmark: pgfId-1413525]Additional References
 
     	 [bookmark: pgfId-1413529]Feature History for DCNM Authentication Settings
 
    
 
   
 
    
     [bookmark: pgfId-1413531][bookmark: 67389]Information About Administering DCNM Authentication Settings
 
    [bookmark: pgfId-1413532]Cisco DCNM authentication settings determine how a Cisco DCNM server authenticates users who attempt to access the server with the Cisco DCNM client. They also determine the user role for the user, which affects what the user can configure in the Cisco DCNM client.
 
    [bookmark: pgfId-1413533]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1413537]Users and User Roles
 
     	 [bookmark: pgfId-1413541]Local Authentication and Cisco DCNM Local Users
 
     	 [bookmark: pgfId-1413545]RADIUS and TACACS+ Authentication
 
     	 [bookmark: pgfId-1413549]User Role Assignment by RADIUS and TACACS+
 
     	 [bookmark: pgfId-1413553]Fallback to Local Authentication
 
     	 [bookmark: pgfId-1413557]Password Recovery
 
     	 [bookmark: pgfId-1413561]Users and Device Credentials
 
     	 [bookmark: pgfId-1413565]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1413567][bookmark: 39346]Users and User Roles
 
     [bookmark: pgfId-1413568]Cisco DCNM implements user-based access to allow you to control who can access a Cisco DCNM server by using the Cisco DCNM client. User access is secured by a password. Cisco DCNM supports strong passwords.
 
     [bookmark: pgfId-1413569]When you ensure that each person who accesses Cisco DCNM has a unique user account, user-based access allows you to determine what actions are taken by each user.
 
     [bookmark: pgfId-1413570]In addition, Cisco DCNM allows you to assign a role to each user. Roles determine what actions a user can take in the Cisco DCNM client. As described in Table 5-1, Cisco DCNM supports two user roles.[bookmark: marker-1413574]
 
     [bookmark: pgfId-1413597]
 
      
       
        
        [bookmark: pgfId-1413578]Table 5-1 [bookmark: 88426]Cisco DCNM User Roles
 
        
        
         
         	 
           
           [bookmark: pgfId-1413582]Cisco DCNM Role 
          
  
         	 
           
           [bookmark: pgfId-1413584]Description 
          
  
        
 
         
         	[bookmark: pgfId-1413586]User
  
         	 
           
           	 [bookmark: pgfId-1413588]Cannot change Cisco DCNM authentication mode
 
           	 [bookmark: pgfId-1413589]Cannot add or delete Cisco DCNM local user accounts
 
           	 [bookmark: pgfId-1413590]Can change the details of its own local user account
 
           	 [bookmark: pgfId-1413591]Can use all other features
 
          
  
        
 
         
         	[bookmark: pgfId-1413593]Administrator
  
         	 
           
           	 [bookmark: pgfId-1413595]Has full control of Cisco DCNM authentication settings
 
           	 [bookmark: pgfId-1413596]Can use all other features
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1413599][bookmark: 59365]Local Authentication and Cisco DCNM Local Users
 
     [bookmark: pgfId-1413600]The Cisco DCNM database contains any Cisco DCNM local users that you create.
 
      
       
     
 
     
 
     [bookmark: pgfId-1413601]Note Cisco DCNM server users are local to the Cisco DCNM server. Creating, changing, and removing Cisco DCNM server users has no effect on user accounts on managed devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1413602]A Cisco DCNM server uses local users to grant access in the following cases:
 
      
      	 [bookmark: pgfId-1413603]When the authentication mode is local
 
      	 [bookmark: pgfId-1413604]When no authentication server for the current authentication mode is reachable.
 
     
 
     [bookmark: pgfId-1413605]You can use local authentication as the primary authentication mode. If you specify RADIUS or TACACS+ as the primary authentication mode, the Cisco DCNM server always falls back to local authentication if no authentication server for the current authentication mode is reachable.
 
    
 
     
      [bookmark: pgfId-1413607][bookmark: 16546]RADIUS and TACACS+ Authentication
 
     [bookmark: pgfId-1413608]You can configure Cisco DCNM to authenticate users with either the RADIUS or TACACS+ AAA protocol.
 
     [bookmark: pgfId-1413609]Cisco DCNM supports primary, secondary, and tertiary authentication servers for RADIUS and TACACS+. Only a primary server is required. For each authentication server, you can specify the port number that the server listens to for authentication requests.
 
     [bookmark: pgfId-1413610]During authentication, if the primary server for the current authentication mode does not respond to the authentication request, the Cisco DCNM server sends the authentication request to the secondary server. If the secondary server does not respond, Cisco DCNM sends the authentication request to the tertiary server.
 
     [bookmark: pgfId-1413611]If none of the servers configured for the current authentication mode responds to an authentication request, the Cisco DCNM server falls back to local authentication.
 
    
 
     
      [bookmark: pgfId-1413613][bookmark: 68949]User Role Assignment by RADIUS and TACACS+
 
     [bookmark: pgfId-1413614]Cisco DCNM supports the assignment of a user role by the RADIUS or TACACS+ server that grants a user access to the Cisco DCNM client. The user role assigned to a user is in effect for the current session in the Cisco DCNM client only.
 
     [bookmark: pgfId-1413615]To assign a Cisco DCNM user role by RADIUS, configure the RADIUS server to return the RADIUS vendor-specific attribute 26/9/1, which is the Cisco-AV-Pair attribute. To assign a Cisco DCNM user role by TACACS+, the TACACS+ server must return a cisco-av-pair attribute-value pair. If an authentication response does not assign the user role, Cisco DCNM assigns the User role. Table 5-2 shows the supported attribute-value pair values for each Cisco DCNM user role.
 
     [bookmark: pgfId-1413648]
 
      
       
        
        [bookmark: pgfId-1413625]Table 5-2 [bookmark: 37552]Cisco DCNM User Role Assignment Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-1413631]Cisco DCNM Role 
          
  
         	 
           
           [bookmark: pgfId-1413633]RADIUS Cisco-AV-Pair Value 
          
  
         	 
           
           [bookmark: pgfId-1413635]TACACS+ Shell cisco-av-pair Value 
          
  
        
 
         
         	[bookmark: pgfId-1413637]User
  
         	 
           
           [bookmark: pgfId-1413639]shell:roles = "network-operator" 
          
  
         	 
           
           [bookmark: pgfId-1413641]cisco-av-pair=shell:roles="network-operator" 
          
  
        
 
         
         	[bookmark: pgfId-1413643]Administrator
  
         	 
           
           [bookmark: pgfId-1413645]shell:roles = "network-admin" 
          
  
         	 
           
           [bookmark: pgfId-1413647]cisco-av-pair=shell:roles="network-admin" 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1413650][bookmark: 70149]Fallback to Local Authentication
 
     [bookmark: pgfId-1413651]Local authentication always is the fallback method for RADIUS and TACACS+ authentication modes. If none of the servers configured for the current authentication mode is available, the Cisco DCNM server uses the local database to authenticate a login requests. This behavior is designed to help you prevent accidental lockout from Cisco DCNM.
 
     [bookmark: pgfId-1413652]For users who need fallback support, the usernames of their local user accounts must be identical to their usernames on the authentication servers. Also, we recommend that their passwords in the local user accounts should be identical to their passwords on the authentication servers. This provides transparent fallback support. Because the user cannot determine whether an authentication server or the local database is providing the authentication service, using usernames and passwords on authentication servers that are different than the usernames and passwords in the local database means that the user cannot be certain which username and password should be given.
 
    
 
     
      [bookmark: pgfId-1413654][bookmark: 45170]Password Recovery
 
     [bookmark: pgfId-1413655]If no one can log into the Cisco DCNM client as a user with a Cisco DCNM Administrator role, reinstall the Cisco DCNM server, which allows you to specify the username and password for a local user account that is assigned the Administrator role. For more information, see the “Reinstalling the Cisco DCNM Server” section.
 
    
 
     
      [bookmark: pgfId-1413660][bookmark: 69608]Users and Device Credentials
 
     [bookmark: pgfId-1413661]Each Cisco DCNM server user has unique device credentials, regardless of whether the user authenticates with a local user account or an account on a RADIUS or TACACS+ server. This allows you to maintain accounting logs on managed devices that reflect the actions of each Cisco DCNM server user. For more information, see the “Information About Devices and Credentials” section.
 
    
 
     
      [bookmark: pgfId-1413666][bookmark: 26517]Virtualization Support
 
     [bookmark: pgfId-1413667]Cisco NX-OS support for virtual device contexts has no effect on Cisco DCNM server users.
 
     [bookmark: pgfId-1413668]Cisco DCNM server users can configure any managed device.
 
    
 
   
 
    
     [bookmark: pgfId-1413670][bookmark: 62107]Licensing Requirements for Administering DCNM Authentication Settings
 
    [bookmark: pgfId-1413671]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1413684]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1413674]Product 
         
  
        	 
          
          [bookmark: pgfId-1413676]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1413678]Cisco DCNM
  
        	[bookmark: pgfId-1413680]Administering Cisco DCNM authentication settings requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1413686][bookmark: 54324]Prerequisites for Administering DCNM Authentication Settings
 
    [bookmark: pgfId-1413687]Administering Cisco DCNM server users has the following prerequisites:
 
     
     	 [bookmark: pgfId-1413688]To add, delete, or modify Cisco DCNM local users, you must be logged into the Cisco DCNM client with a user account that is assigned the Administrator Cisco DCNM role.
 
    
 
   
 
    
     [bookmark: pgfId-1413690][bookmark: 15741]Guidelines and Limitations for Administering DCNM Authentication Settings
 
    [bookmark: pgfId-1413691]Administering Cisco DCNM authentication settings has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1413692]Create a Cisco DCNM user account for each person who uses the Cisco DCNM client. Do not allow people to share a user account.
 
     	 [bookmark: pgfId-1413693]Delete unused Cisco DCNM user accounts.
 
     	 [bookmark: pgfId-1413694]Grant an administrator user account only to those who need to perform administrator tasks in the Cisco DCNM client.
 
     	 [bookmark: pgfId-1413695]We recommend that you use strong passwords. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
    
 
   
 
    
     [bookmark: pgfId-1413697][bookmark: 74505]Configuring DCNM Authentication Settings
 
    [bookmark: pgfId-1413701]Figure 5-1 shows the DCNM Authentication Settings content pane.
 
    [bookmark: pgfId-1413703]Figure 5-1 [bookmark: 47420]DCNM Authentication Settings Content Pane
 
    [bookmark: pgfId-1413707]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1413708]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1413712]Configuring the Authentication Mode
 
     	 [bookmark: pgfId-1413716]Adding a Cisco DCNM Local User
 
     	 [bookmark: pgfId-1413720]Changing the Password of a Cisco DCNM Local User
 
     	 [bookmark: pgfId-1413724]Changing the Full Name, Role, or Description of a Cisco DCNM Local User
 
     	 [bookmark: pgfId-1413728]Deleting a Cisco DCNM Server User
 
     	 [bookmark: pgfId-1413732]Adding Authentication Servers
 
     	 [bookmark: pgfId-1413736]Changing Authentication Server Settings
 
     	 [bookmark: pgfId-1413740]Removing an Authentication Server
 
    
 
     
      [bookmark: pgfId-1054250][bookmark: 14302]Configuring the Authentication Mode
 
     [bookmark: pgfId-1382735]You can configure the mode that the Cisco DCNM server uses to authenticate Cisco DCNM client users.
 
    
 
     
      [bookmark: pgfId-1382772]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1382993]Log into the Cisco DCNM client with a user account that has the Administrator user role.
 
     [bookmark: pgfId-1382796]If you want to enable RADIUS or TACACS+ authentication mode, you must configure at least one authentication server for the desired authentication mode.
 
    
 
     
      [bookmark: pgfId-1382803]DETAILED STEPS
 
     [bookmark: pgfId-1382846]To configure the authentication mode, follow these steps:
 
     
 
     [bookmark: pgfId-1382922]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1382930]Step 2 If necessary, expand the Authentication Mode section.
 
     [bookmark: pgfId-1382897]Step 3 Choose the authentication mode.
 
     [bookmark: pgfId-1382963]Step 4 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1399523]Step 5 Restart the Cisco DCNM server. For more information, see the “Stopping the Cisco DCNM Server” section and the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1399528]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1382703][bookmark: 18497]Adding a Cisco DCNM Local User[bookmark: marker-1173972]
 
     [bookmark: pgfId-1054252]You can add a Cisco DCNM local user account.
 
      
       
     
 
     
 
     [bookmark: pgfId-1075484]Note Adding a Cisco DCNM local user account does not affect the user account configuration on any Cisco NX-OS device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054253]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1054254]Log into the Cisco DCNM client with a user account that has the Administrator user role.
 
     [bookmark: pgfId-1221085]Determine the username and password for the new Cisco DCNM local user account.
 
      
       
     
 
     
 
     [bookmark: pgfId-1144188]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1076722]DETAILED STEPS
 
     [bookmark: pgfId-1076473]To add a Cisco DCNM local user, follow these steps:
 
     
 
     [bookmark: pgfId-1076267]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1076268]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381278]A table of users appears in the DCNM Local Users section.
 
     [bookmark: pgfId-1076269]Step 3 From the menu bar, choose Actions > Add User.
 
     [bookmark: pgfId-1076270]A new row appears at the bottom of the list of users. By default, all fields in the new row are blank.
 
     [bookmark: pgfId-1076691]Step 4 In the DCNM User Name column of the new row, enter the username. The username can be 1 to 198 characters. Entries can contain case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076692]Step 5 (Optional) In the Full Name column, double-click the entry and add a name. For example, enter the real name of the person who will use the Cisco DCNM local user account. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1154691]Step 6 In the DCNM Role column, double-click the entry and choose the role. By default, the role is User.
 
     [bookmark: pgfId-1154353]Step 7 In the Password column, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1154370]Step 8 In the New Password field and the Confirm Password field, enter the password. The password can be 1 to 255 characters. Entries can contain case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076551]Step 9 Click OK.
 
     [bookmark: pgfId-1076593]Step 10 (Optional) In the Description column, double-click the entry and add a description of the user account. For example, you could use this entry to provide e-mail and telephone contact details of the person who will be using this Cisco DCNM server user account. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076274]Step 11 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1076275]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059019][bookmark: 99017]Changing the Password of a Cisco DCNM Local User[bookmark: marker-1173973]
 
     [bookmark: pgfId-1221327]You can change the password of a Cisco DCNM local user.
 
    
 
     
      [bookmark: pgfId-1221329]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1221094]An Administrator role is required if you want to change the password of a local user account other than the account that you use to log into the Cisco DCNM client. If your user account is a local user account and it has the User role, you can change the password of your account only.
 
     [bookmark: pgfId-1059022]Determine what the new password should be.
 
      
       
     
 
     
 
     [bookmark: pgfId-1144205]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059023]DETAILED STEPS
 
     [bookmark: pgfId-1059024]To change the password of a Cisco DCNM local user, follow these steps:
 
     
 
     [bookmark: pgfId-1076846]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Authentication Settings. 
 
     [bookmark: pgfId-1381314]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381315]A table of users appears in the DCNM Local Users section.
 
     [bookmark: pgfId-1076922]Step 3 In the User Name column, click the username for the user account that you want to change.
 
     [bookmark: pgfId-1076923]The row of the username that you clicked is highlighted.
 
     [bookmark: pgfId-1076852]Step 4 In the Password column, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1154424]Step 5 In the New Password field and the Confirm Password field, enter the new password. The password can be 1 to 255 characters. Entries can contain case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076855]Step 6 Click OK.
 
     [bookmark: pgfId-1076857]Step 7 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1076858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1076937][bookmark: 18511]Changing the Full Name, Role, or Description of a Cisco DCNM Local User
 
     [bookmark: pgfId-1076938]You can change the full name, role, or description of a Cisco DCNM local user.
 
      
       
     
 
     
 
     [bookmark: pgfId-1076939]Note You cannot change the username. Instead, add a local user account with the desired username and remove the local user account with the unwanted username.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1076940]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1076941]Determine what the new full name or description should be.
 
     [bookmark: pgfId-1221386]An Administrator role is required if you want to change the full name, role, or description of a local user account other than the local user account that you use to log into the Cisco DCNM client. If your user account is a local user account and it has the User role, you can change the full name and description for your account only.
 
    
 
     
      [bookmark: pgfId-1076942]DETAILED STEPS
 
     [bookmark: pgfId-1076943]To change the full name or description of a Cisco DCNM local user, follow these steps:
 
     
 
     [bookmark: pgfId-1076945]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1381372]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381373]A table of users appears in the DCNM Local Users section.
 
     [bookmark: pgfId-1077385]Step 3 In the User Name column, click the username of the local user account that you want to change.
 
     [bookmark: pgfId-1077386]The row of the username that you clicked is highlighted.
 
     [bookmark: pgfId-1076949]Step 4 (Optional) In the Full Name column, double-click the entry and enter the new name. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076954]Step 5 (Optional) In the DCNM Role column, double-click the entry and choose the new role. You can choose Administrator or User.
 
     [bookmark: pgfId-1154669]Step 6 (Optional) In the Description column, double-click the entry and enter the new description of the user account. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076955]Step 7 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1076956]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059095][bookmark: 21840]Deleting a Cisco DCNM Server User[bookmark: marker-1173974]
 
     [bookmark: pgfId-1059096]You can remove a Cisco DCNM local user account.
 
    
 
     
      [bookmark: pgfId-1059097]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1381507]Log into the Cisco DCNM client with a user account that has the Administrator user role.
 
     [bookmark: pgfId-1381469]Ensure that you are removing the correct Cisco DCNM local user account.
 
    
 
     
      [bookmark: pgfId-1381471]DETAILED STEPS
 
     [bookmark: pgfId-1077315]To delete a Cisco DCNM local user account, follow these steps:
 
     
 
     [bookmark: pgfId-1381529]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1381544]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381545]A table of users appears in the DCNM Local Users section.
 
     [bookmark: pgfId-1381531]Step 3 In the User Name column, click the username of the user account that you want to remove.
 
     [bookmark: pgfId-1381532]The row of the username that you clicked is highlighted.
 
     [bookmark: pgfId-1077523]Step 4 From the menu bar, choose Actions > Delete User.
 
     [bookmark: pgfId-1077347]Step 5 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1077324]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1378958][bookmark: 32778]Adding Authentication Servers
 
     [bookmark: pgfId-1383016]You can add RADIUS and TACACS+ servers to the Cisco DCNM authentication settings.
 
    
 
     
      [bookmark: pgfId-1383027]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1383031]Ensure that you have the following information about each authentication server that you want to add:
 
      
      	 [bookmark: pgfId-1383050]AAA protocol: RADIUS or TACACS+
 
      	 [bookmark: pgfId-1383056]Server IPv4 address or DNS name that can be resolved by the Cisco DCNM server.
 
      	 [bookmark: pgfId-1383057]Secret key.
 
      	 [bookmark: pgfId-1383058]Port number on which the server accepts authentication requests.
 
      	 [bookmark: pgfId-1383067](RADIUS only) Port number on which the server accepts accounting messages.
 
      	 [bookmark: pgfId-1383073]Authentication protocol: PAP, CHAP, MSCHAP, or ASCII.
 
      	 [bookmark: pgfId-1383582](Optional) Username and password of a valid user account on the server for server verification.
 
     
 
     [bookmark: pgfId-1383254]Determine whether the server should be a primary, secondary, or tertiary server, which depends upon your authentication server failover strategy.
 
    
 
     
      [bookmark: pgfId-1383034]DETAILED STEPS
 
     [bookmark: pgfId-1383038]To add authentication servers, follow these steps:
 
     
 
     [bookmark: pgfId-1383083]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1383084]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1393155]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1393156]Step 3 If necessary, expand the RADIUS or TACACS+ server rows.
 
     [bookmark: pgfId-1393157]Step 4 For each authentication server that you want to add, follow these steps:
 
     [bookmark: pgfId-1383205] a. Choose the row in which you want to add the server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383439]Note The Cisco DCNM client does not allow you to add a secondary server if you have not added a primary server. In addition, you cannot add a tertiary server if you have not added a secondary server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383448] b. Double-click the Server Name field and enter the server IPv4 address or DNS host name.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383482]Note If you enter a host name that the Cisco DCNM server cannot resolve, the Server Name field is highlighted in red.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383487] c. Double-click the Secret Key field and enter the secret key (sometimes called a shared secret) of the authentication server.
 
     [bookmark: pgfId-1383505] d. (Optional) If you need to change the default Authentication Port or Accounting Port (RADIUS only), double-click the applicable port field and enter the new port number.
 
     [bookmark: pgfId-1403411] e. Double-click the Authentication Method field and choose the authentication protocol that Cisco DCNM must use when sending authentication requests to the authentication server.
 
     [bookmark: pgfId-1403412]Step 5 (Optional) If you want to verify that the Cisco DCNM server can authenticate a user with a new authentication server, follow these steps:
 
     [bookmark: pgfId-1383540] a. To the right of the row for the authentication server that you want to verify, click Verify.
 
     [bookmark: pgfId-1383567]A Verification dialog box appears.
 
     [bookmark: pgfId-1383572] b. Enter a username and password for a valid user account on the authentication server.
 
     [bookmark: pgfId-1383592] c. Click Verify.
 
     [bookmark: pgfId-1393187]The Cisco DCNM client displays a message indicating whether the verification attempt succeeded or failed. Verification failure may mean that the authentication server is unavailable or that the authentication settings are incorrect.
 
     [bookmark: pgfId-1383537]Step 6 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1383046]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383604][bookmark: 53507]Changing Authentication Server Settings
 
     [bookmark: pgfId-1383614]You can change the settings for authentication servers that you have already configured in the Cisco DCNM client. If you have more than one RADIUS or TACACS+ server, you can change which server is primary, secondary, or tertiary.
 
    
 
     
      [bookmark: pgfId-1383619]DETAILED STEPS
 
     [bookmark: pgfId-1383620]To change authentication server settings, follow these steps:
 
     
 
     [bookmark: pgfId-1383660]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1383661]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1383662]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1403395]Step 3 If necessary, expand the RADIUS or TACACS+ server rows.
 
     [bookmark: pgfId-1403396]Step 4 (Optional) If you want to change the settings of an authentication server, double-click each field that you need to change and enter the changes.
 
     [bookmark: pgfId-1383737]Step 5 (Optional) If you want to reorder RADIUS or TACACS+ servers, right-click a server and choose Move Up or Move Down, as needed.
 
     [bookmark: pgfId-1383672]Step 6 (Optional) If you want to verify that the Cisco DCNM server can authenticate a user with an authentication server, follow these steps:
 
     [bookmark: pgfId-1383673] a. To the right of the row for the authentication server that you want to verify, click Verify.
 
     [bookmark: pgfId-1383674]A Verification dialog box appears.
 
     [bookmark: pgfId-1383675] b. Enter a username and password for a valid user account on the authentication server.
 
     [bookmark: pgfId-1383676] c. Click Verify.
 
     [bookmark: pgfId-1393407]The Cisco DCNM client displays a message indicating whether the verification attempt succeeded or failed. Verification failure may mean that the authentication server is unavailable or that the authentication settings are incorrect.
 
     [bookmark: pgfId-1383678]Step 7 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1383637]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383805][bookmark: 22993]Removing an Authentication Server
 
     [bookmark: pgfId-1383806]You can remove a RADIUS or TACACS+ authentication server from the Cisco DCNM authentication settings.
 
    
 
     
      [bookmark: pgfId-1383927]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1383897]You cannot remove all authentication servers for the current authentication mode. Instead, change the authentication mode first and then remove all the authentication servers.
 
    
 
     
      [bookmark: pgfId-1383807]DETAILED STEPS
 
     [bookmark: pgfId-1383808]To remove an authentication server, follow these steps:
 
     
 
     [bookmark: pgfId-1383809]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1383810]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1383811]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1383812]Step 3 If necessary, expand the RADIUS or TACACS+ server rows.
 
     [bookmark: pgfId-1383814]Step 4 Right-click the authentication server that you want to remove and choose Remove Server.
 
     [bookmark: pgfId-1383821]Step 5 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1383822]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1383127][bookmark: 70905]Viewing Cisco DCNM Local Users
 
    [bookmark: pgfId-1383128]To view Cisco DCNM server user accounts, from the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings and then, if necessary, expand the DCNM Local Users section.
 
    [bookmark: pgfId-1383129]Cisco DCNM server user accounts, including usernames and descriptions, appear in the Contents pane. Passwords appear masked for security. For information about the fields that appear, see the “Field Descriptions for DCNM Authentication Settings” section.
 
   
 
    
     [bookmark: pgfId-1384845][bookmark: 42441]Verifying Authentication Server Settings
 
    [bookmark: pgfId-1384041]You can verify that the Cisco DCNM server can authenticate a user with a particular authentication server that you have configured.
 
     
      [bookmark: pgfId-1384042]DETAILED STEPS
 
     [bookmark: pgfId-1384043]To verify settings for an authentication server, follow these steps:
 
     
 
     [bookmark: pgfId-1384044]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings.
 
     [bookmark: pgfId-1384045]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1384046]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1384051]Step 3 Click Verify.
 
     [bookmark: pgfId-1384052]A Verification dialog box appears.
 
     [bookmark: pgfId-1384053]Step 4 Enter a username and password for a valid user account on the authentication server.
 
     [bookmark: pgfId-1384054]Step 5 To the right of the row for the authentication server that you want to verify, click Verify.
 
     [bookmark: pgfId-1393419]The Cisco DCNM client displays a message indicating whether the verification attempt succeeded or failed. Verification failure may mean that the authentication server is unavailable or that the authentication settings are incorrect.
 
     [bookmark: pgfId-1384057]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1414050][bookmark: 35236]Field Descriptions for DCNM Authentication Settings
 
    [bookmark: pgfId-1414051]This section includes the following field descriptions for the DCNM Authentication Settings feature:
 
     
     	 [bookmark: pgfId-1414055]Authentication Mode Section
 
     	 [bookmark: pgfId-1414059]DCNM Local Users Section
 
     	 [bookmark: pgfId-1414063]Authentication Servers Section
 
    
 
     
      [bookmark: pgfId-1414065][bookmark: 80668]Authentication Mode Section
 
     [bookmark: pgfId-1414090]
 
      
       
        
        [bookmark: pgfId-1414071]Table 5-3 Authentication Mode Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1414075]Field 
          
  
         	 
           
           [bookmark: pgfId-1414077]Description 
          
  
        
 
         
         	[bookmark: pgfId-1414079]Local
  
         	[bookmark: pgfId-1414081]Whether Cisco DCNM authenticates users with the local user database only.
  
        
 
         
         	[bookmark: pgfId-1414083]RADIUS
  
         	[bookmark: pgfId-1414085]Whether Cisco DCNM authenticates users with a RADIUS server. When no configured RADIUS server is reachable, Cisco DCNM falls back to using the local database for user authentication.
  
        
 
         
         	[bookmark: pgfId-1414087]TACACS+
  
         	[bookmark: pgfId-1414089]Whether Cisco DCNM authenticates users with a TACACS+ server. When no configured TACACS+ server is reachable, Cisco DCNM falls back to using the local database for user authentication.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1414092][bookmark: 48947]DCNM Local Users Section
 
     [bookmark: pgfId-1414128]
 
      
       
        
        [bookmark: pgfId-1414098]Table 5-4 DCNM Local Users Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1414102]Field 
          
  
         	 
           
           [bookmark: pgfId-1414104]Description 
          
  
        
 
         
         	[bookmark: pgfId-1414106]DCNM User Name
  
         	[bookmark: pgfId-1414108]Display only. Name of the Cisco DCNM server user account. This name can be used to log into the Cisco DCNM client when the authentication mode is local or when no authentication server for the current authentication mode is reachable. Entries are case sensitive. Valid characters are all letters, numbers, and symbols. The minimum length is 1 character. The maximum length is 198 characters.
  
        
 
         
         	[bookmark: pgfId-1414110]Full Name
  
         	[bookmark: pgfId-1414112]Other name for the user account, such as the name of the person who uses the Cisco DCNM server user account. This name cannot be used to log into the Cisco DCNM client. Valid characters are all letters, numbers, and symbols. The maximum length is 255 characters. This field is blank by default.
  
        
 
         
         	[bookmark: pgfId-1414114]DCNM Role
  
         	[bookmark: pgfId-1414116]Role of the user account. Valid values are User and Administrator. For more information, see Table 5-1. By default, a Cisco DCNM server user account is assigned the role of User.
  
        
 
         
         	[bookmark: pgfId-1414121]Password
  
         	[bookmark: pgfId-1414123]Password for the Cisco DCNM server user. This field is always masked for security. Entries are case sensitive. Valid characters are all letters, numbers, and symbols. The minimum length is 1 character. The maximum length is 255 characters.
  
        
 
         
         	[bookmark: pgfId-1414125]Description
  
         	[bookmark: pgfId-1414127]Description of the Cisco DCNM server user. Valid characters are all letters, numbers, and symbols. The maximum length is 255 characters. This field is blank by default.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1414130][bookmark: 11878]Authentication Servers Section
 
     [bookmark: pgfId-1414169]
 
      
       
        
        [bookmark: pgfId-1414136]Table 5-5 Authentication Servers Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1414140]Field 
          
  
         	 
           
           [bookmark: pgfId-1414142]Description 
          
  
        
 
         
         	[bookmark: pgfId-1414144]Server Name
  
         	[bookmark: pgfId-1414146]DNS name or IPv4 address of the authentication server. 
 
           
           	 [bookmark: pgfId-1414147]DNS name—If you specify a DNS name, the Cisco DCNM server must be able to resolve the IP address of the server. Valid DNS names characters are alphanumeric.
 
           	 [bookmark: pgfId-1414148]IPv4 address—If you specify an IP address, valid entries are in dotted decimal format.
 
          
  
        
 
         
         	[bookmark: pgfId-1414150]Secret Key
  
         	[bookmark: pgfId-1414152]Shared secret of the authentication server. Valid entries are case-sensitive letters, numbers, and symbols.
  
        
 
         
         	[bookmark: pgfId-1414154]Authentication Port
  
         	[bookmark: pgfId-1414156]TCP or UDP port number that the authentication server listens to for authentication requests. By default, the authentication port for a RADIUS server is UDP port 1812 and the authentication port for a TACACS+ server is TCP port 49.
  
        
 
         
         	[bookmark: pgfId-1414158]Accounting Port
  
         	[bookmark: pgfId-1414160]UDP port number that the RADIUS authentication server listens to for authentication requests. By default, the accounting port for a RADIUS server is UDP port 1813.
  
        
 
         
         	[bookmark: pgfId-1414162]Authentication Method
  
         	[bookmark: pgfId-1414164]Authentication protocol that the Cisco DCNM server uses in authentication requests to the authentication server. Supported authentication methods are as follows:
 
           
           	 [bookmark: pgfId-1414165]PAP
 
           	 [bookmark: pgfId-1414166]CHAP
 
           	 [bookmark: pgfId-1414167]MSCHAP
 
           	 [bookmark: pgfId-1414168]ASCII
 
          
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1414171][bookmark: 67961]Additional References
 
    [bookmark: pgfId-1414172]For additional information related to administering Cisco DCNM authentication settings, see the following sections:
 
     
     	 [bookmark: pgfId-1414176]Related Documents
 
     	 [bookmark: pgfId-1414180]Standards
 
    
 
     
      [bookmark: pgfId-1414182][bookmark: 23175]Related Documents
 
     [bookmark: pgfId-1414195]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1414185]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1414187]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1414189]Logging into the Cisco DCNM client
  
         	[bookmark: pgfId-1414194]Opening the Cisco DCNM Client
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1414197][bookmark: 97189]Standards
 
     [bookmark: pgfId-1414207]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1414200]Standards 
          
  
         	 
           
           [bookmark: pgfId-1414202]Title 
          
  
        
 
         
         	[bookmark: pgfId-1414204]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1414206]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1414209][bookmark: 92503]Feature History for DCNM Authentication Settings
 
    [bookmark: pgfId-1414213]Table 5-6 lists the release history for this feature.
 
    [bookmark: pgfId-1414240]
 
     
      
       
       [bookmark: pgfId-1414217]Table 5-6 [bookmark: 50557]Feature History for DCNM Authentication Settings
 
       
       
        
        	 
          
          [bookmark: pgfId-1414223]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1414225]Releases 
         
  
        	 
          
          [bookmark: pgfId-1414227]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1414229]RADIUS and TACACS+ server support
  
        	[bookmark: pgfId-1414231]4.2(1)
  
        	[bookmark: pgfId-1414233]This feature was added, including fallback authentication with Cisco DCNM local users when no authentication server for the current authentication mode is reachable.
  
       
 
        
        	[bookmark: pgfId-1414235]Cisco DCNM local users
  
        	[bookmark: pgfId-1414237]4.2(1)
  
        	[bookmark: pgfId-1414239]This feature was preexisting.
  
       
 
        
        	[bookmark: pgfId-1417550]DCNM Server Users
  
        	[bookmark: pgfId-1417552]4.1(2)
  
        	[bookmark: pgfId-1417554]No change from Release 4.0
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1378522][bookmark: 32110]Administering [bookmark: marker-1378520]Device Discovery 
      
      
 
     
 
 
    [bookmark: pgfId-1387691]This chapter describes how to administer the Device Discovery feature in the Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1387692]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1387696]Information About Device Discovery
 
     	 [bookmark: pgfId-1387700]Licensing Requirements for Device Discovery
 
     	 [bookmark: pgfId-1387704]Prerequisites for Device Discovery
 
     	 [bookmark: pgfId-1387708]Guidelines and Limitations for Device Discovery
 
     	 [bookmark: pgfId-1387712]Performing Device Discovery
 
     	 [bookmark: pgfId-1387716]Viewing the Status of Device Discovery Tasks
 
     	 [bookmark: pgfId-1387720]Where to Go Next
 
     	 [bookmark: pgfId-1387724]Field Descriptions for Device Discovery
 
     	 [bookmark: pgfId-1387728]Additional References for Device Discovery
 
     	 [bookmark: pgfId-1387732]Feature History for Device Discovery
 
    
 
   
 
    
     [bookmark: pgfId-1387734][bookmark: 75135]Information About Device Discovery
 
    [bookmark: pgfId-1387735]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1387739]Device Discovery
 
     	 [bookmark: pgfId-1387743]Cisco Discovery Protocol
 
     	 [bookmark: pgfId-1387747]Credentials and Discovery
 
     	 [bookmark: pgfId-1387751]Cisco NX-OS Device Preparation
 
     	 [bookmark: pgfId-1387755]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1387757][bookmark: 38393]Device Discovery
 
     [bookmark: pgfId-1387758]The Device Discovery feature creates devices in Cisco DCNM by connecting to a Cisco NX-OS device and retrieving the running configuration of the device. Cisco DCNM can also discover Cisco NX-OS devices that are neighbors of the first device, which is known as the seed device.
 
     [bookmark: pgfId-1387759]If the device supports virtual device contexts (VDCs), Cisco DCNM retrieves the running configuration of each virtual device context (VDC) that is configured on the physical device. Cisco DCNM displays each VDC as a device, including the default VDC. If the Cisco NX-OS device has only the default VDC, then device discovery creates only one device in Cisco DCNM.
 
     [bookmark: pgfId-1387760]When Cisco DCNM connects to a device to retrieve its configuration, it uses the XML management interface, which uses the XML-based Network Configuration Protocol (NETCONF) over Secure Shell (SSH). For more information, see the Cisco NX-OS XML Management Interface User Guide, Release 4.x.
 
    
 
     
      [bookmark: pgfId-1387766][bookmark: 71708]Cisco Discovery Protocol
 
     [bookmark: pgfId-1387767]Device discovery uses the Cisco Discovery Protocol (CDP) to find devices that are connected to the initial device in the discovery process. CDP exchanges information between adjacent devices over the data link layer. The exchanged information is helpful in determining the network topology and physical configuration outside of the logical or IP layer.
 
     [bookmark: pgfId-1387768]CDP allows Cisco DCNM to discover devices that are one or more hops beyond the first device (seed device) in the discovery process. When you start the discovery process using the Device Discovery feature, you can limit the number of hops that the discovery process can make.
 
     [bookmark: pgfId-1387769]After Cisco DCNM discovers a Cisco NX-OS device using CDP, it connects to the device and retrieves information, such as the running configuration of the device. The information collected allows Cisco DCNM to manage the device.
 
     [bookmark: pgfId-1387770]Cisco DCNM supports CDP hops on some Cisco switches that run Cisco IOS software. Although Cisco DCNM cannot manage these devices, the Topology feature allows you to see unmanaged devices and the CDP links between unmanaged devices and managed devices.
 
    
 
     
      [bookmark: pgfId-1387772][bookmark: 37122]Credentials and Discovery
 
     [bookmark: pgfId-1387773]Device discovery requires that you provide a username and password for a user account on the seed device. To successfully complete the discovery of a Cisco NX-OS device, the user account that you specify must be assigned to either the network-admin or the vdc-admin role.
 
     [bookmark: pgfId-1387774]If you want to discover devices that are one or more hops from the seed device, all devices in the chain of hops must be configured with a user account of the same username and password. All Cisco NX-OS devices in the chain of hops must assign the user account to the network-admin or the vdc-admin role.
 
    
 
     
      [bookmark: pgfId-1387776][bookmark: 56491]Cisco NX-OS Device Preparation
 
     [bookmark: pgfId-1387777]Before you perform device discovery, you should ensure that the Cisco NX-OS device configuration can support a successful discovery. For more information, see the “Cisco NX-OS Device Configuration Requirements” section.
 
    
 
     
      [bookmark: pgfId-1387782][bookmark: 55359]Virtualization Support
 
     [bookmark: pgfId-1387783]When Cisco DCNM discovers a Cisco NX-OS device that supports VDCs, it determines how many VDC are on the Cisco NX-OS device. In Cisco DCNM, each VDC is treated as a separate device. The status of each VDC is tracked separately and you can configure each VDC independently of other VDCs on a Cisco NX-OS device.
 
     [bookmark: pgfId-1390004]Before discovering a Cisco Nexus 7000 Series device that has non-default VDCs, ensure that each VDC meets the prerequisites for discovery. For more information, see the “Prerequisites for Device Discovery” section.
 
    
 
   
 
    
     [bookmark: pgfId-1387785][bookmark: 45990]Licensing Requirements for Device Discovery
 
    [bookmark: pgfId-1387786]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1387799]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1387789]Product 
         
  
        	 
          
          [bookmark: pgfId-1387791]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1387793]Cisco DCNM
  
        	[bookmark: pgfId-1387795]Device Discovery requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1387801][bookmark: 47313]Prerequisites for Device Discovery
 
    [bookmark: pgfId-1387802]Prior to performing device discovery, you should be familiar with the following:
 
     
     	 [bookmark: pgfId-1387803]VDCs
 
     	 [bookmark: pgfId-1387804]CDP
 
    
 
    [bookmark: pgfId-1387805]Device Discovery has the following prerequisites:
 
     
     	 [bookmark: pgfId-1387806]The Cisco DCNM server must be able to reach to devices that it discovers.
 
     	 [bookmark: pgfId-1387807]Cisco NX-OS devices must be running a supported release of Cisco NX-OS. For information about supported releases of Cisco NX-OS, see the  Cisco DCNM Release Notes, Release 4.x .
 
     	 [bookmark: pgfId-1387812]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Cisco NX-OS Device Preparation” section.
 
     	 [bookmark: pgfId-1390068]For a Cisco Nexus 7000 Series device, each VDC that you want to discover must have a management interface configured. Cisco DCNM supports discovery of VDCs that are configured with a management interface that is the mgmt0 interface, which is an out-of-band virtual interface, or with an in-band Ethernet interface that is allocated to the VDC.
 
     	 [bookmark: pgfId-1390069]To allow Cisco DCNM to discover devices that are CDP neighbors, CDP must be enabled both globally on each device and specifically on the device interfaces used for device discovery. For a Cisco Nexus 7000 Series device, CDP must be enabled globally in each VDC and on the management interface that each VDC is configured to use.
 
    
 
   
 
    
     [bookmark: pgfId-1387817][bookmark: 40902]Guidelines and Limitations for Device Discovery
 
    [bookmark: pgfId-1387818]The Device Discovery feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1387819]Ensure that Cisco NX-OS devices that you want to discover have been prepared for discovery. For more information, see the “Cisco NX-OS Device Configuration Requirements” section.
 
     	 [bookmark: pgfId-1387823]Cisco DCNM can manage only devices that run Cisco NX-OS. For more information about supported device operating systems and supported device hardware, see the  Cisco DCNM Release Notes, Release 4.x .
 
     	 [bookmark: pgfId-1387827]CDP-based discovery of devices requires that all devices in the chain of CDP hops use the same username and password specified for the seed device. If your security practices do not allow the same username and password to be used on each device, you can perform device discovery for each device individually.
 
     	 [bookmark: pgfId-1387828]Devices that are CDP hops but which are not running Cisco IOS software appear in the Topology feature but cannot be managed by Cisco DCNM.
 
    
 
   
 
    
     [bookmark: pgfId-1387830][bookmark: 81498]Performing Device Discovery
 
    [bookmark: pgfId-1387834]Figure 6-1 shows the Device Discovery content pane.
 
    [bookmark: pgfId-1387836]Figure 6-1 [bookmark: 60141]Device Discovery Content Pane
 
    [bookmark: pgfId-1387840]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1387841]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1387845]Discovering Devices
 
     	 [bookmark: pgfId-1387849]Rediscovering Devices
 
    
 
     
      [bookmark: pgfId-1053795][bookmark: 24305][bookmark: 71793]Discovering Devices[bookmark: marker-1173942]
 
     [bookmark: pgfId-1063473]You can discover one or more devices. When a discovery task succeeds, Cisco DCNM retrieves the running configuration and status information of discovered Cisco NX-OS devices.
 
     [bookmark: pgfId-1233880]Use this procedure for the following purposes:
 
      
      	 [bookmark: pgfId-1234361]To discover devices that are not currently managed by Cisco DCNM. For example, you should use this procedure when Cisco DCNM has not yet discovered any devices, such as after a new installation.
 
      	 [bookmark: pgfId-1233952]To discover devices that you have added to your network without rediscovering devices that Cisco DCNM already has discovered.
 
      	 [bookmark: pgfId-1234329]To rediscover the topology when CDP links have changed, without rediscovering devices that Cisco DCNM has already discovered.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1063475]Note You must successfully discover a Cisco NX-OS device before you can use Cisco DCNM to configure the device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1053360]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1075035]Ensure that you have configured the Cisco NX-OS device so that the Cisco DCNM server can connect to it. For more information, see the “Cisco NX-OS Device Configuration Requirements” section.
 
     [bookmark: pgfId-1130713]Determine the IPv4 address of the device that you want Cisco DCNM to connect to when it starts the discovery task. This is the seed device for the discovery.
 
     [bookmark: pgfId-1130736]Determine whether you want to discover devices that are CDP neighbors of the seed device. If so, determine the maximum number of hops from the seed device that the discovery process can make.
 
      
       
     
 
     
 
     [bookmark: pgfId-1130763]Note The discovery process can perform complete discovery of neighbors only if the neighboring devices are configured with the same credentials as the seed device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1075036]DETAILED STEPS
 
     [bookmark: pgfId-1053363]To discover one or more Cisco NX-OS devices, follow these steps:
 
     
 
     [bookmark: pgfId-1075045]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Device Discovery. 
 
     [bookmark: pgfId-1075046]The discovery tasks appear in the Discovery Tasks area of the Contents pane.
 
     [bookmark: pgfId-1075047]Step 2 In the Seed Device field, enter the IPv4 address of the device that you want Cisco DCNM to connect to when it starts the discovery task. Valid entries are in dotted decimal format.
 
     [bookmark: pgfId-1075100]Step 3 In the User Name field, enter the username of a user account on the device. The user account must have a network-admin or vdc-admin role.
 
     [bookmark: pgfId-1075189]Step 4 In the Password field, enter the password for the user account that you entered in the User Name field.
 
     [bookmark: pgfId-1173368]Step 5 (Optional) If you want Cisco DCNM to discover devices that are CDP neighbors of the seed device, in the Maximum Hops of Neighbors to Discover field, enter the desired maximum number of hops. By default, the maximum hops is 0 (zero).
 
     [bookmark: pgfId-1233969]Step 6 Ensure that Rediscover Configuration and Status for Existing Devices is unchecked. By default, this check box is unchecked.
 
     [bookmark: pgfId-1234191]By leaving this check box unchecked, you enable Cisco DCNM to use previously discovered devices as CDP hops without retrieving their running configuration and status information.
 
     [bookmark: pgfId-1075315]Step 7 Click Start Discovery.
 
     [bookmark: pgfId-1075049]After a short delay, the discovery task appears at the bottom of the list of tasks in the Discovery Tasks area. Cisco DCNM updates the task status periodically.
 
     [bookmark: pgfId-1075236]Step 8 Wait until the status for the task is Successful. This step may take several minutes.
 
     [bookmark: pgfId-1075050]After the status is Successful, you can use Cisco DCNM to configure and monitor the discovered devices.
 
     [bookmark: pgfId-1076061]You do not need to save your changes.
 
     [bookmark: pgfId-1075051]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1063160][bookmark: 15491]Rediscovering Devices[bookmark: marker-1173943]
 
     [bookmark: pgfId-1063161]You can rediscover one or more devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-1063444]Note Rediscovery replaces any configuration data that Cisco DCNM has for a Cisco NX-OS device with the configuration data retrieved during the rediscovery. If you need to discover one or more devices without retrieving configuration and status information for already discovered devices, see the “Discovering Devices” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1063445]You must successfully discover a Cisco NX-OS device before you can use Cisco DCNM to configure the device.
 
    
 
     
      [bookmark: pgfId-1063162]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1195074]Ensure that you have configured the Cisco NX-OS device so that the Cisco DCNM server can connect to it. For more information, see the “Cisco NX-OS Device Preparation” section.
 
    
 
     
      [bookmark: pgfId-1131946]DETAILED STEPS
 
     [bookmark: pgfId-1131947]To rediscover one or more Cisco NX-OS devices, follow these steps:
 
     
 
     [bookmark: pgfId-1075341]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Device Discovery. 
 
     [bookmark: pgfId-1075342]The discovery tasks and their status appear in the Discovery Tasks area of the Contents pane.
 
     [bookmark: pgfId-1150124]Step 2 In the Seed Device field, enter the IPv4 address of the device that you want Cisco DCNM to connect to when it starts the discovery task. Valid entries are in dotted decimal format.
 
     [bookmark: pgfId-1075344]Step 3 In the User Name field, enter the username of a user account on the device. The user account must have a network-admin or vdc-admin role.
 
     [bookmark: pgfId-1075346]Step 4 In the Password field, enter the password for the user account that you entered in the User Name field.
 
     [bookmark: pgfId-1131995]Step 5 (Optional) If you want Cisco DCNM to rediscover devices that are CDP neighbors of the seed device, in the Maximum Hops of Neighbors to Discover field, enter the desired maximum number of hops. By default, the maximum hops is 0 (zero).
 
     [bookmark: pgfId-1075349]Step 6 Check Rediscover Configuration and Status for Existing Devices. By default, this check box is unchecked.
 
     [bookmark: pgfId-1234582]By checking this check box, you enable Cisco DCNM to replace any configuration and status information that it has about a previously discovered device with the running configuration and status information retrieved from the device.
 
     [bookmark: pgfId-1075416]Step 7 Click Start Discovery.
 
     [bookmark: pgfId-1075350]After a short delay, the discovery task appears at the bottom of the list of tasks in the Discovery Tasks area. Cisco DCNM updates the task status periodically.
 
     [bookmark: pgfId-1076072]Step 8 Wait until the status for the task is Successful. This step may take several minutes.
 
     [bookmark: pgfId-1076073]After the status is Successful, you can use Cisco DCNM to configure and monitor the discovered devices.
 
     [bookmark: pgfId-1076074]You do not need to save your changes.
 
     [bookmark: pgfId-1075353]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1053375][bookmark: 84654]Viewing the Status of Device Discovery Tasks
 
    [bookmark: pgfId-1378583]To view the status of device discovery tasks, from the Feature Selector pane, choose DCNM Server Administration > Device Discovery.
 
    [bookmark: pgfId-1378584]The tasks, including the task status, appear in the Discovery Tasks area in the Contents pane. For information about the fields that appear, see the “Field Descriptions for Device Discovery” section.
 
   
 
    
     [bookmark: pgfId-1387948][bookmark: 42401]Where to Go Next
 
    [bookmark: pgfId-1387949]View the discovered devices and configure unique device credentials, as needed. For more information, see the “Administering Devices and Credentials” section.
 
   
 
    
     [bookmark: pgfId-1387954][bookmark: 58163]Field Descriptions for Device Discovery
 
    [bookmark: pgfId-1387955]This section includes the following field descriptions for the Device Discovery feature:
 
     
     	 [bookmark: pgfId-1387959]Device Discovery Content Pane
 
     	 [bookmark: pgfId-1387963]Related Fields
 
    
 
     
      [bookmark: pgfId-1387965][bookmark: 50779]Device Discovery Content Pane
 
     [bookmark: pgfId-1388029]
 
      
       
        
        [bookmark: pgfId-1387971]Table 6-1 Device Discovery Content Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1387975]Field 
          
  
         	 
           
           [bookmark: pgfId-1387977]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1387979]Discovery Setting 
          
  
        
 
         
         	[bookmark: pgfId-1387983]Seed Device
  
         	[bookmark: pgfId-1387985]IPv4 address of the first device that you want to discover. Valid entries are in dotted decimal format. By default, this field is blank.
  
        
 
         
         	[bookmark: pgfId-1387987]User Name
  
         	[bookmark: pgfId-1387989]Name of the device user account that the Cisco DCNM server uses to access the device. The user account must have network-admin or vdc-admin privileges on the device. By default, this field is blank.
  
        
 
         
         	[bookmark: pgfId-1387991]Password
  
         	[bookmark: pgfId-1387993]Password for the device user account specified in the User Name field. By default, this field is blank.
  
        
 
         
         	[bookmark: pgfId-1387995]Maximum Hops of Neighbors to Discover
  
         	[bookmark: pgfId-1387997]Largest permissible number of CDP hops between the Cisco DCNM server and the device. If the server connects to the device but exceeds this number of hops, the discovery fails. The default setting is 0 (zero), which disables the discovery of neighboring devices.
  
        
 
         
         	[bookmark: pgfId-1387999]Rediscover Configuration and Status for Existing Devices
  
         	[bookmark: pgfId-1388001]Whether the discovery task you are configuring is to replace an existing device discovery that has already completed. By default, this check box is unchecked.
  
        
 
         
         	 
           
           [bookmark: pgfId-1388003]Discovery Tasks 
          
  
        
 
         
         	[bookmark: pgfId-1388007]Task ID
  
         	[bookmark: pgfId-1388009]Display only. Number assigned to the discovery task. The task ID indicates the order in which discovery tasks occurred.
  
        
 
         
         	[bookmark: pgfId-1388011]Owner
  
         	[bookmark: pgfId-1388013]Display only. Cisco DCNM server user account used to start the discovery task.
  
        
 
         
         	[bookmark: pgfId-1388015]Seed Device IP Address
  
         	[bookmark: pgfId-1388017]Display only. IPv4 address of the seed device.
  
        
 
         
         	[bookmark: pgfId-1388019]Discovered Time
  
         	[bookmark: pgfId-1388021]Display only. Date and time of the most recent update to the Status field.
  
        
 
         
         	[bookmark: pgfId-1388023]Status
  
         	[bookmark: pgfId-1388025]Display only. State of the discovery task. Valid values are as follows:
 
           
           	 [bookmark: pgfId-1388026]In progress—The discovery tasks are ongoing.
 
           	 [bookmark: pgfId-1388027]Successful—The discovery task completed without errors.
 
           	 [bookmark: pgfId-1388028]Failed—The discovery task completed with errors.
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1388031][bookmark: 56721]Related Fields
 
     [bookmark: pgfId-1388034]For information about fields that configure devices, see the “Administering Devices and Credentials” section.
 
    
 
   
 
    
     [bookmark: pgfId-1388037][bookmark: 96108]Additional References for Device Discovery
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1388051]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1388053]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1388055]Cisco NX-OS XML management interface
  
        	[bookmark: pgfId-1388061]Cisco NX-OS XML Management Interface User Guide, Release 4.x
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1388064][bookmark: 35448]Standards
 
    [bookmark: pgfId-1388075]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1388067]Standards 
         
  
        	 
          
          [bookmark: pgfId-1388069]Title 
         
  
       
 
        
        	[bookmark: pgfId-1388071]NETCONF protocol over the Secure Shell (SSH)
  
        	[bookmark: pgfId-1388074] RFC 4742
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1388077][bookmark: 92503]Feature History for Device Discovery
 
     
      
       
       [bookmark: pgfId-1388085]Table 6-2 [bookmark: 50557]Feature History for Device Discovery
 
       
       
        
        	 
          
          [bookmark: pgfId-1388091]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1388093]Releases 
         
  
        	 
          
          [bookmark: pgfId-1388095]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1388097]Device Discovery
  
        	[bookmark: pgfId-1388099]4.2(1)
  
        	[bookmark: pgfId-1388101]No change from Release 4.1
  
       
 
        
        	[bookmark: pgfId-1390153]Device Discovery
  
        	[bookmark: pgfId-1390145]4.1(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1110711][bookmark: 47491]Administering [bookmark: marker-1173944]Devices and Credentials 
      
      
 
     
 
 
    [bookmark: pgfId-1398746]This chapter describes how to administer Cisco NX-OS devices and the credentials that are used by the Cisco Data Center Network Manager (DCNM) server to authenticate itself to the devices.
 
    [bookmark: pgfId-1398751]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1398755]Information About Devices and Credentials
 
     	 [bookmark: pgfId-1398759]Licensing Requirements for Devices and Credentials
 
     	 [bookmark: pgfId-1398763]Prerequisites for Administering Devices and Credentials
 
     	 [bookmark: pgfId-1398767]Guidelines and Limitations for Devices and Credentials
 
     	 [bookmark: pgfId-1398771]Configuring Devices and Credentials
 
     	 [bookmark: pgfId-1398775]Viewing Device Credentials and Status
 
     	 [bookmark: pgfId-1398779]Field Descriptions for Devices and Credentials
 
     	 [bookmark: pgfId-1398783]Additional References for Devices and Credentials
 
     	 [bookmark: pgfId-1398787]Feature History for Devices and Credentials
 
    
 
   
 
    
     [bookmark: pgfId-1398789][bookmark: 99822]Information About Devices and Credentials
 
    [bookmark: pgfId-1398790]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1398794]Devices
 
     	 [bookmark: pgfId-1398798]Credentials
 
     	 [bookmark: pgfId-1398802]Device Status
 
     	 [bookmark: pgfId-1398806]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1398808][bookmark: 13452]Devices
 
     [bookmark: pgfId-1398809]The Devices and Credentials feature allows you to administer the management state of devices. If the managed physical device supports virtual device contexts (VDCs), Cisco DCNM represents each VDC as a device. If you need to retrieve the running configuration and status information of a single VDC on a physical device with multiple VDCs, rather than performing device discovery for all the VDCs on the physical device, you can use the Devices and Credentials feature to rediscover the single device that represents the changed VDC.
 
    
 
     
      [bookmark: pgfId-1398811][bookmark: 55200]Credentials
 
     [bookmark: pgfId-1398812]Devices and Credentials supports the ability to secure each managed device with different credentials. Cisco DCNM allows you to configure unique credentials for each discovered device or the use of default credentials when you do not configure unique credentials for a device. If some managed devices share the same credentials but others do not, you can configure unique credentials for some devices and configure the default credentials with the credentials that are shared by some of the managed devices.
 
     [bookmark: pgfId-1398813]Devices and Credentials associates a unique set of device credentials with each Cisco DCNM server user. This means that the accounting logs on managed devices reflect the actions of each Cisco DCNM server user. If you log into the Cisco DCNM client as a user who does not have device credentials configured, the Cisco DCNM client prompts you to configure device credentials for the user account.
 
     [bookmark: pgfId-1398814]If support for accounting is not important to your organization, you must still configure each Cisco DCNM server user with device credentials, even if the credentials specified for each user are the same.
 
    
 
     
      [bookmark: pgfId-1398816][bookmark: 45389]Device Status
 
     [bookmark: pgfId-1398817]The Devices and Credentials feature shows the status each device. The possible status are as follows:
 
      
      	 [bookmark: pgfId-1398818]Managed—Cisco DCNM can connect to the device using SSH, configure the running configuration of the device, and retrieve logs and other data from it. This status is possible only for devices that run a supported release of Cisco NX-OS and that are configured properly to support discovery by Cisco DCNM. For more information, see the “Cisco NX-OS Device Preparation” section.
 
      	 [bookmark: pgfId-1398822]Unmanaged—Cisco DCNM does not manage the device or monitor the status of the device. 
 
      	 [bookmark: pgfId-1398823]Unreachable—Cisco DCNM cannot connect to the device, which was a managed device prior to becoming unreachable. Common causes for this status are as follows:
 
     
 
     [bookmark: pgfId-1398824] – A network issue is preventing the Cisco DCNM server from contacting the device.
 
     [bookmark: pgfId-1398825] – SSH is disabled on the device.
 
     [bookmark: pgfId-1398826] – All terminal lines on the device are in use.
 
    
 
     
      [bookmark: pgfId-1398828][bookmark: 55842]Virtualization Support
 
     [bookmark: pgfId-1398829]For devices that support VDCs, Cisco DCNM treats each VDC on a physical device as a separate device; therefore, Cisco DCNM can maintain unique credentials for each VDC on a device. Cisco DCNM tracks the status of each VDC separately, as well.
 
    
 
   
 
    
     [bookmark: pgfId-1398831][bookmark: 64029]Licensing Requirements for Devices and Credentials
 
    [bookmark: pgfId-1398832]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1398845]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1398835]Product 
         
  
        	 
          
          [bookmark: pgfId-1398837]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1398839]Cisco DCNM
  
        	[bookmark: pgfId-1398841]Device and Credentials requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1398847][bookmark: 57296]Prerequisites for Administering Devices and Credentials
 
    [bookmark: pgfId-1398848]Performing device discovery with the Devices and Credentials feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1398849]The Cisco DCNM server must be able to connect to a device that you want to discover.
 
     	 [bookmark: pgfId-1398850]Cisco NX-OS devices must be running a supported release of Cisco NX-OS. For information about supported releases of Cisco NX-OS, see the  Cisco DCNM Release Notes, Release 4.x .
 
     	 [bookmark: pgfId-1398854]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Cisco NX-OS Device Preparation” section.
 
    
 
   
 
    
     [bookmark: pgfId-1398859][bookmark: 76033]Guidelines and Limitations for Devices and Credentials
 
    [bookmark: pgfId-1398860]The Devices and Credentials feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1398861]Discovering a device by using the Devices and Credentials feature does not support CDP-based discovery of neighboring devices. To use CDP-based discovery, see the “Administering Device Discovery” section.
 
     	 [bookmark: pgfId-1398865]Be careful when you change the default credentials or device-specific credentials. Incorrect credentials prevent Cisco DCNM from managing devices.
 
    
 
   
 
    
     [bookmark: pgfId-1398867][bookmark: 98789]Configuring Devices and Credentials
 
    [bookmark: pgfId-1398871]Figure 7-1 shows the Devices and Credentials content pane.
 
    [bookmark: pgfId-1398873]Figure 7-1 [bookmark: 25617]Devices and Credentials Content Pane
 
    [bookmark: pgfId-1398877]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1398878]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1398882]Adding a Device
 
     	 [bookmark: pgfId-1398886]Discovering a Device
 
     	 [bookmark: pgfId-1398890]Unmanaging a Device
 
     	 [bookmark: pgfId-1398894]Deleting a Device
 
     	 [bookmark: pgfId-1398898]Configuring Default Device Credentials
 
     	 [bookmark: pgfId-1398902]Clearing Default Device Credentials
 
     	 [bookmark: pgfId-1398906]Configuring Unique Credentials for a Device
 
     	 [bookmark: pgfId-1398910]Clearing Unique Credentials for a Device
 
    
 
     
      [bookmark: pgfId-1054021][bookmark: 44596]Adding a Device[bookmark: marker-1173945]
 
     [bookmark: pgfId-1070492]You can add a device. After you add a device, you can discover it. For more information, see the “Discovering a Device” section.
 
    
 
     
      [bookmark: pgfId-1070048]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1070049]Determine the IPv4 address for the device.
 
     [bookmark: pgfId-1072930]Determine whether Cisco DCNM can communicate with the device using the default device credentials or whether you need to add unique device credentials when you add the device to Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1072896]DETAILED STEPS
 
     [bookmark: pgfId-1070054]To add a device, follow these steps:
 
     
 
     [bookmark: pgfId-1070055]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1070056]The discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1070057]Step 2 From the menu bar, choose Actions > New Device.
 
     [bookmark: pgfId-1070716]A blank row appears in the Devices area on the Contents pane.
 
     [bookmark: pgfId-1070720]Step 3 In the IP Address column for the new device, enter the IPv4 address that Cisco DCNM must use to connect to the device.
 
     [bookmark: pgfId-1070058]Step 4 Press Enter.
 
     [bookmark: pgfId-1070062]Step 5 (Optional) If you need to add unique device credentials, in the User Credentials column, double-click the entry for the device that you added, click the down-arrow button, and configure the unique device credentials.
 
     [bookmark: pgfId-1072947]Step 6 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1071105]The status of the new device is Unmanaged.
 
     [bookmark: pgfId-1070063]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1072443][bookmark: 34367]Discovering a Device[bookmark: marker-1173946]
 
     [bookmark: pgfId-1072444]You can discover a device.
 
     [bookmark: pgfId-1072838]Discovering an unmanaged device changes its status to Managed. During the discovery, Cisco DCNM retrieves the running configuration of the device.
 
     [bookmark: pgfId-1074601]If you are rediscovering a device, the configuration data that Cisco DCNM retrieves replaces any existing configuration data for the device. Whenever the configuration data that Cisco DCNM has for the device is not accurate, such as when a device administrator has used the command-line interface to change the running configuration, you can use this procedure to update the configuration data that Cisco DCNM has for the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1074711]Note Discovering a device does not affect the running configuration of the device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1074603]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1069834]Ensure that you have either configured the device entry with unique device credentials or that Cisco DCNM can use the default device credentials to connect to the device. For more information, see the “Configuring Default Device Credentials” section.
 
    
 
     
      [bookmark: pgfId-1069838]DETAILED STEPS
 
     [bookmark: pgfId-1069839]To discover a device, follow these steps:
 
     
 
     [bookmark: pgfId-1069840]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1069841]The discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1069842]Step 2 Click the device that you want to discover.
 
     [bookmark: pgfId-1069847]Step 3 From the menu bar, choose Actions > Discover.
 
     [bookmark: pgfId-1073149]The device discovery begins. The status of the device changes to Discovering.
 
     [bookmark: pgfId-1073150]Step 4 Wait for the status to change to Managed.
 
     [bookmark: pgfId-1074119]Typically, the device discovery occurs in less than 5 minutes. After the status changes to Managed, you can use Cisco DCNM to configure the device.
 
     [bookmark: pgfId-1074149]You do not need to save your changes.
 
     [bookmark: pgfId-1074120]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1069370][bookmark: 84817]Unmanaging a Device[bookmark: marker-1173947]
 
     [bookmark: pgfId-1069699]You can change the status of a device to unmanaged.
 
    
 
     
      [bookmark: pgfId-1069701]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1069702]Ensure that you are changing the status of the correct device. Cisco DCNM cannot control the running configuration of an unmanaged device.
 
    
 
     
      [bookmark: pgfId-1069706]DETAILED STEPS
 
     [bookmark: pgfId-1069707]To change the status of a device to unmanaged, follow these steps:
 
     
 
     [bookmark: pgfId-1069708]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1069709]The discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1073524]Step 2 Click the device whose status you want to change to unmanaged.
 
     [bookmark: pgfId-1073525]Step 3 From the menu bar, choose Actions > Unmanage.
 
     [bookmark: pgfId-1073526]After a short delay, the status of the device changes to Unmanaged.
 
     [bookmark: pgfId-1074172]You do not need to save your changes.
 
     [bookmark: pgfId-1073531]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1072102][bookmark: 42525]Deleting a Device[bookmark: marker-1173948]
 
     [bookmark: pgfId-1072103]You can delete a device. When you delete a device, you delete all configuration data about the device from Cisco DCNM.
 
     [bookmark: pgfId-1074984]You should consider deleting devices that you do not intend to manage with Cisco DCNM. Additionally, if a network administrator of a device that supports VDCs uses the command-line interface of the device to delete a VDC, you should delete from Cisco DCNM the device that represented the VDC.
 
      
       
     
 
     
 
     [bookmark: pgfId-1074242]Note Deleting a device does not affect the running configuration of the device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1074342]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1074343]Ensure that you are deleting the correct device.
 
    
 
     
      [bookmark: pgfId-1074347]DETAILED STEPS
 
     [bookmark: pgfId-1074348]To delete a device, follow these steps:
 
     
 
     [bookmark: pgfId-1074176]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1074177]The discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1074178]Step 2 Click the device that you want to delete.
 
     [bookmark: pgfId-1154234]Step 3 From the menu bar, choose Actions > Delete.
 
     [bookmark: pgfId-1154235]The device disappears from the Devices area.
 
     [bookmark: pgfId-1154236]You do not need to save your changes.
 
     [bookmark: pgfId-1154237]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1069130][bookmark: 83658]Configuring Default Device Credentials[bookmark: marker-1173949]
 
     [bookmark: pgfId-1054023]You can configure the default credentials, which Cisco DCNM uses to authenticate itself when it connects to discovered Cisco NX-OS devices. Cisco DCNM uses the default device credentials to communicate with each discovered device that you have not configured with unique device credentials.
 
      
       
     
 
     
 
     [bookmark: pgfId-1232931]Note Device credentials are unique for each Cisco DCNM server user.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054024]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1232918]Determine what the default device credentials should be. All Cisco NX-OS devices that Cisco DCNM uses the default credentials to communicate with must have a network administrator account configured with a username and password that are identical to the default credentials that you configure in Cisco DCNM.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065628]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054026]DETAILED STEPS
 
     [bookmark: pgfId-1054027]To configure default device credentials, follow these steps:
 
     
 
     [bookmark: pgfId-1064943]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1064944]The Default Credentials area appears in the Contents pane, above the Devices area, which lists the discovered devices.
 
     [bookmark: pgfId-1054030]Step 2 In the User Name field, enter the username for the default credentials. A valid username can be 1 to 32 characters. Valid characters are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1054032]Note Cisco NX-OS supports usernames that are a maximum of 28 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1065870]Step 3 To the right of the Password field, click the down-arrow button.
 
     [bookmark: pgfId-1066832]Step 4 In the Password field and the Confirm Password field, enter the password for the default credentials. Valid passwords are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065941]Note Cisco NX-OS supports passwords that are a maximum of 64 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1068889]Step 5 Click OK.
 
     [bookmark: pgfId-1065478]Step 6 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1054037]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1066254][bookmark: 50593]Clearing Default Device Credentials
 
     [bookmark: pgfId-1066255]You can clear the default device credentials.
 
      
       
     
 
     
 
     [bookmark: pgfId-1066293]Note If you clear the default device credentials, Cisco DCNM can connect to discovered devices only if you have configured unique credentials for each managed device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1066256]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1066257]If you intend to use Cisco DCNM without default device credentials, you should ensure that Cisco DCNM is configured with unique device credentials for each discovered device before you perform this procedure. For more information, see the “Configuring Unique Credentials for a Device” section.
 
    
 
     
      [bookmark: pgfId-1057877]DETAILED STEPS
 
     [bookmark: pgfId-1066009]To configure default device credentials, follow these steps:
 
     
 
     [bookmark: pgfId-1066010]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1066011]The Default Credentials area appears in the Contents pane, above the Devices area, which lists the discovered devices.
 
     [bookmark: pgfId-1066012]Step 2 In the Default Credentials area, click Clear.
 
     [bookmark: pgfId-1066014]The User Name field and the Password field clear.
 
     [bookmark: pgfId-1066016]Step 3 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1079171]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1173963][bookmark: 49561]Configuring Unique Credentials for a Device
 
     [bookmark: pgfId-1173964]You can configure credentials that are unique to a discovered device. When unique credentials exist for a discovered device, Cisco DCNM uses them when it connects to the device rather than using the default device credentials.
 
      
       
     
 
     
 
     [bookmark: pgfId-1232942]Note Device credentials are unique for each Cisco DCNM server user.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058483]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1058484]Determine the username and password for a network administrator user account on the discovered device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1144179]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058485]DETAILED STEPS
 
     [bookmark: pgfId-1066621]To configure unique credentials for a discovered device, follow these steps:
 
     
 
     [bookmark: pgfId-1066622]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1066623]The discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1067211]Step 2 In the User Credentials column for the device, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1067212]Step 3 In the User Name field, enter the username. Valid usernames are between 1 and 32 characters. Valid characters are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1067338]Note Cisco NX-OS supports usernames that are a maximum of 28 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1067213]Step 4 In the Password field and the Confirm Password field, enter the password. Valid passwords are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1067049]Note Cisco NX-OS supports passwords that are a maximum of 64 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1067050]Step 5 Click OK.
 
     [bookmark: pgfId-1068884]Step 6 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1066629]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058530][bookmark: 77234]Clearing Unique Credentials for a Device
 
     [bookmark: pgfId-1058531]You can clear unique credentials for a discovered device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1068215]Note If you clear the unique credentials for a discovered device, Cisco DCNM uses the default credentials to connect to the device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058532]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1068411]If you intend to operate Cisco DCNM without unique credentials for the device, you should ensure that Cisco DCNM is configured with default device credentials before you perform this procedure. For more information, see the “Configuring Default Device Credentials” section.
 
    
 
     
      [bookmark: pgfId-1058534]DETAILED STEPS
 
     [bookmark: pgfId-1068680]To clear unique credentials from a discovered device, follow these steps:
 
     
 
     [bookmark: pgfId-1068681]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1068682]Discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1068683]Step 2 In the User Credentials column for the device, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1068684]Step 3 In the User Name field, delete all text.
 
     [bookmark: pgfId-1068830]Step 4 In the Password field, delete all text.
 
     [bookmark: pgfId-1068834]Step 5 In the Confirm Password field, delete all text.
 
     [bookmark: pgfId-1068688]Step 6 Click OK.
 
     [bookmark: pgfId-1068877]Step 7 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1068689]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1054039][bookmark: 86594]Viewing Device Credentials and Status
 
    [bookmark: pgfId-1061133]To view the status for devices and whether credentials are configured for the device, from the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials.
 
    [bookmark: pgfId-1061729]The default credentials appears in the Default Credentials area in the Contents pane. Information about devices, including credentials and status, appear in the Devices area in the Contents pane. For information about the fields that appear, see the “Field Descriptions for Devices and Credentials” section.
 
   
 
    
     [bookmark: pgfId-1399266][bookmark: 22611]Field Descriptions for Devices and Credentials
 
     
      
       
       [bookmark: pgfId-1399279]Table 7-1 Device and Credentials Content Pane 
 
       
       
        
        	 
          
          [bookmark: pgfId-1399283]Field 
         
  
        	 
          
          [bookmark: pgfId-1399285]Description 
         
  
       
 
        
        	 
          
          [bookmark: pgfId-1399287]Default Credentials 
         
  
       
 
        
        	[bookmark: pgfId-1399291]User Name
  
        	[bookmark: pgfId-1399293]Name of the Cisco NX-OS device user account that the Cisco DCNM server uses to access any device that it is discovering or that it is managing. On the device, the user account must be assigned to the network-admin or vdc-admin role. By default, this field is blank.
 [bookmark: pgfId-1399294]Note The information in the User Credentials field in the Devices area overrides the information in the Default Credentials section.
  
       
 
        
        	[bookmark: pgfId-1399296]Password
  
        	[bookmark: pgfId-1399298]Password for the Cisco NX-OS device user account specified in the User Name field. By default, this field is blank.
  
       
 
        
        	 
          
          [bookmark: pgfId-1399300]Devices 
         
  
       
 
        
        	[bookmark: pgfId-1399304]IP Address
  
        	[bookmark: pgfId-1399306]Display only. IPv4 address of the Cisco NX-OS device.
  
       
 
        
        	[bookmark: pgfId-1399308]Name
  
        	[bookmark: pgfId-1399310]Display only. Name of the Cisco NX-OS device.
  
       
 
        
        	[bookmark: pgfId-1399312]User Credentials
  
        	[bookmark: pgfId-1399314]The Cisco NX-OS user account that Cisco DCNM uses to connect to the Cisco NX-OS device. 
 [bookmark: pgfId-1399315]Note If you configure this field, Cisco DCNM uses the user account that you configure when it connects to the device. If this field is blank, Cisco DCNM uses the user account specified in the Default Credentials area. By default, this field is blank.
  
       
 
        
        	[bookmark: pgfId-1399317]Status
  
        	[bookmark: pgfId-1399319]Display only. Whether the Cisco DCNM server can connect to and configure the device. Valid values are as follows:
 
          
          	 [bookmark: pgfId-1399320]Managed—The Cisco DCNM server can configure the device.
 
          	 [bookmark: pgfId-1399321]Unmanaged—The Cisco DCNM server cannot configure the device.
 
          	 [bookmark: pgfId-1399322]Unreachable—The Cisco DCNM server cannot reach the device.
 
         
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1399325][bookmark: 59150]Additional References for Devices and Credentials
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1399339]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1399341]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1399343]Cisco NX-OS XML management interface
  
        	[bookmark: pgfId-1399349]Cisco NX-OS XML Management Interface User Guide, Release 4.x
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1399352][bookmark: 70458]Standards
 
    [bookmark: pgfId-1399363]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1399355]Standards 
         
  
        	 
          
          [bookmark: pgfId-1399357]Title 
         
  
       
 
        
        	[bookmark: pgfId-1399359]NETCONF protocol over the Secure Shell (SSH)
  
        	[bookmark: pgfId-1399362] RFC 4742
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1399365][bookmark: 92503]Feature History for Devices and Credentials
 
     
      
       
       [bookmark: pgfId-1399373]Table 7-2 [bookmark: 50557]Feature History for Devices and Credentials
 
       
       
        
        	 
          
          [bookmark: pgfId-1399379]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1399381]Releases 
         
  
        	 
          
          [bookmark: pgfId-1399383]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1399385]Devices and Credentials
  
        	[bookmark: pgfId-1399387]4.2(1)
  
        	[bookmark: pgfId-1399389]No change from Release 4.1
  
       
 
        
        	[bookmark: pgfId-1400936]Devices and Credentials
  
        	[bookmark: pgfId-1400924]4.1(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1373286][bookmark: 49646]Administering DCNM Licensed Devices 
      
      
 
     
 
 
    [bookmark: pgfId-1385358]This chapter describes how to use the DCNM Licensed Devices feature.
 
    [bookmark: pgfId-1385363]This chapter includes the following topics:
 
     
     	 [bookmark: pgfId-1385367]Information About DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385371]Licensing Requirements for Administering DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385375]Prerequisites for Administering DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385379]Guidelines and Limitations for Administering DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385383]Configuring DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385387]Viewing DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385391]Field Descriptions for DCNM Licensed Devices
 
     	 [bookmark: pgfId-1385395]Additional References
 
     	 [bookmark: pgfId-1385399]Feature History for DCNM Licensed Devices
 
    
 
   
 
    
     [bookmark: pgfId-1385401][bookmark: 30510]Information About DCNM Licensed Devices
 
    [bookmark: pgfId-1385402]The DCNM Licensed Devices feature allows you to control which physical devices you can manage with licensed Cisco Data Center Network Manager (DCNM) features. The feature maintains a list of licensed devices. If a device is on this list, you can manage licensed Cisco DCNM features on the device.
 
    [bookmark: pgfId-1385403]You can add as many devices to licenses as your licenses support. For example, if you install two LAN Enterprise licenses that each support 5 devices, you can add a total of 10 devices to the list of licensed devices.
 
    [bookmark: pgfId-1385404]You can also remove devices from the list of licensed devices and replace them with other devices.
 
    [bookmark: pgfId-1385405]When you try to use a Cisco DCNM licensed feature to configure a device that you have not added to the list of licensed devices, the Cisco DCNM client does not allow you to use the feature to configure the unlicensed device.
 
   
 
    
     [bookmark: pgfId-1385407][bookmark: 99420]Licensing Requirements for Administering DCNM Licensed Devices
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1385411]Product 
         
  
        	 
          
          [bookmark: pgfId-1385413]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1385415]Cisco DCNM
  
        	[bookmark: pgfId-1385417]DCNM Licensed Devices requires an Enterprise LAN license. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1385423][bookmark: 91601]Prerequisites for Administering DCNM Licensed Devices
 
    [bookmark: pgfId-1385424]Administering DCNM Licensed Devices has the following prerequisites:
 
     
     	 [bookmark: pgfId-1385427]You must install one or more LAN Enterprise licenses. For more information, see the “Installing Licenses” section.
 
     	 [bookmark: pgfId-1385429]You must discover the devices that you want to add to the list of Cisco DCNM-licensed devices. For more information, see the “Discovering Devices” section.
 
    
 
   
 
    
     [bookmark: pgfId-1385434][bookmark: 29118]Guidelines and Limitations for Administering DCNM Licensed Devices
 
    [bookmark: pgfId-1385435]Administering DCNM Licensed Devices has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1385436]You can add only managed devices to the list of licensed devices.
 
     	 [bookmark: pgfId-1385437]You can add to the list of licensed devices only as many devices as permitted by all of the LAN Enterprise licenses that you have installed.
 
     	 [bookmark: pgfId-1385438]When you remove a device from the list of licensed devices, the device is removed from Cisco DCNM. If the physical device supports VDCs, all the VDCs on the device are removed from Cisco DCNM. To continue managing the device, you must discover the device. For more information, see the “Discovering Devices” section. 
 
    
 
   
 
    
     [bookmark: pgfId-1385443][bookmark: 35886]Configuring DCNM Licensed Devices
 
    [bookmark: pgfId-1385447]Figure 8-1 shows the DCNM Licensed Devices content pane.
 
    [bookmark: pgfId-1385449]Figure 8-1 [bookmark: 15624]DCNM Licensed Devices Content Pane
 
    [bookmark: pgfId-1385453]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1385454]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1385458]Adding Devices to the Licensed Devices List
 
     	 [bookmark: pgfId-1385462]Removing Devices from the Licensed Devices List
 
    
 
     
      [bookmark: pgfId-1373384][bookmark: 17248]Adding Devices to the Licensed Devices List[bookmark: marker-1373383]
 
     [bookmark: pgfId-1373385]You can add managed devices to the list of Cisco DCNM-licensed devices.
 
    
 
     
      [bookmark: pgfId-1373386]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1373387]You must have installed at least one Cisco DCNM Enterprise LAN license. For more information, see the “Installing Licenses” section.
 
     [bookmark: pgfId-1373391]If you have already added as many devices as the maximum number of devices allowed by your licenses, you must remove one or more devices from the list of licensed devices before you can add other devices to the list. For more information, see the “Removing Devices from the Licensed Devices List” section.
 
    
 
     
      [bookmark: pgfId-1373395]DETAILED STEPS
 
     [bookmark: pgfId-1373396]To add a device to the list of licensed devices, follow these steps:
 
     
 
     [bookmark: pgfId-1373397]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Licensed Devices.
 
     [bookmark: pgfId-1373398]The Contents pane displays the list of licensed devices.
 
     [bookmark: pgfId-1373399]Step 2 From the menu bar, choose Actions > New.
 
     [bookmark: pgfId-1373400]The Cisco DCNM client adds a row to the list and the Available Devices dialog box lists available and selected physical devices.
 
     [bookmark: pgfId-1373401]Step 3 From the Available Devices list, choose the physical devices that you want to add to the license and then click Add.
 
     [bookmark: pgfId-1373402]Step 4 Click OK.
 
     [bookmark: pgfId-1373403]The Contents pane displays a list of licensed devices, including the devices that you added.
 
     [bookmark: pgfId-1373404]Step 5 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1373405]You can begin using licensed Cisco DCNM features when you manage the device.
 
     [bookmark: pgfId-1373406]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373414][bookmark: 88983]Removing Devices from the Licensed Devices List[bookmark: marker-1373413]
 
     [bookmark: pgfId-1373415]You can remove one or more physical devices from the list of Cisco DCNM-licensed devices when you no longer need to use licensed Cisco DCNM features to manage the devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-1373416]Note When you remove a physical device from the list of licensed devices, the device and all of its VDCs are removed from Cisco DCNM. To continue managing the device, you must discover the device. For more information, see the “Discovering Devices” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373420]DETAILED STEPS
 
     [bookmark: pgfId-1373421]To remove devices from the list of licensed devices, follow these steps:
 
     
 
     [bookmark: pgfId-1373422]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Licensed Devices.
 
     [bookmark: pgfId-1373423]The Contents pane displays the list of licensed devices.
 
     [bookmark: pgfId-1373424]Step 2 For each device that you want to remove from the list of licensed devices, follow these steps:
 
     [bookmark: pgfId-1373425] a. Choose the device that you want to remove from the list of licensed devices.
 
     [bookmark: pgfId-1373426] b. From the menu bar, choose Actions > Delete.
 
     [bookmark: pgfId-1373427]The Cisco DCNM client displays a confirmation dialog box.
 
     [bookmark: pgfId-1373428] c. Click Yes.
 
     [bookmark: pgfId-1373429]The Cisco DCNM client removes the device from the list of licensed devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-1373430]Note Devices that you remove from the list of licensed devices are no longer managed by Cisco DCNM.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1373431]Step 3 (Optional) To continue managing devices that you removed from the list of licensed devices, discover the devices. For more information, see the “Discovering Devices” section.
 
     [bookmark: pgfId-1373435]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1373446][bookmark: 30712]Viewing DCNM Licensed Devices
 
    [bookmark: pgfId-1373447]To view the list of Cisco DCNM-licensed devices, from the Feature Selector pane, choose DCNM Server Administration > DCNM Licensed Devices.
 
    [bookmark: pgfId-1373448]The list of Cisco DCNM-licensed devices appears in the Contents pane. For information about the fields that appear, see the “Field Descriptions for DCNM Licensed Devices” section.
 
   
 
    
     [bookmark: pgfId-1385551][bookmark: 81270]Field Descriptions for DCNM Licensed Devices
 
     
      
       
       [bookmark: pgfId-1385564]Table 8-1 DCNM Licensed Devices Content Pane 
 
       
       
        
        	 
          
          [bookmark: pgfId-1385568]Field 
         
  
        	 
          
          [bookmark: pgfId-1385570]Description 
         
  
       
 
        
        	[bookmark: pgfId-1385572]Number of Devices Licensed
  
        	[bookmark: pgfId-1385574]Display only. Sum of devices licensed by all Cisco DCNM Enterprise LAN licenses installed. For example, if you installed two licenses that each support 5 devices, this field would display 10.
  
       
 
        
        	[bookmark: pgfId-1385576]Switch Name
  
        	[bookmark: pgfId-1385578]Display only. Name of a licensed physical device. You can use licensed Cisco DCNM features on the device.
  
       
 
        
        	[bookmark: pgfId-1385580]Virtual Devices
  
        	[bookmark: pgfId-1385582]Display only. Each virtual device context (VDC) that is configured on the physical device. If the physical device does not support VDCs, this field is empty.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1385585][bookmark: 33403]Additional References
 
    [bookmark: pgfId-1385586]For additional information related to administering DCNM Licensed Devices, see the following sections:
 
     
     	 [bookmark: pgfId-1385590]Related Documents
 
     	 [bookmark: pgfId-1385594]Standards
 
    
 
     
      [bookmark: pgfId-1385596][bookmark: 66091]Related Documents
 
     [bookmark: pgfId-1385609]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1385599]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1385601]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1385603]Installing a Cisco DCNM Enterprise LAN license
  
         	[bookmark: pgfId-1385608]Installing Licenses
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1385611][bookmark: 84492]Standards
 
     [bookmark: pgfId-1385621]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1385614]Standards 
          
  
         	 
           
           [bookmark: pgfId-1385616]Title 
          
  
        
 
         
         	[bookmark: pgfId-1385618]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1385620]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1385623][bookmark: 92503]Feature History for DCNM Licensed Devices
 
     
      
       
       [bookmark: pgfId-1385631]Table 8-2 [bookmark: 50557]Feature History for DCNM Licensed Devices
 
       
       
        
        	 
          
          [bookmark: pgfId-1385637]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1385639]Releases 
         
  
        	 
          
          [bookmark: pgfId-1385641]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1388189]DCNM Licensed Devices
  
        	[bookmark: pgfId-1388191]4.2(1)
  
        	[bookmark: pgfId-1388193]No change from Release 4.1
  
       
 
        
        	[bookmark: pgfId-1385643]DCNM Licensed Devices
  
        	[bookmark: pgfId-1385645]4.1(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1240539][bookmark: 85688]Working with [bookmark: marker-1240537]Topology 
      
      
 
     
 
 
    [bookmark: pgfId-1259075]This chapter describes how to use the Topology feature in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1259080]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1259084]Information About Topology
 
     	 [bookmark: pgfId-1259088]Licensing Requirements for Topology
 
     	 [bookmark: pgfId-1259092]Prerequisites for Topology
 
     	 [bookmark: pgfId-1259096]Guidelines and Limitations
 
     	 [bookmark: pgfId-1259100]Using the Topology Feature
 
     	 [bookmark: pgfId-1259108]Related Documents
 
     	 [bookmark: pgfId-1259112]Feature History for Topology
 
    
 
   
 
    
     [bookmark: pgfId-1259114][bookmark: 69949]Information About Topology
 
    [bookmark: pgfId-1259115]The Topology feature provides you with a topology map of supported Cisco NX-OS devices. The topology map also shows switches that run Cisco IOS software, such as the Catalyst 6500 series switches, that are linked by the Cisco Discovery Protocol (CDP). For Nexus 7000 Series devices, the map shows details about virtual device contexts (VDCs).
 
    [bookmark: pgfId-1259116]When Cisco Data Center Network Manager (DCNM) receives new information, the Cisco DCNM client updates the map dynamically. By default, updates occur once a minute. You can see changes occur to the status of links and devices, such as links going down or VDC creation, deletion, or modification. 
 
    [bookmark: pgfId-1259117]Because the map is always current, you can use it to troubleshoot ongoing network management issues.
 
    [bookmark: pgfId-1259118]You can modify and save the layout of device icons. The map also provides you quick access to configuring features for a managed device.
 
    [bookmark: pgfId-1259119]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1259123]Map Views
 
     	 [bookmark: pgfId-1259127]Layouts
 
     	 [bookmark: pgfId-1259131]vPC Support
 
    
 
     
      [bookmark: pgfId-1259134][bookmark: 45093]Map Views[bookmark: marker-1259133]
 
     [bookmark: pgfId-1259135]The topology map includes four views of your topology, described in the following topics:
 
      
      	 [bookmark: pgfId-1259139]Physical View
 
      	 [bookmark: pgfId-1259143]PortChannel and vPC
 
      	 [bookmark: pgfId-1259147]Logical vPC View
 
      	 [bookmark: pgfId-1259151]VLANs/STP
 
     
 
    
 
     
      [bookmark: pgfId-1259153][bookmark: 74938]Physical View
 
     [bookmark: pgfId-1259157]The Physical View (see Figure 9-1) shows the physical connections between discovered devices. This is the default topology view.
 
     [bookmark: pgfId-1259159]Figure 9-1 [bookmark: 19030]Physical View of the Topology Map
 
     [bookmark: pgfId-1259163]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1259165][bookmark: 83961]PortChannel and vPC
 
     [bookmark: pgfId-1259169]The PortChannel and vPC view (see Figure 9-2) shows all physical connections and all logical connections among discovered devices, including port channel links, virtual port channel (vPC) links, and vPC peer links. Physical links appear in gray in this view.
 
     [bookmark: pgfId-1259171]Figure 9-2 [bookmark: 50955]PortChannel and vPC View of the Topology Map
 
     [bookmark: pgfId-1259175]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1259177][bookmark: 77617]Logical vPC View
 
     [bookmark: pgfId-1259181]The Logical vPC View (see Figure 9-3) shows vPC links and vPC peer links among discovered devices, without showing the physical connections.
 
     [bookmark: pgfId-1259183]Figure 9-3 [bookmark: 62915]Logical vPC View of the Topology Map
 
     [bookmark: pgfId-1259187]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1259189][bookmark: 73382]VLANs/STP
 
     [bookmark: pgfId-1259193]The VLANs/STP view (see Figure 9-4) shows VLANs configured among discovered devices.
 
     [bookmark: pgfId-1259195]Figure 9-4 [bookmark: 75039]VLANs/STP View of the Topology Map
 
     [bookmark: pgfId-1259199]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1259248][bookmark: 21578]Layouts[bookmark: marker-1231446]
 
     [bookmark: pgfId-1259249]The topology map enables you to move devices to where you want them. You can save the layout so that the next time you use the topology map, devices are where you placed them. The Cisco DCNM client saves topology layouts as local user data on the computer that runs the Cisco DCNM client. When you are using the Cisco DCNM client, you do not have access to topology layouts that you saved on other computers or that you saved while logged in to the computer under a different username.
 
     [bookmark: pgfId-1259250]In addition to saved layouts, when you are using the Physical View, you can load one of the following layouts:
 
      
      	 [bookmark: pgfId-1259253]Spring—Devices appear in locations determined by weighting the connections, which often produces a layout with minimal or no crossed connections.
 
      	 [bookmark: pgfId-1259254]Tree—Devices appear in a tree unless connections create loops among the devices, in which case devices appear in a spanning tree, that is, a grid in which most of the connections follow the grid layout.
 
     
 
    
 
     
      [bookmark: pgfId-1259256][bookmark: 59822]vPC Support
 
     [bookmark: pgfId-1259257]The topology map provides the following additional vPC-specific features:
 
      
      	 [bookmark: pgfId-1259258]vPC creation—You can launch the vPC Creation Wizard from the PortChannel and vPC view. See the “Launching the vPC Wizard” section.
 
      	 [bookmark: pgfId-1259262]Quick access to the vPC feature—You can access the configuration for a specific vPC from the PortChannel and vPC view or the Logical vPC View. See the “Managing a vPC” section.
 
      	 [bookmark: pgfId-1259266]vPC configuration inconsistency—You can see vPC links and vPC peer links that have configuration inconsistencies. You can open the Resolve Configuration Consistency dialog box from the topology map. See the “Finding and Resolving vPC Configuration Inconsistencies” section.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1259271][bookmark: 29596]Licensing Requirements for Topology
 
    [bookmark: pgfId-1259272]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1259285]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1259275]Product 
         
  
        	 
          
          [bookmark: pgfId-1259277]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1259279]Cisco DCNM
  
        	[bookmark: pgfId-1259281]The Topology feature requires no license; however, the Logical vPC View of the topology map requires a LAN Enterprise license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1259287][bookmark: 16098]Prerequisites for Topology
 
    [bookmark: pgfId-1259288]Topology has the following prerequisites:
 
     
     	 [bookmark: pgfId-1259289]The topology map shows only devices that Cisco DCNM has discovered.
 
     	 [bookmark: pgfId-1259290]On devices shown in the topology map, CDP should be enabled both globally and specifically on interfaces used for device discovery.
 
    
 
   
 
    
     [bookmark: pgfId-1259292][bookmark: 58316]Guidelines and Limitations
 
    [bookmark: pgfId-1259293]Topology has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1259294]While the Topology feature is an unlicensed feature, you must have a LAN Enterprise license to manage the nondefault VDCs of Nexus 7000 Series devices that appears in the topology.
 
     	 [bookmark: pgfId-1259295]The Topology feature displays changes to the topology periodically as determined by the polling frequency for accounting and system logs. By default, the polling frequency is one minute. For more information, see the “Information About Auto-Synchronization with Devices” section.
 
    
 
   
 
    
     [bookmark: pgfId-1259301][bookmark: 24305][bookmark: 71793]Using the Topology Feature
 
    [bookmark: pgfId-1259302]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1259306]Opening the Topology Map
 
     	 [bookmark: pgfId-1259310]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1259314]Using the Viewing Tools
 
     	 [bookmark: pgfId-1259318]Showing, Hiding, and Using the Details Pane
 
     	 [bookmark: pgfId-1259322]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1259326]Managing a vPC
 
     	 [bookmark: pgfId-1259330]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1259334]Accessing Other Cisco DCNM Features from the Topology Map
 
     	 [bookmark: pgfId-1259338]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1259342]Loading a Layout
 
     	 [bookmark: pgfId-1259346]Reloading the Previously Saved Layout
 
     	 [bookmark: pgfId-1259350]Exporting the Topology as a JPG Image
 
    
 
     
      [bookmark: pgfId-1203117][bookmark: 13513]Opening the Topology Map[bookmark: marker-1231458]
 
     [bookmark: pgfId-1203118]You can open the topology map to view the topology of discovered devices.
 
    
 
     
      [bookmark: pgfId-1203125]DETAILED STEPS
 
     [bookmark: pgfId-1203126]To view the topology, follow these steps:
 
     
 
     [bookmark: pgfId-1203127]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
     [bookmark: pgfId-1203128]The topology map appears in the Contents pane. Buttons for each of the available topology views appear above the topology map.
 
     [bookmark: pgfId-1203129]Step 2 (Optional) If you want to change topology views, click the topology view name.
 
     [bookmark: pgfId-1203130]The topology map shows the view of the topology that you selected.
 
     [bookmark: pgfId-1203131]Step 3 (Optional) If you want to use a view-specific option, see the following table:
 
     [bookmark: pgfId-1203169]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1203134]View Feature 
          
  
         	 
           
           [bookmark: pgfId-1203136]Available In View 
          
  
         	 
           
           [bookmark: pgfId-1203138]How to Use 
          
  
        
 
         
         	[bookmark: pgfId-1203140]Show/hide all VDCs
  
         	 
           
           	 [bookmark: pgfId-1203142]Physical View
 
           	 [bookmark: pgfId-1203143]VLANs/STP
 
          
  
         	[bookmark: pgfId-1203145]Right-click in a blank space on the map and choose Show All VDCs or Hide All VDCs.
 [bookmark: pgfId-1203146]When you view all VDCs, Cisco Nexus 7000 Series devices appear as gray boxes that contain device icons for each VDC configured on the Cisco Nexus 7000 Series device.
  
        
 
         
         	[bookmark: pgfId-1203148]Filter VLANs
  
         	 
           
           	 [bookmark: pgfId-1203150]VLANs/STP
 
          
  
         	[bookmark: pgfId-1203152] 1. On the map, find the VLANs box.
 [bookmark: pgfId-1203153] 2. Enter a list of VLAN IDs. You can specify a single VLAN ID, a range of VLAN IDs, or comma-separated IDs and ranges.
 [bookmark: pgfId-1203154] 3. Click Filter.
  
        
 
         
         	[bookmark: pgfId-1203156]Show/hide non-forwarding links
  
         	 
           
           	 [bookmark: pgfId-1203158]VLANs/STP
 
          
  
         	[bookmark: pgfId-1203160] 1. On the map, find the VLANs box.
 [bookmark: pgfId-1203161] 2. Check or uncheck the Show Non-Forwarding Link (Blocking & Disabled) as needed.
  
        
 
         
         	[bookmark: pgfId-1203163]Show/hide vPCs or port channels
  
         	 
           
           	 [bookmark: pgfId-1203165]PortChannel and vPC
 
          
  
         	[bookmark: pgfId-1203167] 1. On the map, find the gray box that contains the Show vPC check box and the Show Port Channel check box. You may need to scroll the map or zoom out to locate the gray box.
 [bookmark: pgfId-1203168] 2. Check or uncheck the check boxes as needed.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1203170]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1209900][bookmark: 16219]Understanding Device Icons and Links[bookmark: marker-1231469]
 
     [bookmark: pgfId-1209901]To understand the device icons and links shown in the topology map, you can open the legend. The legend presents information about the device icons and links shown in the currently selected topology view.
 
    
 
     
      [bookmark: pgfId-1209945]DETAILED STEPS
 
     [bookmark: pgfId-1209957]To open the legend, follow these steps:
 
     
 
     [bookmark: pgfId-1209968]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
     [bookmark: pgfId-1209969]The topology map appears in the Contents pane. Buttons for each of the available topology views appear above the topology map.
 
     [bookmark: pgfId-1209970]Step 2 (Optional) If you want to change topology views, click the topology view name.
 
     [bookmark: pgfId-1209971]The topology map shows the view of the topology that you selected. The topology toolbar appears on the left side of the topology map.
 icon. 
     
 
     [bookmark: pgfId-1210026]The Legend dialog box displays information about the device icons and links that may appear in the currently selected topology view.
 
     [bookmark: pgfId-1210032]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1209904][bookmark: 88222]Using the Viewing Tools[bookmark: marker-1209903]
 
     [bookmark: pgfId-1195696]You can use the pan, select, zoom, and search tools to view the topology map.
 
     [bookmark: pgfId-1195190]The following table describes the viewing tools that are available in the topology toolbar, which is on the left side of the topology map.
 
     [bookmark: pgfId-1195789]
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
       
        
         
         	 
           
           [bookmark: pgfId-1195245]Viewing Tool Icon and Name 
          
  
         	 
           
           [bookmark: pgfId-1195247]How to Use 
          
  
        
 
        
          Pan 
         	[bookmark: pgfId-1195251]Moves, or pans, the map.
 icon.
 [bookmark: pgfId-1195256] 2. Click anywhere on the topology map, and hold down the mouse button.
 [bookmark: pgfId-1195257] 3. Drag the map in any direction.
 [bookmark: pgfId-1195258] 4. Release the mouse button.
  
        
 
        
          Select 
         	[bookmark: pgfId-1195265]Allows you to select a device, link, or port icon.
 icon.
 [bookmark: pgfId-1195266] 2. Click the device, link, or port icon that you want to work with.
 [bookmark: pgfId-1195267]A balloon displays information about the icon that you clicked.
  
        
 
        
          Zoom in Rect 
         	[bookmark: pgfId-1195288]Zooms to a specific portion of the map.
 icon.
 [bookmark: pgfId-1195671] 2. Click on the map and drag a rectangle over the area that you want to see, and release the mouse button.
  
        
 
        
          Zoom In icon. 
        
 
        
          Zoom Out icon. 
        
 
        
          Fit to View icon. 
        
 
        
          Reset Zoom icon. 
        
 
        
          Search 
         	[bookmark: pgfId-1200086]Allows you to use the device search tool, so that you can search for a device by its name.
 icon.
 icon.
 icon again.
 [bookmark: pgfId-1200185]Tip You can move the Search tool on the topology map by clicking and dragging it when you have the Select tool enabled.  
        
 
        
          Legend 
         	[bookmark: pgfId-1213648]Opens the Legend dialog box. See the “Understanding Device Icons and Links” section.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1172562][bookmark: 45344]Showing, Hiding, and Using the Details Pane
 
     [bookmark: pgfId-1190323]You can show or hide the Details pane within the topology map. When you are showing the Details pane, you can use the sections within the Details pane to learn about the devices and connections in the topology.
 
    
 
     
      [bookmark: pgfId-1174624]DETAILED STEPS
 
     [bookmark: pgfId-1173281]To show, hide, or use the Details pane, follow these steps:
 
     
 
     [bookmark: pgfId-1218065]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
     [bookmark: pgfId-1218066]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
      
       
     
 
     
 
     [bookmark: pgfId-1218067]Tip To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
      
      
 
     
 
     
 icon. 
     
 
     [bookmark: pgfId-1183364]When you choose to show details, the Details pane appears between the topology toolbar and the topology map.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1197276]Step 3 To use the sections within the Details pane, see the following table:
 
    [bookmark: pgfId-1199369]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1199330]Section 
         
  
        	 
          
          [bookmark: pgfId-1199332]Available In 
         
  
        	 
          
          [bookmark: pgfId-1199334]How to Use 
         
  
       
 
        
        	[bookmark: pgfId-1199336]VDC View
  
        	 
          
          	 [bookmark: pgfId-1199338]Physical View
 
          	 [bookmark: pgfId-1199339]VLANs/STP
 
         
  
        	[bookmark: pgfId-1199341]Explore the VDC View tree to see which Nexus 7000 Series devices contain VDCs. To see details about a device, click on it and see the Properties section.
  
       
 
        
        	[bookmark: pgfId-1199343]vPC
  
        	 
          
          	 [bookmark: pgfId-1199345]Port Channel and vPC
 
          	 [bookmark: pgfId-1199346]Logical vPC
 
         
  
        	[bookmark: pgfId-1199348]Explore the vPC tree to see a categorized listing of all logical connections in the topology map. To see details about a vPC, vPC peer link, or a port channel, click on it and see the Properties section.
  
       
 
        
        	[bookmark: pgfId-1199350]Overview
  
        	 
          
          	 [bookmark: pgfId-1199352]All views
 
         
  
        	[bookmark: pgfId-1199354]Tip To view the Overview section, you may need to click the Overview tab in the Properties section. The Overview and Properties sections share the same section title bar. [bookmark: pgfId-1199355]The Overview section shows a thumbnail view of the whole topology. A blue rectangle indicates the portion of the topology that is currently shown in the map.
 
          
          	 [bookmark: pgfId-1199356]To change which portion of the topology is shown in the map, in the overview, click where you want the map to show.
 
          	 [bookmark: pgfId-1199357]To zoom in or out, click a corner of the blue rectangle and drag it until the map is enlarged or shrunk as you want.
 
         
  
       
 
        
        	[bookmark: pgfId-1199359]Properties
  
        	 
          
          	 [bookmark: pgfId-1199361]All views
 
         
  
        	[bookmark: pgfId-1199363]Tip To view the Properties section, you may need to click the Properties tab in the Overview section. The Overview and Properties sections share the same section title bar. [bookmark: pgfId-1199364] 1. Do one of the following:
 [bookmark: pgfId-1199365] – In the VDC View section, click on a physical or virtual device.
 [bookmark: pgfId-1199366] – In the vPC section, click on a logical connection.
 [bookmark: pgfId-1199367] – In the topology map, click on a device, link, or port.
 [bookmark: pgfId-1199368] 2. In the Properties section, view the properties of the object that you selected.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1173344]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1173346][bookmark: 50266]Launching the vPC Wizard
 
    [bookmark: pgfId-1205248]From the topology map, you can launch the vPC wizard to create a vPC.
 
   
 
    
     [bookmark: pgfId-1206611]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1206811]Determine which two devices you want to use as the vPC peer switches.
 
   
 
    
     [bookmark: pgfId-1206762]DETAILED STEPS
 
    [bookmark: pgfId-1206639]To launch the vPC wizard, follow these steps:
 
    
 
    [bookmark: pgfId-1206698]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1206699]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1206700]Step 2 Above the map, click PortChannel and vPC.
 
    [bookmark: pgfId-1206701]The map shows the PortChannel and vPC view of the topology.
 icon. 
    
 
    [bookmark: pgfId-1206831]Step 4 Click one device that you want to use as a vPC peer switch.
 
    [bookmark: pgfId-1206847]Step 5 Press and hold the Shift key.
 
    [bookmark: pgfId-1206865]Step 6 Click the device that you want to use as a vPC peer switch.
 
    [bookmark: pgfId-1206874]Step 7 Right-click either device and choose Launch vPC Wizard.
 
    [bookmark: pgfId-1206881]The vPC Creation Wizard dialog box appears.
 
    [bookmark: pgfId-1206900]For more information about using this wizard, see the Cisco DCNM Interfaces Configuration Guide, Release 4.x.
 
    [bookmark: pgfId-1206905]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1209251][bookmark: 55325]Managing a vPC[bookmark: marker-1231482]
 
    [bookmark: pgfId-1234753]From the topology map, you can access the vPC feature for a specific vPC link.
 
   
 
    
     [bookmark: pgfId-1234755]DETAILED STEPS
 
    [bookmark: pgfId-1207008]To manage a vPC, follow these steps:
 
    
 
    [bookmark: pgfId-1207049]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1207050]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1207051]Step 2 Above the map, click one of the following views:
 
     
      
      	 [bookmark: pgfId-1207075] PortChannel and vPC 
 
      	 [bookmark: pgfId-1207286] Logical vPC View 
 
     
 
    
 
    [bookmark: pgfId-1207298]Step 3 Locate the vPC link for the vPC that you want to manage.
 
    [bookmark: pgfId-1207317]Step 4 Use the step that applies to the view that you selected:
 
     
      
      	 [bookmark: pgfId-1207288]PortChannel and vPC—Right-click the ellipse on the vPC link and choose  Manage vPC .
 
      	 [bookmark: pgfId-1207336]Logical vPC View—Right-click the vPC link and choose  Manage vPC .
 
     
 
    
 
    [bookmark: pgfId-1207353]The vPC feature appears. The vPC that you want to manage is selected in the summary table.
 
    [bookmark: pgfId-1207369]For more information about the vPC feature, see the Cisco DCNM Interfaces Configuration Guide, Release 4.x.
 
    [bookmark: pgfId-1207391]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1205222][bookmark: 32228]Finding and Resolving vPC Configuration Inconsistencies[bookmark: marker-1231486]
 
    [bookmark: pgfId-1207460]You can use the topology map to find vPCs that have configuration inconsistencies and open the Resolve Configuration Inconsistency dialog box.
 
   
 
    
     [bookmark: pgfId-1207497]DETAILED STEPS
 
    [bookmark: pgfId-1207518]To find and resolve vPC configuration inconsistencies, follow these steps:
 
    
 
    [bookmark: pgfId-1207557]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1207558]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1207803]Step 2 Above the map, click one of the following views:
 
     
      
      	 [bookmark: pgfId-1207804] PortChannel and vPC 
 
      	 [bookmark: pgfId-1207805] Logical vPC View 
 
     
 
    
 
    [bookmark: pgfId-1207693]Step 3 Locate the vPC for which you want to resolve configuration inconsistencies.
 
    [bookmark: pgfId-1207895]If a vPC link has configuration inconsistencies, a red ellipse appears over the link. If you use the PortChannel and vPC view, vPC peer links with configuration inconsistencies also show a red ellipse.
 
    [bookmark: pgfId-1207955]Step 4 (Optional) If you want to resolve configuration inconsistencies now, do one of the following:
 
     
      
      	 [bookmark: pgfId-1207956]To resolve configuration inconsistencies for the vPC link  and the vPC peer link, right-click the red ellipse on the vPC link and choose  Launch Configuration Consistency .
 
      	 [bookmark: pgfId-1207971]To resolve configuration inconsistencies for the vPC peer link only, right-click the red ellipse on the vPC link and choose  Launch Configuration Consistency .
 
     
 
    
 
    [bookmark: pgfId-1207981]The Resolve Configuration Inconsistency dialog box opens.
 
    [bookmark: pgfId-1209627]For more information about using the Resolve Configuration Inconsistencies dialog box, see the Cisco DCNM Interfaces Configuration Guide, Release 4.x.
 
    [bookmark: pgfId-1209631]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1209633][bookmark: 23733]Accessing Other Cisco DCNM Features from the Topology Map[bookmark: marker-1231487]
 
    [bookmark: pgfId-1207959]You can use the topology map to access other features for managed devices. From the topology map, you can access features that are found in the following Feature Selector drawers:
 
     
     	 [bookmark: pgfId-1172959]Inventory
 
     	 [bookmark: pgfId-1172960]Virtual Devices
 
     	 [bookmark: pgfId-1172961]Interfaces
 
     	 [bookmark: pgfId-1192856]Routing
 
     	 [bookmark: pgfId-1172971]Switching
 
     	 [bookmark: pgfId-1172992]Security
 
    
 
    [bookmark: pgfId-1173015]You can also use the topology map to access the Device Discovery feature.
 
   
 
    
     [bookmark: pgfId-1173059]DETAILED STEPS
 
    [bookmark: pgfId-1173097]To access a feature from the topology map, follow these steps:
 
    
 
    [bookmark: pgfId-1174265]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1174266]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1174267]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1173124]Step 2 If you want to access a Cisco DCNM feature for a specific managed device, do the following:
 
    [bookmark: pgfId-1174820] a. Find the device in the topology map.
 
    [bookmark: pgfId-1174856] b. Right-click the device and choose the feature that you want to configure.
 
    [bookmark: pgfId-1174864]The feature that you selected appears in the Contents pane. The device that you selected on the topology map is selected in the Summary table for the feature.
 
    [bookmark: pgfId-1174757]Step 3 If you want to access the Device Discovery feature, right-click a blank area on the map and choose Discover Devices.
 
    [bookmark: pgfId-1174794]The Device Discovery feature appears in the Contents pane.
 
    [bookmark: pgfId-1173125]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1172822][bookmark: 57614]Moving Devices in the Topology Map[bookmark: marker-1176354]
 
    [bookmark: pgfId-1171502]You can move device icons that are shown in the topology map. The position of devices is shared by all the topology views, that is, if you move a device and then change to another topology view, the device remains where you moved it to.
 
    [bookmark: pgfId-1172214]You can also save the layout, which you can reload later if you make additional changes and want to revert to your last save. For more information, see the “Reloading the Previously Saved Layout” section.
 
    [bookmark: pgfId-1172399]The saved layout becomes the default layout that you see in the topology map when you start the Cisco DCNM client.
 
     
      
    
 
    
 
    [bookmark: pgfId-1172218]Note The Cisco DCNM client saves topology layouts as local user data on the computer that runs the Cisco DCNM client. When you are using the Cisco DCNM client, you do not have access to topology layouts that you saved on other computers or that you saved while logged in to the computer under a different username.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1172219]DETAILED STEPS
 
    [bookmark: pgfId-1171514]To move devices in the topology map, follow these steps:
 
    
 
    [bookmark: pgfId-1174280]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1174281]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1174282]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1171534]Step 3 Find and move device icons as needed. To move an icon, click on the device icon, hold down the mouse button, drag the icon to the new location, and release the mouse button.
 
    [bookmark: pgfId-1171671]You can zoom and pan as needed to find icons. For more information, see the “Using the Viewing Tools” section.
 icon. 
    
 
    [bookmark: pgfId-1171641]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1171875][bookmark: 71895]Loading a Layout[bookmark: marker-1231491]
 
    [bookmark: pgfId-1201198]When you are using the Physical View, you can choose to load a layout. The position of devices is shared by all the topology views. This behavior allows you to use any of the layouts in all views by loading the layout in the Physical View and then choosing another view.
 
     
      
    
 
    
 
   
 
   
 
    
     [bookmark: pgfId-1199788]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1204251]Determine which physical devices, if any, that you want to specify as core switches. When you load a layout other than a saved layout, core switches appear at the top of the topology map, and devices that are one CDP hop from the core switches appear just below them.
 
   
 
    
     [bookmark: pgfId-1204233]DETAILED STEPS
 
    [bookmark: pgfId-1199969]To load a topology layout in Physical View, follow these steps:
 
    
 
    [bookmark: pgfId-1199970]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1199971]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1200002]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1200003]Step 2 (Optional) For each physical device that you want to appear at the top of the layout, right-click on the device icon and choose Make as Core Switch.
 icon. 
    
 
    [bookmark: pgfId-1200004]The Layout drop-down list appears.
 
    [bookmark: pgfId-1200039]Step 4 From the Layout drop-down list, select the layout that you want to load.
 
    [bookmark: pgfId-1200038]The Physical View of the topology map changes to the layout that you selected. Any devices that you specified as core switches appear at the top of the map, with devices that are one CDP hop away from the core switches appearing just below them.
 
    [bookmark: pgfId-1199978]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1199943][bookmark: 55331]Reloading the Previously Saved Layout[bookmark: marker-1231492]
 
    [bookmark: pgfId-1171876]You can load the most recently saved layout. This feature allows you to undo changes to device placement that you have made since you last saved the layout.
 
     
      
    
 
    
 
    [bookmark: pgfId-1172310]Note The Cisco DCNM client saves topology layouts as local user data on the computer that runs the Cisco DCNM client. When you are using the Cisco DCNM client, you do not have access to topology layouts that you saved on other computers or that you saved while logged in to the computer under a different username.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1171391]DETAILED STEPS
 
    [bookmark: pgfId-1171398]To reload the most recent saved topology layout, follow these steps:
 
    
 
    [bookmark: pgfId-1174294]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1174295]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1174296]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1171855]The topology map changes to the most recent layout that you saved.
 
    [bookmark: pgfId-1171430]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1171998][bookmark: 55986]Exporting the Topology as a JPG Image[bookmark: marker-1176371]
 
    [bookmark: pgfId-1171999]You can export, or save, a JPG image of the topology map. The JPG image created shows only the portion of the topology that appears in the Cisco DCNM client at the moment that you save the JPG file.
 
   
 
    
     [bookmark: pgfId-1171972]DETAILED STEPS
 
    [bookmark: pgfId-1171979]To export the visible portion of the topology map as a JPG image, follow these steps:
 
    
 
    [bookmark: pgfId-1174304]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1174305]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1174306]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1174903]Step 2 View the portion of the topology map that you want to save. For more information, see the “Using the Viewing Tools” section.
 
    [bookmark: pgfId-1175544]Step 3 Arrange the device icons as desired. For more information, see the “Moving Devices in the Topology Map” section.
 icon. 
    
 
    [bookmark: pgfId-1175550]A dialog box appears.
 
    [bookmark: pgfId-1174923]Step 5 Specify the location and filename of the JPG image and click Save.
 
    [bookmark: pgfId-1181167]The JPG image of the visible portion of the topology map is saved.
 
    [bookmark: pgfId-1181168]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1260074][bookmark: 12973]Related Documents
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1260078]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1260080]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1260082]VDCs
  
        	[bookmark: pgfId-1260086]Cisco DCNM Virtual Device Context Configuration Guide, Release 4.x
  
       
 
        
        	[bookmark: pgfId-1260089]vPCs
  
        	[bookmark: pgfId-1260094]Cisco DCNM Interfaces Configuration Guide, Release 4.x
  
       
 
        
        	[bookmark: pgfId-1260103]Device discovery
  
        	[bookmark: pgfId-1260108]Administering Device Discovery
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1260111][bookmark: 92503]Feature History for Topology
 
     
      
       
       [bookmark: pgfId-1260122]Table 9-1 [bookmark: 50557]Feature History for Topology 
 
       
       
        
        	 
          
          [bookmark: pgfId-1260128]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1260130]Releases 
         
  
        	 
          
          [bookmark: pgfId-1260132]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1260134]Topology
  
        	[bookmark: pgfId-1260136]4.2(1)
  
        	[bookmark: pgfId-1260138]Support for hierarchical and grid layouts was removed.
  
       
 
        
        	[bookmark: pgfId-1261608]vPC support
  
        	[bookmark: pgfId-1261626]4.1(2)
  
        	[bookmark: pgfId-1261612]This feature was added to the topology map.
  
       
 
        
        	[bookmark: pgfId-1261602]Multiple views
  
        	[bookmark: pgfId-1261632]4.1(2)
  
        	[bookmark: pgfId-1261606]This feature was added to the topology map.
  
       
 
        
        	[bookmark: pgfId-1261622]Topology
  
        	[bookmark: pgfId-1261624]4.1(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1068256][bookmark: 29826]Managing [bookmark: marker-1068254]Events 
      
      
 
     
 
 
    [bookmark: pgfId-1101168]This chapter describes how to use the Event Browser and feature-specific Events tabs in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1101173]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1101177]Information About Events
 
     	 [bookmark: pgfId-1101181]Licensing Requirements for the Event Browser
 
     	 [bookmark: pgfId-1101185]Prerequisites for Events
 
     	 [bookmark: pgfId-1101189]Guidelines and Limitations
 
     	 [bookmark: pgfId-1101193]Using the Event Browser and Events Tabs
 
     	 [bookmark: pgfId-1101197]Field Descriptions for Events
 
     	 [bookmark: pgfId-1101201]Related Documents
 
     	 [bookmark: pgfId-1101205]Feature History for the Event Browser and Events Tabs
 
    
 
   
 
    
     [bookmark: pgfId-1101207][bookmark: 69949]Information About Events
 
    [bookmark: pgfId-1101208]Cisco DCNM allows you to view and manage recent status events. An event can be either of the following:
 
     
     	 [bookmark: pgfId-1101209]A status-related system message that Cisco DCNM retrieves from managed devices. For more information, see the “Logfile Requirements” section.
 
     	 [bookmark: pgfId-1101213]A message generated by the Cisco DCNM server.
 
    
 
    [bookmark: pgfId-1101214]The Cisco DCNM client includes the Event Browser and feature-specific Events tabs that appears in the Details pane for features that can have events. The Event Browser shows all recent status events while a feature-specific Events tab shows recent status events that pertain to the feature. The Cisco DCNM client updates the Event Browser and Events tabs dynamically when it receives new events from the server.
 
    [bookmark: pgfId-1101215]In the Event Browser and on Events tabs, you can change the status of an event, add notes to an event, or delete an event.
 
    [bookmark: pgfId-1101216]In addition, the Event Browser provides a pie chart and a bar chart of events separated by the event severity. You can also delete individual events from the events database.
 
    [bookmark: pgfId-1061211]To control the minimum severity of event messages, you configure the logging level for Cisco NX-OS features and for Cisco DCNM server features. For more information, see the “Cisco NX-OS System-Message Logging Requirements” section.
 
     
      
    
 
    
 
    [bookmark: pgfId-1061220]Note Cisco DCNM has minimum logging level requirements for managed Cisco NX-OS devices. Logging levels on a managed device should never be lower than the minimum requirements.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1061255]For more information about Cisco DCNM server logging levels, see Chapter17, “Administering DCNM Server Log Settings”
 
     
      
    
 
    
 
    [bookmark: pgfId-1061374]Note Configuring Cisco DCNM server log settings does not affect logging levels on managed Cisco NX-OS devices.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1101244][bookmark: 29596]Licensing Requirements for the Event Browser
 
    [bookmark: pgfId-1101245]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1101258]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1101248]Product 
         
  
        	 
          
          [bookmark: pgfId-1101250]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1101252]Cisco DCNM
  
        	[bookmark: pgfId-1101254]The Event Browser requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1101260][bookmark: 16098]Prerequisites for Events
 
    [bookmark: pgfId-1101261]The Event Browser has the following prerequisites:
 
     
     	 [bookmark: pgfId-1101262]You should be familiar with Cisco NX-OS system messages.
 
     	 [bookmark: pgfId-1101263]Managed Cisco NX-OS devices must be configured to send system messages to the Cisco DCNM server.
 
    
 
   
 
    
     [bookmark: pgfId-1101265][bookmark: 58316]Guidelines and Limitations
 
    [bookmark: pgfId-1101266]The Event Browser has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1101267]The Event Browser and feature-specific Events tabs display only status events, which are events generated when the status of a feature or object changes. For example, configuration events do not appear in the Event Browser or on an Events tab.
 
     	 [bookmark: pgfId-1101268]The Event Browser can display event messages that are no older than 24 hours when you start the Cisco DCNM client. By default, the Cisco DCNM client fetches from the server messages that are no older than 1 hour.
 
     	 [bookmark: pgfId-1101269]The Event Browser can display up to 2000 events. The events database is limited by the amount of space available to the database.
 
     	 [bookmark: pgfId-1101270]You cannot use Cisco DCNM to control the logging levels of managed Cisco NX-OS devices. For more information, see the “Cisco NX-OS System-Message Logging Requirements” section.
 
     	 [bookmark: pgfId-1101274]We recommend that you delete events that you no longer need or that you have resolved. For information about deleting old events from the events database, see the “Deleting Data from the Events Database” section.
 
    
 
   
 
    
     [bookmark: pgfId-1101280][bookmark: 24305][bookmark: 71793]Using the Event Browser and Events Tabs
 
    [bookmark: pgfId-1101284]Figure 10-1 shows the Event Browser content pane.
 
    [bookmark: pgfId-1101286]Figure 10-1 [bookmark: 60141]Event Browser Content Pane
 
    [bookmark: pgfId-1101290]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1101291]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1101295]Viewing the Event Browser
 
     	 [bookmark: pgfId-1101299]Applying and Removing an Event Filter
 
     	 [bookmark: pgfId-1101303]Viewing Events on an Events Tab
 
     	 [bookmark: pgfId-1101307]Changing the Status of an Event
 
     	 [bookmark: pgfId-1101311]Adding a Note to One or More Events
 
     	 [bookmark: pgfId-1101315]Deleting an Event
 
    
 
     
      [bookmark: pgfId-1053641][bookmark: 62663]Viewing the Event Browser[bookmark: marker-1056103]
 
     [bookmark: pgfId-1053642]You can use the Event Browser to view recent events and a summary chart of those events. By default, the Event Browser shows events that occurred up to 1 hour prior to starting the Cisco DCNM client. For more information, see the “Configuring the Maximum Age of Events Fetched from the Server” section.
 
    
 
     
      [bookmark: pgfId-1053646]DETAILED STEPS
 
     [bookmark: pgfId-1053647]To view the Event Browser, follow these steps:
 
     
 
     [bookmark: pgfId-1052110]Step 1 From the Feature Selector pane, choose Event Browser.
 
     [bookmark: pgfId-1052131]The event table appears in the Contents pane. A summary chart appears above the Feature Selector pane.
 
     [bookmark: pgfId-1083133]Step 2 (Optional) If you want to change the summary chart that appears, above the Feature Selector, choose one of the following Chart Type options, as needed:
 
      
       
       	 [bookmark: pgfId-1083143]Bar Chart
 
       	 [bookmark: pgfId-1083179]Pie Chart
 
      
 
     
 
     [bookmark: pgfId-1082159]The colors of the chart correspond to event severity levels, as indicated in the legend that appears above the chart.
 
     [bookmark: pgfId-1083598]Step 3 (Optional) If you want to sort or filter events, you can use one or more of the filtering features as described in the following table:
 
     [bookmark: pgfId-1082176]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1082191]Event Sorting and Filtering Feature 
          
  
         	 
           
           [bookmark: pgfId-1082193]How to Use 
          
  
        
 
         
         	[bookmark: pgfId-1082195]Alphabetical sorting by column
  
         	[bookmark: pgfId-1082197]Click the column heading to cycle through the sorting options, as follows:
 
           
           	 [bookmark: pgfId-1082254]First click—Events are sorted by ascending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082299]Second click—Events are sorted by descending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082346]Third click—Events are not sorted by the values in the column.
 
          
  
        
 
         
         	[bookmark: pgfId-1082199]Event Filter
  
         	[bookmark: pgfId-1082201]See the “Applying and Removing an Event Filter” section.
  
        
 
         
         	[bookmark: pgfId-1082203]Filter by Column Values
  
         	[bookmark: pgfId-1082205] 1. From the menu bar, choose View > Filter.
 [bookmark: pgfId-1082453]The column headings become drop-down lists.
 [bookmark: pgfId-1082432] 2. From each column heading list that you want to use to filter events, choose the value that events appearing in the Event Browser must include.
  
        
 
         
         	[bookmark: pgfId-1082207]Filter by text
  
         	[bookmark: pgfId-1082536]In the Event Browser toolbar, enter the text that you want to use to filter the events.
 [bookmark: pgfId-1082209]The Event Browser shows only the events that contain the text that you enter.
 [bookmark: pgfId-1082550]Tip To configure quick filtering options, use the drop-down list of the Event Browser toolbar.  
        
 
        
      
 
     
 
     [bookmark: pgfId-1052119]Step 4 (Optional) If you want to view details about a specific event, follow these steps:
 
     [bookmark: pgfId-1052141] a. Find the event in the event list.
 
     [bookmark: pgfId-1052146] b. Click the event.
 
     [bookmark: pgfId-1052147] c. Expand the Details pane, if necessary.
 
     [bookmark: pgfId-1052150]Details about the selected event appear in the Details pane.
 
     [bookmark: pgfId-1052687] d. (Optional) To read notes and messages about status changes to the event, read the information in the Action Log field.
 
     [bookmark: pgfId-1052154]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1065483][bookmark: 11851]Applying and Removing an Event Filter[bookmark: marker-1065482]
 
     [bookmark: pgfId-1065484]You can filter events in the Event Browser by the following criteria:
 
      
      	 [bookmark: pgfId-1065761]Event date and time—By default, the Cisco DCNM client displays all events received after you started the Cisco DCNM client and for a configurable number of hours prior to starting the Cisco DCNM client (for more information, see the “Configuring the Maximum Age of Events Fetched from the Server” section).
 
      	 [bookmark: pgfId-1065777]Event severity—By default, the Cisco DCNM client displays events of all severities.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085065]Note When you apply an event filter, the Events tab continues to display events when the Cisco DCNM server receives them. The filter criteria that you select only affect the Filtered Events tab.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067857]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1067893]If the message “Filter Applied” appears at the top of the Contents pane, the Cisco DCNM client is applying an event filter to the Event Browser.
 
    
 
     
      [bookmark: pgfId-1065494]DETAILED STEPS
 
     [bookmark: pgfId-1065495]To apply or remove an event filter in the Event Browser, follow these steps:
 
     
 
     [bookmark: pgfId-1082807]Step 1 View events in the Event Browser (see the “Viewing the Event Browser” section).
 
     [bookmark: pgfId-1082809]Step 2 If you want to apply an event filter, follow these steps:
 
     [bookmark: pgfId-1082810] a. From the menu bar, choose View > Event Filter.
 
     [bookmark: pgfId-1066132] b. Check the Apply Filter check box.
 
     [bookmark: pgfId-1066149] c. Configure the filter criteria.
 
     [bookmark: pgfId-1066133] d. Click OK.
 
     [bookmark: pgfId-1066134]A Filtered Events tab appears in the Event Browser. The tab displays the events that match the filtering criteria that you specified. The message “Filter Applied” appears at the top of the Contents pane.
 
     [bookmark: pgfId-1065835]Step 3 If you want to remove an event filter, follow these steps:
 
     [bookmark: pgfId-1068386] a. From the menu bar, choose View > Event Filter.
 
     [bookmark: pgfId-1066035] b. Uncheck the Apply Filter check box.
 
     [bookmark: pgfId-1066073] c. Click OK.
 
     [bookmark: pgfId-1066107]The Filtered Events tab disappears. No message appears at the top of the Contents pane.
 
     [bookmark: pgfId-1065509]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1052604][bookmark: 40404]Viewing Events on an Events Tab[bookmark: marker-1056104]
 
     [bookmark: pgfId-1073297]You can view feature-specific events on the Events tab that appears in the Details pane for a feature. By default, an Events tab shows events received up to 1 hour prior to starting the Cisco DCNM client. For more information, see the “Configuring the Maximum Age of Events Fetched from the Server” section.
 
    
 
     
      [bookmark: pgfId-1073368]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1073369]Typically, the Events tab appears when, in the Summary pane, you select an object that can have events associated with it. For example, if you select Interfaces > Physical > Ethernet from the Feature Selector pane, the Summary pane displays devices. Devices contain slots, and slots contain Ethernet ports. When you select a device, slot, or port, the Details pane displays an Events tab. 
 
     [bookmark: pgfId-1073308]What you select in the Summary pane affects which events are shown in the tab. Continuing the Ethernet interface example, the scope of the events in the Events tab depends on what you select, as follows:
 
      
      	 [bookmark: pgfId-1052509]Device—Events that pertain to the selected device, any slot within the device, and any Ethernet interface within the slot.
 
      	 [bookmark: pgfId-1052512]Slot—Events that pertain to the selected slot and to any Ethernet interface within the slot.
 
      	 [bookmark: pgfId-1052513]Port—Events that pertain to the selected Ethernet interface.
 
     
 
    
 
     
      [bookmark: pgfId-1052487]DETAILED STEPS
 
     [bookmark: pgfId-1052481]To view an event on an Events tab, follow these steps:
 
     
 
     [bookmark: pgfId-1052482]Step 1 From the Feature Selector pane, choose the feature for which you want to view events.
 
     [bookmark: pgfId-1052465]For example, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1052473]Step 2 From the Summary pane, select an object.
 
     [bookmark: pgfId-1052522]The Events tab appears in the Details pane. In the Events tab, the events table appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1052527]Note If no Events tab appears, then Cisco DCNM cannot display events for the object you selected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1082629]Step 3 (Optional) If you want to sort or filter events, you can use one or more of the filtering features as described in the following table:
 
     [bookmark: pgfId-1082661]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1082632]Event Sorting and Filtering Feature 
          
  
         	 
           
           [bookmark: pgfId-1082634]How to Use 
          
  
        
 
         
         	[bookmark: pgfId-1082636]Alphabetical sorting by column
  
         	[bookmark: pgfId-1082638]Click the column heading to cycle through the sorting options, as follows:
 
           
           	 [bookmark: pgfId-1082639]First click—Events are sorted by ascending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082640]Second click—Events are sorted by descending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082641]Third click—Events are not sorted by the values in the column.
 
          
  
        
 
         
         	[bookmark: pgfId-1082650]Filter by Column Values
  
         	[bookmark: pgfId-1082652] 1. From the menu bar, choose View > Filter.
 [bookmark: pgfId-1082653]The column headings become drop-down lists.
 [bookmark: pgfId-1082654] 2. From each column heading list that you want to use to filter events, choose the value that events appearing in the Events tab must include.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1067050]Step 4 (Optional) If you want to view details about a specific event, follow these steps:
 
     [bookmark: pgfId-1052547] a. Find the event in the event list.
 
     [bookmark: pgfId-1052549] b. Click the event.
 
     [bookmark: pgfId-1052550] c. Expand the Details pane, if necessary.
 
     [bookmark: pgfId-1052653]Details about the selected event appear in the Details pane.
 
     [bookmark: pgfId-1052682] d. (Optional) To read notes and messages about status changes to the event, read the information in the Action Log field.
 
     [bookmark: pgfId-1052540]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1052975][bookmark: 63537]Changing the Status of an Event[bookmark: marker-1056105]
 
     [bookmark: pgfId-1052977]You can change the status of an event to one of the following statuses:
 
      
      	 [bookmark: pgfId-1082125]Acknowledged—Shown as a green check mark.
 
      	 [bookmark: pgfId-1053330]Closed—Shown as a yellow folder.
 
     
 
     [bookmark: pgfId-1053008]By default, the status of new event is Open, which is indicated in the Annotation column by a green check mark with a red slash across it.
 
    
 
     
      [bookmark: pgfId-1052978]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1052979]Select an event in the Event Browser or on an Events tab for a specific feature. For more information, see the “Viewing the Event Browser” section or the “Viewing Events on an Events Tab” section.
 
    
 
     
      [bookmark: pgfId-1052895]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1052896]Step 1 In the event table, right-click the selected event.
 
     [bookmark: pgfId-1052897]Step 2 Choose Acknowledge or Open, as needed.
 
     [bookmark: pgfId-1053412]The new status appears in the Annotation column for the selected event.
 
     [bookmark: pgfId-1053443]In the Details pane, the message about the status change appears in the Action Log field.
 
     [bookmark: pgfId-1052898]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1056122][bookmark: 64608]Adding a Note to One or More Events[bookmark: marker-1056135]
 
     [bookmark: pgfId-1056123]You can add a note to one or more events. Notes can contain 1 to 1000 characters.
 
    
 
     
      [bookmark: pgfId-1052923]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1052924]Find the events to which you want to add a note. For more information, see the “Viewing the Event Browser” section or the “Viewing Events on an Events Tab” section.
 
    
 
     
      [bookmark: pgfId-1053458]DETAILED STEPS
 
     [bookmark: pgfId-1067988]To add a note to one or more events, follow these steps:
 
     
 
     [bookmark: pgfId-1053459]Step 1 Select one or more events. Do one of the following:
 
      
       
       	 [bookmark: pgfId-1068031]To select one event, click the one event that you want to select.
 
       	 [bookmark: pgfId-1068114]To select two or more adjacent events, click and drag across the events.
 
       	 [bookmark: pgfId-1068091]To select two more events, press and hold  Ctrl and click each event.
 
      
 
     
 
     [bookmark: pgfId-1067997]Step 2 On one of the selected events, right-click and then choose Add Notes.
 
     [bookmark: pgfId-1068005]The Notes dialog box appears.
 
     [bookmark: pgfId-1053460]Step 3 Enter the note. You can enter up to 1000 case-sensitive, alphanumeric characters.
 
     [bookmark: pgfId-1053480]Step 4 Click OK.
 
     [bookmark: pgfId-1053488]The note appears in the Action Log field for each selected event.
 
     [bookmark: pgfId-1052934]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1053057][bookmark: 92871]Deleting an Event[bookmark: marker-1056136]
 
     [bookmark: pgfId-1053059]You can delete one or more events from the Event Browser or a feature-specific Events tab. A deleted event no longer appears in the Event Browser or on a feature-specific Events tab; however, the event remains in the events database.
 
     [bookmark: pgfId-1062631]For information about deleting old events from the events database, see the “Deleting Data from the Events Database” section.
 
    
 
     
      [bookmark: pgfId-1053060]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1052762]Select an event in the Event Browser or on an Events tab for a specific feature. For more information, see the “Viewing the Event Browser” section or the “Viewing Events on an Events Tab” section.
 
    
 
     
      [bookmark: pgfId-1052769]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1052778]Step 1 In the event table, select one or more events that you want to delete.
 
      
       
     
 
     
 
     [bookmark: pgfId-1053124]Note To select more than one event, you can click and drag across the events or you can press and hold Ctrl and click each event.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1053092]Step 2 Right-click a selected event.
 
     [bookmark: pgfId-1052784]Step 3 Choose Remove Event.
 
     [bookmark: pgfId-1053131]The selected events disappear from the Event Browser.
 
     [bookmark: pgfId-1052785]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1101498][bookmark: 58163]Field Descriptions for Events
 
    [bookmark: pgfId-1101499]This section includes the following field descriptions for Events:
 
     
     	 [bookmark: pgfId-1101503]Events Table
 
     	 [bookmark: pgfId-1101507]Event Details
 
    
 
     
      [bookmark: pgfId-1101509][bookmark: 50779]Events Table
 
     [bookmark: pgfId-1101510]The events table appears in the Event Browser and on feature-specific Events tabs.
 
     [bookmark: pgfId-1101562]
 
      
       
        
        [bookmark: pgfId-1101516]Table 10-1 Events Table 
 
        
        
         
         	 
           
           [bookmark: pgfId-1101520]Field 
          
  
         	 
           
           [bookmark: pgfId-1101522]Description 
          
  
        
 
         
         	[bookmark: pgfId-1101524]Device
  
         	[bookmark: pgfId-1101526]Display only. Name and IP address of the device that the event is related to.
  
        
 
         
         	[bookmark: pgfId-1101528]Source
  
         	[bookmark: pgfId-1101530]Display only. Where the event message originated. Sources are either a feature on a managed Cisco NX-OS device or the Cisco DCNM server.
  
        
 
         
         	[bookmark: pgfId-1101532]Feature
  
         	[bookmark: pgfId-1101534]Display only. Name of the Cisco NX-OS or Cisco DCNM server feature that the event pertains to.
  
        
 
         
         	[bookmark: pgfId-1101536]Time
  
         	[bookmark: pgfId-1101538]Display only. Date and time that the event occurred.
  
        
 
         
         	[bookmark: pgfId-1101540]Severity
  
         	[bookmark: pgfId-1101542]Display only. Severity of the event. Possible severities are as follows:
 
           
           	 [bookmark: pgfId-1101543]Emergency
 
           	 [bookmark: pgfId-1101544]Alert
 
           	 [bookmark: pgfId-1101545]Critical
 
           	 [bookmark: pgfId-1101546]Error
 
           	 [bookmark: pgfId-1101547]Warning
 
           	 [bookmark: pgfId-1101548]Notification
 
           	 [bookmark: pgfId-1101549]Informational
 
           	 [bookmark: pgfId-1101550]Debug
 
          
  
        
 
         
         	[bookmark: pgfId-1101552]Message
  
         	[bookmark: pgfId-1101554]Display only. Text of the event.
  
        
 
         
         	[bookmark: pgfId-1101556]Annotation
  
         	[bookmark: pgfId-1101558]Status of the event. Possible statuses are as follows:
 
           
           	 [bookmark: pgfId-1101559]Open—The default status of an event. You cannot assign an event the status of Open.
 
           	 [bookmark: pgfId-1101560]Acknowledged
 
           	 [bookmark: pgfId-1101561]Closed
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1101564][bookmark: 91295]Event Details
 
     [bookmark: pgfId-1101565]Event details appear below the events table in the Event Browser and on feature-specific Events tabs.
 
     [bookmark: pgfId-1101602]
 
      
       
        
        [bookmark: pgfId-1101571]Table 10-2 Event Details 
 
        
        
         
         	 
           
           [bookmark: pgfId-1101575]Field 
          
  
         	 
           
           [bookmark: pgfId-1101577]Description 
          
  
        
 
         
         	[bookmark: pgfId-1101579]Event Type
  
         	[bookmark: pgfId-1101581]Display only. Type of the event. Event types are categories that describe the general nature of the event. Possible event types are as follows:
 
           
           	 [bookmark: pgfId-1101582]Communication
 
           	 [bookmark: pgfId-1101583]Environmental
 
           	 [bookmark: pgfId-1101584]Equipment
 
           	 [bookmark: pgfId-1101585]Processing Error
 
           	 [bookmark: pgfId-1101586]Quality of Service
 
           	 [bookmark: pgfId-1101587]Security
 
           	 [bookmark: pgfId-1101588]Unknown
 
          
  
        
 
         
         	[bookmark: pgfId-1101590]Action Log
  
         	[bookmark: pgfId-1101592]Shows all actions taken on the event and all notes added to the event.
  
        
 
         
         	[bookmark: pgfId-1101594]Life Cycle Type
  
         	[bookmark: pgfId-1101596]Display only. Type of life cycle of the event. Possible life cycle types are as follows:
 
           
           	 [bookmark: pgfId-1101597]State Change
 
           	 [bookmark: pgfId-1101598]Attribute Value Change
 
           	 [bookmark: pgfId-1101599]Instance Creation
 
           	 [bookmark: pgfId-1101600]Instance Deletion
 
           	 [bookmark: pgfId-1101601]Informational
 
          
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1101604][bookmark: 12973]Related Documents
 
    [bookmark: pgfId-1101635]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1101607]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1101609]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1101611]Minimum required Cisco NX-OS logging levels
  
        	[bookmark: pgfId-1101616]Logging Severity-Level Requirements
  
       
 
        
        	[bookmark: pgfId-1101618]Cisco DCNM server log settings
  
        	[bookmark: pgfId-1101623]Administering DCNM Server Log Settings
  
       
 
        
        	[bookmark: pgfId-1101625]Deleting events from the events database
  
        	[bookmark: pgfId-1101630]Deleting Data from the Events Database
  
       
 
        
        	[bookmark: pgfId-1101632]Cisco NX-OS system messages
  
        	[bookmark: pgfId-1101634]Cisco NX-OS System Messages Reference
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1101637][bookmark: 92503]Feature History for the Event Browser and Events Tabs
 
    [bookmark: pgfId-1101641]Table 10-3 lists the release history for this feature.
 
    [bookmark: pgfId-1101662]
 
     
      
       
       [bookmark: pgfId-1101645]Table 10-3 [bookmark: 50557]Feature History for the Event Browser and Events Tabs
 
       
       
        
        	 
          
          [bookmark: pgfId-1101651]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1101653]Releases 
         
  
        	 
          
          [bookmark: pgfId-1101655]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1104126]Event Browser and Events tabs
  
        	[bookmark: pgfId-1104128]4.2(1)
  
        	[bookmark: pgfId-1104130]No change from Release 4.1
  
       
 
        
        	[bookmark: pgfId-1104132]Event filter results shown in a Filtered Events tab
  
        	[bookmark: pgfId-1104134]4.1(2)
  
        	[bookmark: pgfId-1104136]This feature was added to the Event Browser.
  
       
 
        
        	[bookmark: pgfId-1101657]Event Browser and Events tabs
  
        	[bookmark: pgfId-1104146]4.1(2)
  
        	[bookmark: pgfId-1101661]No change from Release 4.0
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1085241]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1050709][bookmark: 28199]Working with Inventory 
      
      
 
     
 
 
    [bookmark: pgfId-1115455]This chapter describes how to use the Inventory feature in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1115456]This chapter has the following sections:
 
     
     	 [bookmark: pgfId-1115460]Information About Inventory
 
     	 [bookmark: pgfId-1115464]Licensing Requirements for Inventory
 
     	 [bookmark: pgfId-1115468]Prerequisites for Inventory
 
     	 [bookmark: pgfId-1115472]Displaying the Chassis Information
 
     	 [bookmark: pgfId-1115476]Displaying the Module Information
 
     	 [bookmark: pgfId-1115480]Displaying the Power Supply Information
 
     	 [bookmark: pgfId-1115484]Displaying the Fan Tray Information
 
     	 [bookmark: pgfId-1115488]Feature History for Inventory
 
    
 
   
 
    
     [bookmark: pgfId-1115490][bookmark: 90497]Information About Inventory
 
    [bookmark: pgfId-1095524]The Inventory feature, shown in Figure 11-1, displays information about the chassis, modules, fan trays, and power supplies for managed devices. The Cisco DCNM client can display summary and detailed information for these device components.
 
    [bookmark: pgfId-1115504]Figure 11-1 [bookmark: 34687]Inventory Contents Pane
 
    [bookmark: pgfId-1115508]
 
     
     [image: ] 
    
 
   
 
    
     [bookmark: pgfId-1115510][bookmark: 51127]Licensing Requirements for Inventory
 
    [bookmark: pgfId-1115511]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1115524]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1115514]Product 
         
  
        	 
          
          [bookmark: pgfId-1115516]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1115518]Cisco DCNM
  
        	[bookmark: pgfId-1115520]Inventory requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1115526][bookmark: 78783]Prerequisites for Inventory
 
    [bookmark: pgfId-1115527]The Inventory feature has the following prerequisite:
 
     
     	 [bookmark: pgfId-1115528]The physical device must be managed by Cisco DCNM.
 
    
 
   
 
    
     [bookmark: pgfId-1115530][bookmark: 69153]Displaying the Chassis Information
 
    [bookmark: pgfId-1115531]Cisco DCNM displays summary, detail, environmental, and event information for the chassis.
 
    [bookmark: pgfId-1115532]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1115536]Displaying the Chassis Summary Information
 
     	 [bookmark: pgfId-1115540]Displaying the Chassis Detail information
 
     	 [bookmark: pgfId-1115544]Displaying the Chassis Environmental Status
 
     	 [bookmark: pgfId-1115548]Displaying the Chassis CPU Utilization
 
     	 [bookmark: pgfId-1115552]Displaying the Chassis Memory Utilization
 
     	 [bookmark: pgfId-1115556]Displaying the Chassis Events
 
    
 
     
      [bookmark: pgfId-1058752][bookmark: 55697]Displaying the Chassis Summary Information
 
     [bookmark: pgfId-1059449]Cisco DCNM displays the chassis summary information for each device it manages when you choose Inventory in the Feature Selector pane. The summary information includes the chassis description, product ID, serial number, hardware version, software version, status, temperature, and events.[bookmark: marker-1061048]
 
    
 
     
      [bookmark: pgfId-1060228]DETAILED STEPS
 
     [bookmark: pgfId-1060237]To display the summary information for a chassis, from the Feature Selector pane, choose Inventory. The summary pane displays summary information for each managed device.
 
    
 
     
      [bookmark: pgfId-1058536][bookmark: 95419]Displaying the Chassis Detail information
 
     [bookmark: pgfId-1065854]Cisco DCNM displays the chassis detail information for the device that you choose in the Summary pane. This detail information includes hardware and software information. The hardware information includes the switch name, product ID, IP address, serial number, chassis description[bookmark: marker-1065855].
 
    
 
     
      [bookmark: pgfId-1069100]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1065869]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1065870]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1065871]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1065872]Tabs appear in the Details pane. The Details tab shows the hardware and software information.
 
     [bookmark: pgfId-1065875]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1062046][bookmark: 24062]Displaying the Chassis Environmental Status
 
     [bookmark: pgfId-1062047]Cisco DCNM displays the chassis environmental status information for the device that you choose in the Summary pane. The environmental information includes power usage information and information about supervisor and power supply redundancy[bookmark: marker-1062048].
 
    
 
     
      [bookmark: pgfId-1062049]DETAILED STEPS
 
     [bookmark: pgfId-1062050]To display the environmental status for a chassis, follow these steps:
 
     
 
     [bookmark: pgfId-1062051]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1062052]Summary information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1062053]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1062054]Tabs appear in the Details pane.
 
     [bookmark: pgfId-1062249]Step 3 From the Details pane, click the Environmental Status tab.
 
     [bookmark: pgfId-1062270]Power usage and redundancy information appears in the Details pane.
 
     [bookmark: pgfId-1063659]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1062015][bookmark: 20776]Displaying the Chassis CPU Utilization
 
     [bookmark: pgfId-1061720]Cisco DCNM displays the percentage of CPU utilization over time for the device that you choose in the Summary pane. You can customize the reporting of this utilization for types of utilization (user, kernel, or idle), specific thresholds, and time intervals.[bookmark: marker-1061721] 
 
    
 
     
      [bookmark: pgfId-1061722]DETAILED STEPS
 
     [bookmark: pgfId-1061723]To display the CPU utilization, follow these steps:
 
     
 
     [bookmark: pgfId-1061724]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1061725]Summary information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1061726]Step 2 From the summary pane, click the device.
 
     [bookmark: pgfId-1061727]Tabs appear in the Details pane.
 
     [bookmark: pgfId-1063202]Step 3 From the Details pane, click the CPU Utilization tab.
 
     [bookmark: pgfId-1063203]The CPU utilization table appears.
 
     [bookmark: pgfId-1063204]Step 4 (Optional) To display the percentage of utilization devoted to user or kernel functions, follow these steps:
 
     [bookmark: pgfId-1063205] a. Click Select Parameters.
 
     [bookmark: pgfId-1063206]A list of utilization types (user, kernel, and idle) appears.
 
     [bookmark: pgfId-1063207] b. Choose the utilization types that you need to see reported.
 
     [bookmark: pgfId-1063208]Step 5 (Optional) To display utilization within specific thresholds, follow these steps:
 
     [bookmark: pgfId-1063209] a. Click the Turn Thresholds On/Off tool.
 
     [bookmark: pgfId-1063210]The Adjust Threshold Limits slider tool appears on the toolbar next to the Turn Thresholds On/Off tool.
 
     [bookmark: pgfId-1063211] b. To set a minimum CPU utilization threshold, move the left slider to the desired utilization.
 
     [bookmark: pgfId-1063212] c. To set a maximum CPU utilization threshold, move the right slider to the desired utilization.
 
     [bookmark: pgfId-1063213]Step 6 (Optional) To change the monitoring frequency, follow these steps:
 
     [bookmark: pgfId-1063214] a. Click in the Select Frequency tool drop-down list.
 
     [bookmark: pgfId-1063215]Time intervals appear for you to choose.
 
     [bookmark: pgfId-1063216] b. Choose the appropriate time interval.
 
     [bookmark: pgfId-1063217]Step 7 Click the Start Monitoring tool to begin monitoring CPU utilization.
 
     [bookmark: pgfId-1063218]Step 8 (Optional) To stop monitoring the CPU utilization, click the Stop Monitoring tool.
 
     [bookmark: pgfId-1063219]Step 9 (Optional) To display how the CPU utilization compares over days or months, follow these steps:
 
     [bookmark: pgfId-1063220] a. Click Show Overview Chart.
 
     [bookmark: pgfId-1063221] b. (Optional) To see the latest or real-time utilization data, click RT.
 
     [bookmark: pgfId-1063222] c. (Optional) To compare utilization data over days or months, click the appropriate button for the amount of time desired (1d shows one day, 2d shows two days, and so on).
 
     [bookmark: pgfId-1063223]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1063965][bookmark: 58862]Displaying the Chassis Memory Utilization
 
     [bookmark: pgfId-1063966]Cisco DCNM displays the percentage of memory utilization over time for the device that you choose in the Summary pane. You can customize the reporting of this utilization for specific thresholds and time intervals.[bookmark: marker-1063967] 
 
    
 
     
      [bookmark: pgfId-1063968]DETAILED STEPS
 
     [bookmark: pgfId-1062345]To display the memory utilization, follow these steps:
 
     
 
     [bookmark: pgfId-1062346]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1062347]Summary information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1063794]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1063795]Tabs appear in the Details pane.
 
     [bookmark: pgfId-1063796]Step 3 From the Details pane, click the Memory Utilization tab.
 
     [bookmark: pgfId-1063797]The Memory Utilization table appears.
 
     [bookmark: pgfId-1063798]Step 4 (Optional) To display utilization within specific thresholds, follow these steps:
 
     [bookmark: pgfId-1063799] a. Click the Turn Thresholds On/Off tool.
 
     [bookmark: pgfId-1063800]The Adjust Threshold Limits slider tool appears on the toolbar next to the Turn Thresholds On/Off tool.
 
     [bookmark: pgfId-1063801] b. To set a minimum utilization threshold, move the left slider to the desired utilization.
 
     [bookmark: pgfId-1063802] c. To set a maximum utilization threshold, move the right slider to the desired utilization.
 
     [bookmark: pgfId-1063803]Step 5 (Optional) To change the monitoring frequency, follow these steps:
 
     [bookmark: pgfId-1063804] a. Click in the Select Frequency tool drop-down list.
 
     [bookmark: pgfId-1063805]Time intervals appear for you to choose.
 
     [bookmark: pgfId-1063806] b. Choose the appropriate time interval.
 
     [bookmark: pgfId-1063807]Step 6 Click the Start Monitoring tool to begin monitoring utilization.
 
     [bookmark: pgfId-1063808]Step 7 (Optional) To stop monitoring the utilization, click the Stop Monitoring tool.
 
     [bookmark: pgfId-1063809]Step 8 (Optional) To display how the utilization compares over days or months, follow these steps:
 
     [bookmark: pgfId-1063810] a. Click Show Overview Chart.
 
     [bookmark: pgfId-1063811] b. (Optional) To see the latest or real-time utilization data, click RT.
 
     [bookmark: pgfId-1063812] c. (Optional To compare utilization data over days or months, click the appropriate button for the amount of time desired (1d shows one day, 2d shows two days, and so on).
 
     [bookmark: pgfId-1063813]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058699][bookmark: 13415]Displaying the Chassis Events
 
     [bookmark: pgfId-1062489]Cisco DCNM displays the chassis events, which includes the source, time, severity, message, and status of the event. You can display additional details for an event[bookmark: marker-1065042].
 
    
 
     
      [bookmark: pgfId-1062491]DETAILED STEPS
 
     [bookmark: pgfId-1062492]To display the chassis events, follow these steps:
 
     
 
     [bookmark: pgfId-1062493]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1062494]Summary information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1062495]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1062496]Tabs appear in the Details pane.
 
     [bookmark: pgfId-1064973]Step 3 From the Details pane, click the Memory Utilization tab.
 
     [bookmark: pgfId-1064974]The Memory Utilization table appears.
 
     [bookmark: pgfId-1064955]Step 4 (Optional) To see details for the event, select the event in the Details pane and click the up arrow at the bottom of the details pane.
 
     [bookmark: pgfId-1071732]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1115562][bookmark: 31492]Displaying the Module Information
 
    [bookmark: pgfId-1115563]Cisco DCNM displays summary, detail, environmental, and event information for the supervisor modules, I/O modules, and fabric modules.
 
    [bookmark: pgfId-1115564]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1115568]Displaying the Module Summary Information
 
     	 [bookmark: pgfId-1115572]Displaying the Module Detail Information
 
     	 [bookmark: pgfId-1115576]Displaying the Module Environmental Status
 
     	 [bookmark: pgfId-1115580]Displaying TCAM Statistics
 
     	 [bookmark: pgfId-1115584]Displaying the Module Events
 
    
 
     
      [bookmark: pgfId-1058874][bookmark: 44728]Displaying the Module Summary Information
 
     [bookmark: pgfId-1065481]Cisco DCNM displays the module summary information for each device it manages when you expand the device listing in the Summary pane. The summary information includes the module description, product ID, serial number, hardware version, software version, status, temperature, and events.[bookmark: marker-1065482]
 
    
 
     
      [bookmark: pgfId-1065483]DETAILED STEPS
 
     [bookmark: pgfId-1065484]To display the summary information for a module, follow these steps:
 
     
 
     [bookmark: pgfId-1065502]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1065511]Chassis summary information for the device appears in the Summary pane.
 
     [bookmark: pgfId-1065520]Step 2 From the Summary pane, expand the device with the modules that you are interested in viewing.
 
     [bookmark: pgfId-1065529]A list of modules, power supplies, and fan trays appears under the device in the Summary pane. Each line includes summary information for the component.
 
     [bookmark: pgfId-1065755]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058875][bookmark: 65036]Displaying the Module Detail Information
 
     [bookmark: pgfId-1069184]Cisco DCNM displays the module detail information for the device that you choose in the Summary pane. This detail information includes general identification information and special information that applies to the the module type[bookmark: marker-1069185].
 
    
 
     
      [bookmark: pgfId-1069186]DETAILED STEPS
 
     [bookmark: pgfId-1071792]To display module detail information, follow these steps:
 
     
 
     [bookmark: pgfId-1065995]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1065996]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1065997]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1066039]Step 3 Expand the device.
 
     [bookmark: pgfId-1066060]The device listing expands to include a summary of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1066099]Step 4 Click the module.
 
     [bookmark: pgfId-1066116]Tabs appear in the Details pane. General details appear in the Details tab.
 
     [bookmark: pgfId-1065999]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1065176][bookmark: 80319]Displaying the Module Environmental Status
 
     [bookmark: pgfId-1066376]Cisco DCNM displays the module environmental status information for the supervisor module, I/O module, or fabric module that you choose in the Summary pane. The environmental information includes power usage and temperature information[bookmark: marker-1066377].
 
    
 
     
      [bookmark: pgfId-1066378]DETAILED STEPS
 
     [bookmark: pgfId-1066379]To display the environmental status for a module, follow these steps:
 
     
 
     [bookmark: pgfId-1066380]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1066381]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1066382]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1066384]Step 3 Expand the device.
 
     [bookmark: pgfId-1066749]The device listing expands to include a summary of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1066577]Step 4 Click the module.
 
     [bookmark: pgfId-1066982]Step 5 From the Details pane, click the Environmental Status tab.
 
     [bookmark: pgfId-1066385]Power supply and temperature sections appear in the Details pane. The Power Supply section is expanded and the two temperature sections are not expanded
 
     [bookmark: pgfId-1067160]Step 6 (Optional) To see textual temperature information, expand the Temperature Status Table section.
 
     [bookmark: pgfId-1067254]Step 7 (Optional) To see graphical temperature information, expand the Temperature Status Thermometer section.
 
     [bookmark: pgfId-1066386]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1112752][bookmark: 84654]Displaying TCAM Statistics
 
     [bookmark: pgfId-1112753]The following window appears in the TCAM Statistics tab:
 
      
      	 [bookmark: pgfId-1112754]TCAM Statistics Chart—Information about TCAM usage on the module.
 
     
 
     [bookmark: pgfId-1112760]See the “Working with Statistics and Charts” section for more information on collecting statistics for this feature.
 
    
 
     
      [bookmark: pgfId-1112731][bookmark: 15196]Displaying the Module Events
 
     [bookmark: pgfId-1067530]Cisco DCNM displays the module event information for the supervisor module, I/O module, or fabric module that you choose in the Summary pane. The events information includes source, time, severity, message, and status information for the event. You can display details for each event[bookmark: marker-1068200].
 
    
 
     
      [bookmark: pgfId-1067532]DETAILED STEPS
 
     [bookmark: pgfId-1067533]To display the events for a module, follow these steps:
 
     
 
     [bookmark: pgfId-1067534]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1067535]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1067536]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1067537]Step 3 Expand the device.
 
     [bookmark: pgfId-1067538]The device listing expands to include a summary listing of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1067539]Step 4 Click the module.
 
     [bookmark: pgfId-1067540]Step 5 From the Details pane, click the Events tab.
 
     [bookmark: pgfId-1067541]An events listing appears in the Details pane.
 
     [bookmark: pgfId-1067542]Step 6 (Optional) To see details for an event, click on the event and click the up arrow button at the bottom of the pane.
 
     [bookmark: pgfId-1067544]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1115598][bookmark: 18633]Displaying the Power Supply Information
 
    [bookmark: pgfId-1115599]Cisco DCNM displays summary information, general details, and events for power supplies.
 
    [bookmark: pgfId-1115600]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1115604]Displaying the Power Supply Summary Information
 
     	 [bookmark: pgfId-1115608]Displaying the Power Supply Detail Information
 
     	 [bookmark: pgfId-1115612]Displaying the Power Supply Events
 
    
 
     
      [bookmark: pgfId-1059134][bookmark: 79277]Displaying the Power Supply Summary Information
 
     [bookmark: pgfId-1068986]Cisco DCNM displays the power supply summary information for each device it manages when you expand the device listing in the Summary pane. The summary information includes the module description, product ID, serial number, hardware version, software version, status, temperature, and events.[bookmark: marker-1068987]
 
    
 
     
      [bookmark: pgfId-1068988]DETAILED STEPS
 
     [bookmark: pgfId-1068989]To display the summary information for a power supply, follow these steps:
 
     
 
     [bookmark: pgfId-1068990]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1068991]Chassis summary information for the device appears in the Summary pane.
 
     [bookmark: pgfId-1068992]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1071036]Step 3 Expand the device with the modules that you are interested in viewing.
 
     [bookmark: pgfId-1068993]A list of modules, power supplies, and fan trays appears under the device in the Summary pane. Each line includes summary information for the component.
 
     [bookmark: pgfId-1068994]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059166][bookmark: 19817]Displaying the Power Supply Detail Information
 
     [bookmark: pgfId-1069352]Cisco DCNM displays the power supply detail information for the device that you choose in the Summary pane. This detail information includes general identification information, power (watts), and current (Amps)[bookmark: marker-1069353].
 
    
 
     
      [bookmark: pgfId-1069354]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1069355]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1069356]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1069357]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1069358]Step 3 Expand the device.
 
     [bookmark: pgfId-1069359]The device listing expands to include a summary of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1069360]Step 4 Click the power supply.
 
     [bookmark: pgfId-1069361]Tabs appear in the Details pane. General details appear in the Details tab.
 
     [bookmark: pgfId-1069362]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1069630][bookmark: 37529]Displaying the Power Supply Events
 
     [bookmark: pgfId-1069631]Cisco DCNM displays the event information for the power supply that you choose in the Summary pane. The events information includes source, time, severity, message, and status information for the events. You can display details for each event[bookmark: marker-1069632].
 
    
 
     
      [bookmark: pgfId-1069633]DETAILED STEPS
 
     [bookmark: pgfId-1069551]To display the events for a power supply, follow these steps:
 
     
 
     [bookmark: pgfId-1069552]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1069553]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1069554]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1069555]Step 3 Expand the device.
 
     [bookmark: pgfId-1069556]The device listing expands to include a summary listing of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1069557]Step 4 Click the power supply.
 
     [bookmark: pgfId-1069558]Step 5 From the Details pane, click the Events tab.
 
     [bookmark: pgfId-1069559]An events listing appears in the Details pane.
 
     [bookmark: pgfId-1069560]Step 6 (Optional) To see details for an event, click on the event and click the up arrow button at the bottom of the pane.
 
     [bookmark: pgfId-1071073]A field opens to display detailed event information.
 
     [bookmark: pgfId-1069561]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1115617][bookmark: 83109]Displaying the Fan Tray Information
 
    [bookmark: pgfId-1115618]Cisco DCNM displays summary information, general details, and events for fan trays.
 
    [bookmark: pgfId-1115619]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1115623]Displaying the Fan Tray Summary Information
 
     	 [bookmark: pgfId-1115627]Displaying the Fan Tray Detail Information
 
     	 [bookmark: pgfId-1115631]Displaying the Fan Tray Events
 
    
 
     
      [bookmark: pgfId-1059187][bookmark: 52180]Displaying the Fan Tray Summary Information
 
     [bookmark: pgfId-1070266]Cisco DCNM displays the fan tray summary information for each device it manages when you expand the device listing in the Summary pane. The summary information includes the fan identification and status information.[bookmark: marker-1070267]
 
    
 
     
      [bookmark: pgfId-1070268]DETAILED STEPS
 
     [bookmark: pgfId-1070269]To display the summary information for a fan tray, follow these steps:
 
     
 
     [bookmark: pgfId-1070270]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1070271]Chassis summary information for the device appears in the Summary pane.
 
     [bookmark: pgfId-1070272]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1071049]Step 3 Expand the device with the fan tray that you are interested in viewing.
 
     [bookmark: pgfId-1070273]A list of modules, power supplies, and fan trays appears under the device in the Summary pane. Each line includes summary information for the component.
 
     [bookmark: pgfId-1070274]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059208][bookmark: 47519]Displaying the Fan Tray Detail Information
 
     [bookmark: pgfId-1070697]Cisco DCNM displays the fan tray detail information for the device that you choose in the Summary pane. This detail information includes descriptive information and status for the fan tray[bookmark: marker-1070698].
 
    
 
     
      [bookmark: pgfId-1070699]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1070700]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1070701]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1070702]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1070703]Step 3 Expand the device.
 
     [bookmark: pgfId-1070704]The device listing expands to include a summary of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1070705]Step 4 Click the fan tray.
 
     [bookmark: pgfId-1070706]Tabs appear in the Details pane. General details appear in the Details tab.
 
     [bookmark: pgfId-1070707]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1069892][bookmark: 53137]Displaying the Fan Tray Events
 
     [bookmark: pgfId-1070742]Cisco DCNM displays the event information for the fan tray that you choose in the Summary pane. The events information includes source, time, severity, message, and status information for the event. You can display details for each event[bookmark: marker-1070743].
 
    
 
     
      [bookmark: pgfId-1070744]DETAILED STEPS
 
     [bookmark: pgfId-1070745]To display the events for a fan tray, follow these steps:
 
     
 
     [bookmark: pgfId-1070746]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1070747]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1070748]Step 2 From the Summary pane, click the device.
 
     [bookmark: pgfId-1070749]Step 3 Expand the device.
 
     [bookmark: pgfId-1070750]The device listing expands to include a summary listing of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1070751]Step 4 Click the fan tray.
 
     [bookmark: pgfId-1070752]Step 5 From the Details pane, click the Events tab.
 
     [bookmark: pgfId-1070753]An events listing appears in the Details pane.
 
     [bookmark: pgfId-1070754]Step 6 (Optional) To see details for an event, click on the event and click the up arrow button at the bottom of the pane.
 
     [bookmark: pgfId-1070755]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1115637][bookmark: 92503]Feature History for Inventory
 
    [bookmark: pgfId-1115641]Table 11-1 lists the release history for this feature.
 
    [bookmark: pgfId-1115665]
 
     
      
       
       [bookmark: pgfId-1115648]Table 11-1 [bookmark: 50557]Feature History for Inventory 
 
       
       
        
        	 
          
          [bookmark: pgfId-1115654]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1115656]Releases 
         
  
        	 
          
          [bookmark: pgfId-1115658]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1116950]Inventory
  
        	[bookmark: pgfId-1116952]4.2(3)
  
        	[bookmark: pgfId-1116954]Support was added for Nexus 4000 Series switches.
  
       
 
        
        	[bookmark: pgfId-1117700]Inventory
  
        	[bookmark: pgfId-1117702]4.2(1)
  
        	[bookmark: pgfId-1117704]Support was added for Nexus 5000 Series switches and Nexus 2000 Series fabric extenders.
  
       
 
        
        	[bookmark: pgfId-1115660]Inventory
  
        	[bookmark: pgfId-1115662]4.1(2)
  
        	[bookmark: pgfId-1115664]No change from Release 4.0
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1091586]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1219931][bookmark: 92434]Configuring SPAN 
      
      
 
     
 
 
    [bookmark: pgfId-1239616]This chapter describes how to configure an Ethernet switched port analyzer [bookmark: marker-1239615](SPAN) to analyze traffic between ports on Cisco NX-OS devices.
 
     
      
    
 
    
 
    [bookmark: pgfId-1235354]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1239626]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1239630]Information About SPAN
 
     	 [bookmark: pgfId-1239634]Licensing Requirements for SPAN
 
     	 [bookmark: pgfId-1239638]Prerequisites for SPAN
 
     	 [bookmark: pgfId-1239642]Guidelines and Limitations
 
     	 [bookmark: pgfId-1239646]Configuring SPAN
 
     	 [bookmark: pgfId-1239658]Field Descriptions for SPAN
 
     	 [bookmark: pgfId-1239662]Additional References
 
     	 [bookmark: pgfId-1239666]Feature History for SPAN
 
    
 
   
 
    
     [bookmark: pgfId-1239669][bookmark: 15525]Information About SPAN [bookmark: marker-1239668]
 
    [bookmark: pgfId-1239670]SPAN analyzes all traffic between source ports by directing the SPAN session traffic to a destination port with an external analyzer attached to it.
 
    [bookmark: pgfId-1239671]You can define the sources and destinations to monitor in a SPAN sessions on the local device.
 
    [bookmark: pgfId-1239672]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1239676]SPAN Sources
 
     	 [bookmark: pgfId-1239680]SPAN Destinations
 
     	 [bookmark: pgfId-1239684]SPAN Sessions
 
     	 [bookmark: pgfId-1239688]Virtual SPAN Sessions
 
     	 [bookmark: pgfId-1239692]Multiple SPAN Sessions
 
     	 [bookmark: pgfId-1239696]High Availability
 
     	 [bookmark: pgfId-1239700]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1239702][bookmark: 55488]SPAN Sources
 
     [bookmark: pgfId-1239703]The interfaces from which traffic can be monitored are called SPAN sources. Sources designate the traffic to monitor and whether to copy ingress, egress, or both directions of traffic. SPAN sources include the following:
 
      
      	 [bookmark: pgfId-1239704]Ethernet ports
 
      	 [bookmark: pgfId-1239705]VLANs—When a VLAN is specified as a SPAN source, all supported interfaces in the VLAN are SPAN sources. 
 
      	 [bookmark: pgfId-1239706]Remote SPAN (RSPAN) VLANs
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1239708]Note A single SPAN session can include mixed sources in any combination of the above.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1239709]Characteristics of Source Ports
 
     [bookmark: pgfId-1239710]SPAN source ports have the following characteristics:
 
      
      	 [bookmark: pgfId-1239711]A port configured as a source port cannot also be configured as a destination port.
 
      	 [bookmark: pgfId-1239712]An RSPAN VLAN can only be used as a SPAN source.
 
     
 
    
 
     
      [bookmark: pgfId-1239717][bookmark: 22333]SPAN Destinations
 
     [bookmark: pgfId-1239718]SPAN destinations refer to the interfaces that monitor source ports. Destination ports receive the copied traffic from SPAN sources. 
 
    
 
     
      [bookmark: pgfId-1239719]Characteristics of Destination Ports
 
     [bookmark: pgfId-1239720]SPAN destination ports have the following characteristics:
 
      
      	 [bookmark: pgfId-1239721]Destinations for a SPAN session include Ethernet ports or port-channel interfaces in either access or trunk mode.
 
      	 [bookmark: pgfId-1239722]A port configured as a destination port cannot also be configured as a source port.
 
      	 [bookmark: pgfId-1239723]A destination port can be configured in only one SPAN session at a time.
 
      	 [bookmark: pgfId-1239724]Destination ports do not participate in any spanning tree instance. SPAN output includes Bridge Protocol Data Unit (BPDU) Spanning-Tree Protocol hello packets.
 
      	 [bookmark: pgfId-1239725]An RSPAN VLAN cannot be used as a SPAN destination.
 
      	 [bookmark: pgfId-1239726]You can configure SPAN destinations to inject packets to disrupt a certain TCP packet stream in support of the Intrusion Detection System (IDS). 
 
      	 [bookmark: pgfId-1239727]You can configure SPAN destinations to enable a forwarding engine to learn the MAC address of the IDS. 
 
     
 
    
 
     
      [bookmark: pgfId-1239729][bookmark: 64181]SPAN Sessions
 
     [bookmark: pgfId-1239731]You can create up to 18 SPAN [bookmark: marker-1239730]sessions designating sources and destinations to monitor. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1239732]Note Only two SPAN sessions can be running simultaneously.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1239736]Figure 12-1 shows a SPAN configuration. Packets on three Ethernet ports are copied to destination port Ethernet 2/5. Only traffic in the direction specified is copied.
 
     [bookmark: pgfId-1239738]Figure 12-1 [bookmark: 49543]SPAN Configuration
 
     [bookmark: pgfId-1239742].
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1239744][bookmark: 72232]Virtual SPAN Sessions
 
     [bookmark: pgfId-1239746]You can create a virtual [bookmark: marker-1239745]SPAN session to monitor multiple VLAN sources and choose only VLANs of interest to transmit on multiple destination ports. For example, you can configure SPAN on a trunk port and monitor traffic from different VLANs on different destination ports.
 
     [bookmark: pgfId-1239750]Figure 12-2 shows a virtual SPAN configuration. The virtual SPAN session copies traffic from the three VLANs to the three specified destination ports. You can choose which VLANs to allow on each destination port to limit the traffic that the device transmits on it. In Figure 12-2, the device transmits packets from one VLAN at each destination port.
 
      
       
     
 
     
 
     [bookmark: pgfId-1239754]Note Virtual SPAN sessions cause all source packets to be copied to all destinations, whether the packets are required at the destination or not. VLAN traffic filtering occurs at the egress destination port level.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1239756]Figure 12-2 [bookmark: 71442]Virtual SPAN Configuration
 
     [bookmark: pgfId-1239760].
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1239763]For information about configuring a virtual SPAN session, see the “Configuring a Virtual SPAN Session” section.
 
    
 
     
      [bookmark: pgfId-1239766][bookmark: 50955]Multiple SPAN Sessions
 
     [bookmark: pgfId-1239768][bookmark: marker-1239767]Although you can define up to 18 SPAN sessions, only two SPAN sessions can be running simultaneously. You can shut down an unused SPAN session.
 
     [bookmark: pgfId-1239771]For information about shutting down SPAN sessions, see the “Shutting Down or Resuming a SPAN Session” section.
 
    
 
     
      [bookmark: pgfId-1239774][bookmark: 16355]High Availability
 
     [bookmark: pgfId-1239778]The SPAN feature [bookmark: marker-1239775]supports stateless and stateful restarts. After a reboot or supervisor switchover, Cisco NX-OS applies the running configuration.
 
    
 
     
      [bookmark: pgfId-1239781][bookmark: 99052]Virtualization Support
 
     [bookmark: pgfId-1239783]A virtual device context [bookmark: marker-1239782](VDC) is a logical representation of a set of system resources. SPAN applies only to the VDC where the commands are entered.
 
     [bookmark: pgfId-1239791]For information about configuring VDCs, see the Cisco DCNM Virtual Device Context Configuration Guide, Release 4.x.
 
    
 
   
 
    
     [bookmark: pgfId-1239794][bookmark: 29596]Licensing Requirements for SPAN
 
    [bookmark: pgfId-1239796]The following table shows the licensing [bookmark: marker-1239795]requirements for this feature:
 
    [bookmark: pgfId-1239816]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1239799]Product 
         
  
        	 
          
          [bookmark: pgfId-1239801]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1239803]Cisco DCNM
  
        	[bookmark: pgfId-1239805]SPAN requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For a complete explanation of the Cisco DCNM licensing scheme, see the Cisco DCNM Fundamentals Configuration Guide, Release 4.x.
  
       
 
        
        	[bookmark: pgfId-1239810]NX-OS
  
        	[bookmark: pgfId-1239812]SPAN requires no license. Any feature not included in a license package is bundled with the Cisco NX-OS system images and is provided at no extra charge to you. For a complete explanation of the NX-OS licensing scheme, see the Cisco Nexus 7000 Series NX-OS Licensing Guide, Release 4.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1239818][bookmark: 16098]Prerequisites for SPAN
 
    [bookmark: pgfId-1239820]SPAN has the following [bookmark: marker-1239819]prerequisites:
 
     
     	 [bookmark: pgfId-1239821]You must first configure the ports on each device to support the desired SPAN configuration. For more information, see the  Cisco DCNM Interfaces Configuration Guide, Release 4.x .
 
    
 
   
 
    
     [bookmark: pgfId-1239829][bookmark: 58316]Guidelines and Limitations
 
    [bookmark: pgfId-1239831]SPAN has the following configuration[bookmark: marker-1239830] guidelines and limitations:
 
     
     	 [bookmark: pgfId-1239836] Table 1  lists the [bookmark: marker-1239835]SPAN session limits.
 
    
 
    [bookmark: pgfId-1239867]
 
     
      
       
       [bookmark: pgfId-1239840]Table 1 [bookmark: 30793]SPAN Session Limits
 
       
       
        
        	 
          
          [bookmark: pgfId-1239844]Description 
         
  
        	 
          
          [bookmark: pgfId-1239846]Limit 
         
  
       
 
        
        	[bookmark: pgfId-1239848]Configured SPAN sessions
  
        	[bookmark: pgfId-1239850]18
  
       
 
        
        	[bookmark: pgfId-1239852]Simultaneously running SPAN sessions
  
        	[bookmark: pgfId-1239854]2
  
       
 
        
        	[bookmark: pgfId-1239856]Source interfaces per session
  
        	[bookmark: pgfId-1239858]128
  
       
 
        
        	[bookmark: pgfId-1239860]Source VLANS per session
  
        	[bookmark: pgfId-1239862]32
  
       
 
        
        	[bookmark: pgfId-1239864]Destination interfaces per session
  
        	[bookmark: pgfId-1239866]32
  
       
 
       
     
 
    
 
     
     	 [bookmark: pgfId-1239868]A destination port can only be configured in one SPAN session at a time.
 
     	 [bookmark: pgfId-1239869]You cannot configure a port as both a source and destination port.
 
     	 [bookmark: pgfId-1239870]A single SPAN session can include mixed sources in any combination of the following:
 
    
 
    [bookmark: pgfId-1239871] – Ethernet ports
 
    [bookmark: pgfId-1239872] – VLANs
 
     
     	 [bookmark: pgfId-1239874]Destination ports do not participate in any spanning tree instance. SPAN output includes Bridge Protocol Data Unit (BPDU) Spanning-Tree Protocol hello packets.
 
     	 [bookmark: pgfId-1239875]When a SPAN session contains multiple egress source ports, packets that these ports receive may be replicated even though they are not transmitted on the ports. Some examples of this behavior on source ports are as follows:
 
    
 
    [bookmark: pgfId-1239876] – Traffic that results from flooding
 
    [bookmark: pgfId-1239877] – Broadcast and multicast traffic
 
     
     	 [bookmark: pgfId-1239878]For VLAN SPAN sessions with both ingress and egress configured, two packets (one from ingress and one from egress) are forwarded from the destination port if the packets get switched on the same VLAN.
 
     	 [bookmark: pgfId-1239879]VLAN SPAN monitors only the traffic that leaves or enters Layer 2 ports in the VLAN.
 
     	 [bookmark: pgfId-1239881]You can configure an RSPAN VLAN for use only as a SPAN session source.
 
     	 [bookmark: pgfId-1239882]You can configure a SPAN session on the local device only.
 
     	 [bookmark: pgfId-1239883]If you configure a SPAN session, ensure that you configure the logging level for SPAN to 6 (Informational) or a higher level on the Cisco NX-OS device. To configure the device with the minimal required logging configuration, log into the command-line interface of the device and use the following commands:
 
    
 
     
     [bookmark: pgfId-1239884]switch(config)# logging level monitor 6 
    
 
     
     [bookmark: pgfId-1239885]switch(config)# logging logfile messages 6 
    
 
     
     [bookmark: pgfId-1239886]switch(config)# logging event link-status default 
    
 
     
     [bookmark: pgfId-1239887] 
    
 
    [bookmark: pgfId-1239890]For more information about Cisco NX-OS system-message logging requirements, see the Cisco DCNM Fundamentals Configuration Guide, Release 4.x.
 
   
 
    
     [bookmark: pgfId-1239893][bookmark: 95033]Configuring SPAN
 
    [bookmark: pgfId-1239894]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1239898]Configuring a SPAN Session
 
     	 [bookmark: pgfId-1239902]Configuring a Virtual SPAN Session
 
     	 [bookmark: pgfId-1239906]Configuring an RSPAN VLAN
 
     	 [bookmark: pgfId-1239910]Shutting Down or Resuming a SPAN Session
 
    
 
     
      [bookmark: pgfId-1088793][bookmark: 30332]Configuring a SPAN Session
 
     [bookmark: pgfId-1221325]You can configure a SPAN s[bookmark: marker-1182897]ession on the local device only. By default, SPAN sessions are created in the shut state.For [bookmark: marker-1119751]sources, you can specify Ethernet ports, port channels, VLANs, and RSPAN VLANs. You can specify private VLANs (primary, isolated, and community) in SPAN sources. .
 
     [bookmark: pgfId-1073093]For [bookmark: marker-1110639]destination ports, you can specify Ethernet ports or port-channels in either access or trunk mode. You must enable monitor mode on all destination ports.
 
    
 
     
      [bookmark: pgfId-1115641]BEFORE YOU BEGIN
 
      
      	 [bookmark: pgfId-1239947]A single SPAN session can include mixed sources in any combination of Ethernet ports or VLANs.
 
      	 [bookmark: pgfId-1239948]You must have already configured the destination ports in access or trunk mode. For more information, see the  Cisco DCNM Interfaces Configuration Guide, Release 4.x .
 
     
 
    
 
     
      [bookmark: pgfId-1048956]DETAILED STEPS
 
     [bookmark: pgfId-1221820]To configure a SPAN session, follow these steps:
 
     
 
     [bookmark: pgfId-1221821]Step 1 From the Feature Selector pane, choose Interfaces > Traffic Monitoring > SPAN. The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1221822]Step 2 From the Summary pane, double-click the device that you want to configure with a SPAN session to display the configured SPAN sessions.
 
     [bookmark: pgfId-1221823]Step 3 (Optional) To delete a SPAN session that you are no longer using, right-click the SPAN session and choose Delete.
 
     [bookmark: pgfId-1221824]Step 4 (Optional) To configure a new SPAN session, from the menu bar choose File > New Local SPAN Session. By default, SPAN sessions are created in the shut state.
 
     [bookmark: pgfId-1221825] a. (Only the first time you create a SPAN session) From the Summary pane, double-click the device that you want to configure with a SPAN session to display the configured SPAN sessions.
 
     [bookmark: pgfId-1221826] b. (Optional) To modify the session number, from the Summary pane, double-click the Session Id field and enter a session number from 1 to 18.
 
      
       
     
 
     
 
     [bookmark: pgfId-1221827]Note You can only modify the session number immediately after you create the session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1221828]Step 5 From the Summary pane, choose the SPAN session to configure.
 
     [bookmark: pgfId-1221829]Step 6 From the Details pane, click the Configuration tab and expand the Session Settings section, if necessary. 
 
     [bookmark: pgfId-1221830]Step 7 (Optional) To add a description of the SPAN session, specify it in the Description field.
 
     [bookmark: pgfId-1221831]Step 8 (Optional) In the Filtered VLANs field, click the down arrow to display and choose from the configured VLANs.
 
     [bookmark: pgfId-1221832]Step 9 Add source Ethernet ports to the SPAN session as follows:
 
     [bookmark: pgfId-1221833] a. From the Ports association panel, double-click the device and then double-click the desired slot to display ports. 
 
     [bookmark: pgfId-1221834] b. Choose the port, right-click on the port row, and choose Add to SPAN Source to add this port to the SPAN session sources. 
 
     [bookmark: pgfId-1221835]Step 10 Add source VLANs or RSPAN VLANs to the SPAN session as follows:
 
     [bookmark: pgfId-1221836] a. From the VLANs association panel, double-click the device to display the configured VLANs.
 
     [bookmark: pgfId-1221837] b. Choose the VLAN, right-click on the VLAN row, and choose Add to SPAN Source to add this VLAN to the SPAN session sources.
 
     [bookmark: pgfId-1221838]Step 11 Add destination Ethernet ports to the SPAN session as follows:
 
     [bookmark: pgfId-1221839] a. From the Ports association panel, double-click the device and then double-click the desired slot to display ports.
 
     [bookmark: pgfId-1221840] b. Choose an access or trunk port. 
 
     [bookmark: pgfId-1221841] c. In the Monitor column check the check box to enable monitoring on this port.
 
     [bookmark: pgfId-1221842] d. Right-click on the port row and choose Add to SPAN Destination to add this port to the SPAN session destinations.
 
     [bookmark: pgfId-1221843]Step 12 (Optional) To modify SPAN session source settings, follow these steps:
 
     [bookmark: pgfId-1221844] a. From the Details pane, click the Configuration tab and expand the Source and Destination section, if necessary.
 
     [bookmark: pgfId-1221845] b. To modify the ingress or egress choice for a source, check or uncheck the Ingress or Egress check box to activate the desired direction to monitor. By default, both ingress and egress are monitored.
 
     [bookmark: pgfId-1221846] c. To delete a SPAN source or destination, choose the source or destination entry, right-click on it, and choose Delete.
 
     [bookmark: pgfId-1221847]Step 13 From the menu bar, choose File > Deploy to apply your changes to the device.
 
     [bookmark: pgfId-1221848]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1089366][bookmark: 48216]Configuring a Virtual SPAN Session
 
     [bookmark: pgfId-1073099]You can configure a [bookmark: marker-1182898]virtual SPAN session to copy packets from source ports, VLANs, and RSPAN VLANs to destination ports on the local device. By default, SPAN sessions are created in the shut state.
 
     [bookmark: pgfId-1073100]For sources, you can specify ports, VLANs, or RSPAN VLANs.
 
     [bookmark: pgfId-1074948]For destination ports, you can specify Ethernet ports. You can choose which VLANs to allow on each destination port to limit the traffic that the device transmits on it.
 
    
 
     
      [bookmark: pgfId-1075161]BEFORE YOU BEGIN
 
      
      	 [bookmark: pgfId-1240173]You have already configured the destination ports in trunk mode. For more information, see the  Cisco DCNM Interfaces Configuration Guide, Release 4.x .
 
     
 
    
 
     
      [bookmark: pgfId-1075175]DETAILED STEPS
 
     [bookmark: pgfId-1221889]To configure a virtual SPAN session, follow these steps:
 
     
 
     [bookmark: pgfId-1221890]Step 1 From the Feature Selector pane, choose Interfaces > Traffic Monitoring > SPAN. The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1221891]Step 2 From the Summary pane, double-click the device that you want to configure with a SPAN session to display the configured SPAN sessions.
 
     [bookmark: pgfId-1221892]Step 3 (Optional) To delete a SPAN session that you are no longer using, right-click the SPAN session and choose Delete.
 
     [bookmark: pgfId-1221893]Step 4 (Optional) To configure a new SPAN session, from the menu bar choose File > New Local SPAN Session. By default, SPAN sessions are created in the shut state.
 
     [bookmark: pgfId-1221894] a. (Only the first time you create a SPAN session) From the Summary pane, double-click the device that you want to configure with a SPAN session to display the configured SPAN sessions.
 
     [bookmark: pgfId-1221895] b. (Optional) To modify the session number, from the Summary pane, double-click the Session Id field and enter a session number from 1 to 18.
 
      
       
     
 
     
 
     [bookmark: pgfId-1221896]Note You can only modify the session number immediately after you create the session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1221897]Step 5 From the Summary pane, choose the SPAN session to configure.
 
     [bookmark: pgfId-1221898]Step 6 From the Details pane, click the Configuration tab and expand the Session Settings section, if necessary. 
 
     [bookmark: pgfId-1221899]Step 7 (Optional) To add a description of the SPAN session, specify it in the Description field.
 
     [bookmark: pgfId-1221900]Step 8 (Optional) To add VLANs to filter (include) in the SPAN session, in the Filtered VLANs field, down array to displays the configured VLANs that you can choose.
 
     [bookmark: pgfId-1221901]Step 9 Add source Ethernet ports to the SPAN session as follows:
 
     [bookmark: pgfId-1221902] a. From the Ports association panel, double-click the device and then double-click the desired slot to display ports.
 
     [bookmark: pgfId-1221903] b. Choose the port, right-click on the port row, and choose Add to SPAN Source to add this port to the SPAN session sources.
 
     [bookmark: pgfId-1221904]Step 10 Add source VLANs or RSPAN VLANs to the SPAN session as follows:
 
     [bookmark: pgfId-1221905] a. From the VLANs association panel, double-click the device to display the configured VLANs.
 
     [bookmark: pgfId-1221906] b. Choose the VLAN, right-click on the VLAN row, and choose Add to SPAN Source to add this VLAN to the SPAN session sources.
 
     [bookmark: pgfId-1221907]Step 11 Add destination Ethernet ports to the SPAN session as follows:
 
     [bookmark: pgfId-1221908] a. From the Ports association panel, double-click the device and then double-click the desired slot to display ports.
 
     [bookmark: pgfId-1221909] b. Choose an access or trunk port. 
 
     [bookmark: pgfId-1221910] c. In the Monitor column check the check box to enable monitoring on this port.
 
     [bookmark: pgfId-1221911] d. Right-click on the port row and choose Add to SPAN Destination to add this port to the SPAN session destinations.
 
     [bookmark: pgfId-1221912]Step 12 Limit the VLANs allowed on a trunk port by following these steps:
 
     [bookmark: pgfId-1221913] a. From the Feature Selector pane, choose Interfaces > Physical > Ethernet. The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1221914] b. From the Summary pane, double-click the device and then double-click the slot that you want to configure.
 
     [bookmark: pgfId-1221915] c. Choose the trunk port to configure.
 
     [bookmark: pgfId-1221916] d. From the Details pane, click the Port Details tab and expand the Port Mode Settings section, if necessary.
 
     [bookmark: pgfId-1221917] e. Limit the VLANs on the trunk by clicking the Allowed VLANs field. The field displays configured VLANs that you can choose.
 
     [bookmark: pgfId-1221918]Step 13 From the menu bar, choose File > Deploy to apply your changes to the device.
 
     [bookmark: pgfId-1221919]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1098640][bookmark: 36855]Configuring an RSPAN VLAN
 
     [bookmark: pgfId-1098641]You can specify a remote S[bookmark: marker-1182905]PAN (RSPAN) VLAN as a SPAN session source. 
 
    
 
     
      [bookmark: pgfId-1098652]DETAILED STEPS
 
     [bookmark: pgfId-1221941]To configure an RSPAN VLAN, follow these steps:
 
     
 
     [bookmark: pgfId-1221942]Step 1 From the Feature Selector pane, choose Switching > VLAN. The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1221943]Step 2 From the Summary pane, double-click the device that you want to configure.
 
     [bookmark: pgfId-1221944]Step 3 Choose the VLAN to configure.
 
     [bookmark: pgfId-1221945]Step 4 From the Details pane, click the VLAN Details tab and expand the Advanced Settings section, if necessary.
 
     [bookmark: pgfId-1221946]Step 5 Check the RSPAN VLAN check box.
 
     [bookmark: pgfId-1221947]Step 6 From the menu bar, choose File > Deploy to apply your changes to the device.
 
     [bookmark: pgfId-1221948]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1080584][bookmark: 59756]Shutting Down or Resuming a SPAN Session
 
     [bookmark: pgfId-1080585]You can shut down[bookmark: marker-1182910] SPAN sessions to discontinue the copying of packets from sources to destinations. Because only two SPAN sessions can be running simultaneously, you can shut down one session in order to free hardware resources to enable another session. By default, SPAN sessions are created in the shut state.
 
     [bookmark: pgfId-1099117]You can resume[bookmark: marker-1182911] (enable) SPAN sessions to resume the copying of packets from sources to destinations. In order to enable a SPAN session that is already enabled but operationally down, you must first shut it down and then enable it.
 
    
 
     
      [bookmark: pgfId-1080596]DETAILED STEPS
 
     [bookmark: pgfId-1221970]To shut down or resume (enable) a SPAN session, follow these steps:
 
     
 
     [bookmark: pgfId-1221971]Step 1 From the Feature Selector pane, choose Interfaces > Traffic Monitoring > SPAN.
 
     [bookmark: pgfId-1221972]The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1221973]Step 2 From the Summary pane, double-click the device to display the configured SPAN sessions.
 
     [bookmark: pgfId-1221974]Step 3 From the Summary pane, choose the SPAN session to configure.
 
     [bookmark: pgfId-1221975]Step 4 From the Details pane, click the Configuration tab and expand the Session Settings section, if necessary. 
 
     [bookmark: pgfId-1221976]Step 5 Resume (enable) the SPAN session by choosing Up in the Admin Status field.
 
     [bookmark: pgfId-1221977]Step 6 Shut down the SPAN session by choosing Down in the Admin Status field.
 
      
       
     
 
     
 
     [bookmark: pgfId-1221978]Note If a monitor session is enabled but its operational status is down, then to enable the session you must first shut down the session followed by resuming the session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1221979]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1240669]Field Descriptions for [bookmark: 58163]SPAN
 
    [bookmark: pgfId-1240670]This section includes the following field descriptions for SPAN:
 
     
     	 [bookmark: pgfId-1240674]Local SPAN Session: Configuration: Session Settings Section
 
     	 [bookmark: pgfId-1240678]Local SPAN Session: Configuration: Source and Destination Section
 
    
 
     
      [bookmark: pgfId-1240680][bookmark: 55009]Local SPAN Session: Configuration: Session Settings Section
 
     [bookmark: pgfId-1240718]
 
      
       
        
        [bookmark: pgfId-1240687]Table 12-2 Local SPAN Session: Configuration: [bookmark: marker-1240683]Session Settings Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1240691]Element 
          
  
         	 
           
           [bookmark: pgfId-1240693]Description 
          
  
        
 
         
         	[bookmark: pgfId-1240695]Session Id
  
         	[bookmark: pgfId-1240697]Local SPAN session number. Can only be specified when the session is first created. The value ranges from 1 to 18.
  
        
 
         
         	[bookmark: pgfId-1240699]Description
  
         	[bookmark: pgfId-1240701]Description for this session.
  
        
 
         
         	[bookmark: pgfId-1240703]Filtered VLANs
  
         	[bookmark: pgfId-1240705]When clicked, list of configured VLANs.
  
        
 
         
         	[bookmark: pgfId-1240707]Admin Status
  
         	[bookmark: pgfId-1240709]Administrative status of the session.
  
        
 
         
         	[bookmark: pgfId-1240711]Operational Status
  
         	[bookmark: pgfId-1240713]Display only. Whether the session is shut (down) or enabled (up).
  
        
 
         
         	[bookmark: pgfId-1240715]Status Description
  
         	[bookmark: pgfId-1240717]Display only. Status description.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1240720][bookmark: 61054]Local SPAN Session: Configuration: Source and Destination Section
 
     [bookmark: pgfId-1240766]
 
      
       
        
        [bookmark: pgfId-1240727]Table 12-3 Local SPAN Session: Configuration: S[bookmark: marker-1240723]ource and Destination Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1240731]Element 
          
  
         	 
           
           [bookmark: pgfId-1240733]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1240735]Source 
          
  
        
 
         
         	[bookmark: pgfId-1240739]Interface/VLAN
  
         	[bookmark: pgfId-1240741]Display only. Port or VLAN number.
  
        
 
         
         	[bookmark: pgfId-1240743]Description
  
         	[bookmark: pgfId-1240745]Display only. Port or VLAN description.
  
        
 
         
         	[bookmark: pgfId-1240747]Ingress
  
         	[bookmark: pgfId-1240749]Status of whether to monitor ingress packets.
  
        
 
         
         	[bookmark: pgfId-1240751]Egress
  
         	[bookmark: pgfId-1240753]Status of whether to monitor egress packets.
  
        
 
         
         	 
           
           [bookmark: pgfId-1240755]Destination 
          
  
        
 
         
         	[bookmark: pgfId-1240759]Interface
  
         	[bookmark: pgfId-1240761]Display only. Port number.
  
        
 
         
         	[bookmark: pgfId-1240763]Description
  
         	[bookmark: pgfId-1240765]Display only. Port description.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1240768][bookmark: 96108]Additional References
 
    [bookmark: pgfId-1240769]For additional information related to implementing SPAN, see the following sections:
 
     
     	 [bookmark: pgfId-1240773]Related Documents
 
     	 [bookmark: pgfId-1240777]Standards
 
    
 
     
      [bookmark: pgfId-1240805][bookmark: 12973]Related Documents
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1240781]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1240783]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1240792]VDCs
  
         	[bookmark: pgfId-1240796]Cisco DCNM Virtual Device Context Configuration Guide, Release 4.x
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1240816][bookmark: 35448]Standards
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1240809]Standards 
          
  
         	 
           
           [bookmark: pgfId-1240811]Title 
          
  
        
 
         
         	[bookmark: pgfId-1240813]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1240815]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1240818][bookmark: 95966]Feature History for SPAN
 
    [bookmark: pgfId-1240822]Table 12-4 lists the release history for this feature.
 
    [bookmark: pgfId-1240843]
 
     
      
       
       [bookmark: pgfId-1240826]Table 12-4 [bookmark: 50557]Feature History for SPAN
 
       
       
        
        	 
          
          [bookmark: pgfId-1240832]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1240834]Releases 
         
  
        	 
          
          [bookmark: pgfId-1240836]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1240838]Guidelines and Limitations
  
        	[bookmark: pgfId-1240840]4.2(1)
  
        	[bookmark: pgfId-1240842]No change from Release 4.1.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1107189]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1374373][bookmark: 33088]Managing [bookmark: marker-1374371]Device Operating Systems 
      
      
 
     
 
 
    [bookmark: pgfId-1449983]This chapter describes how to use the Device OS Management feature in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1449988]This chapter includes the following topics:
 
     
     	 [bookmark: pgfId-1449992]Information About Device OS Management
 
     	 [bookmark: pgfId-1449996]Licensing Requirements for Device OS Management
 
     	 [bookmark: pgfId-1450000]Prerequisites for Device OS Management
 
     	 [bookmark: pgfId-1450004]Guidelines and Limitations for Device OS Management
 
     	 [bookmark: pgfId-1450008]Using the Device OS Management Window
 
     	 [bookmark: pgfId-1450012]Configuring Software Installation Jobs
 
     	 [bookmark: pgfId-1450016]Configuring File Servers
 
     	 [bookmark: pgfId-1450020]Field Descriptions for Device OS Management
 
     	 [bookmark: pgfId-1450024]Additional References
 
     	 [bookmark: pgfId-1450028]Feature History for Device OS Management
 
    
 
   
 
    
     [bookmark: pgfId-1450031][bookmark: 14255]Information About Device OS Management[bookmark: marker-1450030]
 
    [bookmark: pgfId-1450032]The Device OS Management feature allows you to control the software images installed on Nexus 7000 Series devices that are managed by Cisco DCNM.
 
    [bookmark: pgfId-1450033]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1450037]Device OS Management Screen
 
     	 [bookmark: pgfId-1450041]Software Installation Jobs
 
     	 [bookmark: pgfId-1450045]File Servers
 
     	 [bookmark: pgfId-1450049]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1450051][bookmark: 66262]Device OS Management Screen
 
     [bookmark: pgfId-1450052]The Device OS Management screen allows you to view information about the software images used by a managed device. You can also start the Software Installation Wizard from the Device OS Management Summary pane.
 
    
 
     
      [bookmark: pgfId-1450054][bookmark: 31416]Software Installation Jobs
 
     [bookmark: pgfId-1450055]The Software Installation Jobs feature allows you to create and monitor software installation jobs. Cisco DCNM provides the Software Installation Wizard, which you use to specify all the necessary information for configuring a software installation job.
 
     [bookmark: pgfId-1450056]You can create software installation jobs that affect one or more managed devices. You can use software images that are already in the local file system of the devices or Cisco DCNM can instruct each managed device included in a job to transfer software images to the local file system on the managed device. Your options are as follows:
 
      
      	 [bookmark: pgfId-1450057]Device file system—You can use software images that are in the local file system of the devices. You must ensure that the images exist on the devices prior to configuring the installation job.
 
     
 
     [bookmark: pgfId-1450058]You can specify a software image for a device type category rather than for a single device; however, the image that you specify must exist on each device in the category in the same location and with the same filename. For example, if you specify bootflash:/images/n7000-s1-dk9.4.1.2.upg.bin, the n7000-s1-dk9.4.1.2.upg.bin image file must exist in bootflash:/images on each device in the device category.
 
      
      	 [bookmark: pgfId-1450059]File server—You can use a file server that you have configured in Cisco DCNM. If you use a file server, Cisco DCNM uses the information that you provide when you configure the file server and when you configure the software installation job to assemble a URL that the managed devices in the job can use to retrieve the software images.
 
     
 
     [bookmark: pgfId-1450060]Before configuring a software installation job, you should ensure that the software images are on the file server. You must also configure the file server in Cisco DCNM. For more information, see the “File Servers” section.
 
      
      	 [bookmark: pgfId-1450064]URL—You can use a URL to specify the image files. The verification that Cisco DCNM performs for a URL varies depending upon the transfer protocol that you use, as follows:
 
     
 
     [bookmark: pgfId-1450065] – FTP—Cisco DCNM verifies the URL format, that the FTP server in the URL is reachable, and that the specified image file exists on the FTP server. The FTP URL format is as follows:
 
     [bookmark: pgfId-1450066]ftp://username@servername/path/filename 
 
     [bookmark: pgfId-1450067] – SFTP—Cisco DCNM verifies the URL format, that the SFTP server in the URL is reachable, and that the image file specified exists on the SFTP server. The SFTP URL format is as follows:
 
     [bookmark: pgfId-1450068]sftp://username@servername/path/filename 
 
     [bookmark: pgfId-1450069] – TFTP—You must ensure that the path and image filename are correct. Cisco DCNM verifies the URL format and that the TFTP server in the URL is reachable. The TFTP URL format is as follows:
 
     [bookmark: pgfId-1450070]tftp://servername/path/filename 
 
     [bookmark: pgfId-1450071] – SCP—You must ensure that the SCP server is reachable and that the path and image filename are correct. Cisco DCNM verifies the URL format. The SCP URL format is as follows:
 
     [bookmark: pgfId-1450072]scp://username@servername/path/filename 
 
     [bookmark: pgfId-1450073]The Software Installation Wizard includes an optional step for verifying the version compatibility of software images with the managed devices. During this step, if a software image was specified by a URL or file server, Cisco DCNM instructs managed devices to copy the software image from the URL or file server to the bootflash file system on the device. If you skip the version compatibility step, Cisco DCNM does not instruct devices to copy software images from URLs or file servers until the installation job begins.
 
    
 
     
      [bookmark: pgfId-1450075][bookmark: 46483]File Servers
 
     [bookmark: pgfId-1450076]The File Servers feature allows you to configure files servers, which you can use for the following purposes:
 
      
      	 [bookmark: pgfId-1450077]Software installation jobs—Cisco DCNM can get software image files from a file server and transfer them to devices included in a software installation job.
 
      	 [bookmark: pgfId-1450078]Configuration rollbacks—Cisco DCNM can back up device configurations to a file server when you roll back a device configuration.
 
     
 
     [bookmark: pgfId-1450079]Cisco DCNM supports file servers that use the following protocols:
 
      
      	 [bookmark: pgfId-1450080]FTP
 
      	 [bookmark: pgfId-1450081]SFTP
 
      	 [bookmark: pgfId-1452085]TFTP
 
     
 
     [bookmark: pgfId-1452086]If you use a file server in a software installation job, consider the following items:
 
      
      	 [bookmark: pgfId-1452087]The managed devices included in the job must be able to connect to the file server directly.
 
      	 [bookmark: pgfId-1452100]To ensure that software image files transfer as quickly as possible, use a file server that is on the same LAN as the devices included in the software installation job. If the available file servers transfer software image files too slowly, before you create the software installation job, manually copy the files to the devices that you will include the job and configure the job to use the manually copied files rather than a file server.
 
     
 
    
 
     
      [bookmark: pgfId-1450085][bookmark: 79174]Virtualization Support
 
     [bookmark: pgfId-1450086]Device software images apply to physical devices rather than virtual device contexts (VDCs). When you change the software image on a managed device, all VDCs on the device use the new software image.
 
    
 
   
 
    
     [bookmark: pgfId-1450088][bookmark: 51127]Licensing Requirements for Device OS Management
 
    [bookmark: pgfId-1450089]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1450102]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1450092]Product 
         
  
        	 
          
          [bookmark: pgfId-1450094]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1450096]Cisco DCNM
  
        	[bookmark: pgfId-1450098]Device OS Management requires a LAN Enterprise license. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1450104][bookmark: 78783]Prerequisites for Device OS Management
 
    [bookmark: pgfId-1450105]The Device OS Management feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1450106]The Device OS Management feature supports only devices that are managed by Cisco DCNM, which means that Cisco DCNM must have successfully discovered the device.
 
     	 [bookmark: pgfId-1450107]The Device OS Management feature supports only devices that you have added to the list of Cisco DCNM-licensed devices.
 
     	 [bookmark: pgfId-1450108]Devices included in a software installation job must be reachable by Cisco DCNM when a software installation job occurs. Software installation jobs fail for unreachable devices.
 
    
 
   
 
    
     [bookmark: pgfId-1450110][bookmark: 87804]Guidelines and Limitations for Device OS Management
 
    [bookmark: pgfId-1450111]The Device OS Management feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1450112]URLs and file servers used in a software installation job must be reachable by the managed devices included in the job.
 
     	 [bookmark: pgfId-1450113]If you use a DNS name in a URL or when you configure a file server, ensure that managed devices using the URL or file server can resolve the DNS name.
 
     	 [bookmark: pgfId-1450114]Software installation jobs do not reload connectivity management processors (CMPs). You must manually reload CMPs as needed when a software installation job completes. The status for a completed software installation job includes messages about CMPs that must be reloaded manually. For more information, see the  Cisco Nexus 7000 Series NX-OS Software Upgrade and Downgrade Guide, Release 4.x .
 
     	 [bookmark: pgfId-1450118]For Cisco Nexus 7000 series devices that have a single supervisor module, a software installation job does not reload the device. After the installation job completes, to run the newly installed software image on a single-supervisor Nexus 7000 series device, you must manually reload the device. For more information, see the  Cisco Nexus 7000 Series NX-OS Software Upgrade and Downgrade Guide, Release 4.x .
 
    
 
   
 
    
     [bookmark: pgfId-1389483][bookmark: 54640]Using the Device OS Management Window[bookmark: marker-1400968]
 
    [bookmark: pgfId-1450142]Figure 13-1 shows the Device OS Management content pane.
 
    [bookmark: pgfId-1450144]Figure 13-1 [bookmark: 10762]Device OS Management Content Pane
 
    [bookmark: pgfId-1450148]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1450149]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1450153]Viewing Device Image Details
 
     	 [bookmark: pgfId-1450157]Installing Software on a Device
 
    
 
     
      [bookmark: pgfId-1388447][bookmark: 91967]Viewing Device Image Details[bookmark: marker-1388446]
 
     [bookmark: pgfId-1388448]You can view details about the software image on a managed device.
 
    
 
     
      [bookmark: pgfId-1388449]DETAILED STEPS
 
     [bookmark: pgfId-1388450]To view details about a software image on a managed device, follow these steps:
 
     
 
     [bookmark: pgfId-1388451]Step 1 From the Feature Selector pane, choose Device OS Management.
 
     [bookmark: pgfId-1388452]A table of managed devices appears in the Summary pane. Each row displays software image information about a device. Devices are listed alphabetically.
 
     [bookmark: pgfId-1388453]Step 2 Click the device for which you want to see software image details.
 
     [bookmark: pgfId-1388454]The Details pane displays two sections of information. In addition to displaying the information also shown in the Summary pane, if an installation job is scheduled, the System section displays a message about any scheduled installation job, including a link to the installation job.
 
     [bookmark: pgfId-1388455]The Software Installation Jobs section displays information about future, ongoing, and past installation jobs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1388456]Tip To expand or collapse the System or the Software Installation Jobs sections, double-click the section title.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1388457]Step 3 (Optional) To open a scheduled software installation job, in the System section, click the link to the installation job.
 
     [bookmark: pgfId-1388458]The Feature Selector pane changes to the Software Installation Jobs feature. For more information, see the “Viewing Software Installation Job Details” section.
 
     [bookmark: pgfId-1388462]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1389801][bookmark: 45634]Installing Software on a Device[bookmark: marker-1400969]
 
     [bookmark: pgfId-1394020]You can install software on a device listed on the Device OS Management Summary pane. Installing software from the Device OS Management Summary pane starts the Software Installation Wizard, which allows you to create or modify a software installation job.
 
    
 
     
      [bookmark: pgfId-1397634]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1397635]Ensure that the software images that you want to install are available by one of the options that the Software Installation Wizard supports. For more information, see the “Software Installation Jobs” section. 
 
    
 
     
      [bookmark: pgfId-1394075]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1394472]Step 1 From the Feature Selector pane, choose Device OS Management >Device OS Management.
 
     [bookmark: pgfId-1394473]A table of managed devices appears in the Summary pane.
 
     [bookmark: pgfId-1394363]Step 2 Click a device that you want to include in a new software installation job.
 
     [bookmark: pgfId-1394538]Step 3 From the menu bar, choose Actions > Install Software.
 
     [bookmark: pgfId-1396608]The Software Installation Wizard dialog box displays the Select Switches step. The device that you selected is listed under Selected Switches.
 
     [bookmark: pgfId-1394786]Step 4 To use the Wizard, see the “Using the Software Installation Wizard” section.
 
     [bookmark: pgfId-1394364]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1397762][bookmark: 81912]Configuring Software Installation Jobs[bookmark: marker-1400971]
 
    [bookmark: pgfId-1450268]Figure 13-2 shows the Software Installation Jobs content pane.
 
    [bookmark: pgfId-1450270]Figure 13-2 [bookmark: 54160]Software Installation Jobs Content Pane
 
    [bookmark: pgfId-1450274]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1450275]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1452340]Viewing Software Installation Job Details
 
     	 [bookmark: pgfId-1452344]Creating or Editing a Software Installation Job
 
     	 [bookmark: pgfId-1452348]Using the Software Installation Wizard
 
     	 [bookmark: pgfId-1450291]Rescheduling a Software Installation Job
 
     	 [bookmark: pgfId-1450295]Deleting a Software Installation Job
 
     	 [bookmark: pgfId-1450299]Adding or Changing Comments for a Software Installation Job
 
    
 
     
      [bookmark: pgfId-1386708][bookmark: 72635]Viewing Software Installation Job Details[bookmark: marker-1386707]
 
     [bookmark: pgfId-1386709]You can view the details of a software installation job, including its status.
 
    
 
     
      [bookmark: pgfId-1386710]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1386711]You must have configured a software installation job before you can view its details.
 
    
 
     
      [bookmark: pgfId-1386712]DETAILED STEPS
 
     [bookmark: pgfId-1386713]To view software installation job details, follow these steps:
 
     
 
     [bookmark: pgfId-1386714]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs. 
 
     [bookmark: pgfId-1386715]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1386716]Step 2 Click the software installation job for which you want to view details.
 
     [bookmark: pgfId-1386717]The Details pane displays two sections of information. The General section displays the job ID, the job owner, scheduling information, comments, and installation options.
 
     [bookmark: pgfId-1386718]The Device and Software Images section displays a table of devices included in the job, the software images to be installed on each device, and the status of the installation for the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1386719]Tip To expand or collapse the General or the Device and Software Images sections, double-click the section title.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1386720]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1396876][bookmark: 38169]Creating or Editing a Software Installation Job[bookmark: marker-1400975]
 
     [bookmark: pgfId-1397572]From the Software Installation Jobs content pane, you can create a software installation job or edit an existing job. Creating or editing a job from the Software Installation Jobs content pane starts the Software Installation Wizard, which allows you to create or modify a job.
 
    
 
     
      [bookmark: pgfId-1397573]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1418702]Ensure that the software images that you want to install are available by one of the options that the Software Installation Wizard supports. For more information, see the “Software Installation Jobs” section.
 
     [bookmark: pgfId-1452232]To ensure that software image files transfer as quickly as possible, use a file server that is on the same LAN as the devices included in the software installation job. If the available file servers transfer software image files too slowly, before you create the software installation job, manually copy the files to the devices that you will include the job and configure the job to use the manually copied files rather than a file server.
 
    
 
     
      [bookmark: pgfId-1417233]DETAILED STEPS
 
     [bookmark: pgfId-1396115]To create or edit a software installation job, follow these steps:
 
     
 
     [bookmark: pgfId-1396236]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1396237]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1396238]Step 2 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1396239]If you want to create a job, from the menu bar, choose  Actions > New .
 
       	 [bookmark: pgfId-1396241]If you want to edit a job, in the Summary pane, click the job, and then, from the menu bar, choose  Actions > Edit .
 
      
 
     
 
     [bookmark: pgfId-1396495]The Software Installation Wizard dialog box displays the Select Switches step.
 
     [bookmark: pgfId-1396530]Step 3 To use the wizard, see the “Using the Software Installation Wizard” section.
 
     [bookmark: pgfId-1396148]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1397910][bookmark: 63326]Using the Software Installation Wizard[bookmark: marker-1397909]
 
     [bookmark: pgfId-1394919]You can use the Software Installation Wizard to configure a new software installation job or make changes to an existing software installation job.
 
    
 
     
      [bookmark: pgfId-1120750]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1396275]Start the Software Installation Wizard, from one of the following places:
 
      
      	 [bookmark: pgfId-1396374]Device OS Management—See the “Installing Software on a Device” section.
 
      	 [bookmark: pgfId-1396378]Software Installation Jobs—See the “Creating or Editing a Software Installation Job” section.
 
     
 
    
 
     
      [bookmark: pgfId-1396271]DETAILED STEPS
 
     [bookmark: pgfId-1120754]To use the Software Installation Wizard, follow these steps:
 
     
 
     [bookmark: pgfId-1377590]Step 1 In the Software Installation Wizard dialog box, follow these steps for each device that you want to include in the installation job:
 
     [bookmark: pgfId-1377620] a. Under Available Switches, click the device.
 
     [bookmark: pgfId-1377702] b. Click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-1379628]Tip To remove a device from the job, under Selected Switches, click the device and then click Remove.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1377703]Step 2 Click Next.
 
     [bookmark: pgfId-1377771]The Software Installation Wizard dialog box displays the Specify Software Images step. Devices are categorized by the physical device type. You can specify software images for each device individually or for an entire category of devices of the same physical type.
 
     [bookmark: pgfId-1377704]Step 3 [bookmark: 68317]For each device or physical device category, specify a kickstart image and a system image. To do so, follow these steps once for the Kickstart Image text box and again for the System Image text box:
 
     [bookmark: pgfId-1377809] a. In the applicable image text box, click to activate the text box and then click the more button.
 
     [bookmark: pgfId-1377933]The Software Image Browser dialog box appears.
 
     [bookmark: pgfId-1378003] b. Specify the location of the file for the software image to be installed. To do so, choose one of the following options:
 
      
      	 [bookmark: pgfId-1378004]File Server—If you choose this option, you must pick a file server from the Repository list, navigate the folders on the file server, and select the software image file.
 
      	 [bookmark: pgfId-1378069]Switch File System—If you choose this option, you must navigate the file system on a device and select the software image file.
 
     
 
     [bookmark: pgfId-1380717]If you are specifying a software image for a device type category, the image specified must exist on each device in the category, in the same location and with the same filename.
 
      
      	 [bookmark: pgfId-1378089]URL—If you choose this option, enter the URL in the URL text box. If the transfer protocol that you use includes a username in the URL, in the Password text box type the password for the username in the URL.
 
     
 
     [bookmark: pgfId-1378441] c. Click OK.
 
     [bookmark: pgfId-1378590]If you specified a URL, Cisco DCNM verifies the URL.
 
     [bookmark: pgfId-1418237]The Software Image Browser dialog box closes. The applicable image text box displays the software image that you chose.
 
     [bookmark: pgfId-1378259]Step 4 (Optional) If you do not want the Software Installation Wizard to verify that the selected kickstart and system software images are compatible with a device, check the Skip Version Compatibility check box in the row of the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1407337]Tip The Next button remains unavailable until you have specified a kickstart image and a system image for each device included in the software installation job.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1378576]Step 5 Click Next.
 
     [bookmark: pgfId-1379977]If you specified a URL or a software image repository for the location of software images, Cisco DCNM instructs the devices in the job to retrieve the images from the specified locations.
 
     [bookmark: pgfId-1407359]If any device does not have enough space in its local file system to receive the software image files, a dialog box provides you the option to free up space on the device.
 
     [bookmark: pgfId-1380039]Step 6 If you receive a warning about insufficient space on the device, do one of the following:
 
      
       
       	 [bookmark: pgfId-1380040]If you want to delete files from devices, click  Yes . Use the Delete Files dialog box to explore the local file system of devices and delete unwanted files. When you are done, click  OK and then click  Next .
 
       	 [bookmark: pgfId-1380164]If you want to remove the device from the job, click  No , click  Back , and return to Step 3.
 
       	 [bookmark: pgfId-1380132]If you want to exit the Software Installation Wizard, click  No and then click  Cancel .
 
      
 
     
 
     [bookmark: pgfId-1380041]Unless you chose to skip the version compatibility check for every device in the installation job, the Software Installation Wizard dialog box displays the Pre-installation Checks step. The Version Compatibility Check column indicates whether a device passed or failed the check.
 
     [bookmark: pgfId-1379101]Step 7 If the Software Install Wizard dialog box displays the Pre-installation Checks step, follow these steps:
 
     [bookmark: pgfId-1378815] a. If any device failed the version compatibility check, do one of the following:
 
     [bookmark: pgfId-1378816] – If you want to change the software image files specified for a device, click Back and return to Step 3.
 
     [bookmark: pgfId-1378844] – If you want the job to proceed by not installing software on devices that failed the version compatibility check, check the Skip devices with version compatibility failure check box.
 
     [bookmark: pgfId-1378817] b. Click Next.
 
     [bookmark: pgfId-1379159]The Software Installation Wizard dialog box displays the Installation Options and Schedule step.
 
     [bookmark: pgfId-1379141]Step 8 (Optional) If you want the job to save the current configuration or delete the current configuration on each device, follow these steps:
 
     [bookmark: pgfId-1379358] a. Check the Installation Options check box.
 
     [bookmark: pgfId-1379367] b. If you want the job to copy the running configuration to the startup configuration on each device, click the Save Running Configuration to Startup before Installation radio button. After the installation job, devices in the job will have the same configuration that they did prior to the job, unless the installation is an upgrade or downgrade that modifies the running configuration.
 
     [bookmark: pgfId-1379411] c. If you want the job to delete the startup configuration on each device, click the Erase Startup Configuration before Installation radio button. After the installation job completes, devices in the job will have only the default running configuration.
 
     [bookmark: pgfId-1379331]Step 9 Under Schedule, do one of the following:
 
      
       
       	 [bookmark: pgfId-1379231]If you want the software installation job to start immediately after you complete the Wizard, click the  Install Now radio button.
 
       	 [bookmark: pgfId-1379296]If you want to specify a date and time for the start of the software installation job, click the  Schedule Installation radio button and then use the  Date and Time field to specify when the job should begin.
 
      
 
     
 
     [bookmark: pgfId-1379180]Step 10 (Optional) In the Comments text box, enter a comment about the installation job.
 
     [bookmark: pgfId-1379224]Step 11 Under Execution Mode, do one of the following:
 
      
       
       	 [bookmark: pgfId-1442754]If you want the installation job to run on one device at a time before it begins on the next device included in the job, click the  Sequential  radio button.
 
       	 [bookmark: pgfId-1442643]If you want the installation job to start at the same time on all the devices included in the job, click the  Concurrent radio button.
 
      
 
     
 
     [bookmark: pgfId-1442626]Step 12 (Optional) If you want the software installation job to save the log data for failed installations, check the Archive logs from switches on DCNM server upon installation failure check box.
 
     [bookmark: pgfId-1379193]Step 13 Click Finish.
 
     [bookmark: pgfId-1380306]If you specified a date and time for the job under Schedule, the Wizard closes and the job appears in the Summary pane.
 
     [bookmark: pgfId-1380348]If you clicked the Install Now radio button under Schedule, the Software Installation Status dialog box displays information about each device in the job and the job status.
 
     [bookmark: pgfId-1380442]Step 14 If the Software Installation Status dialog box appears, do one of the following:
 
      
       
       	 [bookmark: pgfId-1380510]If you want to close the dialog box and allow the job to run, click  Run in Background .
 
       	 [bookmark: pgfId-1380577]If you want to abort software installation on one or more devices, for each device, click the device and click  Abort Selected .
 
       	 [bookmark: pgfId-1380633]If you want to abort software installation for all devices, click  Abort All .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1380668]Tip If you abort software installation on all devices, click Close to close the dialog box.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1120935]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1118637][bookmark: 69928]Rescheduling a Software Installation Job[bookmark: marker-1173979]
 
     [bookmark: pgfId-1118662]You can change the scheduled date and time of a software installation job.
 
    
 
     
      [bookmark: pgfId-1118677]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1118944]The software installation job that you want to reschedule must have a status of Scheduled. You cannot reschedule aborted or completed jobs.
 
    
 
     
      [bookmark: pgfId-1118932]DETAILED STEPS
 
     [bookmark: pgfId-1118839]To reschedule a software installation job, follow these steps:
 
     
 
     [bookmark: pgfId-1118867]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1381680]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1118720]Step 2 In the Summary pane, click the job that you want to reschedule.
 
     [bookmark: pgfId-1381693]The Details pane displays information about the job.
 
     [bookmark: pgfId-1381725]Step 3 (Optional) From the Details tab, expand the General section, if necessary.
 
     [bookmark: pgfId-1381862]Step 4 Use the Scheduled At field to specify when the job should begin.
 
     [bookmark: pgfId-1381798]Step 5 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1118732]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375223][bookmark: 48260]Deleting a Software Installation Job[bookmark: marker-1375222]
 
     [bookmark: pgfId-1375224]You can delete a software installation job, regardless of its state. In the Summary pane for Software Installation Jobs, completed and aborted jobs remain until you delete them.
 
    
 
     
      [bookmark: pgfId-1375228]DETAILED STEPS
 
     [bookmark: pgfId-1381870]To delete a software installation job, follow these steps:
 
     
 
     [bookmark: pgfId-1381871]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1381872]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1381873]Step 2 In the Summary pane, click the job that you want to delete.
 
     [bookmark: pgfId-1381874]The Details pane displays information about the job.
 
     [bookmark: pgfId-1381875]Step 3 From the menu bar, choose Actions > Delete.
 
     [bookmark: pgfId-1381876]A Warning dialog box displays a confirmation message.
 
     [bookmark: pgfId-1382007]Step 4 Click Yes.
 
     [bookmark: pgfId-1381877]The job is removed from the summary pane. You do not need to save your changes.
 
     [bookmark: pgfId-1421414]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375271][bookmark: 58804]Adding or Changing Comments for a Software Installation Job[bookmark: marker-1375270]
 
     [bookmark: pgfId-1375272]You can add or change the comments associated with a software installation job.
 
    
 
     
      [bookmark: pgfId-1375276]DETAILED STEPS
 
     [bookmark: pgfId-1382125]To add or change comments for a software installation job, follow these steps:
 
     
 
     [bookmark: pgfId-1382107]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1382108]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1382109]Step 2 In the Summary pane, click the job for which you want to add or change comments.
 
     [bookmark: pgfId-1382110]The Details pane displays information about the job.
 
     [bookmark: pgfId-1382111]Step 3 (Optional) From the Details tab, expand the General section, if necessary.
 
     [bookmark: pgfId-1382112]Step 4 In the Comments field, enter your comments.
 
     [bookmark: pgfId-1382113]Step 5 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1382114]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1382170][bookmark: 65161]Changing Installation Options for a Software Installation Job[bookmark: marker-1382169]
 
     [bookmark: pgfId-1382171]You can change the installation options associated with a software installation job. Installation options allow you to specify whether Cisco DCNM should save the running configuration of devices, delete the startup configuration, or take no action on the configuration of devices prior to installing the software.
 
    
 
     
      [bookmark: pgfId-1382173]DETAILED STEPS
 
     [bookmark: pgfId-1382174]To change installation options for a software installation job, follow these steps:
 
     
 
     [bookmark: pgfId-1382175]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1382176]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1382177]Step 2 In the Summary pane, click the job for which you want to add or change comments.
 
     [bookmark: pgfId-1382178]The Details pane displays information about the job.
 
     [bookmark: pgfId-1382179]Step 3 (Optional) From the Details tab, expand the General section, if necessary.
 
     [bookmark: pgfId-1382443]Step 4 If you want devices in the software installation job to have only the default device configuration after the installation job completes, follow these steps:
 
     [bookmark: pgfId-1382511] a. Check the Installation Options check box.
 
     [bookmark: pgfId-1382513] b. If you want the job to delete the startup configuration on each device, click the Erase Startup Configuration before Installation radio button.
 
     [bookmark: pgfId-1382493]Step 5 If you want devices in the software installation job to have the same running configuration after the installation job completes, follow these steps:
 
     [bookmark: pgfId-1382586] a. Check the Installation Options check box.
 
     [bookmark: pgfId-1382688] b. If you want the job to copy the running configuration to the startup configuration on each device, click the Save Running Configuration to Startup before Installation radio button.
 
     [bookmark: pgfId-1382689]Step 6 If you want the devices in the software installation job to use their current startup configuration as their running configuration after the software installation job completes, uncheck the Installation Options check box.
 
     [bookmark: pgfId-1382690]Step 7 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1382182]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1390009][bookmark: 84558]Configuring File Servers[bookmark: marker-1400977]
 
    [bookmark: pgfId-1450615]Figure 13-3 shows the File Servers content pane.
 
    [bookmark: pgfId-1450617]Figure 13-3 [bookmark: 63582]File Servers Content Pane
 
    [bookmark: pgfId-1450621]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1450622]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1450626]Adding a File Server
 
     	 [bookmark: pgfId-1450630]Changing a File Server
 
     	 [bookmark: pgfId-1450634]Deleting a File Server
 
    
 
     
      [bookmark: pgfId-1375329][bookmark: 13500]Adding a File Server[bookmark: marker-1375328]
 
     [bookmark: pgfId-1375330]You can add a file server to Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1375332]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375333]Gather the following information about the file server:
 
      
      	 [bookmark: pgfId-1382817]Server IP address or hostname
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1382837]Note If you use the hostname, it must be registered with the DNS server that the Cisco DCNM server is configured to use.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1382933]Transfer protocol that the server provides. Cisco DCNM supports the following transfer protocols:
 
     
 
     [bookmark: pgfId-1382954] – FTP
 
     [bookmark: pgfId-1382966] – SFTP
 
     [bookmark: pgfId-1382971] – TFTP
 
      
      	 [bookmark: pgfId-1382982]Username and password that Cisco DCNM should use to access the server.
 
      	 [bookmark: pgfId-1383005]The base directory on the server. All files and directories that Cisco DCNM needs to access must be available under this directory.
 
     
 
    
 
     
      [bookmark: pgfId-1375334]DETAILED STEPS
 
     [bookmark: pgfId-1375335]To add a file server, follow these steps:
 
     
 
     [bookmark: pgfId-1383028]Step 1 From the Feature Selector pane, choose Device OS Management > File Servers.
 
     [bookmark: pgfId-1383029]The Contents pane displays a table of file servers.
 
     [bookmark: pgfId-1383030]Step 2 From the menu bar, choose Actions > New File Server.
 
     [bookmark: pgfId-1383031]A new row appears in the Contents pane, with the cursor in the Server Name/IP Address field.
 
     [bookmark: pgfId-1383032]Step 3 In the Server Name/IP Address field, enter the IP address or hostname of the file server.
 
     [bookmark: pgfId-1383143]Step 4 Double-click the Protocol field and choose the protocol from the list that appears. Supported protocols are as follows:
 
      
       
       	 [bookmark: pgfId-1383146]FTP
 
       	 [bookmark: pgfId-1383157]SFTP
 
       	 [bookmark: pgfId-1383162]TFTP
 
      
 
     
 
     [bookmark: pgfId-1383040]Step 5 If the file server requires authentication, double-click the User Credentials field and enter the username and password for the server. If you want Cisco DCNM to remember the password, check the Save Password check box.
 
     [bookmark: pgfId-1383219]Step 6 Double-click the Base Directory field.
 
     [bookmark: pgfId-1383234]The Software Image Browser dialog box appears.
 
     [bookmark: pgfId-1383228]Step 7 Explore the server file system and choose the directory that Cisco DCNM should use as the base directory. All files and directories that Cisco DCNM needs to access must be located under this directory. By default, the root directory of the server is the base directory.
 
     [bookmark: pgfId-1383250]Step 8 (Optional) Double-click the Comment field and enter your comments.
 
     [bookmark: pgfId-1383167]Step 9 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1375341]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375388][bookmark: 52847]Changing a File Server[bookmark: marker-1383530]
 
     [bookmark: pgfId-1383258]You can change the user credentials, base directory, and comments of a file server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383265]Note You cannot change the values in the Server Name/IP Address or Protocol fields. If you need to change these values, delete the file server and create a file server with the new values.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383314]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1383344]If you are changing the user credentials or base directory, determine what the new user credentials or base directory should be.
 
    
 
     
      [bookmark: pgfId-1383362]DETAILED STEPS
 
     [bookmark: pgfId-1383378]To change a file server, follow these steps:
 
     
 
     [bookmark: pgfId-1383543]Step 1 From the Feature Selector pane, choose Device OS Management > File Servers.
 
     [bookmark: pgfId-1383544]The Contents pane displays a table of file servers.
 
     [bookmark: pgfId-1383684]Step 2 In the table, locate the row for the file server that you want to change.
 
     [bookmark: pgfId-1383738]Step 3 Perform the following items to change the file server entry as needed:
 
      
       
       	 [bookmark: pgfId-1383608]If you want to change the user credentials, double-click the User Credentials field for the file server and enter or clear the username and password for the server. If you want Cisco DCNM to remember the password, check the  Save Password check box.
 
       	 [bookmark: pgfId-1383630]If you want to change the base directory, double-click the Base Directory field and use the Software Image Browser dialog box to choose the directory that Cisco DCNM should use as the base directory.
 
       	 [bookmark: pgfId-1383652]If you want to change the comments, double-click the Comments field and enter your comments.
 
      
 
     
 
     [bookmark: pgfId-1383578]Step 4 From the menu bar, choose File > Deploy to save the file server changes.
 
     [bookmark: pgfId-1383467]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383470][bookmark: 88466]Deleting a File Server[bookmark: marker-1383469]
 
     [bookmark: pgfId-1375389]You can delete a file server.
 
    
 
     
      [bookmark: pgfId-1375391]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375392]Ensure that the file server is specified in the Archival Settings feature as the file server for configuration rollback. For more information, see the “Configuring the Rollback File Server Setting” section.
 
    
 
     
      [bookmark: pgfId-1375393]DETAILED STEPS
 
     [bookmark: pgfId-1375394]To delete a file server, follow these steps:
 
     
 
     [bookmark: pgfId-1383766]Step 1 From the Feature Selector pane, choose Device OS Management > File Servers.
 
     [bookmark: pgfId-1383767]The Contents pane displays a table of file servers.
 
     [bookmark: pgfId-1383768]Step 2 In the table, click the row for the file server that you want to delete.
 
     [bookmark: pgfId-1375397]Step 3 From the menu bar, choose Actions > Delete.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383826]Note If the file server is specified in the Archival Settings feature as the file server for a configuration rollback, a dialog box informs you that the file server cannot be deleted. For more information, see the “Configuring the Rollback File Server Setting” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1417196]The file server is removed from the summary pane. You do not need to save your changes.
 
     [bookmark: pgfId-1375400]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1450697][bookmark: 59585]Field Descriptions for Device OS Management
 
    [bookmark: pgfId-1450698]This section includes field descriptions for the three features available in the Feature Selector drawer for Device OS Management:
 
     
     	 [bookmark: pgfId-1450702]Field Descriptions for Device OS Management
 
     	 [bookmark: pgfId-1450706]Field Descriptions for Software Installation Jobs
 
     	 [bookmark: pgfId-1450710]Field Descriptions for the File Servers Contents Pane
 
    
 
     
      [bookmark: pgfId-1450712][bookmark: 49384]Field Descriptions for Device OS Management
 
     [bookmark: pgfId-1450713]This section includes the following field descriptions for the Device OS Management feature:
 
      
      	 [bookmark: pgfId-1450717]Device: Details: System Section
 
      	 [bookmark: pgfId-1450721]Device: Details: Software Installation Jobs Section
 
     
 
    
 
     
      [bookmark: pgfId-1450723][bookmark: 59437]Device: Details: System Section
 
     [bookmark: pgfId-1450772]
 
      
       
        
        [bookmark: pgfId-1450729]Table 13-1 Device: Details: System Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1450733]Field 
          
  
         	 
           
           [bookmark: pgfId-1450735]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1450737]System 
          
  
        
 
         
         	[bookmark: pgfId-1450741]Device Name
  
         	[bookmark: pgfId-1450743]Display only. Name of the managed device.
  
        
 
         
         	[bookmark: pgfId-1450745]IP Address
  
         	[bookmark: pgfId-1450747]Display only. IP address that Cisco DCNM uses to connect to the managed device.
  
        
 
         
         	[bookmark: pgfId-1450749]Model
  
         	[bookmark: pgfId-1450751]Display only. Hardware model name of the managed device.
  
        
 
         
         	[bookmark: pgfId-1450753]Redundancy Supervisor
  
         	[bookmark: pgfId-1450755]Display only. Whether the device has a secondary supervisor module.
  
        
 
         
         	 
           
           [bookmark: pgfId-1450757]Software 
          
  
        
 
         
         	[bookmark: pgfId-1450761]System Version
  
         	[bookmark: pgfId-1450763]Display only. Release number of the system image currently installed on the managed device.
  
        
 
         
         	[bookmark: pgfId-1450765]System Image
  
         	[bookmark: pgfId-1450767]Display only. Filename of the system image currently installed on the managed device.
  
        
 
         
         	[bookmark: pgfId-1450769]Kickstart Image
  
         	 
           
            
             
             [bookmark: pgfId-1450780]Table 13-2 Device: Details: Software Installation Jobs Section 
 
             
             
              
              	 
                
                [bookmark: pgfId-1450784]Field 
               
  
              	 
                
                [bookmark: pgfId-1450786]Description 
               
  
             
 
              
              	[bookmark: pgfId-1450788]Job ID
  
              	[bookmark: pgfId-1450790]Display only. Identification number of the job.
  
             
 
              
              	[bookmark: pgfId-1450792]Owner
  
              	[bookmark: pgfId-1450794]Display only. Cisco DCNM user who created the installation job.
  
             
 
              
              	[bookmark: pgfId-1450796]Software Image and Version
  
              	[bookmark: pgfId-1450798]Display only. Name of the system image specified in the job.
  
             
 
              
              	[bookmark: pgfId-1450800]Scheduled At
  
              	[bookmark: pgfId-1450802]Display only. Date and time that the installation job is scheduled to occur.
  
             
 
              
              	[bookmark: pgfId-1450804]Completed At
  
              	[bookmark: pgfId-1450806]Display only. Date and time that the installation job occurred. If the job has not completed, this field is blank.
  
             
 
              
              	[bookmark: pgfId-1450808]Status
  
              	[bookmark: pgfId-1450810]Display only. Status of the installation job. If the job is ongoing, failed, or successful, you can expand the status and see more information about the job.
  
             
 
              
              	[bookmark: pgfId-1450812]Comment
  
              	[bookmark: pgfId-1450814]Display only. Text of any comments added to the installation job.
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1450817][bookmark: 57584]Field Descriptions for Software Installation Jobs
 
           [bookmark: pgfId-1450818]This section includes the following field descriptions for the Software Installation Jobs feature:
 
            
            	 [bookmark: pgfId-1450822]Installation Job: Details: General Section
 
            	 [bookmark: pgfId-1450826]Installation Job: Details: Devices and Software Images Section
 
           
 
          
 
           
            [bookmark: pgfId-1450828][bookmark: 33753]Installation Job: Details: General Section
 
           [bookmark: pgfId-1450885]
 
            
             
              
              [bookmark: pgfId-1450834]Table 13-3 Installation Job: Details: General Section 
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1450838]Field 
                
  
               	 
                 
                 [bookmark: pgfId-1450840]Description 
                
  
              
 
               
               	 
                 
                 [bookmark: pgfId-1450842]General 
                
  
              
 
               
               	[bookmark: pgfId-1450846]Job ID
  
               	[bookmark: pgfId-1450848]Display only. Identification number of the job.
  
              
 
               
               	[bookmark: pgfId-1450850]Owner
  
               	[bookmark: pgfId-1450852]Display only. Cisco DCNM user who created the installation job.
  
              
 
               
               	[bookmark: pgfId-1450854]Scheduled At
  
               	[bookmark: pgfId-1450856]Date and time that the installation job is scheduled to occur. If the job has not yet occurred, this field is configurable.
  
              
 
               
               	[bookmark: pgfId-1450858]Completed At
  
               	[bookmark: pgfId-1450860]Display only. Date and time that the installation job occurred. If the job has not completed, this field is blank.
  
              
 
               
               	[bookmark: pgfId-1450862]Status
  
               	[bookmark: pgfId-1450864]Display only. Status of the installation job.
  
              
 
               
               	[bookmark: pgfId-1450866]Comment
  
               	[bookmark: pgfId-1450868]Text entered by Cisco DCNM users.
  
              
 
               
               	 
                 
                 [bookmark: pgfId-1450870]Installation Options 
                
  
              
 
               
               	[bookmark: pgfId-1450874]Installation Options
  
               	[bookmark: pgfId-1450876]Whether the installation job affects the startup configuration. By default, this check box is unchecked.
  
              
 
               
               	[bookmark: pgfId-1450878]Save Running Configuration to Startup before Installation
  
               	[bookmark: pgfId-1450880]Specifies that the installation job copies the running configuration of each device in the job to its startup configuration prior to installing the software image.
  
              
 
               
               	[bookmark: pgfId-1450882]Erase Startup Configuration before Installation
  
               	 
                 
                  
                   
                   [bookmark: pgfId-1450893]Table 13-4 Installation Job: Details: General Section 
 
                   
                   
                    
                    	 
                      
                      [bookmark: pgfId-1450897]Field 
                     
  
                    	 
                      
                      [bookmark: pgfId-1450899]Description 
                     
  
                   
 
                    
                    	[bookmark: pgfId-1450901]Device
  
                    	[bookmark: pgfId-1450903]Display only. Name of the managed device.
  
                   
 
                    
                    	[bookmark: pgfId-1450905]Platform
  
                    	[bookmark: pgfId-1450907]Display only. Hardware model name of the managed device.
  
                   
 
                    
                    	[bookmark: pgfId-1450909]Kickstart Image
  
                    	[bookmark: pgfId-1450911]Display only. Filename of the kickstart image currently installed on the managed device.
  
                   
 
                    
                    	[bookmark: pgfId-1450913]System Image
  
                    	 
                      
                       
                        
                        [bookmark: pgfId-1450924]Table 13-5 File Servers Contents Pane 
 
                        
                        
                         
                         	 
                           
                           [bookmark: pgfId-1450928]Field 
                          
  
                         	 
                           
                           [bookmark: pgfId-1450930]Description 
                          
  
                        
 
                         
                         	[bookmark: pgfId-1450932]Server Name/IP Address
  
                         	[bookmark: pgfId-1450934]DNS name or IP address of the file server. If you use the file server in a software installation job, ensure that devices in the job can connect to the name or address that you specify. This field is editable only when you create the file server entry. You cannot edit it after saving your changes to the Cisco DCNM server.
  
                        
 
                         
                         	[bookmark: pgfId-1450936]Protocol
  
                         	[bookmark: pgfId-1450938]Transfer protocol supported by the server. Valid values are as follows:
 
                           
                           	 [bookmark: pgfId-1450939]FTP
 
                           	 [bookmark: pgfId-1450940]SFTP
 
                           	 [bookmark: pgfId-1450941]TFTP
 
                          
 [bookmark: pgfId-1450942]This field is editable only when you create the file server entry. You cannot edit it after saving your changes to the Cisco DCNM server.
  
                        
 
                         
                         	[bookmark: pgfId-1450944]User Credentials
  
                         	[bookmark: pgfId-1450946]Username and password required to access the file server.
  
                        
 
                         
                         	[bookmark: pgfId-1450948]Base Directory
  
                         	[bookmark: pgfId-1450950]Directory that Cisco DCNM should consider as the root directory on the server. Directories specified for software installation jobs using this server will be relative to this directory.
  
                        
 
                         
                         	[bookmark: pgfId-1450952]Comment
  
                         	[bookmark: pgfId-1450954]Text entered by Cisco DCNM users.
  
                        
 
                        
                      
 
                     
 
                      
                       [bookmark: pgfId-1450957][bookmark: 53004]Additional References
 
                      [bookmark: pgfId-1450958]For additional information related to the Device OS Management feature, see the following sections:
 
                       
                       	 [bookmark: pgfId-1450962]Related Documents
 
                       	 [bookmark: pgfId-1450966]Standards
 
                      
 
                       
                        [bookmark: pgfId-1450980][bookmark: 16521]Related Documents
 
                        
                         
                          
                           
                           	 
                             
                             [bookmark: pgfId-1450970]Related Topic 
                            
  
                           	 
                             
                             [bookmark: pgfId-1450972]Document Title 
                            
  
                          
 
                           
                           	[bookmark: pgfId-1450974]Upgrading and downgrading Cisco NX-OS software using the command-line interface on Nexus 7000 series switches.
  
                           	[bookmark: pgfId-1450978]Cisco Nexus 7000 Series NX-OS Software Upgrade and Downgrade Guide, Release 4.x
  
                          
 
                          
                        
 
                       
 
                      
 
                       
                        [bookmark: pgfId-1450991][bookmark: 55398]Standards
 
                        
                         
                          
                           
                           	 
                             
                             [bookmark: pgfId-1450984]Standards 
                            
  
                           	 
                             
                             [bookmark: pgfId-1450986]Title 
                            
  
                          
 
                           
                           	[bookmark: pgfId-1450988]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
                           	[bookmark: pgfId-1450990]—
  
                          
 
                          
                        
 
                       
 
                      
 
                     
 
                      
                       [bookmark: pgfId-1450993][bookmark: 92503]Feature History for Device OS Management
 
                      [bookmark: pgfId-1450997]Table 13-6 lists the release history for this feature.
 
                      [bookmark: pgfId-1451021]
 
                       
                        
                         
                         [bookmark: pgfId-1451004]Table 13-6 [bookmark: 50557]Feature History for Device OS Management 
 
                         
                         
                          
                          	 
                            
                            [bookmark: pgfId-1451010]Feature Name 
                           
  
                          	 
                            
                            [bookmark: pgfId-1451012]Releases 
                           
  
                          	 
                            
                            [bookmark: pgfId-1451014]Feature Information 
                           
  
                         
 
                          
                          	[bookmark: pgfId-1455537]Device OS Management
  
                          	[bookmark: pgfId-1455539]4.2(1)
  
                          	[bookmark: pgfId-1455541]No change from Release 4.1
  
                         
 
                          
                          	[bookmark: pgfId-1455563]Device OS Management
  
                          	[bookmark: pgfId-1455565]4.1(2)
  
                          	[bookmark: pgfId-1455567]This feature was introduced.
  
                         
 
                          
                          	[bookmark: pgfId-1455581]Software Installation Jobs
  
                          	[bookmark: pgfId-1455583]4.1(2)
  
                          	[bookmark: pgfId-1455585]This feature was introduced.
  
                         
 
                          
                          	[bookmark: pgfId-1451016]File Servers
  
                          	[bookmark: pgfId-1451018]4.1(2)
  
                          	 
                           
  
                         
 
                         
                       
 
                      
 
                     
 
                   
 
                   
                 
 
                
 
              
 
              
            
 
           
 
          
 
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1425063][bookmark: 33088]Working [bookmark: marker-1425060]with Configuration Change Management 
      
      
 
     
 
 
    [bookmark: pgfId-1459540]This chapter describes how to use the Configuration Change Management feature.
 
    [bookmark: pgfId-1459545]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1459549]Information About Configuration Change Management
 
     	 [bookmark: pgfId-1459553]Licensing Requirements for Configuration Change Management
 
     	 [bookmark: pgfId-1459557]Prerequisites for Configuration Change Management
 
     	 [bookmark: pgfId-1459561]Guidelines and Limitations for Configuration Change Management
 
     	 [bookmark: pgfId-1459565]Working with the Version Browser
 
     	 [bookmark: pgfId-1459569]Configuring Archival Jobs
 
     	 [bookmark: pgfId-1459573]Configuring Archival Settings
 
     	 [bookmark: pgfId-1459577]Field Descriptions for Configuration Change Management
 
     	 [bookmark: pgfId-1459581]Additional References
 
     	 [bookmark: pgfId-1459585]Feature History for Configuration Change Management
 
    
 
   
 
    
     [bookmark: pgfId-1459587][bookmark: 14255]Information About Configuration Change Management
 
    [bookmark: pgfId-1459588]The Configuration Change Management feature allows you to keep an archive of configurations from managed Cisco Nexus 7000 Series devices. You can view and compare archived configurations. You can roll back the running configuration of a managed device to any archived configuration version available for the device in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1459589]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1459593]Version Browser
 
     	 [bookmark: pgfId-1459597]Archival Jobs
 
     	 [bookmark: pgfId-1459601]Archival Settings
 
     	 [bookmark: pgfId-1459605]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1459607][bookmark: 18833]Version Browser
 
     [bookmark: pgfId-1459608]The Version Browser feature allows you to see information about archived configurations, view and compare specific configuration versions, and merge changes from one configuration version to another. After you modify a configuration by merging changes, you can save the modified configuration as a text file on a file system available to the computer that you are using to run the Cisco DCNM client.
 
     [bookmark: pgfId-1459609]From the Version Browser, you can initiate a configuration rollback for a device, using any of the archived configurations available in Cisco DCNM for the device. Cisco DCNM uses the rollback feature available in Cisco NX-OS. For more information about the Cisco NX-OS rollback feature, see the Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 4.x.
 
    
 
     
      [bookmark: pgfId-1459614][bookmark: 23414]Archival Jobs
 
     [bookmark: pgfId-1459615]The Archival Jobs feature allows you to control the automated archival of the running configuration on managed devices. You can add, edit, and delete custom archival jobs. A job consists of settings that determine when the job runs and a list of managed devices included in the job. You can choose to archive configurations at a regular interval, at a scheduled time on selected days, or whenever Cisco DCNM detects configuration changes on a device. You can also comment on a job.
 
     [bookmark: pgfId-1459616]The Default archival job always exists. You cannot delete it. By default, it is disabled.
 
     [bookmark: pgfId-1459617]Devices can be assigned to one archival job only. If you assign a device to an archival job, Cisco DCNM removes the device from the job that it was previously assigned to.
 
     [bookmark: pgfId-1459618]If a managed device is not assigned to a custom archival job, Cisco DCNM automatically assigns it to the Default archival job.
 
    
 
     
      [bookmark: pgfId-1459620][bookmark: 22919]Archival Settings
 
     [bookmark: pgfId-1459621]The Archival Settings feature allows you to configure settings related to configuration change management, including the number of configuration versions that Cisco DCNM stores for each managed device, how many rollback and archival history entries Cisco DCNM stores for each managed device, and which file server Cisco DCNM uses during a configuration rollback.
 
    
 
     
      [bookmark: pgfId-1459623][bookmark: 72624]Virtualization Support
 
     [bookmark: pgfId-1459624]Cisco DCNM treats each virtual device context (VDC) on a Cisco NX-OS device as a separate device; therefore, Cisco DCNM archives the running configurations of each VDC provided that Cisco DCNM has successfully discovered the VDC and views it as a managed device.
 
    
 
   
 
    
     [bookmark: pgfId-1459626][bookmark: 51127]Licensing Requirements for Configuration Change Management
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1459630]Product 
         
  
        	 
          
          [bookmark: pgfId-1459632]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1459634]Cisco DCNM
  
        	[bookmark: pgfId-1459636]Configuration Change Management requires a LAN Enterprise license. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1459642][bookmark: 78783]Prerequisites for Configuration Change Management
 
    [bookmark: pgfId-1459643]The Configuration Change Management feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1459644]The Configuration Change Management feature supports only devices that are managed by Cisco DCNM, which means that Cisco DCNM must have successfully discovered the device.
 
     	 [bookmark: pgfId-1459645]The Configuration Change Management feature supports only devices that you have added to the list of Cisco DCNM-licensed devices.
 
     	 [bookmark: pgfId-1459646]Devices must be reachable by Cisco DCNM when Cisco DCNM attempts to archive the configuration or to perform a configuration rollback. An archival job or configuration rollback fails if the device is unreachable by Cisco DCNM.
 
    
 
   
 
    
     [bookmark: pgfId-1459648][bookmark: 87804]Guidelines and Limitations for Configuration Change Management
 
    [bookmark: pgfId-1459649]Configuration Change Management has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1459650]You can archive a maximum of 50 configuration versions per managed device.
 
     	 [bookmark: pgfId-1459651]Configure archival jobs and archival settings based upon the needs of your organization.
 
     	 [bookmark: pgfId-1459652]We recommend enabling the Default archival job and configuring the job to run at the lowest frequency that your backup policy tolerates.
 
     	 [bookmark: pgfId-1463732]Access to archived configurations is supported through the Cisco DCNM client only. The client provides features for viewing, comparing, and deleting archived configurations. Each archived configuration is marked with the date and time that Cisco DCNM archived the configuration. For more information, see the “Working with the Version Browser” section.
 
    
 
   
 
    
     [bookmark: pgfId-1459654][bookmark: 54640]Working with the Version Browser
 
    [bookmark: pgfId-1459675][bookmark: marker-1435996]Figure 14-1 shows the Version Browser content pane.
 
    [bookmark: pgfId-1459677]Figure 14-1 [bookmark: 10762]Version Browser Content Pane
 
    [bookmark: pgfId-1459681]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1459682]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1459686]Viewing the Archival Status of a Device
 
     	 [bookmark: pgfId-1459690]Viewing the Archival History of a Device
 
     	 [bookmark: pgfId-1459694]Browsing and Commenting on Configuration Versions
 
     	 [bookmark: pgfId-1459698]Archiving the Current Running Configuration of a Device
 
     	 [bookmark: pgfId-1459702]Viewing an Archived Configuration Version
 
     	 [bookmark: pgfId-1459706]Comparing Configuration Versions
 
     	 [bookmark: pgfId-1459710]Using the Version Comparison Tools
 
     	 [bookmark: pgfId-1459714]Merging Configuration Differences
 
     	 [bookmark: pgfId-1459718]Performing a Configuration Rollback
 
     	 [bookmark: pgfId-1459722]Viewing the Rollback History of a Device
 
     	 [bookmark: pgfId-1459726]Deleting All Archived Configurations for a Device
 
    
 
     
      [bookmark: pgfId-1388646][bookmark: 59028]Viewing the Archival Status of a Device[bookmark: marker-1388645]
 
     [bookmark: pgfId-1388647]You can view the archival status of a device. The archival status for a device includes the following information:
 
      
      	 [bookmark: pgfId-1388898]Whether the archival job that includes the device is enabled or disabled.
 
      	 [bookmark: pgfId-1388950]The schedule for the archival job that includes the device.
 
      	 [bookmark: pgfId-1388971]The Job ID of the archival job that includes the device.
 
     
 
    
 
     
      [bookmark: pgfId-1388648]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1403905]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    
 
     
      [bookmark: pgfId-1388463]DETAILED STEPS
 
     [bookmark: pgfId-1388464]To view the archival status of a device, follow these steps:
 
     
 
     [bookmark: pgfId-1388465]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1388466]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1388467]Step 2 Click the device that has the archival status that you want to view.
 
     [bookmark: pgfId-1388468]The Details pane displays archive-related information about the device, including an Archival Status section.
 
     [bookmark: pgfId-1414669]If the archival job that includes the device is enabled, a View Schedule link appears.
 
     [bookmark: pgfId-1415228]If the archival job that includes the device is disabled, a Enable Archival Schedule link appears.
 
     [bookmark: pgfId-1389155]Step 3 (Optional) If you want to view the details of the archival job that includes the device, click the View Schedule link or the Enable Archival Schedule link. For more information, see the “Viewing Details of an Archival Job” section.
 
     [bookmark: pgfId-1389156]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383801][bookmark: 32571]Viewing the Archival History of a Device[bookmark: marker-1383800]
 
     [bookmark: pgfId-1388254]You can view the archival history of a device. The archival history records each attempt to create a new archival configuration version from the current running configuration of a device.
 
    
 
     
      [bookmark: pgfId-1383803]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1403889]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    
 
     
      [bookmark: pgfId-1383804]DETAILED STEPS
 
     [bookmark: pgfId-1383805]To view the archival history of a device, follow these steps:
 
     
 
     [bookmark: pgfId-1383806]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1388329]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1383808]Step 2 Click the device that has archival history that you want to view.
 
     [bookmark: pgfId-1388338]The Details pane displays archive-related information about the device, including an Archival History section.
 
     [bookmark: pgfId-1383809]Step 3 (Optional) If necessary, click the Archival History section to expand it.
 
     [bookmark: pgfId-1383812]The Archival History section displays a table of information about every attempt made to create a new archival configuration version for the device.
 
     [bookmark: pgfId-1383813]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383829][bookmark: 23271]Browsing and Commenting on Configuration Versions[bookmark: marker-1383828]
 
     [bookmark: pgfId-1383830]You can browse the archived configuration versions for managed devices. Browsing allows you to see information about all versions of an archived configuration.
 
     [bookmark: pgfId-1387829]You can also add, change, or delete comments on any version of an archived configuration.
 
    
 
     
      [bookmark: pgfId-1404163]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1404164]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
     [bookmark: pgfId-1404165]The archived configuration versions that you want to browse or comment on must exist in Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1404166]DETAILED STEPS
 
     [bookmark: pgfId-1383833]To browse and comment on configuration versions, follow these steps:
 
     
 
     [bookmark: pgfId-1387959]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1387960]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1387961]Step 2 Double-click the device that has archived configuration versions that you want to browse.
 
     [bookmark: pgfId-1387979]A list of archived configuration versions appears below the device that you double-clicked. For each version, the Summary pane shows the version ID, the date and time that Cisco DCNM created the version, the Cisco DCNM user who created the version, and comments about the version.
 
     [bookmark: pgfId-1383836]Step 3 (Optional) If you want to comment on a version, follow these steps:
 
     [bookmark: pgfId-1388120] a. Click the version that you want to update with comments.
 
     [bookmark: pgfId-1388160]The Details pane shows the Version Details tab, which contains the same information about the version that appears in the Summary pane, except that the Comments box is available for you to use.
 
     [bookmark: pgfId-1388200] b. Click in the Comments box and enter your comments.
 
     [bookmark: pgfId-1388231] c. From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1383841]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383857][bookmark: 12298]Archiving the Current Running Configuration of a Device[bookmark: marker-1383856]
 
     [bookmark: pgfId-1383858]You can archive the current running configuration of a managed device.
 
     [bookmark: pgfId-1387311]Archiving the current running configuration succeeds only if the most recent archived version in Cisco DCNM is different than the current running configuration.
 
    
 
     
      [bookmark: pgfId-1383859]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1387129]The device must be managed and reachable.
 
     [bookmark: pgfId-1403958]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    
 
     
      [bookmark: pgfId-1383860]DETAILED STEPS
 
     [bookmark: pgfId-1383861]To archive the current running configuration of a managed device, follow these steps:
 
     
 
     [bookmark: pgfId-1387214]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1387215]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1387216]Step 2 Click the device that has a running configuration that you want to archive now.
 
     [bookmark: pgfId-1387281]Step 3 From the menu bar, choose Actions > Archive Configuration.
 
     [bookmark: pgfId-1383868]Step 4 To confirm that Cisco DCNM successfully archived the configuration, view the list of archived configuration versions for the device. If necessary, double-click the device to open the list. The new version should appear at the top of the list.
 
      
       
     
 
     
 
     [bookmark: pgfId-1387367]Note If a message box notifies you that archiving the configuration was skipped, then Cisco DCNM did not detect differences between the current running configuration and the most recent archived configuration version for the device. To close the message box, click OK.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383869]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383885][bookmark: 16430]Viewing an Archived Configuration Version[bookmark: marker-1383884]
 
     [bookmark: pgfId-1383886]You can view a version of an archived configuration.
 
    
 
     
      [bookmark: pgfId-1383887]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1403832]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
     [bookmark: pgfId-1386865]The archived configuration version that you want to view must exist in Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1383888]DETAILED STEPS
 
     [bookmark: pgfId-1383889]To view a version of an archived configuration, follow these steps:
 
     
 
     [bookmark: pgfId-1386748]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1386749]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1386750]Step 2 Click the device that has an archived configuration version that you want to view.
 
     [bookmark: pgfId-1386913]Step 3 (Optional) If necessary, to view the list of archived configuration versions for the device, double-click the device.
 
     [bookmark: pgfId-1386914]Step 4 Click the version of the archived configuration that you want to view.
 
     [bookmark: pgfId-1383892]Step 5 From the menu bar, choose Actions > View Configuration.
 
     [bookmark: pgfId-1386989]In the Details pane, the Configuration tab displays the configuration version that you selected.
 
      
       
     
 
     
 
     [bookmark: pgfId-1392802]Tip You can search the text of the configuration. To do so, press Ctrl + F.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383897]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383913][bookmark: 51408]Comparing Configuration Versions[bookmark: marker-1405467]
 
     [bookmark: pgfId-1383914]You can compare two configuration versions. The configurations that you can compare can be any two archived configuration version in Cisco DCNM, including archived configurations from different managed devices. You can also compare an archived configuration version to the running configuration or the startup configuration of a managed device.
 
    
 
     
      [bookmark: pgfId-1383915]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1404170]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
     [bookmark: pgfId-1386605]If you are comparing archived configuration versions, the two versions must exist in Cisco DCNM.
 
     [bookmark: pgfId-1392237]If you are comparing an archived configuration version to a running configuration or startup configuration on a managed device, the device must be reachable by Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1386588]DETAILED STEPS
 
     [bookmark: pgfId-1383917]To compare an archived configuration version to another configuration version, follow these steps:
 
     
 
     [bookmark: pgfId-1383918]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1385626]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1385627]Step 2 Double-click the device that has an archived configuration version that you want to compare to another configuration version.
 
     [bookmark: pgfId-1394094]Step 3 (Optional) If necessary, to view the list of archived configurations for the device, double-click the device.
 
     [bookmark: pgfId-1394140]Step 4 Click the archived configuration version that you want to compare to another configuration version.
 
     [bookmark: pgfId-1395552]Step 5 Use the following table to compare the selected version to the configuration version that you want:
 
     [bookmark: pgfId-1396203]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1396163]To Compare With 
          
  
         	 
           
           [bookmark: pgfId-1396165]Follow These Steps 
          
  
        
 
         
         	[bookmark: pgfId-1396167]Most recent configuration version from the current device
  
         	[bookmark: pgfId-1396169]Right-click the version and choose Compare with > Latest.
  
        
 
         
         	[bookmark: pgfId-1396171]Next configuration version from the current device
  
         	[bookmark: pgfId-1396173]Right-click the version and choose Compare with > Next.
  
        
 
         
         	[bookmark: pgfId-1396175]Previous configuration version from the current device
  
         	[bookmark: pgfId-1396177]Right-click the version and choose Compare with > Previous.
  
        
 
         
         	[bookmark: pgfId-1396179]Another configuration version that you select
  
         	[bookmark: pgfId-1396181] 1. Press and hold the Ctrl key.
 [bookmark: pgfId-1396182] 2. Click the archived configuration version that you want to compare the first selected version to, and then release the Ctrl key.
 [bookmark: pgfId-1396183] 3. Right-click either selected configuration version and choose Compare with > Selected Versions.
 [bookmark: pgfId-1396184]The selected configuration versions appear in the two configuration panes on the Compare tab. The configuration version that is listed highest in the Summary pane appears in the left configuration pane.
 [bookmark: pgfId-1396185]Tip You can select archived configuration versions from different devices.  
        
 
         
         	[bookmark: pgfId-1396187]Current running configuration from the current device
  
         	[bookmark: pgfId-1396189]Right-click the version and choose Compare with > Current Running Configuration.
  
        
 
         
         	[bookmark: pgfId-1396191]Current startup configuration from the current device
  
         	[bookmark: pgfId-1396193]Right-click the version and choose Compare with > Current Startup Configuration.
  
        
 
         
         	[bookmark: pgfId-1396195]A configuration version from another device
  
         	[bookmark: pgfId-1396197] 1. Right-click the version and choose Compare with > Another Device Configuration Version.
 [bookmark: pgfId-1396198]In the Details pane, the Compare tab shows the selected configuration version in the left configuration pane.
 [bookmark: pgfId-1396199] 2. From the Device list above the right configuration pane, choose the device that has the configuration version that you want to compare with the configuration in the left pane.
 [bookmark: pgfId-1396200] 3. From the Version list, pick the configuration version that you want to compare. You can use any version archived by Cisco DCNM or you can use the running configuration or the startup configuration currently on the device.
 icon.
 [bookmark: pgfId-1396202]The right configuration pane displays the configuration version that you specified.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1396204]In the Details pane, the Compare tab displays the two configuration versions in side-by-side panes.
 
     [bookmark: pgfId-1403974]Step 6 Use the version comparison tools as needed. For more information, see the “Using the Version Comparison Tools” section.
 
     [bookmark: pgfId-1396205]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1405483][bookmark: 21914]Using the Version Comparison Tools[bookmark: marker-1405487]
 
     [bookmark: pgfId-1405484]When you use the Version Browser to compare configuration versions, the Compare tab in the Details pane has many options to assist you with the comparison.
 
      
       
     
 
     
 
     [bookmark: pgfId-1389617]Note You must be comparing two configurations to use the version comparison tools. For more information, see the “Comparing Configuration Versions” section.
 
      
      
 
     
 
     
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
       
       	 [bookmark: pgfId-1391218]Undo all configuration merges.
 
       	 [bookmark: pgfId-1391373]Remove all bookmarks.
 
       	 [bookmark: pgfId-1391238]Jump to the first line in both configuration panes.
 
       	 [bookmark: pgfId-1391255]Use the Full Configuration view.
 
      
 
      
 
      
 
      
 
       
        
         
         	 
           
           [bookmark: pgfId-1389978]Option Icon and Name 
          
  
         	 
           
           [bookmark: pgfId-1389980]How to Use the Option 
          
  
        
 
        
          Full vs. Delta View 
         	[bookmark: pgfId-1389984]From the list, choose the desired viewing option, as follows:
 
           
           	 [bookmark: pgfId-1389985]
 
           [image: ] —Shows all of both configuration versions. 
          
 
           
           	 [bookmark: pgfId-1389986]
 
           [image: ] —Shows only the sections of each configuration that differ. 
          
  
        
 
        
          Next Diff icon to jump to the next difference between the two configurations shown. 
        
 
        
          Prev Diff icon to jump to the previous difference between the two configurations shown. 
        
 
        
          Bookmark 
         	[bookmark: pgfId-1390137] 1. Click a line in one of the configuration panes.
 icon.
 [bookmark: pgfId-1390174]A bookmark icon appears beside the line number.
  
        
 
        
          Next Bookmark 
         	[bookmark: pgfId-1390192] 1. Click the configuration pane that has the bookmarked line that you want to view.
 icon.
 [bookmark: pgfId-1390113]The configurations in both panes jump to the next bookmarked line.
  
        
 
        
          Prev Bookmark 
         	[bookmark: pgfId-1391010] 1. Click the configuration pane that has the bookmarked line that you want to view.
 icon.
 [bookmark: pgfId-1391012]The configurations in both panes jump to the previous bookmarked line.
  
        
 
        
          Compare 
         	[bookmark: pgfId-1390010]Use this option to choose the archived configuration version shown in the right configuration pane.
 [bookmark: pgfId-1391087] 1. From the Device list, choose the device that has the configuration version that you want to compare with the configuration in the left pane.
 [bookmark: pgfId-1416725] 2. From the Version list, pick the configuration version that you want to compare. You can use any version archived by Cisco DCNM or you can use the running configuration or the startup configuration currently on the device.
 icon.
 [bookmark: pgfId-1391365]The right configuration pane displays the configuration version that you specified.
  
        
 
        
          Reset icon when you want to do the following: 
        
 
        
          Merge 
         	[bookmark: pgfId-1390018]Use this option to copy a difference from the configuration in the left configuration pane into the configuration in the right pane.
 [bookmark: pgfId-1391884]For detailed steps, see the “Merging Configuration Differences” section.
  
        
 
        
          Save As icon to save the configuration in the right pane to a filename and location that you specify in the Save dialog box that appears. 
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1398855][bookmark: 44207]Merging Configuration Differences[bookmark: marker-1405612]
 
     [bookmark: pgfId-1392034]While you are comparing two configuration versions, you can merge lines that contain differences. The merge feature allows you to merge a whole line shown in the left configuration pane into the configuration that is shown in the right configuration pane.
 
    
 
     
      [bookmark: pgfId-1396756]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1396830]You must be comparing two configuration versions that have differences.
 
     [bookmark: pgfId-1397101]Ensure that the configuration version that you want to want to merge the changes into appears in the right configuration pane.
 
    
 
     
      [bookmark: pgfId-1397189]DETAILED STEPS
 
     [bookmark: pgfId-1397235]To merge configuration differences, follow these steps:
 
     
 icon as needed to jump to the line that you want to merge from the left configuration pane into the right configuration pane. 
     
 
      
       
     
 
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1417017]The selected configuration line in the left pane replaces the selected line in the right pane.
 
    [bookmark: pgfId-1404029]Step 3 Repeat Step 1 and Step 2 as often as needed.
 
     
      
    
 
    
 
   
 
   
 icon and use the Save dialog box to save the configuration to a filename and location that you specify. 
   
 
   [bookmark: pgfId-1397260]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1386614][bookmark: 63250]Performing a Configuration Rollback[bookmark: marker-1383940]
 
    [bookmark: pgfId-1383942]You can roll back the configuration of a managed device to any previous version that is archived by Cisco DCNM. A rollback replaces the running configuration of the managed device with an archived configuration version that you specify.
 
   
 
    
     [bookmark: pgfId-1383943]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1404271]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    [bookmark: pgfId-1385506]The archived configuration version that you want to use in the rollback must exist in Cisco DCNM.
 
   
 
    
     [bookmark: pgfId-1383944]DETAILED STEPS
 
    [bookmark: pgfId-1383945]To perform a configuration rollback, follow these steps:
 
    
 
    [bookmark: pgfId-1383946]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
    [bookmark: pgfId-1386507]The Summary pane displays a table of devices.
 
    [bookmark: pgfId-1386508]Step 2 Click the device for which you want to perform a configuration rollback.
 
    [bookmark: pgfId-1386509]The Details pane displays archival information about the device, including a Rollback History section.
 
    [bookmark: pgfId-1386510]Step 3 (Optional) If necessary, to view the list of archived configurations for the device, double-click the device.
 
    [bookmark: pgfId-1386511]Step 4 Click the version of the archived configuration that you want to use as the running configuration on the device.
 
    [bookmark: pgfId-1386512]Step 5 Do one of the following:
 
     
      
      	 [bookmark: pgfId-1386513]If you want to save the configuration version that you selected as the startup configuration on the device, choose one of the following rollback options:
 
     
 
    
 
    [bookmark: pgfId-1386514] – If you want Cisco DCNM to restore the original running configuration of the device if any configuration command fails during the rollback, from the menu bar, choose Actions > Rollback and Save as Start-up > Restore Original Config on Error (Atomic).
 
    [bookmark: pgfId-1386515] – If you want Cisco DCNM to ignore configuration errors during a rollback, from the menu bar, choose Actions > Rollback and Save as Start-up > Skip Errors and Rollback (Best Effort).
 
    [bookmark: pgfId-1386516] – If you want Cisco DCNM to stop the rollback at the first configuration error, from the menu bar, choose Actions > Rollback and Save as Start-up > Stop Rollback at First Error.
 
     
      
      	 [bookmark: pgfId-1386517]If you want the rollback to proceed without affecting the startup configuration currently on the device, choose one of the following rollback options:
 
     
 
    
 
    [bookmark: pgfId-1386518] – If you want Cisco DCNM to restore the original running configuration of the device if any configuration command fails during the rollback, from the menu bar, choose Actions > Rollback > Restore Original Config on Error (Atomic).
 
    [bookmark: pgfId-1386519] – If you want Cisco DCNM to ignore configuration errors during a rollback, from the menu bar, choose Actions > Rollback > Skip Errors and Rollback (Best Effort).
 
    [bookmark: pgfId-1386520] – If you want Cisco DCNM to stop the rollback at the first configuration error, from the menu bar, choose Actions > Rollback > Stop Rollback at First Error.
 
    [bookmark: pgfId-1386521]Cisco DCNM begins the rollback operation.
 
    [bookmark: pgfId-1383953]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1404325][bookmark: 74633]Viewing the Rollback History of a Device[bookmark: marker-1404324]
 
    [bookmark: pgfId-1404326]You can view the rollback history of a device.
 
   
 
    
     [bookmark: pgfId-1404327]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1404434]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
   
 
    
     [bookmark: pgfId-1404348]DETAILED STEPS
 
    [bookmark: pgfId-1383973]To view the rollback history of a device, follow these steps:
 
    
 
    [bookmark: pgfId-1385332]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
    [bookmark: pgfId-1385333]The Summary pane displays a table of devices.
 
    [bookmark: pgfId-1385334]Step 2 Click the device for which you want to view the rollback history.
 
    [bookmark: pgfId-1383980]The Details pane displays archival information about the device, including a Rollback History section.
 
    [bookmark: pgfId-1385444]Step 3 (Optional) If necessary, double-click the Rollback History section to expand it.
 
    [bookmark: pgfId-1385468]In the Rollback History section, a table of rollback history events appears. If no configuration rollbacks have occurred on the device, the table is empty.
 
    [bookmark: pgfId-1383981]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1383997][bookmark: 82761]Deleting All Archived Configurations for a Device[bookmark: marker-1383996]
 
    [bookmark: pgfId-1383998]You can delete all the archived configuration versions of a device.
 
     
      
    
 
    
 
    [bookmark: pgfId-1385001]Note You cannot delete a specific version of an archived configuration.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1383999]BEFOREYOU BEGIN
 
    [bookmark: pgfId-1385161]Be certain that you do not want any of the archived configuration version for the device. You cannot undo the deletion and the Cisco DCNM client does not confirm your choice to delete the archived configuration versions.
 
   
 
    
     [bookmark: pgfId-1385157]DETAILED STEPS
 
    [bookmark: pgfId-1384000]To delete all archived configurations for a device, follow these steps:
 
    
 
    [bookmark: pgfId-1384001]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
    [bookmark: pgfId-1384002]The Summary pane displays a table of devices.
 
    [bookmark: pgfId-1384003]Step 2 Click the device that has archived configurations that you want to delete.
 
    [bookmark: pgfId-1385187]Step 3 Verify that you clicked the correct device.
 
     
      
    
 
    
 
    [bookmark: pgfId-1385218]Note The next step deletes the archived configuration versions without confirming your choice.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1384004]Step 4 From the menu bar, choose Actions > Delete All Versions.
 
    [bookmark: pgfId-1385249]The archived configurations for the selected device disappear from the Summary pane.
 
    [bookmark: pgfId-1384008]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1399578][bookmark: 21980]Configuring Archival Jobs[bookmark: marker-1405613]
 
    [bookmark: pgfId-1460074]Figure 14-1 shows the Archival Jobs content pane.
 
    [bookmark: pgfId-1460075]Figure 14-2 Archival Jobs Content Pane
 
    [bookmark: pgfId-1460079]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1460080]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1460084]Configuring an Archival Job
 
     	 [bookmark: pgfId-1460088]Enabling and Disabling an Archival Job
 
     	 [bookmark: pgfId-1460092]Deleting an Archival Job
 
     	 [bookmark: pgfId-1460096]Viewing Details of an Archival Job
 
     	 [bookmark: pgfId-1460100]Viewing the History of an Archival Job
 
    
 
     
      [bookmark: pgfId-1384057][bookmark: 20691]Configuring an Archival Job[bookmark: marker-1384056]
 
     [bookmark: pgfId-1384058]You can create an archival job or make changes to an existing archival job.
 
      
       
     
 
     
 
     [bookmark: pgfId-1384691]Note By default, a new archival job is enabled.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1404460]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1404537]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. You can include only licensed devices in an archival job.
 
    
 
     
      [bookmark: pgfId-1404538]DETAILED STEPS
 
     [bookmark: pgfId-1384060]To configure an archival job, follow these steps:
 
     
 
     [bookmark: pgfId-1384061]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384062]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384063]Step 2 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1384064]If you want to create an archival job, from the menu bar, choose  File > New Job .
 
       	 [bookmark: pgfId-1384065]If you want to make changes to an existing archival job, in the Summary pane, click the job that you want to change.
 
      
 
     
 
     [bookmark: pgfId-1384066]The Details pane shows the Details tab and Archival History tab for the job.
 
     [bookmark: pgfId-1384067]Step 3 (Optional) If necessary, in the Details pane, click the Details tab.
 
     [bookmark: pgfId-1384068]Step 4 (Optional) In the Comments field, enter your comments about the job.
 
     [bookmark: pgfId-1384069]Step 5 (Optional) If you want the job to archive configurations at a specific time, follow these steps:
 
     [bookmark: pgfId-1384070] a. Click the Archive at Specified Time radio button.
 
     [bookmark: pgfId-1384071] b. In the row of Days check boxes, check the check box for each day that you want the archival job to be active.
 
     [bookmark: pgfId-1384072] c. Do one of the following:
 
     [bookmark: pgfId-1384073] – If you want the job to archive configurations at a regular interval, click the Archive Interval radio button and use the adjacent box and list to specify the interval. You can specify an interval in minutes or hours. The maximum interval is either 59 minutes or 23 hours.
 
     [bookmark: pgfId-1384074] – If you want the job to archive configurations once on each day that the job is active, click the Archive at radio button and use the adjacent box to specify the time that you want the job to start.
 
     [bookmark: pgfId-1384075]Step 6 (Optional) If you want the job to archive configurations at any time that Cisco DCNM detects a change to the configuration of a device included in the job, click the Archive whenever a Configuration Change is Detected radio button.
 
     [bookmark: pgfId-1384076]Step 7 If you want to add one or more devices to the archival job, follow these steps:
 
     [bookmark: pgfId-1384077] a. Under Device, right-click in a blank area and choose Add New Device.
 
     [bookmark: pgfId-1415381]A dialog box shows available and selected devices.
 
     [bookmark: pgfId-1415365] a. For each device that you want to add, under Available Devices, click the device and click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-1384079]Tip To add all devices to the job, click Add All.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1384080] b. Click OK.
 
     [bookmark: pgfId-1384783]The devices that you added appear under Devices.
 
     [bookmark: pgfId-1384081]Step 8 If you want to remove a device from an archival job, follow these steps:
 
     [bookmark: pgfId-1384082] a. Under Devices, click the device that you want to remove from the job.
 
     [bookmark: pgfId-1384083] b. Right-click the device and choose Remove Device.
 
     [bookmark: pgfId-1384814]The device that you removed no longer appears under Devices.
 
     [bookmark: pgfId-1384085]Step 9 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1384844]If you created an archival job, it is enabled by default. If you changed an existing archival job, whether it is enabled or disabled does not change.
 
     [bookmark: pgfId-1384086]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1384102][bookmark: 87932]Enabling and Disabling an Archival Job[bookmark: marker-1384101]
 
     [bookmark: pgfId-1384103]You can enable or disable any archival job.
 
    
 
     
      [bookmark: pgfId-1404543]DETAILED STEPS
 
     [bookmark: pgfId-1384105]To enable or disable an archival job, follow these steps:
 
     
 
     [bookmark: pgfId-1384106]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384107]The Summary pane displays a table of archival jobs. In the Job ID column, enabled jobs show a green triangle and disabled jobs show a red square.
 
     [bookmark: pgfId-1384108]Step 2 In the Summary pane, click the archival job that you want to enable or disable.
 
     [bookmark: pgfId-1384109]Step 3 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1384110]To enable the job, from the menu bar, choose  Actions > Enable . The icon in the Job ID column changes to show a green triangle.
 
       	 [bookmark: pgfId-1384111]To disable the job, from the menu bar, choose  Actions > Disable . The icon in the Job ID column changes to show a red square.
 
      
 
     
 
     [bookmark: pgfId-1384112]You do not need to save your changes.
 
     [bookmark: pgfId-1384113]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1384129][bookmark: 49488]Deleting an Archival Job[bookmark: marker-1384128]
 
     [bookmark: pgfId-1384130]You can delete an archival job but not the Default archival job. When you delete an archival job, any devices included in the deleted job are automatically added to the Default archival job.
 
    
 
     
      [bookmark: pgfId-1384131]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1384132]At least one custom archival job must exist in Cisco DCNM. You cannot delete the Default archival job.
 
    
 
     
      [bookmark: pgfId-1384133]DETAILED STEPS
 
     [bookmark: pgfId-1384134]To delete an archival job, follow these steps:
 
     
 
     [bookmark: pgfId-1384135]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384136]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384137]Step 2 In the Summary pane, click the archival job that you want to delete.
 
     [bookmark: pgfId-1384138]Step 3 From the menu bar, choose Actions > Delete.
 
     [bookmark: pgfId-1384139]The archival job disappears from the Summary pane.
 
     [bookmark: pgfId-1384140]Devices that were included in the deleted job are automatically added to the Default archival job.
 
     [bookmark: pgfId-1384141]You do not need to save your changes.
 
     [bookmark: pgfId-1384142]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1384158][bookmark: 20709]Viewing Details of an Archival Job[bookmark: marker-1384157]
 
     [bookmark: pgfId-1384159]You can view the details of an archival job, which include the job ID, the owner of the job, comments about the job, the job schedule, and the devices included in the job.
 
    
 
     
      [bookmark: pgfId-1384160]DETAILED STEPS
 
     [bookmark: pgfId-1384161]To view the details of an archival job, follow these steps:
 
     
 
     [bookmark: pgfId-1384162]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384163]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384164]Step 2 In the Summary pane, click the archival job that has details that you want to view.
 
     [bookmark: pgfId-1384165]The Details pane displays information about the archival job, including a Details tab.
 
     [bookmark: pgfId-1384166]Step 3 (Optional) If necessary, in the Details pane, click the Details tab.
 
     [bookmark: pgfId-1384167]The Details pane displays information and settings for the archival job that you selected.
 
     [bookmark: pgfId-1384168]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1384184][bookmark: 94750]Viewing the History of an Archival Job[bookmark: marker-1384183]
 
     [bookmark: pgfId-1384185]You can view the history of an archival job.
 
    
 
     
      [bookmark: pgfId-1384186]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1384187]The archival job must have occurred at least once; otherwise, there are no archival history entries to view.
 
    
 
     
      [bookmark: pgfId-1384188]DETAILED STEPS
 
     [bookmark: pgfId-1384189]To view the history of an archival job, follow these steps:
 
     
 
     [bookmark: pgfId-1384190]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384191]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384192]Step 2 In the Summary pane, click the archival job that has archival history that you want to view.
 
     [bookmark: pgfId-1384193]The Details pane displays information about the archival job, including an Archival History tab.
 
     [bookmark: pgfId-1384194]Step 3 In the Details pane, click the Archival History tab.
 
     [bookmark: pgfId-1384195]The Details pane displays a list of archival history entries, ordered by the date and time when the entry occurred.
 
     [bookmark: pgfId-1384196]Step 4 (Optional) To see additional details about an archival history entry, in the Status column, click the plus symbol (+) to expand the entry.
 
     [bookmark: pgfId-1384197]The expanded entry lists information for each device included in the entry.
 
     [bookmark: pgfId-1384198]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1396396][bookmark: 27537]Configuring Archival Settings[bookmark: marker-1405614]
 
    [bookmark: pgfId-1460266]Figure 14-3 shows the Archival Settings content pane.
 
    [bookmark: pgfId-1460268]Figure 14-3 [bookmark: 82467]Archival Settings Content Pane
 
    [bookmark: pgfId-1460272]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1460273]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1460277]Configuring Version and History Settings
 
     	 [bookmark: pgfId-1460281]Configuring the Rollback File Server Setting
 
    
 
     
      [bookmark: pgfId-1384231][bookmark: 88623]Configuring Version and History Settings[bookmark: marker-1384230]
 
     [bookmark: pgfId-1384232]You can configure the following settings about configuration versions and history:
 
      
      	 [bookmark: pgfId-1384233]Maximum number of configuration versions that Cisco DCNM archives per managed device.
 
      	 [bookmark: pgfId-1384234]Maximum number of rollback history and archival history status entries that Cisco DCNM retains per managed device.
 
     
 
    
 
     
      [bookmark: pgfId-1384235]DETAILED STEPS
 
     [bookmark: pgfId-1384236]To configure version and history settings, follow these steps:
 
     
 
     [bookmark: pgfId-1384237]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Settings.
 
     [bookmark: pgfId-1384238]The Contents pane displays the Archival Settings fields.
 
     [bookmark: pgfId-1384239]Step 2 (Optional) Use the Maximum Version for a Device [0 - 50] box to configure the maximum number of configuration versions that Cisco DCNM should archive for each managed device.
 
     [bookmark: pgfId-1384240]Step 3 (Optional) Use the Max Rollback and Archival History Status [0 - 100] box to configure the maximum number of rollback history and archival history status entries that Cisco DCNM retains for each managed device.
 
     [bookmark: pgfId-1384241]Step 4 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1384242]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1384257][bookmark: 78807]Configuring the Rollback File Server Setting[bookmark: marker-1384256]
 
     [bookmark: pgfId-1384258]You can configure whether Cisco DCNM uses a specific file server during a configuration rollback or whether it uses any available file server that you have configured.
 
    
 
     
      [bookmark: pgfId-1384259]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1384262]You must configure at least one file server in Cisco DCNM. For more information, see the “Adding a File Server” section.
 
    
 
     
      [bookmark: pgfId-1384264]DETAILED STEPS
 
     [bookmark: pgfId-1384265]To configure the rollback file server settings, follow these steps:
 
     
 
     [bookmark: pgfId-1384266]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Settings.
 
     [bookmark: pgfId-1384267]The Contents pane displays the Archival Settings fields.
 
     [bookmark: pgfId-1384268]Step 2 (Optional) If you want Cisco DCNM to use any available file server during a configuration rollback, under File Server for Configuration Rollback, click the Any File Server radio button.
 
     [bookmark: pgfId-1384269]Step 3 (Optional) If you want to specify a file server that Cisco DCNM should use during a configuration rollback, follow these steps:
 
     [bookmark: pgfId-1384270] a. Under File Server for Configuration Rollback, click the Use the following File Server radio button.
 
     [bookmark: pgfId-1384271] b. From the File Server drop-down list, choose the file server.
 
     [bookmark: pgfId-1384272]Step 4 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1384273]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1460321][bookmark: 59585]Field Descriptions for Configuration Change Management
 
    [bookmark: pgfId-1460322]This section includes the field descriptions for the three features available in the Feature Selector drawer for Configuration Change Management:
 
     
     	 [bookmark: pgfId-1460326]Field Descriptions for the Version Browser
 
     	 [bookmark: pgfId-1460330]Field Descriptions for Archival Jobs
 
     	 [bookmark: pgfId-1460334]Field Descriptions for the Archival Settings Contents Pane
 
    
 
     
      [bookmark: pgfId-1460336][bookmark: 49384]Field Descriptions for the Version Browser
 
     [bookmark: pgfId-1460337]This section includes the following field descriptions for the Device OS Management feature:
 
      
      	 [bookmark: pgfId-1460341]Device: Details: Archival Status Section
 
      	 [bookmark: pgfId-1460345]Device: Details: Rollback History Section
 
      	 [bookmark: pgfId-1460349]Device: Details: Archival History Section
 
      	 [bookmark: pgfId-1460353]Version: Version Details Tab
 
      	 [bookmark: pgfId-1460357]Version: Compare Tab
 
     
 
    
 
     
      [bookmark: pgfId-1460359][bookmark: 47587]Device: Details: Archival Status Section
 
     [bookmark: pgfId-1460384]
 
      
       
        
        [bookmark: pgfId-1460365]Table 14-1 Device: Details: Archival Status Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1460369]Field 
          
  
         	 
           
           [bookmark: pgfId-1460371]Description 
          
  
        
 
         
         	[bookmark: pgfId-1460373]Status
  
         	[bookmark: pgfId-1460375]Display only. Whether the archival job that the device is assigned to is enabled or disabled.
  
        
 
         
         	[bookmark: pgfId-1460377]Schedule
  
         	[bookmark: pgfId-1460379]Display only. When the archival job that the device is assigned to is scheduled to occur.
  
        
 
         
         	[bookmark: pgfId-1460381]Job ID
  
         	 
           
            
             
             [bookmark: pgfId-1460392]Table 14-2 Device: Details: Rollback History Section 
 
             
             
              
              	 
                
                [bookmark: pgfId-1460396]Field 
               
  
              	 
                
                [bookmark: pgfId-1460398]Description 
               
  
             
 
              
              	[bookmark: pgfId-1460400]Time
  
              	[bookmark: pgfId-1460402]Display only. Date and time that the rollback occurred.
  
             
 
              
              	[bookmark: pgfId-1460404]Version
  
              	[bookmark: pgfId-1460406]Display only. Configuration version that became the running configuration as a result of the rollback.
  
             
 
              
              	[bookmark: pgfId-1460408]User
  
              	[bookmark: pgfId-1460410]Display only. Username of the Cisco DCNM user who initiated the rollback.
  
             
 
              
              	[bookmark: pgfId-1460412]Status
  
              	 
                
                 
                  
                  [bookmark: pgfId-1460423]Table 14-3 Device: Details: Archival History Section 
 
                  
                  
                   
                   	 
                     
                     [bookmark: pgfId-1460427]Field 
                    
  
                   	 
                     
                     [bookmark: pgfId-1460429]Description 
                    
  
                  
 
                   
                   	[bookmark: pgfId-1460431]Time Stamp
  
                   	[bookmark: pgfId-1460433]Display only. Date and time that the archival event occurred.
  
                  
 
                   
                   	[bookmark: pgfId-1460435]Job Id
  
                   	[bookmark: pgfId-1460437]Display only. Identification number of the archival job that created the archival event.
  
                  
 
                   
                   	[bookmark: pgfId-1460439]Status
  
                   	[bookmark: pgfId-1460441]Display only. Whether the archival event succeeded, failed, or was skipped.
  
                  
 
                   
                   	[bookmark: pgfId-1460443]Reason
  
                   	 
                     
                      
                       
                       [bookmark: pgfId-1460454]Table 14-4 Version: Version Details Tab 
 
                       
                       
                        
                        	 
                          
                          [bookmark: pgfId-1460458]Field 
                         
  
                        	 
                          
                          [bookmark: pgfId-1460460]Description 
                         
  
                       
 
                        
                        	[bookmark: pgfId-1460462]Config Version ID
  
                        	[bookmark: pgfId-1460464]Display only. Version identification number for the archived configuration version. Each archived configuration for a device receives a unique version ID.
  
                       
 
                        
                        	[bookmark: pgfId-1460466]Creation Time
  
                        	[bookmark: pgfId-1460468]Display only. Date and time that an archival job created the configuration version.
  
                       
 
                        
                        	[bookmark: pgfId-1460470]Created By
  
                        	[bookmark: pgfId-1460472]Display only. Username of the Cisco DCNM user who created the archival job that created the configuration version or the Cisco DCNM user who manually initiated the archival event that created the configuration version.
  
                       
 
                        
                        	[bookmark: pgfId-1460474]Comments
  
                        	 
                          
                           
                            
                            [bookmark: pgfId-1460485]Table 14-5 Version: Compare Tab 
 
                            
                            
                             
                             	 
                               
                               [bookmark: pgfId-1460489]Field 
                              
  
                             	 
                               
                               [bookmark: pgfId-1460491]Description 
                              
  
                            
 
                             
                             	[bookmark: pgfId-1460493]Device
  
                             	[bookmark: pgfId-1460495]Name of the managed device that the configuration version came from. In the left configuration pane, this field is display only. In the right configuration pane on the Compare tab, this field is configurable and you can select any managed device that you have added to the Cisco DCNM license.
  
                            
 
                             
                             	[bookmark: pgfId-1460497]Version
  
                             	[bookmark: pgfId-1460499]Configuration version ID of the archived configuration. In the left configuration pane, this field is display only. In the right configuration pane on the Compare tab, this field is a drop-down list with the following options:
 
                               
                               	 [bookmark: pgfId-1460500]Configuration version IDs—The numbers of the archived configuration versions currently available in Cisco DCNM.
 
                               	 [bookmark: pgfId-1460501]Running-Configuration—The running configuration currently on the managed device selected in the Device field.
 
                               	 [bookmark: pgfId-1460502]Start-up Config—The startup configuration currently on the managed device selected in the Device field.
 
                              
  
                            
 
                            
                          
 
                         
 
                          
                           [bookmark: pgfId-1460505][bookmark: 57584]Field Descriptions for Archival Jobs
 
                          [bookmark: pgfId-1460506]This section includes the following field descriptions for the Archival Jobs feature:
 
                           
                           	 [bookmark: pgfId-1460510]Archival Job: Details Tab
 
                           	 [bookmark: pgfId-1460514]Archival Job: Archival History Tab
 
                          
 
                         
 
                          
                           [bookmark: pgfId-1460516][bookmark: 33753]Archival Job: Details Tab
 
                          [bookmark: pgfId-1460585]
 
                           
                            
                             
                             [bookmark: pgfId-1460522]Table 14-6 Archival Job: Details Tab 
 
                             
                             
                              
                              	 
                                
                                [bookmark: pgfId-1460526]Field 
                               
  
                              	 
                                
                                [bookmark: pgfId-1460528]Description 
                               
  
                             
 
                              
                              	 
                                
                                [bookmark: pgfId-1460530]General 
                               
  
                             
 
                              
                              	[bookmark: pgfId-1460534]Job ID
  
                              	[bookmark: pgfId-1460536]Display only. Identification number of the archival job.
  
                             
 
                              
                              	[bookmark: pgfId-1460538]Owner
  
                              	[bookmark: pgfId-1460540]Display only. Username of the Cisco DCNM user who created the archival job.
  
                             
 
                              
                              	[bookmark: pgfId-1460542]Comments
  
                              	[bookmark: pgfId-1460544]Text entered by Cisco DCNM users.
  
                             
 
                              
                              	 
                                
                                [bookmark: pgfId-1460546]Settings 
                               
  
                             
 
                              
                              	[bookmark: pgfId-1460550]Enable Archival
  
                              	[bookmark: pgfId-1460552]Whether the archival job is enabled. By default, this check box is unchecked.
  
                             
 
                              
                              	[bookmark: pgfId-1460554]Archive at Specified Time
  
                              	[bookmark: pgfId-1460556]Archival job occurs at the time specified by the Days and Archival Interval or Archive at fields.
  
                             
 
                              
                              	[bookmark: pgfId-1460558]Days
  
                              	[bookmark: pgfId-1460560]Days of the week that the archival job occurs. By default, the All check box is checked, which makes the individual day check boxes unavailable.
  
                             
 
                              
                              	[bookmark: pgfId-1460562]Archive Interval
  
                              	[bookmark: pgfId-1460564]Specifies that the archival job occurs at a regular interval, specified by the interval value box and the unit drop-down list, to the right of this radio button.
  
                             
 
                              
                              	[bookmark: pgfId-1460566]Archive at
  
                              	[bookmark: pgfId-1460568]Specifies that the archival job occurs once on each active day, at the time specified in the box to the right of this radio button.
  
                             
 
                              
                              	[bookmark: pgfId-1460570]Archive whenever a Configuration Change is Detected
  
                              	[bookmark: pgfId-1460572]Specifies that Cisco DCNM archives the running configuration of a device in the job when it detects that the running configuration of a device has changed.
  
                             
 
                              
                              	 
                                
                                [bookmark: pgfId-1460574]Devices 
                               
  
                             
 
                              
                              	[bookmark: pgfId-1460578]Name
  
                              	[bookmark: pgfId-1460580]Name of devices that are assigned to the archival job.
  
                             
 
                              
                              	[bookmark: pgfId-1460582]IP Address
  
                              	 
                                
                                 
                                  
                                  [bookmark: pgfId-1460593]Table 14-7 Installation Job: Details: General Section 
 
                                  
                                  
                                   
                                   	 
                                     
                                     [bookmark: pgfId-1460597]Field 
                                    
  
                                   	 
                                     
                                     [bookmark: pgfId-1460599]Description 
                                    
  
                                  
 
                                   
                                   	[bookmark: pgfId-1460601]Time
  
                                   	[bookmark: pgfId-1460603]Display only. Date and time that the archival job ran.
  
                                  
 
                                   
                                   	[bookmark: pgfId-1460605]Status
  
                                   	[bookmark: pgfId-1460607]Display only. Number of devices in the job for which the archival job run succeeded, failed, or was skipped. The numbers are shown after each status, in parentheses.
  
                                  
 
                                   
                                   	[bookmark: pgfId-1460609]Device Name
  
                                   	[bookmark: pgfId-1460611]Display only. Name of a device assigned to the job. This field is shown when you expand the status of an archival history entry.
  
                                  
 
                                   
                                   	[bookmark: pgfId-1460613]IP Address
  
                                   	[bookmark: pgfId-1460615]Display only. IP address that Cisco DCNM used to attempt to connect to the device. This field is shown when you expand the status of an archival history entry.
  
                                  
 
                                   
                                   	[bookmark: pgfId-1460617]Status (per Device)
  
                                   	[bookmark: pgfId-1460619]Display only. Whether the archival job run succeeded, failed, or was skipped for the device.
  
                                  
 
                                   
                                   	[bookmark: pgfId-1460621]Reason
  
                                   	 
                                     
                                      
                                       
                                       [bookmark: pgfId-1460633]Table 14-8 Archival Settings Contents Pane 
 
                                       
                                       
                                        
                                        	 
                                          
                                          [bookmark: pgfId-1460637]Field 
                                         
  
                                        	 
                                          
                                          [bookmark: pgfId-1460639]Description 
                                         
  
                                       
 
                                        
                                        	[bookmark: pgfId-1460641]Maximum Versions for a Device
  
                                        	[bookmark: pgfId-1460643]Largest number of archived configuration versions that Cisco DCNM retains for each device included in an archival job. Valid values are from 0 to 50, where 50 is the default value.
  
                                       
 
                                        
                                        	[bookmark: pgfId-1460645]Max Rollback and Archival History Status
  
                                        	[bookmark: pgfId-1460647]Largest number of rollback history and archival history status entries Cisco DCNM retains for each device.
  
                                       
 
                                        
                                        	 
                                          
                                          [bookmark: pgfId-1460649]File Server for Configuration Rollback 
                                         
  
                                       
 
                                        
                                        	[bookmark: pgfId-1460653]Any File Server
  
                                        	[bookmark: pgfId-1460655]Specifies that Cisco DCNM selects a file server to upload configurations to during a configuration rollback. Any file server that you have configured in Cisco DCNM may be used.
  
                                       
 
                                        
                                        	[bookmark: pgfId-1460657]Use the following File Server
  
                                        	[bookmark: pgfId-1460659]Specifies that Cisco DCNM uploads configurations during a configuration rollback to the file server that you specify in the File Server drop-down list.
  
                                       
 
                                        
                                        	[bookmark: pgfId-1460661]File Server
  
                                        	[bookmark: pgfId-1460663]IP address or DNS name of the file server that Cisco DCNM uploads configurations to during a rollback. This field is available only when you select the Use the following File Server radio button.
  
                                       
 
                                       
                                     
 
                                    
 
                                     
                                      [bookmark: pgfId-1460666][bookmark: 53004]Additional References
 
                                     [bookmark: pgfId-1460667]For additional information related to configuration change management, see the following sections:
 
                                      
                                      	 [bookmark: pgfId-1460671]Related Documents
 
                                      	 [bookmark: pgfId-1460675]Standards
 
                                     
 
                                      
                                       [bookmark: pgfId-1460677][bookmark: 16521]Related Documents
 
                                      [bookmark: pgfId-1460697]
 
                                       
                                        
                                         
                                          
                                          	 
                                            
                                            [bookmark: pgfId-1460680]Related Topic 
                                           
  
                                          	 
                                            
                                            [bookmark: pgfId-1460682]Document Title 
                                           
  
                                         
 
                                          
                                          	[bookmark: pgfId-1460684]File servers in Cisco DCNM
  
                                          	[bookmark: pgfId-1460689]File Servers
  
                                         
 
                                          
                                          	[bookmark: pgfId-1460691]Configuration rollbacks in Cisco NX-OS
  
                                          	[bookmark: pgfId-1460695]Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 4.x
  
                                         
 
                                         
                                       
 
                                      
 
                                     
 
                                      
                                       [bookmark: pgfId-1460699][bookmark: 55398]Standards
 
                                      [bookmark: pgfId-1460709]
 
                                       
                                        
                                         
                                          
                                          	 
                                            
                                            [bookmark: pgfId-1460702]Standards 
                                           
  
                                          	 
                                            
                                            [bookmark: pgfId-1460704]Title 
                                           
  
                                         
 
                                          
                                          	[bookmark: pgfId-1460706]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
                                          	[bookmark: pgfId-1460708]—
  
                                         
 
                                         
                                       
 
                                      
 
                                     
 
                                    
 
                                     
                                      [bookmark: pgfId-1460711][bookmark: 92503]Feature History for Configuration Change Management
 
                                      
                                       
                                        
                                        [bookmark: pgfId-1460722]Table 14-9 [bookmark: 50557]Feature History for Configuration Change Management 
 
                                        
                                        
                                         
                                         	 
                                           
                                           [bookmark: pgfId-1460728]Feature Name 
                                          
  
                                         	 
                                           
                                           [bookmark: pgfId-1460730]Releases 
                                          
  
                                         	 
                                           
                                           [bookmark: pgfId-1460732]Feature Information 
                                          
  
                                        
 
                                         
                                         	[bookmark: pgfId-1460734]Configuration Change Management
  
                                         	[bookmark: pgfId-1460736]4.2(1)
  
                                         	[bookmark: pgfId-1460738]No change from Release 4.1
  
                                        
 
                                         
                                         	[bookmark: pgfId-1464153]Version Browser
  
                                         	[bookmark: pgfId-1464155]4.1(2)
  
                                         	[bookmark: pgfId-1464157]This feature was introduced.
  
                                        
 
                                         
                                         	[bookmark: pgfId-1464147]Archival Jobs
  
                                         	[bookmark: pgfId-1464182]4.1(2)
  
                                         	[bookmark: pgfId-1464184]This feature was introduced.
  
                                        
 
                                         
                                         	[bookmark: pgfId-1464141]Archival Settings
  
                                         	[bookmark: pgfId-1464186]4.1(2)
  
                                         	 
                                          
  
                                        
 
                                        
                                      
 
                                     
 
                                    
 
                                  
 
                                  
                                
 
                               
 
                             
 
                             
                           
 
                          
 
                         
 
                       
 
                       
                     
 
                    
 
                  
 
                  
                
 
               
 
             
 
             
           
 
          
 
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1222406][bookmark: 33088]Administering [bookmark: marker-1222404]Auto-Synchronization with Devices 
      
      
 
     
 
 
    [bookmark: pgfId-1392651]This chapter describes how to administer the Auto-Synchronization with Devices feature in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1392656]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1392660]Information About Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1392664]Licensing Requirements for Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1392668]Prerequisites for Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1392672]Guidelines and Limitations for Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1392676]Configuring Device Auto-Synchronization
 
     	 [bookmark: pgfId-1392680]Viewing the Status of Auto-Synchronization Pollers
 
     	 [bookmark: pgfId-1392684]Field Descriptions for Auto Synchronization with Devices
 
     	 [bookmark: pgfId-1392688]Additional References
 
     	 [bookmark: pgfId-1392692]Feature History for Auto-Synchronization with Devices
 
    
 
   
 
    
     [bookmark: pgfId-1392694][bookmark: 14255]Information About Auto-Synchronization with Devices
 
    [bookmark: pgfId-1392695]The Auto Synchronizing with Devices feature ensures that the Cisco Data Center Network Manager (DCNM) server has current configuration and status information about managed devices. The Cisco DCNM server creates one poller process for each device to retrieve the system and accounting logs that this feature requires.
 
    [bookmark: pgfId-1392696]When you choose Auto Synchronization with Devices on the Feature Selector, the content pane shows information about each poller process and allows you to control them.
 
    [bookmark: pgfId-1392697]You can configure the length of time that Cisco DCNM waits before polling a device again. By default, Cisco DCNM polls each managed device every 60 seconds. You can increase the length of time to a maximum of 300 seconds. For more information, see the “Configuring the Polling Interval” section.
 
    [bookmark: pgfId-1392701]Cisco DCNM polls devices concurrently; however, to avoid polling all devices simultaneously, Cisco DCNM begins polling devices in alphabetical device-name order and delays each polling process by a short, random amount of time.
 
    [bookmark: pgfId-1392702]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1392706]Automatic and Manual Purging of Event Data
 
     	 [bookmark: pgfId-1392710]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1392712][bookmark: 99322]Automatic and Manual Purging of Event Data
 
     [bookmark: pgfId-1392713]You can use the Auto-Synchronization with Devices feature to delete unwanted event data. Cisco DCNM supports automatic purging of event data. You can configure the following aspects of automatic event data purging:
 
      
      	 [bookmark: pgfId-1392714]Days of the week and time of day that automatic purging occurs.
 
      	 [bookmark: pgfId-1392715]Whether Cisco DCNM determines which event data to purge by the age of the data or by a maximum number of database entries.
 
      	 [bookmark: pgfId-1392716]Severity level of events.
 
     
 
     [bookmark: pgfId-1392717]You can also manually purge event data.
 
    
 
     
      [bookmark: pgfId-1392719][bookmark: 49358]Virtualization Support
 
     [bookmark: pgfId-1392720]Cisco DCNM treats each virtual device context (VDC) on a Cisco NX-OS device as a separate device. Cisco DCNM creates one poller process per device.
 
    
 
   
 
    
     [bookmark: pgfId-1392722][bookmark: 51127]Licensing Requirements for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1392723]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1392736]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1392726]Product 
         
  
        	 
          
          [bookmark: pgfId-1392728]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1392730]Cisco DCNM
  
        	[bookmark: pgfId-1392732]Auto-Synchronization with Devices requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1392738][bookmark: 78783]Prerequisites for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1392739]The Auto-Synchronization with Devices feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1392740]The Cisco DCNM server must be able to connect to the devices.
 
     	 [bookmark: pgfId-1392741]The Cisco NX-OS device must be running a supported version of Cisco NX-OS.
 
     	 [bookmark: pgfId-1392742]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Cisco NX-OS Device Preparation” section.
 
    
 
   
 
    
     [bookmark: pgfId-1392747][bookmark: 87804]Guidelines and Limitations for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1392748]The Auto-Synchronization with Devices feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1392749]We recommend that you use the default device polling interval unless you encounter issues with synchronization due to slow response from devices or to managing many devices. For more information, see the “Configuring the Polling Interval” section.
 
     	 [bookmark: pgfId-1392753]For the Auto-Synchronization with Devices feature, the Cisco DCNM client does not automatically update the information shown in the Summary pane. To ensure that you are viewing current information, from the menu bar, choose  View > Refresh .
 
     	 [bookmark: pgfId-1392754]We recommend that you configure automatic purging of event data to ensure that the Cisco DCNM database size does not grow too large.
 
    
 
   
 
    
     [bookmark: pgfId-1392756][bookmark: 54640]Configuring Device Auto-Synchronization
 
    [bookmark: pgfId-1392760]Figure 15-1 shows the Auto-Synchronization with Devices content pane.
 
    [bookmark: pgfId-1392762]Figure 15-1 [bookmark: 10762]Auto-Synchronization with Devices Content Pane
 
    [bookmark: pgfId-1392766]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1392767]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1392771]Starting and Stopping a Poller
 
     	 [bookmark: pgfId-1392775]Configuring the Polling Interval
 
     	 [bookmark: pgfId-1392779]Synchronizing with a Device
 
     	 [bookmark: pgfId-1392783]Deleting Data from the Events Database
 
     	 [bookmark: pgfId-1392787]Enabling and Disabling Automatic Event Purging
 
     	 [bookmark: pgfId-1392791]Configuring Automatic Event Purge Settings
 
     	 [bookmark: pgfId-1392795]Purging Events Now
 
    
 
     
      [bookmark: pgfId-1118467][bookmark: 91967]Starting and Stopping a Poller[bookmark: marker-1173976]
 
     [bookmark: pgfId-1118500]You can start and stop a poller for a device. When a poller is stopped, auto-synchronization for the device does not occur.
 
    
 
     
      [bookmark: pgfId-1231951]DETAILED STEPS
 
     [bookmark: pgfId-1121271]To start or stop a poller, follow these steps:
 
     
 
     [bookmark: pgfId-1121417]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1121418]A table of pollers appears in the Contents pane. Each row corresponds to a poller for a particular device. Devices are listed alphabetically. The Poller Status field displays messages about whether the poller is running or is stopped.
 
     [bookmark: pgfId-1121419]Step 2 Click the poller that you want to start or stop.
 
     [bookmark: pgfId-1121510]Step 3 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1121519]To start a poller, from the menu bar, choose  Actions > Start Poller . The Poller Status field changes to Running.
 
       	 [bookmark: pgfId-1121583]To stop a poller, from the menu bar, choose  Actions > Stop Poller . The Poller Status field changes to Stopped.
 
      
 
     
 
     [bookmark: pgfId-1121423]You do not need to save your changes.
 
     [bookmark: pgfId-1121424]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1121355][bookmark: 63326]Configuring the Polling Interval[bookmark: marker-1173977]
 
     [bookmark: pgfId-1378730]You can configure how often the Cisco DCNM server synchronizes with managed devices. While synchronizing, the Cisco DCNM server fetches accounting and system logs from managed devices. This setting affects how frequently features in the Cisco DCNM client receive updated information about managed devices.
 
    
 
     
      [bookmark: pgfId-1378731]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1378732]The default polling interval is 60 seconds.
 
     [bookmark: pgfId-1120779]Determine how often you want Cisco DCNM to perform auto-synchronization with managed devices. In general, consider the following:
 
      
      	 [bookmark: pgfId-1120655]How often device configurations are changed by means other than Cisco DCNM, such as using the command-line interface of a device. If changes by means other than Cisco DCNM are common, consider using a short polling interval.
 
      	 [bookmark: pgfId-1120682]How important it is to your organization that Cisco DCNM be up to date with managed device configurations. If up-to-date configuration information is important to your organization, consider using a short polling interval.
 
     
 
    
 
     
      [bookmark: pgfId-1120750]DETAILED STEPS
 
     [bookmark: pgfId-1120754]To configure the polling interval, follow these steps:
 
     
 
     [bookmark: pgfId-1120806]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1120807]The device polling interval appears in the Contents pane, above the table of pollers.
 
     [bookmark: pgfId-1120837]Step 2 In the Device Polling Interval field, enter the number of seconds between auto-synchronizations for all devices. The default interval is 60 seconds. You can specify an interval between 30 and 300 seconds.
 
     [bookmark: pgfId-1120989]Step 3 From the menu bar, choose File > Deploy to save the polling interval.
 
     [bookmark: pgfId-1120935]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1118604][bookmark: 31973]Synchronizing with a Device[bookmark: marker-1173978]
 
     [bookmark: pgfId-1119030]You can make Cisco DCNM synchronize with a device manually when you do not want to wait for the next auto-synchronization to occur.
 
      
       
     
 
     
 
     [bookmark: pgfId-1119842]Note If many configuration changes have occurred on the device since the last successful synchronization, consider performing device discovery instead of synchronization. For more information, see “Discovering a Device” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1119843]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1119844]Ensure that you have either configured the device entry with unique device credentials or that Cisco DCNM can use the default device credentials to connect to the device. For more information, see the “Configuring Default Device Credentials” section.
 
    
 
     
      [bookmark: pgfId-1119848]DETAILED STEPS
 
     [bookmark: pgfId-1119849]To synchronize with a device, follow these steps:
 
     
 
     [bookmark: pgfId-1119850]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices. 
 
     [bookmark: pgfId-1119851]A table of pollers appears in the Contents pane. Each row corresponds to a poller for a particular device. Devices are listed alphabetically. 
 
     [bookmark: pgfId-1119852]Step 2 Click the device that you want Cisco DCNM to synchronize with.
 
     [bookmark: pgfId-1119853]Step 3 From the menu bar, choose Actions > Synchronize with Device.
 
     [bookmark: pgfId-1120440]Synchronization begins.
 
     [bookmark: pgfId-1119856]To determine when the synchronization has finished, watch the Last Sync Status column. Typically, synchronization with a device occurs in less than 5 minutes.
 
     [bookmark: pgfId-1119857]You do not need to save your changes.
 
     [bookmark: pgfId-1119858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1118637][bookmark: 69928]Deleting Data from the Events Database[bookmark: marker-1173979]
 
     [bookmark: pgfId-1375865]You can delete data from the events database based on the exact age of the events. Events that you delete can no longer appear in the Event Browser or on a feature-specific Events tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-1375866]Tip If you want to delete events based on the number of events in the database, see the “Purging Events Now” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375867]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1118944]Determine the date and time of the newest events data that you want to delete. When you follow the steps in this procedure, Cisco DCNM deletes all events that are older than the date and time that you select.
 
    
 
     
      [bookmark: pgfId-1118932]DETAILED STEPS
 
     [bookmark: pgfId-1118839]To delete data from the events database, follow these steps:
 
     
 
     [bookmark: pgfId-1118867]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1118868]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1118720]Step 2 From the Delete events older than drop-down list, choose the date and time of the newest event that you want to delete and click OK.
 
     [bookmark: pgfId-1119017]Step 3 Click Delete.
 
     [bookmark: pgfId-1119021]Cisco DCNM deletes all events older than the date and time that you specified.
 
     [bookmark: pgfId-1118732]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1133658][bookmark: 23698]Enabling and Disabling Automatic Event Purging[bookmark: marker-1382195]
 
     [bookmark: pgfId-1375624]You can enable or disable the automatic purging of events from the Cisco DCNM events database.
 
    
 
     
      [bookmark: pgfId-1375634]DETAILED STEPS
 
     [bookmark: pgfId-1375665]To enable or disable automatic event purging, follow these steps:
 
     
 
     [bookmark: pgfId-1375666]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1375667]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1375687]Step 2 Under Purge Settings, do one of the following:
 
      
       
       	 [bookmark: pgfId-1375688]To enable automatic event purging, check  Enable Auto Purge .
 
       	 [bookmark: pgfId-1375689]To disable automatic event purging, uncheck  Enable Auto Purge .
 
      
 
     
 
     [bookmark: pgfId-1375690]Step 3 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1375671]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375601][bookmark: 56301]Configuring Automatic Event Purge Settings
 
     [bookmark: pgfId-1375735]You can configure when automatic event purging occurs and the criteria that Cisco DCNM uses to determine which events to purge.
 
    
 
     
      [bookmark: pgfId-1376641]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1376751]Determine when you want automatic event purging to occur. We recommend that automatic event purging occur when Cisco DCNM usage is low.
 
     [bookmark: pgfId-1376762]If you perform backups of your Cisco DCNM databases, consider scheduling automatic event purging after database backups have occurred, to ensure that you retain a record of all events.
 
     [bookmark: pgfId-1376793]Determine what criteria you want Cisco DCNM to use to determine which events to purge. The criteria available are as follows:
 
      
      	 [bookmark: pgfId-1376794]Age of event—Cisco DCNM can purge all events that are older than a specific number of days, weeks, or months.
 
      	 [bookmark: pgfId-1376819]Number of events in the database—When the number of events in the database exceeds the maximum number that you specify, Cisco DCNM can purge the oldest events first until the maximum number is not exceeded.
 
      	 [bookmark: pgfId-1383152]Severity of event—Cisco DCNM can purge events based on the severity level of the event.
 
     
 
     [bookmark: pgfId-1376830]If you enable both criteria, Cisco DCNM applies them independently of each other.
 
    
 
     
      [bookmark: pgfId-1376752]DETAILED STEPS
 
     [bookmark: pgfId-1376120]To configure automatic event purge settings, follow these steps:
 
     
 
     [bookmark: pgfId-1376143]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1376144]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1376134]Step 2 Under Purge Threshold, configure the criteria that Cisco DCNM uses to determine which events to purge. You can configure any of the criteria in the following table:
 
     [bookmark: pgfId-1376286]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1376299]Purge Criteria 
          
  
         	 
           
           [bookmark: pgfId-1376301]How to Configure 
          
  
        
 
         
         	[bookmark: pgfId-1376303]Age of events
  
         	[bookmark: pgfId-1376339] 1. Check Data older than.
 [bookmark: pgfId-1376340] 2. From the first drop-down list, choose the number of days, weeks, or months.
 [bookmark: pgfId-1376341] 3. From the second drop-down list, choose Days, Weeks, or Months, as needed.
  
        
 
         
         	[bookmark: pgfId-1377207]Number of events in the database
  
         	[bookmark: pgfId-1376395] 1. Check Total Entries Exceed(0-2147483647).
 [bookmark: pgfId-1376396] 2. In the box, enter the maximum number of entries that you want to allow in the events database.
  
        
 
         
         	[bookmark: pgfId-1383095]Severity of event
  
         	[bookmark: pgfId-1383097] 1. Check Severity. The list of eight severity levels becomes available.
 [bookmark: pgfId-1383115] 2. For each severity level that you want Cisco DCNM to use to determine whether to purge events, check the severity level.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1376260]Step 3 Under Purge Settings, follow these steps to configure when you want automatic purging to occur:
 
     [bookmark: pgfId-1376272] a. Check the days-of-the-week check boxes to specify which days of the week that you want automatic purging to occur.
 
     [bookmark: pgfId-1376532] b. Use the Run at box to configure the exact time on the specified days that you want automatic event purging to occur.
 
     [bookmark: pgfId-1376570]Step 4 (Optional) If you want to enable automatic event purging, check Enable Auto Purge.
 
     [bookmark: pgfId-1376681]Step 5 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1376603]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1376572][bookmark: 39920]Purging Events Now[bookmark: marker-1382204]
 
     [bookmark: pgfId-1376573]You can purge event data on demand, using the automatic event purge settings to determine which events are purged. Events that you delete can no longer appear in the Event Browser or on a feature-specific Events tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-1375886]Tip If you want to delete events on demand, based on the exact age of the events, see the “Deleting Data from the Events Database” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375888]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375776]Ensure that the automatic event purge settings are configured as needed. For more information, see the “Configuring Automatic Event Purge Settings” section.
 
    
 
     
      [bookmark: pgfId-1375975]DETAILED STEPS
 
     [bookmark: pgfId-1376040]To purge events from the events database now, follow these steps:
 
     
 
     [bookmark: pgfId-1376041]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1376042]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1376044]Step 2 Under Purge Settings, click Purge Now.
 
     [bookmark: pgfId-1376045]Cisco DCNM deletes events, using the automatic event purge settings to determine which events to purge.
 
     [bookmark: pgfId-1376046]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1375723][bookmark: 72635]Viewing the Status of Auto-Synchronization Pollers
 
    [bookmark: pgfId-1133659]To view the status of an auto-synchronization poller, from the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
    [bookmark: pgfId-1133660]Poller status and information about the synchronization time and status appear in the Pollers area in the Contents pane. For information about the fields that appear, see the “Field Descriptions for Auto Synchronization with Devices” section.s
 
   
 
    
     [bookmark: pgfId-1392986][bookmark: 59585]Field Descriptions for Auto Synchronization with Devices
 
    [bookmark: pgfId-1392987]This section includes the following field descriptions for the Auto Synchronization with Devices feature:
 
     
     	 [bookmark: pgfId-1392991]Summary Pane
 
     	 [bookmark: pgfId-1392995]Events Database Administration Tab
 
    
 
     
      [bookmark: pgfId-1392997][bookmark: 59437]Summary Pane
 
     [bookmark: pgfId-1393038]
 
      
       
        
        [bookmark: pgfId-1393003]Table 15-1 Auto Synchronization with Devices Summary Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1393007]Field 
          
  
         	 
           
           [bookmark: pgfId-1393009]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1393011]Pollers 
          
  
        
 
         
         	[bookmark: pgfId-1393015]Device Polling Interval
  
         	[bookmark: pgfId-1393017]Number of seconds that all pollers wait before the next attempt to synchronize with a device. The default value is 60 seconds. Valid values are from 30 to 300 seconds.
  
        
 
         
         	[bookmark: pgfId-1393019]Last Refresh Time
  
         	[bookmark: pgfId-1393021]Display only. Date and time that the Cisco DCNM client updated information shown on the Content pane.
  
        
 
         
         	[bookmark: pgfId-1393023]Device
  
         	[bookmark: pgfId-1393025]Display only. Name and IP address of the device for the corresponding poller.
  
        
 
         
         	[bookmark: pgfId-1393027]Poller Status
  
         	[bookmark: pgfId-1393029]Display only. Whether the poller is running or stopped. A running poller attempts to synchronize with the configuration and status information from its device at the frequency specified by the Device Polling Interval field.
  
        
 
         
         	[bookmark: pgfId-1393031]Last Sync Time
  
         	[bookmark: pgfId-1393033]Display only. Date and time that the poller last retrieved system and accounting log data from the device.
  
        
 
         
         	[bookmark: pgfId-1393035]Last Sync Status
  
         	[bookmark: pgfId-1393037]Display only. Whether the most recent synchronization attempt succeeded or failed. If synchronization failed, determine why Cisco DCNM failed to connect to the device. If necessary, rediscover the device.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1393040][bookmark: 16609]Events Database Administration Tab
 
     [bookmark: pgfId-1393101]
 
      
       
        
        [bookmark: pgfId-1393046]Table 15-2 Events Database Administration Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1393050]Field 
          
  
         	 
           
           [bookmark: pgfId-1393052]Description 
          
  
        
 
         
         	[bookmark: pgfId-1393054]Delete events older than
  
         	[bookmark: pgfId-1393056]Date and time of the newest event to be deleted from the events database. There is no default value for this field.
  
        
 
         
         	 
           
           [bookmark: pgfId-1393058]Purge Threshold 
          
  
        
 
         
         	[bookmark: pgfId-1393062]Data older than
  
         	[bookmark: pgfId-1393064]Whether, during automatic event purging, Cisco DCNM deletes events that are older than the age specified in the drop-down lists located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default age is 1 day.
  
        
 
         
         	[bookmark: pgfId-1393066]Total Entries Exceed
  
         	[bookmark: pgfId-1393068]Whether, during automatic event purging, Cisco DCNM deletes the oldest events until the number of events equals the number in the box located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default number of event is 25,000.
  
        
 
         
         	[bookmark: pgfId-1393070]Severity
  
         	[bookmark: pgfId-1393072]Whether, during automatic event purging, Cisco DCNM deletes events with severity levels that are selected from the list of severity levels. By default, this check box is disabled.
  
        
 
         
         	[bookmark: pgfId-1393074]Severity Levels
  
         	[bookmark: pgfId-1393076]The severity levels of events that Cisco DCNM deletes during automatic event purging. The severity levels are available only if the Severity check box is checked. By default, all severity levels are disabled. The severity levels are as follows:
 
           
           	 [bookmark: pgfId-1393077]Emergency
 
           	 [bookmark: pgfId-1393078]Alert
 
           	 [bookmark: pgfId-1393079]Critical
 
           	 [bookmark: pgfId-1393080]Error
 
           	 [bookmark: pgfId-1393081]Warning
 
           	 [bookmark: pgfId-1393082]Notification
 
           	 [bookmark: pgfId-1393083]Informational
 
           	 [bookmark: pgfId-1393084]Debugging
 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1393086]Purge Settings 
          
  
        
 
         
         	[bookmark: pgfId-1393090]Enable Auto Purge
  
         	[bookmark: pgfId-1393092]Whether automatic purging of event data is enabled. By default, this check box is disabled.
  
        
 
         
         	[bookmark: pgfId-1393094]Run on
  
         	[bookmark: pgfId-1393096]Days of the week that the automatic purging of events data occurs. By default, none of the check boxes are checked. If you check the Daily check box, the check boxes for the individual days of the week become unavailable.
  
        
 
         
         	[bookmark: pgfId-1393098]Run at
  
         	[bookmark: pgfId-1393100]Time of day that automatic purging of event data occurs, on the days of the week that automatic purging is enabled.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1393103][bookmark: 53004]Additional References
 
    [bookmark: pgfId-1393104]For additional information related to administering Auto-Synchronization with Devices, see the following sections:
 
     
     	 [bookmark: pgfId-1393108]Related Documents
 
     	 [bookmark: pgfId-1393112]Standards
 
    
 
     
      [bookmark: pgfId-1393114][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1393134]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1393117]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1393119]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1393121]Events
  
         	[bookmark: pgfId-1393126]Chapter 10, “Managing Events”
  
        
 
         
         	[bookmark: pgfId-1393128]Device discovery
  
         	[bookmark: pgfId-1393133]Administering Device Discovery
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1393136][bookmark: 55398]Standards
 
     [bookmark: pgfId-1393146]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1393139]Standards 
          
  
         	 
           
           [bookmark: pgfId-1393141]Title 
          
  
        
 
         
         	[bookmark: pgfId-1393143]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1393145]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1393148][bookmark: 92503]Feature History for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1393152]Table 15-3 lists the release history for this feature.
 
    [bookmark: pgfId-1393176]
 
     
      
       
       [bookmark: pgfId-1393159]Table 15-3 [bookmark: 50557]Feature History for Auto-Synchronization with Devices 
 
       
       
        
        	 
          
          [bookmark: pgfId-1393165]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1393167]Releases 
         
  
        	 
          
          [bookmark: pgfId-1393169]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1393171]Automatic purging based on event severity.
  
        	[bookmark: pgfId-1393173]4.2(1)
  
        	[bookmark: pgfId-1393175]Support was added.
  
       
 
        
        	[bookmark: pgfId-1393981]Automatic purging of statistical data
  
        	[bookmark: pgfId-1393983]4.1(2)
  
        	[bookmark: pgfId-1393985]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1393975]Auto-Synchronization with Devices
  
        	[bookmark: pgfId-1394003]4.1(2)
  
        	[bookmark: pgfId-1394005]This feature was introduced.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1380104][bookmark: 85166]Administering [bookmark: marker-1380102]Statistical Data Collection 
      
      
 
     
 
 
    [bookmark: pgfId-1394505]This chapter describes how to administer Statistical Data Collection in the Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1394510]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1394514]Information About Statistical Data Collection
 
     	 [bookmark: pgfId-1394518]Licensing Requirements for Statistical Data Collection
 
     	 [bookmark: pgfId-1394522]Prerequisites for Statistical Data Collection
 
     	 [bookmark: pgfId-1394526]Guidelines and Limitations for Statistical Data Collection
 
     	 [bookmark: pgfId-1394530]Configuring Statistical Data Collection
 
     	 [bookmark: pgfId-1394534]Viewing the Status of Statistical Data Collectors
 
     	 [bookmark: pgfId-1394538]Field Descriptions for Statistical Data Collection
 
     	 [bookmark: pgfId-1394542]Additional References
 
     	 [bookmark: pgfId-1394546]Feature History for Statistical Data Collection
 
    
 
   
 
    
     [bookmark: pgfId-1394548][bookmark: 68337]Information About Statistical Data Collection
 
    [bookmark: pgfId-1394549]You can use the Statistical Data Collection feature to control the statistics monitoring processes that you have created for one of the many device configuration features that support statistics.
 
    [bookmark: pgfId-1394550]When you choose Statistical Data Collection on the Feature Selector pane, the content pane shows information about each statistical collection and allows you to control them. You can also use this feature to purge old data from the statistical database.
 
    [bookmark: pgfId-1394551]You can configure the length of time that Cisco Data Center Network Manager (DCNM) waits before retrieving statistical data from devices that it is monitoring. By default, Cisco DCNM retrieves statistical data from monitored devices every 30 seconds. You can increase the length of time to a maximum of 4 minutes. For more information, see the “Configuring the Default Frequency of Statistical Data Retrieval” section.
 
    [bookmark: pgfId-1394555]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1394559]Automatic and Manual Purging of Statistical Data
 
     	 [bookmark: pgfId-1394563]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1394565][bookmark: 26781]Automatic and Manual Purging of Statistical Data
 
     [bookmark: pgfId-1394566]You can use the Statistical Data Collection feature to delete unwanted statistical data. Cisco DCNM supports automatic purging of statistical data. You can configure the following aspects of automatic statistical data purging:
 
      
      	 [bookmark: pgfId-1394567]Days of the week and time of day that automatic purging occurs.
 
      	 [bookmark: pgfId-1394568]Whether Cisco DCNM determines which statistical data to purge by the age of the data or by a maximum number of database entries.
 
      	 [bookmark: pgfId-1394569]Whether Cisco DCNM deletes the statistical data entries that it purges or consolidates them into one entry.
 
     
 
     [bookmark: pgfId-1394570]You can also manually purge statistical data.
 
    
 
     
      [bookmark: pgfId-1394572][bookmark: 81615]Virtualization Support
 
     [bookmark: pgfId-1394573]Cisco DCNM treats each virtual device context (VDC) on a Cisco NX-OS device as a separate device. Statistical data collections contain statistics from objects within devices.
 
    
 
   
 
    
     [bookmark: pgfId-1394575][bookmark: 91493]Licensing Requirements for Statistical Data Collection
 
    [bookmark: pgfId-1394576]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1394593]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1394579]Product 
         
  
        	 
          
          [bookmark: pgfId-1394581]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1394583]Cisco DCNM
  
        	[bookmark: pgfId-1394585]Real-time monitoring requires no license.
 [bookmark: pgfId-1394586]Cisco DCNM requires a LAN Enterprise license for the following features:
 
          
          	 [bookmark: pgfId-1394587]Maintaining a history of statistical data
 
          	 [bookmark: pgfId-1394588]Using overview charts
 
         
 [bookmark: pgfId-1394591]For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1394595][bookmark: 46908]Prerequisites for Statistical Data Collection
 
    [bookmark: pgfId-1394596]Statistical data collection has the following prerequisites:
 
     
     	 [bookmark: pgfId-1394597]The Cisco DCNM server must be able to connect to the devices.
 
     	 [bookmark: pgfId-1394598]The Cisco NX-OS device must be running a supported version of Cisco NX-OS.
 
     	 [bookmark: pgfId-1394599]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Cisco NX-OS Device Preparation” section.
 
    
 
   
 
    
     [bookmark: pgfId-1394604][bookmark: 98630]Guidelines and Limitations for Statistical Data Collection
 
    [bookmark: pgfId-1394605]The Statistical Data Collection feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1394606]Collections are created by starting monitoring for a new chart. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     	 [bookmark: pgfId-1394610]For the Statistical Data Collection feature, the Cisco DCNM client does not automatically update the information shown in the Summary pane. To ensure that you are viewing current information, from the menu bar, choose  View > Refresh .
 
     	 [bookmark: pgfId-1394611]When you start statistical monitoring for one or more charts and then close the Cisco DCNM client, a dialog box prompts you to decide whether to stop the collections or let them run. We recommend that you stop any unnecessary collections when you log out of the Cisco DCNM client. This practice conserves database space and decreases server load.
 
     	 [bookmark: pgfId-1394612]We recommend that you configure automatic purging of statistical data to ensure that the Cisco DCNM database size does not grow too large.
 
    
 
   
 
    
     [bookmark: pgfId-1394614][bookmark: 93527]Configuring Statistical Data Collection
 
    [bookmark: pgfId-1394618]Figure 16-1 shows the Statistical Data Collection content pane.
 
    [bookmark: pgfId-1394620]Figure 16-1 [bookmark: 33744]Statistical Data Collection Content Pane
 
    [bookmark: pgfId-1394624]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1394625]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1394629]Starting and Stopping Statistical Data Collection
 
     	 [bookmark: pgfId-1394633]Deleting Statistical Data from a Collection
 
     	 [bookmark: pgfId-1394637]Deleting a Collection
 
     	 [bookmark: pgfId-1394641]Deleting Data from the Statistics Database
 
     	 [bookmark: pgfId-1394645]Enabling and Disabling Automatic Statistical Data Purging
 
     	 [bookmark: pgfId-1394649]Configuring Automatic Statistical Data Purge Settings
 
     	 [bookmark: pgfId-1394653]Purging Statistical Data Now
 
    
 
     
      [bookmark: pgfId-1373519][bookmark: 19915]Starting and Stopping Statistical Data Collection[bookmark: marker-1373518]
 
     [bookmark: pgfId-1373520]You can use the Statistical Data Collection feature to start and stop a statistical data collection process. Each collection process represents a statistical monitoring process that you created by starting monitoring for a device configuration feature.
 
    
 
     
      [bookmark: pgfId-1373521]DETAILED STEPS
 
     [bookmark: pgfId-1373522]To start or stop a collection process, follow these steps:
 
     
 
     [bookmark: pgfId-1373523]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection. 
 
     [bookmark: pgfId-1373524]A table of statistical data collectors appears in the Contents pane. Each row corresponds to a collector for a particular device. The Status field displays whether the collector is running or is stopped.
 
     [bookmark: pgfId-1373525]Step 2 Click the collector that you want to start or stop.
 
     [bookmark: pgfId-1373526]Step 3 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1373527]To start a collector, from the menu bar, choose  Actions > Start Collection . The Status field changes to Running.
 
       	 [bookmark: pgfId-1373528]To stop a collector, from the menu bar, choose  Actions > Stop Collection . The Status field changes to Stopped.
 
      
 
     
 
     [bookmark: pgfId-1373529]You do not need to save your changes.
 
     [bookmark: pgfId-1373530]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373546][bookmark: 29958]Deleting Statistical Data from a Collection[bookmark: marker-1373545]
 
     [bookmark: pgfId-1373547]You can delete statistical data from a collection. This feature allows you to delete all the data from a collection without affecting data from other collections and without deleting the collection itself. Each collection process represents a statistical monitoring process that you created by starting monitoring for a device configuration feature.
 
    
 
     
      [bookmark: pgfId-1373548]DETAILED STEPS
 
     [bookmark: pgfId-1373549]To delete statistical data from a collection, follow these steps:
 
     
 
     [bookmark: pgfId-1373550]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection. 
 
     [bookmark: pgfId-1373551]A table of statistical data collectors appears in the Contents pane. Each row corresponds to a collector for a particular device. Devices are listed alphabetically. The Status field displays whether the collector is running or is stopped.
 
     [bookmark: pgfId-1373552]Step 2 Right-click the collection.
 
     [bookmark: pgfId-1373553]Step 3 From the menu bar, choose Actions > Delete Statistical Data.
 
     [bookmark: pgfId-1373554]Cisco DCNM deletes all statistical data from the collection.
 
     [bookmark: pgfId-1373555]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373575][bookmark: 45685]Deleting a Collection[bookmark: marker-1373574]
 
     [bookmark: pgfId-1373576]You can delete a collection of statistical data from a specific device. Each collection process represents a statistical monitoring process that you created by starting monitoring for a device configuration feature.
 
      
       
     
 
     
 
     [bookmark: pgfId-1373577]Note If you want to delete all data from a collections rather than deleting the collection itself, perform the steps in the “Deleting Statistical Data from a Collection” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373581]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1373582]Determine which collection of data you want to delete.
 
    
 
     
      [bookmark: pgfId-1373583]DETAILED STEPS
 
     [bookmark: pgfId-1373584]To delete a collection of statistical data from a device, follow these steps:
 
     
 
     [bookmark: pgfId-1373585]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection. 
 
     [bookmark: pgfId-1373586]A table of statistical data collectors appears in the Contents pane. Devices are listed alphabetically. Each row corresponds to a collection of statistical data for a particular device.
 
     [bookmark: pgfId-1373587]Step 2 Click the collection of data that you want to delete.
 
     [bookmark: pgfId-1373588]Step 3 From the menu bar, choose Actions > Delete Collection.
 
     [bookmark: pgfId-1373589]The collection is deleted.
 
     [bookmark: pgfId-1373590]You do not need to save your changes.
 
     [bookmark: pgfId-1373591]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1377034][bookmark: 73792]Deleting Data from the Statistics Database[bookmark: marker-1377033]
 
     [bookmark: pgfId-1377035]You can delete statistical data from the statistics database.
 
      
       
     
 
     
 
     [bookmark: pgfId-1373613]Note If you want to delete all data from a specific collection rather than deleting old data from all collections, perform the steps in the “Deleting a Collection” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373617]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1373618]Determine the date and time of the newest statistical data that you want to delete. When you follow the steps in this procedure, Cisco DCNM deletes all statistics that are older than the date and time that you select.
 
    
 
     
      [bookmark: pgfId-1373619]DETAILED STEPS
 
     [bookmark: pgfId-1373620]To delete data from the statistics database, follow these steps:
 
     
 
     [bookmark: pgfId-1373621]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1373622]The Statistics Database area appears in the Contents pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1373623]Step 2 From the Delete statistical data older than drop-down list, select the date and time of the newest statistics that you want to delete and click OK.
 
     [bookmark: pgfId-1373624]Step 3 Click Delete.
 
     [bookmark: pgfId-1373625]Cisco DCNM deletes all statistics older than the date and time that you specified.
 
     [bookmark: pgfId-1373626]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375724][bookmark: 23698]Enabling and Disabling Automatic Statistical Data Purging[bookmark: marker-1382074]
 
     [bookmark: pgfId-1375725]You can enable or disable the automatic purging of statistical data from the Cisco DCNM statistics database.
 
    
 
     
      [bookmark: pgfId-1375726]DETAILED STEPS
 
     [bookmark: pgfId-1375727]To enable or disable automatic statistical data purging, follow these steps:
 
     
 
     [bookmark: pgfId-1375728]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1375729]The Statistical Database Administration tab appears in the Details pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1375730]Step 2 Under Purge Settings, do one of the following:
 
      
       
       	 [bookmark: pgfId-1375731]To enable automatic statistical data purging, check  Enable Auto Purge .
 
       	 [bookmark: pgfId-1375732]To disable automatic statistical data purging, uncheck  Enable Auto Purge .
 
      
 
     
 
     [bookmark: pgfId-1375733]Step 3 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1375734]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375749][bookmark: 56301]Configuring Automatic Statistical Data Purge Settings
 
     [bookmark: pgfId-1375750]You can configure when automatic statistical data purging occurs and the criteria that Cisco DCNM uses to determine which statistical data to purge.
 
    
 
     
      [bookmark: pgfId-1375751]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375752]Determine when you want automatic statistical data purging to occur. We recommend that automatic statistical data purging occur when Cisco DCNM usage is low.
 
     [bookmark: pgfId-1375753]If you perform backups of your Cisco DCNM databases, consider scheduling automatic statistical data purging after database backups have occurred, to ensure that you retain a record of all statistical data.
 
     [bookmark: pgfId-1375754]Determine what criteria you want Cisco DCNM to use to determine which statistical data to purge. The two criteria available are as follows:
 
      
      	 [bookmark: pgfId-1375755]Age of statistical data—Cisco DCNM can purge all statistical data entries that are older than a specific number of days, weeks, or months.
 
      	 [bookmark: pgfId-1375756]Number of statistical data entries in the database—When the number of statistical data entries in the database exceeds the maximum number that you specify, Cisco DCNM can purge the oldest statistical data entries first until the maximum number is not exceeded.
 
     
 
     [bookmark: pgfId-1375757]If you enable both criteria, Cisco DCNM applies them independently of each other.
 
    
 
     
      [bookmark: pgfId-1375758]DETAILED STEPS
 
     [bookmark: pgfId-1375759]To configure automatic statistical data purge settings, follow these steps:
 
     
 
     [bookmark: pgfId-1375760]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1375761]The Statistical Database Administration tab appears in the Details pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1375762]Step 2 Under Purge Threshold, configure the criteria that Cisco DCNM uses to determine which statistical data to purge. You can configure either or both of the criteria in the following table:
 
     [bookmark: pgfId-1375779]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1375765]Purge Criteria 
          
  
         	 
           
           [bookmark: pgfId-1375767]How to Configure 
          
  
        
 
         
         	[bookmark: pgfId-1375769]Age of statistical data
  
         	[bookmark: pgfId-1375771] 1. Check Data older than.
 [bookmark: pgfId-1375772] 2. From the first drop-down list, choose the number of days, weeks, or months.
 [bookmark: pgfId-1375773] 3. From the second drop-down list, choose Days, Weeks, or Months, as needed.
  
        
 
         
         	[bookmark: pgfId-1375775]Number of statistical data entries in the database
  
         	[bookmark: pgfId-1375777] 1. Check Total Entries Exceed(0-2147483647).
 [bookmark: pgfId-1375778] 2. In the box, enter the maximum number of entries that you want to allow in the statistical database.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1375780]Step 3 Configure the action that you want Cisco DCNM to take on statistical database entries that meet the purge criteria. You can choose one of the following:
 
      
       
       	 [bookmark: pgfId-1378626] Delete —Cisco DCNM deletes the database entries that meet the purge criteria.
 
       	 [bookmark: pgfId-1378650] Consolidate —Cisco DCNM merges all statistical data entries that meet the purge criteria into one entry
 
      
 
     
 
     [bookmark: pgfId-1378618]Step 4 Under Purge Settings, follow these steps to configure when you want automatic purging to occur:
 
     [bookmark: pgfId-1375781] a. Check the days-of-the-week check boxes to specify which days of the week that you want automatic purging to occur.
 
     [bookmark: pgfId-1375782] b. Use the Run at box to configure the exact time on the specified days that you want automatic statistical data purging to occur.
 
     [bookmark: pgfId-1375783]Step 5 (Optional) If you want to enable automatic statistical data purging, check Enable Auto Purge.
 
     [bookmark: pgfId-1375784]Step 6 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1375785]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375800][bookmark: 39920]Purging Statistical Data Now[bookmark: marker-1382087]
 
     [bookmark: pgfId-1375801]You can purge statistical data on demand, using the automatic statistical data purge settings to determine which statistical data are purged.
 
      
       
     
 
     
 
     [bookmark: pgfId-1375804]Tip If you want to delete statistical data on demand, based on the exact age of the statistical data entries, see the “Deleting Data from the Statistics Database” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375806]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375807]Ensure that the automatic statistical data purge settings are configured as needed. For more information, see the “Configuring Automatic Statistical Data Purge Settings” section.
 
    
 
     
      [bookmark: pgfId-1375811]DETAILED STEPS
 
     [bookmark: pgfId-1375812]To purge statistical data from the statistical database now, follow these steps:
 
     
 
     [bookmark: pgfId-1375813]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1375814]The Statistical Database Administration tab appears in the Details pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1375815]Step 2 Under Purge Settings, click Purge Now.
 
     [bookmark: pgfId-1375816]Cisco DCNM deletes statistical data, using the automatic statistical data purge settings to determine which statistical data entries to purge.
 
     [bookmark: pgfId-1375817]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1375706][bookmark: 25460]Viewing the Status of Statistical Data Collectors
 
    [bookmark: pgfId-1373646]To view the status of statistical data collectors, from the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
    [bookmark: pgfId-1373647]Collector status and other information appear in the Statistical Data Collectors area in the Contents pane. For information about the fields that appear, see the “Field Descriptions for Statistical Data Collection” section.
 
   
 
    
     [bookmark: pgfId-1394867][bookmark: 73958]Field Descriptions for Statistical Data Collection
 
    [bookmark: pgfId-1394868]This section includes the following field descriptions for the Statistical Data Collection feature:
 
     
     	 [bookmark: pgfId-1394872]Summary Pane
 
     	 [bookmark: pgfId-1394876]Statistical Database Administration Tab
 
    
 
     
      [bookmark: pgfId-1394878][bookmark: 76150]Summary Pane
 
     [bookmark: pgfId-1394933]
 
      
       
        
        [bookmark: pgfId-1394884]Table 16-1 Summary Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1394888]Field 
          
  
         	 
           
           [bookmark: pgfId-1394890]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1394892]Statistical Data Collectors 
          
  
        
 
         
         	[bookmark: pgfId-1394896]Last Refresh Time
  
         	[bookmark: pgfId-1394898]Display only. Date and time that the Cisco DCNM client updated information shown on the Content pane.
  
        
 
         
         	[bookmark: pgfId-1394900]Collector ID
  
         	[bookmark: pgfId-1394902]Display only. Name and IP address of the device for the corresponding poller.
  
        
 
         
         	[bookmark: pgfId-1394904]Owner
  
         	[bookmark: pgfId-1394906]Display only. Username of the Cisco DCNM user who started monitoring for the chart that corresponds to the collection.
  
        
 
         
         	[bookmark: pgfId-1394908]Device
  
         	[bookmark: pgfId-1394910]Display only. Name and IP address of the device that is providing the statistical data in the collection.
  
        
 
         
         	[bookmark: pgfId-1394912]Objects
  
         	[bookmark: pgfId-1394914]Display only. Description of the entity on the device that is providing the statistical data in the collection.
 [bookmark: pgfId-1394915]For example, if the collection has statistical data for a rule that is assigned the sequence number 10 and is in an IPv4 ACL named acl-01, this field displays acl-01,seqNo=10. 
 [bookmark: pgfId-1394916]If the collection has data for the Ethernet 1/5 port, this field displays Ethernet1/5.
  
        
 
         
         	[bookmark: pgfId-1394918]Collected Statistics
  
         	[bookmark: pgfId-1394920]Display only. Type of statistical data in the collection. For example, if the collection has statistical data for a rule in an IPv4 ACL, this field displays IpAclAceMatchStatistics.
  
        
 
         
         	[bookmark: pgfId-1394922]Status
  
         	[bookmark: pgfId-1394924]Display only. Whether the collector is started or stopped.
  
        
 
         
         	 
           
           [bookmark: pgfId-1394926]Statistics Database 
          
  
        
 
         
         	[bookmark: pgfId-1394930]Delete statistical data older than
  
         	[bookmark: pgfId-1394932]Date and time of the newest statistical data to be deleted from the statistics database. There is no default value for this field.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1394935][bookmark: 16609]Statistical Database Administration Tab
 
     [bookmark: pgfId-1394988]
 
      
       
        
        [bookmark: pgfId-1394941]Table 16-2 Statistical Database Administration Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1394945]Field 
          
  
         	 
           
           [bookmark: pgfId-1394947]Description 
          
  
        
 
         
         	[bookmark: pgfId-1394949]Delete statistical data older than
  
         	[bookmark: pgfId-1394951]Date and time of the newest statistical data to be deleted from the statistics database. There is no default value for this field.
  
        
 
         
         	 
           
           [bookmark: pgfId-1394953]Auto Purge 
          
  
        
 
         
         	[bookmark: pgfId-1394957]Action
  
         	[bookmark: pgfId-1394959]Whether automatic statistical data purging deletes or consolidates statistical data entries that trigger the purge threshold. Consolidation merges all statistical data entries that trigger the purge threshold into one entry.
  
        
 
         
         	 
           
           [bookmark: pgfId-1394961]Purge Threshold 
          
  
        
 
         
         	[bookmark: pgfId-1394965]Data older than
  
         	[bookmark: pgfId-1394967]Whether, during automatic statistical data purging, Cisco DCNM deletes statistics entries that are older than the age specified in the drop-down lists located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default age is 1 day.
  
        
 
         
         	[bookmark: pgfId-1394969]Total Entries Exceed
  
         	[bookmark: pgfId-1394971]Whether, during automatic statistical data purging, Cisco DCNM deletes the oldest statistics entries until the number of entries equals the number in the box located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default number of event is 25,000.
  
        
 
         
         	 
           
           [bookmark: pgfId-1394973]Purge Settings 
          
  
        
 
         
         	[bookmark: pgfId-1394977]Enable Auto Purge
  
         	[bookmark: pgfId-1394979]Whether automatic purging of statistical data is enabled. By default, this check box is disabled.
  
        
 
         
         	[bookmark: pgfId-1394981]Run on
  
         	[bookmark: pgfId-1394983]Days of the week that automatic purging of statistical data occurs. By default, none of the check boxes are checked. If you check the Daily check box, the check boxes for the individual days of the week become unavailable.
  
        
 
         
         	[bookmark: pgfId-1394985]Run at
  
         	[bookmark: pgfId-1394987]Time of day that automatic purging of statistical data occurs, on the days of the week that automatic purging is enabled.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1394990][bookmark: 44962]Additional References
 
    [bookmark: pgfId-1394991]For additional information related to administering statistical data collection, see the following sections:
 
     
     	 [bookmark: pgfId-1394995]Related Documents
 
     	 [bookmark: pgfId-1394999]Standards
 
    
 
     
      [bookmark: pgfId-1395001][bookmark: 18088]Related Documents
 
     [bookmark: pgfId-1395014]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1395004]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1395006]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1395008]Device discovery
  
         	[bookmark: pgfId-1395013]Administering Device Discovery
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1395016][bookmark: 86472]Standards
 
     [bookmark: pgfId-1395026]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1395019]Standards 
          
  
         	 
           
           [bookmark: pgfId-1395021]Title 
          
  
        
 
         
         	[bookmark: pgfId-1395023]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1395025]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1395028][bookmark: 92503]Feature History for Statistical Data Collection
 
    [bookmark: pgfId-1395032]Table 16-3 lists the release history for this feature.
 
    [bookmark: pgfId-1395056]
 
     
      
       
       [bookmark: pgfId-1395039]Table 16-3 [bookmark: 50557]Feature History for Statistical Data Collection 
 
       
       
        
        	 
          
          [bookmark: pgfId-1395045]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1395047]Releases 
         
  
        	 
          
          [bookmark: pgfId-1395049]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1395051]Statistical Data Collection
  
        	[bookmark: pgfId-1395053]4.2(1)
  
        	[bookmark: pgfId-1395055]No change from Release 4.1
  
       
 
        
        	[bookmark: pgfId-1397171]Automatic purging of statistical data
  
        	[bookmark: pgfId-1397173]4.1(2)
  
        	[bookmark: pgfId-1397175]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1397189]Statistical Data Collection
  
        	[bookmark: pgfId-1397195]4.1(2)
  
        	[bookmark: pgfId-1397197]This feature was introduced.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1208646][bookmark: 29032]Administering [bookmark: marker-1173986]DCNM Server Log Settings 
      
      
 
     
 
 
    [bookmark: pgfId-1385503]This chapter describes how to administer the DCNM Server Log Settings feature in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1385508]This chapter includes the following section:
 
     
     	 [bookmark: pgfId-1385512]Information About Administering DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385516]Licensing Requirements for Administering DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385520]Prerequisites for Administering DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385524]Guidelines and Limitations for Administering DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385528]Configuring DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385532]Viewing DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385536]Field Descriptions for DCNM Server Log Settings
 
     	 [bookmark: pgfId-1385540]Additional References
 
     	 [bookmark: pgfId-1385544]Feature History for DCNM Server Log Settings
 
    
 
   
 
    
     [bookmark: pgfId-1385546][bookmark: 44768]Information About Administering DCNM Server Log Settings
 
    [bookmark: pgfId-1385547]The Cisco DCNM server maintains a log file of its operations. The log file contains information from Cisco DCNM features and server components.
 
     
      
    
 
    
 
    [bookmark: pgfId-1385548]Note The DCNM Server Log Settings feature does not affect logging levels of Cisco NX-OS devices. Cisco DCNM does not support the configuration of device logging levels.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1385549]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1385553]Logging Levels
 
     	 [bookmark: pgfId-1385557]Log File and Location
 
     	 [bookmark: pgfId-1385561]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1385563][bookmark: 54944]Logging Levels
 
     [bookmark: pgfId-1385564]The Cisco DCNM server supports a hierarchy of logging levels, ordered by severity of log messages. Each level includes messages for that level in addition to all log messages from levels of higher severity. The logging levels, in order from highest to lowest severity, are as follows:
 
      
      	 [bookmark: pgfId-1385565]Fatal Errors
 
      	 [bookmark: pgfId-1385566]Errors
 
      	 [bookmark: pgfId-1385567]Warnings
 
      	 [bookmark: pgfId-1385568]Information
 
      	 [bookmark: pgfId-1385569]Debugging
 
      	 [bookmark: pgfId-1385570]Verbose
 
     
 
    
 
     
      [bookmark: pgfId-1385572][bookmark: 64946]Log File and Location
 
    
 
     
      [bookmark: pgfId-1385579][bookmark: 31297]Virtualization Support
 
     [bookmark: pgfId-1385580]Cisco DCNM server logs do not contain log messages from Cisco NX-OS devices; therefore, this feature has no effect on virtualization support.
 
    
 
   
 
    
     [bookmark: pgfId-1385582][bookmark: 91360]Licensing Requirements for Administering DCNM Server Log Settings
 
    [bookmark: pgfId-1385583]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1385596]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1385586]Product 
         
  
        	 
          
          [bookmark: pgfId-1385588]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1385590]Cisco DCNM
  
        	[bookmark: pgfId-1385592]DCNM Server Log Settings requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1385598][bookmark: 78364]Prerequisites for Administering DCNM Server Log Settings
 
    [bookmark: pgfId-1385599]Administering Cisco DCNM server log settings has the following prerequisites:
 
     
     	 [bookmark: pgfId-1385600]You should be familiar with a Cisco DCNM feature before you configure server log settings for it.
 
    
 
   
 
    
     [bookmark: pgfId-1385602][bookmark: 48799]Guidelines and Limitations for Administering DCNM Server Log Settings
 
    [bookmark: pgfId-1385603]Administering Cisco DCNM server log settings has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1385604]Setting a logging level to a lower severity results in more messages in the log file.
 
     	 [bookmark: pgfId-1385605]We recommend using the default logging settings unless you are troubleshooting an issue.
 
     	 [bookmark: pgfId-1385606]When you are troubleshooting an issue, consider lowering the logging level severity of the affected feature or server component.
 
     	 [bookmark: pgfId-1385607]After you resolve an issue, consider restoring the logging level of the affected feature or server component to a higher severity.
 
    
 
   
 
    
     [bookmark: pgfId-1385609][bookmark: 47388]Configuring DCNM Server Log Settings
 
    [bookmark: pgfId-1385613]Figure 17-1 shows the DCNM Server Log Settings content pane.
 
    [bookmark: pgfId-1385615]Figure 17-1 [bookmark: 77435]DCNM Server Log Settings Content Pane
 
    [bookmark: pgfId-1385619]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1385620]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1385624]Configuring the Default Logging Level
 
     	 [bookmark: pgfId-1385628]Configuring a Unique Logging Level for a Feature or Server Component
 
     	 [bookmark: pgfId-1385632]Configuring a Feature or Server Component to Use the Default Logging Level
 
    
 
     
      [bookmark: pgfId-1054494][bookmark: 69103]Configuring the Default Logging Level[bookmark: marker-1173987]
 
     [bookmark: pgfId-1054496]You can configure the default logging level for all Cisco DCNM features and server components.
 
    
 
     
      [bookmark: pgfId-1054497]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1054498]Determine what the default logging level should be. For more information, see the “Logging Levels” section.
 
    
 
     
      [bookmark: pgfId-1054499]DETAILED STEPS
 
     [bookmark: pgfId-1054500]To configure the default logging level for all Cisco DCNM features and server components, follow these steps:
 
     
 
     [bookmark: pgfId-1076344]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings. 
 
     [bookmark: pgfId-1076345]The log settings appear in the Contents pane.
 
     [bookmark: pgfId-1076346]Step 2 From the Default Logging Level drop-down list, choose the logging level.
 
     [bookmark: pgfId-1076351]Step 3 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1076352]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1174001][bookmark: 90966]Configuring a Unique Logging Level for a Feature or Server Component
 
     [bookmark: pgfId-1174002]You can configure a logging level of a feature or server component that is independent of the default logging level.
 
    
 
     
      [bookmark: pgfId-1059732]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1077713]Determine what the logging level of the feature or service should be. For more information, see the “Logging Levels” section.
 
    
 
     
      [bookmark: pgfId-1059734]DETAILED STEPS
 
     [bookmark: pgfId-1059735]To configure a unique logging level for a feature or server component, follow these steps:
 
     
 
     [bookmark: pgfId-1077753]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings. 
 
     [bookmark: pgfId-1077754]The log settings appear in the Contents pane.
 
     [bookmark: pgfId-1079964]Step 2 Find the feature or server component that you want to configure with a unique logging level.
 
     [bookmark: pgfId-1079965]Step 3 Uncheck Default to the right of the feature or server component.
 
     [bookmark: pgfId-1079966]The logging level drop-down list for the feature or server component becomes available.
 
     [bookmark: pgfId-1077790]Step 4 From the logging level drop-down list, choose the logging level. For more information, see the “Logging Levels” section.
 
     [bookmark: pgfId-1077756]Step 5 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1077757]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054512][bookmark: 33111]Configuring a Feature or Server Component to Use the Default Logging Level
 
     [bookmark: pgfId-1077818]You can configure a feature or server component to use the default logging level.
 
    
 
     
      [bookmark: pgfId-1077819]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1077820]Ensure that the default logging level is appropriate for the feature or service. For more information, see the “Logging Levels” section.
 
    
 
     
      [bookmark: pgfId-1077824]DETAILED STEPS
 
     [bookmark: pgfId-1077825]To configure a feature or server component to use the default logging level, follow these steps:
 
     
 
     [bookmark: pgfId-1077826]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings. 
 
     [bookmark: pgfId-1077827]The log settings appear in the Contents pane.
 
     [bookmark: pgfId-1077828]Step 2 Find the feature or server component that you want to use the default logging level.
 
     [bookmark: pgfId-1077829]Step 3 Check Default to the right of the feature or service.
 
     [bookmark: pgfId-1077830]The logging level drop-down list for the feature or server component becomes unavailable.
 
     [bookmark: pgfId-1077835]Step 4 From the menu bar, choose File > Deploy to apply your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1077836]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1077740][bookmark: 24650]Viewing DCNM Server Log Settings
 
    [bookmark: pgfId-1062401]To view Cisco DCNM server user accounts, from the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings.
 
    [bookmark: pgfId-1062402]The default logging level, feature logging settings, and server component logging settings appear in the Contents pane. For information about the fields that appear, see the “Field Descriptions for DCNM Server Log Settings” section.
 
   
 
    
     [bookmark: pgfId-1385768][bookmark: 44408]Field Descriptions for DCNM Server Log Settings
 
     
      
       
       [bookmark: pgfId-1385781]Table 17-1 DCNM Server Log Settings Content Pane 
 
       
       
        
        	 
          
          [bookmark: pgfId-1385785]Field 
         
  
        	 
          
          [bookmark: pgfId-1385787]Description 
         
  
       
 
        
        	[bookmark: pgfId-1385789]Default Logging Level
  
        	[bookmark: pgfId-1385791]Logging level for the features or server components whose Default check box is checked. The default value for this list is Informational. For more information about logging levels, see the “Logging Levels” section. 
  
       
 
        
        	 
          
          [bookmark: pgfId-1385796]DCNM Features 
         
  
       
 
        
        	[bookmark: pgfId-1385800]Default
  
        	[bookmark: pgfId-1385802]Whether logging for the corresponding feature uses the default logging level or the logging level specified for the feature. When a Default check box is checked, the logging level list for the corresponding feature is unavailable. By default, these check boxes are unchecked.
  
       
 
        
        	[bookmark: pgfId-1385804]AAA
  
        	[bookmark: pgfId-1385806]Logging level for the AAA feature.
  
       
 
        
        	[bookmark: pgfId-1385808]ACL
  
        	[bookmark: pgfId-1385810]Logging level for the access control list feature.
  
       
 
        
        	[bookmark: pgfId-1385812]Dot1X
  
        	[bookmark: pgfId-1385814]Logging level for the 802.1X feature.
  
       
 
        
        	[bookmark: pgfId-1385816]GLBP
  
        	[bookmark: pgfId-1385818]Logging level for the Gateway Load-Balancing Protocol feature.
  
       
 
        
        	[bookmark: pgfId-1385820]Interfaces
  
        	[bookmark: pgfId-1385822]Logging level for the Interfaces feature.
  
       
 
        
        	[bookmark: pgfId-1385824]Key Chain
  
        	[bookmark: pgfId-1385826]Logging level for the keychain management feature.
  
       
 
        
        	[bookmark: pgfId-1385828]Layer 2 Security
  
        	[bookmark: pgfId-1385830]Logging level for the layer 2 security feature, which are as follows:
 
          
          	 [bookmark: pgfId-1385831]Dynamic ARP inspection
 
          	 [bookmark: pgfId-1385832]Port security
 
          	 [bookmark: pgfId-1385833]DHCP snooping
 
          	 [bookmark: pgfId-1385834]IP Source Guard
 
          	 [bookmark: pgfId-1385835]Traffic storm control
 
         
  
       
 
        
        	[bookmark: pgfId-1385837]Object Tracking
  
        	[bookmark: pgfId-1385839]Logging level for the object tracking feature.
  
       
 
        
        	[bookmark: pgfId-1385841]Port Channel
  
        	[bookmark: pgfId-1385843]Logging level for the port security feature.
  
       
 
        
        	[bookmark: pgfId-1385845]SPAN
  
        	[bookmark: pgfId-1385847]Logging level for the SPAN feature.
  
       
 
        
        	[bookmark: pgfId-1385849]Spanning Tree
  
        	[bookmark: pgfId-1385851]Logging level for the STP feature.
  
       
 
        
        	[bookmark: pgfId-1385853]Tunnel
  
        	[bookmark: pgfId-1385855]Logging level for tunnel interface management feature.
  
       
 
        
        	[bookmark: pgfId-1385857]Virtual Devices
  
        	[bookmark: pgfId-1385859]Logging level for the virtual device context feature.
  
       
 
        
        	[bookmark: pgfId-1385861]VLAN
  
        	[bookmark: pgfId-1385863]Logging level for the VLAN feature.
  
       
 
        
        	[bookmark: pgfId-1385865]FabricExtender
  
        	[bookmark: pgfId-1385867]Logging level for the FabricExtender feature.
  
       
 
        
        	[bookmark: pgfId-1385869]VPC
  
        	[bookmark: pgfId-1385871]Logging level for the vPC feature.
  
       
 
        
        	[bookmark: pgfId-1385873]HSRP
  
        	[bookmark: pgfId-1385875]Logging level for the HSRP feature.
  
       
 
        
        	 
          
          [bookmark: pgfId-1385877]DCNM Server Components 
         
  
       
 
        
        	[bookmark: pgfId-1385881]Default
  
        	[bookmark: pgfId-1385883]Whether logging for the corresponding server component uses the default logging level or the logging level specified for the component. When a Default check box is checked, the logging level list for the corresponding component is unavailable. By default, these check boxes are unchecked.
  
       
 
        
        	[bookmark: pgfId-1385885]Event
  
        	[bookmark: pgfId-1385887]Logging level for the event component, which includes messages about how Cisco DCNM processes the system and accounting logs it retrieves from devices and also events generated by Cisco DCNM.
  
       
 
        
        	[bookmark: pgfId-1385889]Statistics Collection
  
        	[bookmark: pgfId-1385891]Logging level for the statistical data collection component.
  
       
 
        
        	[bookmark: pgfId-1385893]Config Archive
  
        	[bookmark: pgfId-1385895]Logging level for the configuration archive component, used by the Configuration Change Management feature.
  
       
 
        
        	[bookmark: pgfId-1385897]Device Connections
  
        	[bookmark: pgfId-1385899]Logging level for the component that connects the Cisco DCNM server to devices.
  
       
 
        
        	[bookmark: pgfId-1385901]Device Discovery
  
        	[bookmark: pgfId-1385903]Logging level for the component that performs device discovery.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1385906][bookmark: 92345]Additional References
 
    [bookmark: pgfId-1385907]For additional information related to administering Cisco DCNM server log settings, see the following sections:
 
     
     	 [bookmark: pgfId-1385911]Related Documents
 
     	 [bookmark: pgfId-1385915]Standards
 
    
 
     
      [bookmark: pgfId-1385917][bookmark: 26697]Related Documents
 
     [bookmark: pgfId-1385930]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1385920]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1385922]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1385924]Troubleshooting Cisco DCNM
  
         	[bookmark: pgfId-1385929]Chapter 19, “Troubleshooting Cisco DCNM”
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1385932][bookmark: 16184]Standards
 
     [bookmark: pgfId-1385942]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1385935]Standards 
          
  
         	 
           
           [bookmark: pgfId-1385937]Title 
          
  
        
 
         
         	[bookmark: pgfId-1385939]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1385941]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1385944][bookmark: 92503]Feature History for DCNM Server Log Settings
 
     
      
       
       [bookmark: pgfId-1385955]Table 17-2 [bookmark: 50557]Feature History for DCNM Server Log Settings 
 
       
       
        
        	 
          
          [bookmark: pgfId-1385961]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1385963]Releases 
         
  
        	 
          
          [bookmark: pgfId-1385965]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1387167]DCNM Server Log Settings
  
        	[bookmark: pgfId-1387169]4.2(1)
  
        	[bookmark: pgfId-1387171]No change from Release 4.1.
  
       
 
        
        	[bookmark: pgfId-1385967]DCNM Server Log Settings
  
        	[bookmark: pgfId-1385969]4.1(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1394317][bookmark: 27743]Maintaining the Cisco DCNM Database[bookmark: marker-1394316] 
      
      
 
     
 
 
    [bookmark: pgfId-1382531]This chapter describes how to maintain the Cisco Data Center Network Manager (DCNM) database.
 
    [bookmark: pgfId-1382533]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1381568]Information About Database Maintenance
 
     	 [bookmark: pgfId-1381572]Licensing Requirements for Database Maintenance
 
     	 [bookmark: pgfId-1381576]Prerequisites for Database Maintenance
 
     	 [bookmark: pgfId-1381580]Guidelines and Limitations for Database Maintenance
 
     	 [bookmark: pgfId-1381584]Performing Database Maintenance
 
     	 [bookmark: pgfId-1388159]Additional References
 
     	 [bookmark: pgfId-1388161]Feature History for Cisco DCNM Database Maintenance
 
    
 
   
 
    
     [bookmark: pgfId-1388802][bookmark: 14255]Information About Database Maintenance
 
    [bookmark: pgfId-1388162]Cisco DCNM uses a PostgreSQL database or an Oracle database to store all data, including configuration information from managed devices, events and statistical data gathered from managed devices, and Cisco DCNM user information. In addition to scripts that you can run to perform database maintenance, Cisco DCNM provides features to help you delete events and statistical data that you no longer need.
 
    [bookmark: pgfId-1386983]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1387154]Automatic and Manual Purging of Data
 
     	 [bookmark: pgfId-1387074]Database Backup
 
     	 [bookmark: pgfId-1387097]Database Clean
 
     	 [bookmark: pgfId-1387006]Database Restore
 
    
 
     
      [bookmark: pgfId-1381610][bookmark: 58558]Automatic and Manual Purging of Data
 
     [bookmark: pgfId-1381611]You can use the Auto-Synchronization with Devices feature to delete unwanted event data and the Statistical Data Collection feature to delete unwanted statistical data. Cisco DCNM supports automatic purging of both types of data. You can configure the following aspects of automatic data purging:
 
      
      	 [bookmark: pgfId-1381612]Days of the week and time of day that automatic purging occurs.
 
      	 [bookmark: pgfId-1381613]Whether Cisco DCNM determines which data to purge by the age of the data or by a maximum number of database entries.
 
      	 [bookmark: pgfId-1388893]For event-related data, whether Cisco DCNM determines which events to purge by event severity.
 
     
 
     [bookmark: pgfId-1381614]We recommend that you configure automatic purging of events and statistical data to ensure that the Cisco DCNM database size does not grow too large.
 
     [bookmark: pgfId-1387402]You can also manually purge events and statistical data.
 
     [bookmark: pgfId-1387460]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1387224]Automatic and Manual Purging of Event Data
 
      	 [bookmark: pgfId-1387195]Automatic and Manual Purging of Statistical Data
 
     
 
    
 
     
      [bookmark: pgfId-1389371][bookmark: 62368]Database Backup
 
     [bookmark: pgfId-1389373]You can use the Cisco DCNM database backup script to create a backup file of the Cisco DCNM database.
 
     [bookmark: pgfId-1391138]We strongly recommend that you regularly back up the Cisco DCNM database and that you archive backup files in a secure location that is not on the Cisco DCNM server system. You should retain the backup files as long as required by the standards of your organization.
 
    
 
     
      [bookmark: pgfId-1390118][bookmark: 12870]Database Clean
 
     [bookmark: pgfId-1390119]You can use the Cisco DCNM database clean script to clean the Cisco DCNM database. Cleaning removes all Cisco DCNM data from the database and is a necessary step prior to restoring the Cisco DCNM database. Any database records that have not been backed up are lost when you clean the database.
 
     [bookmark: pgfId-1392894]You can also clean the database if you want to delete all data and rebuild your Cisco DCNM implementation without restoring data from a backup.
 
    
 
     
      [bookmark: pgfId-1392939][bookmark: 33742]Database Restore
 
     [bookmark: pgfId-1392940]You can use the Cisco DCNM database restore script to restore the Cisco DCNM database from a backup file. The backup file must have been created by the Cisco DCNM database backup script included in the same release of Cisco DCNM that you are restoring the data to. For example, if you are running Cisco DCNM Release 4.2(1), you should only perform database restoration from a backup of Cisco DCNM Release 4.2(1).
 
     [bookmark: pgfId-1391043]Also, the backup file must have been created from the same database type and release that you are restoring the data to. For example, if you are restoring data to an Oracle 11g database, the backup file must have been created from an Oracle 11g database.
 
     [bookmark: pgfId-1390683]Before you restore a Cisco DCNM database, you should clean the database. Restoring a database without cleaning the database can have unpredictable results.
 
    
 
   
 
    
     [bookmark: pgfId-1390685][bookmark: 51127]Licensing Requirements for Database Maintenance
 
    [bookmark: pgfId-1390686]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1381632]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1381622]Product 
         
  
        	 
          
          [bookmark: pgfId-1381624]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1381626]Cisco DCNM
  
        	[bookmark: pgfId-1381628]Database maintenance requires no license. Any feature not included in a license package is bundled with the Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the “Installing Licenses” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1381634][bookmark: 78783]Prerequisites for Database Maintenance
 
    [bookmark: pgfId-1381635]Database maintenance has the following prerequisites:
 
     
     	 [bookmark: pgfId-1381638]You must have successfully installed the Cisco DCNM server.
 
     	 [bookmark: pgfId-1386715]Cleaning the Cisco DCNM database requires that you stop the Cisco DCNM server.
 
     	 [bookmark: pgfId-1386720]Restoring the Cisco DCNM database requires the following:
 
    
 
    [bookmark: pgfId-1391202] – You must have a backup file created from exactly the same release of Cisco DCNM that you are restoring with the backup file.
 
    [bookmark: pgfId-1391253] – You must have a backup file created from exactly the same database type and release that you are restoring data to.
 
    [bookmark: pgfId-1394321] – You must have a backup file that was created from a Cisco DCNM database running in the same operating system as the database that you want to restore. For example, backup files made from a database running in Microsoft Server 2003 can only be used to restore other Cisco DCNM databases running in Microsoft Server 2003.
 
   
 
    
     [bookmark: pgfId-1393398][bookmark: 87804]Guidelines and Limitations for Database Maintenance[bookmark: marker-1393397]
 
    [bookmark: pgfId-1393399]Database maintenance has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1393400]We recommend that you configure automatic purging of statistical data and event data to ensure that the Cisco DCNM database size does not grow too large.
 
     	 [bookmark: pgfId-1382882]We recommend that you perform backups on a regular basis. Follow the standards of your organization to determine how frequently you should perform backups.
 
     	 [bookmark: pgfId-1393132]You can only restore a Cisco DCNM database from a backup of the same release of Cisco DCNM. For example, if you are running Cisco DCNM Release 4.2(1), you should only perform database restoration from a backup of Cisco DCNM Release 4.2(1).
 
     	 [bookmark: pgfId-1393156]You can only restore a Cisco DCNM database from a backup of the same database type and release as the current database. For example, if the current database is an Oracle 11g database, you can only restore it with a backup file made from an Oracle 11g database.
 
     	 [bookmark: pgfId-1394337]You can only restore a Cisco DCNM database from a backup file that was made from a Cisco DCNM database running in the same operating system as the database that you want to restore. For example, backup files made from a database running in Microsoft Server 2003 can only be used to restore other Cisco DCNM databases running in Microsoft Server 2003.
 
    
 
   
 
    
     [bookmark: pgfId-1393134][bookmark: 54640]Performing Database Maintenance
 
    [bookmark: pgfId-1393135]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1381667]Backing Up the Cisco DCNM Database
 
     	 [bookmark: pgfId-1381675]Cleaning a Cisco DCNM Database
 
     	 [bookmark: pgfId-1381679]Restoring a Cisco DCNM Database from a Backup File
 
    
 
     
      [bookmark: pgfId-1383271][bookmark: 91967]Backing Up the Cisco DCNM Database[bookmark: marker-1388122]
 
     [bookmark: pgfId-1384090]You can back up the Cisco DCNM database with the backup script. The Cisco DCNM server installer configures the backup script with the database username and database name that you specified during server installation.
 
    
 
     
      [bookmark: pgfId-1231951]DETAILED STEPS
 
     [bookmark: pgfId-1121271]To back up the Cisco DCNM database, follow these steps:
 
     
 
     [bookmark: pgfId-1384416]Step 1 On the Cisco DCNM server, access a command prompt.
 
     [bookmark: pgfId-1384762]Step 2 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1388353]cd path
 
     [bookmark: pgfId-1384787]where path is the relative or absolute path to the bin directory. For Windows, the default path to the bin directory is C:\Program Files\dcm\dcnm\bin.
 
     [bookmark: pgfId-1384459]Step 3 Run the Cisco DCNM database backup script. The script name depends upon the server operating system and database type, as shown in the following table:
 
     [bookmark: pgfId-1392005]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1391424]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1391426]Database Type 
          
  
         	 
           
           [bookmark: pgfId-1391428]Backup Script Name 
          
  
        
 
         
         	 [bookmark: pgfId-1391430]Microsoft Windows
  
         	[bookmark: pgfId-1391432]PostgreSQL
  
         	[bookmark: pgfId-1391434]backup-pgsql-dcnm-db.bat
  
        
 
         
         	[bookmark: pgfId-1391438]Oracle
  
         	[bookmark: pgfId-1391440]backup-oracle-dcnm-db.bat
  
        
 
         
         	 [bookmark: pgfId-1391442]Linux
  
         	[bookmark: pgfId-1391444]PostgreSQL
  
         	[bookmark: pgfId-1391446]backup-pgsql-dcnm-db.sh
  
        
 
         
         	[bookmark: pgfId-1391450]Oracle
  
         	[bookmark: pgfId-1391452]backup-oracle-dcnm-db.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1393409]Step 4 Enter the filename for the backup that you are creating.
 
     [bookmark: pgfId-1393410]Step 5 At the confirmation prompt, enter y to continue with the backup.
 
     [bookmark: pgfId-1393411]Step 6 Verify that the backup file was created as you specified and has a file size greater than zero.
 
      
      	 [bookmark: pgfId-1385263]On Linux, use the  ls -l command.
 
      	 [bookmark: pgfId-1385285]On Microsoft Windows, use the  dir command.
 
     
 
     [bookmark: pgfId-1385262]Step 7 Store the backup file in a safe location. We recommend that you copy the backup file to a secure location that is off the Cisco DCNM server system so that you can protect your data from the potential of a catastrophic hardware failure.
 
     [bookmark: pgfId-1121424]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1385154]Example
 
     [bookmark: pgfId-1385155]The following example from a Windows server shows how to create a backup named masterbackup.bkp from a PostgreSQL Cisco DCNM database that was installed using default values:
 
      
      [bookmark: pgfId-1385229]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1385230] 
     
 
      
      [bookmark: pgfId-1391699]C:\Program Files\Cisco Systems\dcm\dcnm\bin>backup-pgsql-dcnm-db.bat 
     
 
      
      [bookmark: pgfId-1391700] ======================================================== 
     
 
      
      [bookmark: pgfId-1391701] 
     
 
      
      [bookmark: pgfId-1391702] Database Postgres Environment 
     
 
      
      [bookmark: pgfId-1391703] 
     
 
      
      [bookmark: pgfId-1391704] PostgreSQL Bin Path : ""C:\Program Files\Cisco Systems\dcm\db"\bin" 
     
 
      
      [bookmark: pgfId-1394806] 
     
 
      
      [bookmark: pgfId-1394807] DCNM Database Name : "dcmdb" 
     
 
      
      [bookmark: pgfId-1394808] 
     
 
      
      [bookmark: pgfId-1391708] DCNM Database User Name : "dcnmuser" 
     
 
      
      [bookmark: pgfId-1391709] 
     
 
      
      [bookmark: pgfId-1391710] ======================================================== 
     
 
      
      [bookmark: pgfId-1391711] 
     
 
      
      [bookmark: pgfId-1391712] 
     
 
      
      [bookmark: pgfId-1391713]Please enter the filename to be used for Database Backup:masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1391714]"" 
     
 
      
      [bookmark: pgfId-1391715]"Database Schema "dcnmuser" will be backed up in filename : masterbackup.bkp" 
     
 
      
      [bookmark: pgfId-1391716]"" 
     
 
      
      [bookmark: pgfId-1385233]Continue y/n [n] : y 
     
 
      
      [bookmark: pgfId-1391760]. 
     
 
      
      [bookmark: pgfId-1391761]. 
     
 
      
      [bookmark: pgfId-1391762]. 
     
 
      
      [bookmark: pgfId-1391747]Database backup File: woobie1 
     
 
      
      [bookmark: pgfId-1385234] Operation Completed 
     
 
      
      [bookmark: pgfId-1391756]C:\Program Files\Cisco Systems\dcm\dcnm\bin>dir masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1385235] Volume in drive C has no label. 
     
 
      
      [bookmark: pgfId-1385236] Volume Serial Number is D415-F632 
     
 
      
      [bookmark: pgfId-1385237] 
     
 
      
      [bookmark: pgfId-1385238] Directory of C:\Program Files\PostgreSQL\8.2\bin 
     
 
      
      [bookmark: pgfId-1385239] 
     
 
      
      [bookmark: pgfId-1385240]06/15/2009 01:53 PM 900,129 masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1385241] 1 File(s) 900,129 bytes 
     
 
      
      [bookmark: pgfId-1385242] 0 Dir(s) 23,960,858,624 bytes free 
     
 
      
      [bookmark: pgfId-1385243] 
     
 
      
      [bookmark: pgfId-1385046]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1385105] 
     
 
    
 
     
      [bookmark: pgfId-1118604][bookmark: 31973]Cleaning a Cisco DCNM Database[bookmark: marker-1173978]
 
     [bookmark: pgfId-1119030]You can use the Cisco DCNM database clean script to clean the database, which deletes all data from the Cisco DCNM database. You may want to clean the database for the following reasons:
 
      
      	 [bookmark: pgfId-1385754]You want to restore the Cisco DCNM database from a backup.
 
      	 [bookmark: pgfId-1391835]You want to delete all data and rebuild your Cisco DCNM implementation without restoring data from a backup.
 
     
 
     [bookmark: pgfId-1391852]The Cisco DCNM server installer configures the clean script with the database username and database name that you specified during server installation.
 
    
 
     
      [bookmark: pgfId-1391836]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1391837]Back up the Cisco DCNM database. Any data not preserved in a backup is lost when you clean the database.
 
     [bookmark: pgfId-1385517]Stop the Cisco DCNM server. The Cisco DCNM server must be down before you can finish the database cleaning procedure. For detailed steps, see the “Stopping the Cisco DCNM Server” section.
 
    
 
     
      [bookmark: pgfId-1119848]DETAILED STEPS
 
     [bookmark: pgfId-1119849]To clean the Cisco DCNM database, follow these steps:
 
     
 
     [bookmark: pgfId-1385558]Step 1 On the Cisco DCNM server, access a command prompt.
 
     [bookmark: pgfId-1385842]Step 2 If you have not already done so, stop the Cisco DCNM server. For detailed steps, see the “Stopping the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1391890]Step 3 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1391891]cd path
 
     [bookmark: pgfId-1391892]where path is the relative or absolute path to the bin directory. For Windows, the default path to the bin directory is C:\Program Files\dcm\dcnm\bin.
 
     [bookmark: pgfId-1391893]Step 4 Run the Cisco DCNM database clean script. The script name depends upon the server operating system and database type, as shown in the following table:
 
     [bookmark: pgfId-1392001]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1391969]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1391971]Database Type 
          
  
         	 
           
           [bookmark: pgfId-1391973]Clean Script 
          
  
        
 
         
         	 [bookmark: pgfId-1391975]Microsoft Windows
  
         	[bookmark: pgfId-1391977]PostgreSQL
  
         	[bookmark: pgfId-1391979]clean-pgsql-dcnm-db.bat
  
        
 
         
         	[bookmark: pgfId-1391983]Oracle
  
         	[bookmark: pgfId-1391985]clean-oracle-dcnm-db.bat
  
        
 
         
         	 [bookmark: pgfId-1391987]Linux
  
         	[bookmark: pgfId-1391989]PostgreSQL
  
         	[bookmark: pgfId-1391991]clean-pgsql-dcnm-db.sh
  
        
 
         
         	[bookmark: pgfId-1391995]Oracle
  
         	[bookmark: pgfId-1391997]clean-oracle-dcnm-db.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1392014]Step 5 At the confirmation prompt, enter y to continue with cleaning the database.
 
     [bookmark: pgfId-1385791]Step 6 If you want to restore the Cisco DCNM database from a backup, proceed to the “Restoring a Cisco DCNM Database from a Backup File” section. Do not start the Cisco DCNM server.
 
     [bookmark: pgfId-1385814]If you do not want to restore the Cisco DCNM database from a backup and want to rebuild your Cisco DCNM implementation manually, start the Cisco DCNM server. See the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1119858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1385980]Example
 
     [bookmark: pgfId-1386052]The following example from a Windows server shows how to clean a PostgreSQL Cisco DCNM database that was installed using default values:
 
      
      [bookmark: pgfId-1392029]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1392030] 
     
 
      
      [bookmark: pgfId-1392059]C:\Program Files\Cisco Systems\dcm\dcnm\bin>clean-pgsql-dcnm-db.bat 
     
 
      
      [bookmark: pgfId-1392060] 
     
 
      
      [bookmark: pgfId-1392061] ======================================================== 
     
 
      
      [bookmark: pgfId-1392062] 
     
 
      
      [bookmark: pgfId-1392063] Database Postgres Environment 
     
 
      
      [bookmark: pgfId-1392064] 
     
 
      
      [bookmark: pgfId-1392065] PostgreSQL Bin Path : ""C:\Program Files\Cisco Systems\dcm\db"\bin" 
     
 
      
      [bookmark: pgfId-1392066] 
     
 
      
      [bookmark: pgfId-1392067] DCNM Database Name : "dcmdb" 
     
 
      
      [bookmark: pgfId-1392068] 
     
 
      
      [bookmark: pgfId-1392069] DCNM Database User Name : "dcnmuser" 
     
 
      
      [bookmark: pgfId-1392070] 
     
 
      
      [bookmark: pgfId-1392071] DCNM Database SuperUser Name : "cisco" 
     
 
      
      [bookmark: pgfId-1392072] ========================================================= 
     
 
      
      [bookmark: pgfId-1392073] 
     
 
      
      [bookmark: pgfId-1392074] 
     
 
      
      [bookmark: pgfId-1392075] 
     
 
      
      [bookmark: pgfId-1392076] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392077] PLEASE MAKE SURE THE DCNM SERVICE IS SHUTDOWN BEFORE RUNNING THIS SCRIPT!! 
     
 
      
      [bookmark: pgfId-1392078] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392079] 
     
 
      
      [bookmark: pgfId-1392080] 
     
 
      
      [bookmark: pgfId-1392081]DCNM database schema "dcnmuser" will be deleted permanently... 
     
 
      
      [bookmark: pgfId-1392082] 
     
 
      
      [bookmark: pgfId-1392083]Please Confirm y/n [n] : y 
     
 
      
      [bookmark: pgfId-1392084]. 
     
 
      
      [bookmark: pgfId-1392085]. 
     
 
      
      [bookmark: pgfId-1392086]. 
     
 
      
      [bookmark: pgfId-1392087] Operation Completed 
     
 
      
      [bookmark: pgfId-1386105]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1392114] 
     
 
    
 
     
      [bookmark: pgfId-1118637][bookmark: 69928]Restoring a Cisco DCNM Database from a Backup File[bookmark: marker-1388105]
 
     [bookmark: pgfId-1375865]You can use the Cisco DCNM database restore script to restore the Cisco DCNM database from a backup file. The restore script cleans the database prior to restoring it.
 
    
 
     
      [bookmark: pgfId-1375867]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1392255]Locate the backup file that you want to use to restore the Cisco DCNM database.
 
     [bookmark: pgfId-1383981]Ensure that the backup file that you want to use to restore the database was made from the same release of Cisco DCNM. For example, you can only restore a Cisco DCNM Release 4.2(1) database from a backup file created from a Cisco DCNM Release 4.2(1) database.
 
     [bookmark: pgfId-1392191]Ensure that the backup file was made from the same database type and release as the current database. For example, you can only restore an Oracle 11g database from a backup file made from an Oracle 11g database.
 
     [bookmark: pgfId-1394366]Ensure that the backup file was made from a Cisco DCNM database running in the same operating system as the Cisco DCNM server that you want to restore the database to. For example, backup files made from a database running in Microsoft Server 2003 can only be used to restore other Cisco DCNM databases running in Microsoft Server 2003.
 
     [bookmark: pgfId-1384008]The Cisco DCNM server must be stopped while you are restoring the database.
 
    
 
     
      [bookmark: pgfId-1118932]DETAILED STEPS
 
     [bookmark: pgfId-1386111]To restore the Cisco DCNM database from a backup file, follow these steps:
 
     
 
     [bookmark: pgfId-1386112]Step 1 On the Cisco DCNM server, access a command prompt.
 
     [bookmark: pgfId-1392645]Step 2 If you have not already done so, stop the Cisco DCNM server. For detailed steps, see the “Stopping the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1392271]Step 3 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1392272]cd path
 
     [bookmark: pgfId-1392273]where path is the relative or absolute path to the bin directory. For Windows, the default path to the bin directory is C:\Program Files\dcm\dcnm\bin.
 
     [bookmark: pgfId-1392274]Step 4 Run the Cisco DCNM database restore script. The script name depends upon the server operating system and database type, as shown in the following table:
 
     [bookmark: pgfId-1392360]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1392563]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1392565]Database Type 
          
  
         	 
           
           [bookmark: pgfId-1392567]Restore Script 
          
  
        
 
         
         	 [bookmark: pgfId-1392569]Microsoft Windows
  
         	[bookmark: pgfId-1392571]PostgreSQL
  
         	[bookmark: pgfId-1392573]restore-pgsql-dcnm-db.bat
  
        
 
         
         	[bookmark: pgfId-1392577]Oracle
  
         	[bookmark: pgfId-1392579]restore-oracle-dcnm-db.bat
  
        
 
         
         	 [bookmark: pgfId-1392581]Linux
  
         	[bookmark: pgfId-1392583]PostgreSQL
  
         	[bookmark: pgfId-1392585]restore-pgsql-dcnm-db.sh
  
        
 
         
         	[bookmark: pgfId-1392589]Oracle
  
         	[bookmark: pgfId-1392591]restore-oracle-dcnm-db.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1392655]Step 5 Enter the name of the backup file that you want to use to restore the Cisco DCNM database.
 
     [bookmark: pgfId-1392656]Step 6 At the confirmation prompt, enter y to continue with the database restore.
 
     [bookmark: pgfId-1386132]Step 7 To resume using Cisco DCNM, start the Cisco DCNM server. See the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-1386136]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1386237]Example
 
     [bookmark: pgfId-1386290]The following example from a Windows server shows how to restore a Cisco DCNM PostgreSQL database that was installed using default values and using a backup file named masterbackup.bkp that exists in the bin directory Cisco DCNM installation directory:
 
      
      [bookmark: pgfId-1392681]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1392682] 
     
 
      
      [bookmark: pgfId-1392690] 
     
 
      
      [bookmark: pgfId-1392691]C:\Program Files\Cisco Systems\dcm\dcnm\bin>restore-pgsql-dcnm-db.bat 
     
 
      
      [bookmark: pgfId-1392692] ======================================================== 
     
 
      
      [bookmark: pgfId-1392693] 
     
 
      
      [bookmark: pgfId-1392694] Database Postgres Environment 
     
 
      
      [bookmark: pgfId-1392695] 
     
 
      
      [bookmark: pgfId-1392696] PostgreSQL Bin Path : ""C:\Program Files\Cisco Systems\dcm\db"\bin" 
     
 
      
      [bookmark: pgfId-1392697] 
     
 
      
      [bookmark: pgfId-1392698] DCNM Database Name : "dcmdb" 
     
 
      
      [bookmark: pgfId-1392699] 
     
 
      
      [bookmark: pgfId-1392700] DCNM Database User Name : "dcnmuser" 
     
 
      
      [bookmark: pgfId-1392701] 
     
 
      
      [bookmark: pgfId-1392702] ======================================================== 
     
 
      
      [bookmark: pgfId-1392703] 
     
 
      
      [bookmark: pgfId-1392704] 
     
 
      
      [bookmark: pgfId-1392705] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392706] PLEASE MAKE SURE THE DCNM SERVICE IS SHUTDOWN BEFORE RUNNING THIS SCRIPT!! 
     
 
      
      [bookmark: pgfId-1392707] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392708] 
     
 
      
      [bookmark: pgfId-1392709] 
     
 
      
      [bookmark: pgfId-1392710] 
     
 
      
      [bookmark: pgfId-1392711]Please enter the filename to be used for Database Restore:masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1392712]"" 
     
 
      
      [bookmark: pgfId-1392713]"Database Schema "dcnmuser" will be Restore from filename : masterbackup.bkp" 
     
 
      
      [bookmark: pgfId-1392714]"" 
     
 
      
      [bookmark: pgfId-1392715]Continue y/n [n] : y 
     
 
      
      [bookmark: pgfId-1392716] 
     
 
      
      [bookmark: pgfId-1392717]"Cleaning the database... 
     
 
      
      [bookmark: pgfId-1392718]. 
     
 
      
      [bookmark: pgfId-1392719]. 
     
 
      
      [bookmark: pgfId-1392720]. 
     
 
      
      [bookmark: pgfId-1392721]"Done" 
     
 
      
      [bookmark: pgfId-1392722]pg_restore: connecting to database for restore 
     
 
      
      [bookmark: pgfId-1392723]. 
     
 
      
      [bookmark: pgfId-1392724]. 
     
 
      
      [bookmark: pgfId-1392725]. 
     
 
      
      [bookmark: pgfId-1392726]Restored Database from : masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1392727] Operation Completed 
     
 
      
      [bookmark: pgfId-1386280]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1386288] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1381983][bookmark: 53004]Additional References
 
    [bookmark: pgfId-1381984]For additional information related to maintaining the Cisco DCNM database, see the following sections:
 
     
     	 [bookmark: pgfId-1381988]Related Documents
 
     	 [bookmark: pgfId-1381992]Standards
 
    
 
     
      [bookmark: pgfId-1382013][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1382342]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1381996]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1381998]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1382000]Automatic purge of event data
  
         	[bookmark: pgfId-1382005]Chapter 10, “Managing Events”
  
        
 
         
         	[bookmark: pgfId-1382007]Automatic purge of statistical data
  
         	[bookmark: pgfId-1382012]Chapter 16, “Administering Statistical Data Collection”
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1382024][bookmark: 55398]Standards
 
     [bookmark: pgfId-1382350]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1382017]Standards 
          
  
         	 
           
           [bookmark: pgfId-1382019]Title 
          
  
        
 
         
         	[bookmark: pgfId-1382021]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1382023]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1393641][bookmark: 92503]Feature History for Cisco DCNM Database Maintenance
 
    [bookmark: pgfId-1393645]Table 18-1 lists the release history for this feature.
 
    [bookmark: pgfId-1393669]
 
     
      
       
       [bookmark: pgfId-1393652]Table 18-1 [bookmark: 50557]Feature History for Cisco DCNM Database Maintenance 
 
       
       
        
        	 
          
          [bookmark: pgfId-1393658]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1393660]Releases 
         
  
        	 
          
          [bookmark: pgfId-1393662]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1393664]Database maintenance scripts
  
        	[bookmark: pgfId-1393666]4.2(1)
  
        	[bookmark: pgfId-1393668]Support was added for scripts to perform database backup, restore, and cleaning.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-190769][bookmark: 15697]Troubleshooting Cisco DCNM 
      
      
 
     
 
 
    [bookmark: pgfId-188338]This chapter describes some common issues you may experience while using Cisco Data Center Network Manager (DCNM), and provides solutions.
 
    [bookmark: pgfId-158980]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-169412]Initial Troubleshooting Checklist
 
     	 [bookmark: pgfId-158990]Tips for Using Cisco DCNM
 
     	 [bookmark: pgfId-167761]Trouble with Cisco DCNM Server Installation
 
     	 [bookmark: pgfId-181096]Trouble with Starting the Cisco DCNM Server
 
     	 [bookmark: pgfId-197706]Trouble with the Cisco DCNM Database
 
     	 [bookmark: pgfId-181103]Trouble with the Cisco DCNM Client
 
     	 [bookmark: pgfId-181110]Trouble with Device Discovery or Device Status
 
     	 [bookmark: pgfId-207511]Trouble with Device Management
 
     	 [bookmark: pgfId-187571]Trouble with Device OS Management
 
     	 [bookmark: pgfId-181128]Trouble with Event Browsing
 
    
 
   
 
    
     [bookmark: pgfId-168192][bookmark: 96701]Initial Troubleshooting Checklist
 
    [bookmark: pgfId-168193]Begin troubleshooting Cisco DCNM issues by checking the following issues first:
 
    [bookmark: pgfId-168227]
 
     
     
 
     
 
     
 
      
       
        
        	 
          
          [bookmark: pgfId-168196]Checklist 
         
  
        	 
          
          [bookmark: pgfId-168198]Checkoff 
         
  
       
 
        
        	[bookmark: pgfId-168200]Verify that you have a compatible version of Java installed. Java 1.5.0 is recommended.
   
       
 
        
        	[bookmark: pgfId-168207]Verify that the necessary ports are open in your firewall if Cisco DCNM server is installed behind a firewall.
   
       
 
        
        	[bookmark: pgfId-168214]Verify that you have installed the same version of the Cisco DCNM client and the Cisco DCNM server.
   
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-164254][bookmark: 98296]Tips for Using Cisco DCNM
 
    [bookmark: pgfId-164605]This section includes the following topics:
 
     
     	 [bookmark: pgfId-187536]Events Tabs Show Fewer Events than the Event Browser
 
     	 [bookmark: pgfId-187651]Event Browser Pie Chart May Be Inaccurate for Small Numbers
 
    
 
     
      [bookmark: pgfId-187925][bookmark: 53572]Events Tabs Show Fewer Events than the Event Browser
 
     [bookmark: pgfId-187654]The Event Browser feature shows all messages received by Cisco DCNM, even if the message pertains to a feature that is not supported by Cisco DCNM.
 
     [bookmark: pgfId-187413]An Events tab shows only those messages that reflect the status of the currently selected feature. For some features, this is a subset of the possible messages about the feature.
 
    
 
     
      [bookmark: pgfId-187171][bookmark: 15700]Event Browser Pie Chart May Be Inaccurate for Small Numbers
 
     [bookmark: pgfId-181807]The Event Browser pie chart may sometimes show incorrect sizes for wedges that are less than 5 percent of the pie; however, the numbers shown are correct.
 
    
 
   
 
    
     [bookmark: pgfId-180990][bookmark: 34152]Trouble with Cisco DCNM Server Installation
 
    [bookmark: pgfId-181004]This section includes the following topics:
 
     
     	 [bookmark: pgfId-182161]Postgres Database Installation Fails
 
     	 [bookmark: pgfId-182209]Previous Installation Found When No Previous Installation Exists
 
     	 [bookmark: pgfId-209791]Path to the Perl Binary Directory Not Found
 
    
 
     
      [bookmark: pgfId-186687][bookmark: 66478]Postgres Database Installation Fails
 
     [bookmark: pgfId-186741]Check Table 19-1 for symptoms related to an installation failure of the Postgres database. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-186713]
 
      
       
        
        [bookmark: pgfId-208100]Table 19-1 [bookmark: 10555]Postgres Database Installation Fails 
 
        
        
         
         	 
           
           [bookmark: pgfId-208106]Symptom 
          
  
         	 
           
           [bookmark: pgfId-208108]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-208110]Solution 
          
  
        
 
         
         	 [bookmark: pgfId-208112]Postgres database installation fails.
  
         	[bookmark: pgfId-208114]The username specified to run the Postgres service already exists on the server.
  
         	[bookmark: pgfId-208116]Specify a different username or remove the existing username from the server.
  
        
 
         
         	[bookmark: pgfId-208120]Antivirus software or intrusion detection software, such as Cisco Security Agent, blocked the installation.
  
         	[bookmark: pgfId-208122]Temporarily disable any antivirus software and intrusion detection software, and then reinstall Cisco DCNM.
  
        
 
         
         	[bookmark: pgfId-208124]The PostgresSQL installer shows the following message:
 
           
           [bookmark: pgfId-208402]Failed to run initdb: 128 
          
  
         	[bookmark: pgfId-208126](Windows only) Remote Desktop Connection client not running in console mode.
  
         	[bookmark: pgfId-208128]If you are installing Cisco DCNM on a supported Windows operating system and using Remote Desktop Connection (RDC) to access the Cisco DCNM server system, start RDC from a command prompt and use the /console option, as follows:
 
           
           [bookmark: pgfId-208157]C:\>mstsc /console /v: 
            server 
          
 
           
           [bookmark: pgfId-208158] 
          
 [bookmark: pgfId-208152]where server is the DNS name or IP address of the Cisco DCNM server system.
  
        
 
         
         	[bookmark: pgfId-208585]The PostgresSQL installer shows the following message:
 
           
           [bookmark: pgfId-208586]Failed to create process for initdb. The service cannot be started, either because it is disabled or because it has no enabled devices associated with it. 
          
  
         	[bookmark: pgfId-208588](Windows only) The Secondary Logon service is not running.
  
         	[bookmark: pgfId-208593]Verify that the Secondary Logon service is running.
 [bookmark: pgfId-208683] 1. On the Cisco DCNM server system, open the Control Panel and go to Administrative Tools > Services.
 [bookmark: pgfId-208677] 2. In the list of services, find the Secondary Logon service.
 [bookmark: pgfId-208687] 3. If the status of the Secondary Logon service is not Started, right-click the service and choose Start.
 [bookmark: pgfId-208691] 4. Close the Services window.
 [bookmark: pgfId-208692] 5. Restart the Cisco DCNM server installation.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-196990][bookmark: 66937]Previous Installation Found When No Previous Installation Exists
 
     [bookmark: pgfId-197049]
 
      
       
        
        [bookmark: pgfId-196996]Table 19-2 [bookmark: 99904]Previous Installation Found when No Previous Installation Exists 
 
        
        
         
         	 
           
           [bookmark: pgfId-197002]Symptom 
          
  
         	 
           
           [bookmark: pgfId-197004]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-197006]Solution 
          
  
        
 
         
         	[bookmark: pgfId-197008]A message wrongly states that a previous installation exists.
  
         	[bookmark: pgfId-197010]The following file has incorrect entries regarding Cisco DCNM:
 
           
           [bookmark: pgfId-197011]C:\Program Files\Zero G Registry\.com.zerog.registry.xml 
          
  
         	[bookmark: pgfId-197304] 1. Perform the steps in the “Editing the Zero G Registry File” section.
 [bookmark: pgfId-197306] 2. Install the Cisco DCNM server.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-197265][bookmark: 68385]Editing the Zero G Registry File
 
     [bookmark: pgfId-197266]You can edit the Zero G Registry file to remove incorrect entries, which may cause the installation of the Cisco DCNM server to fail.
 
     
 
     [bookmark: pgfId-197267]Step 1 Make a backup of the .com.zerog.registry.xml file, found at the following location:
 
      
      [bookmark: pgfId-197368]C:\Program Files\Zero G Registry\.com.zerog.registry.xml 
     
 
      
      [bookmark: pgfId-197422] 
     
 
     [bookmark: pgfId-197268]Step 2 Open the file in a text editor.
 
     [bookmark: pgfId-197269]Step 3 Within the <products> element, remove the following <product> element and all its descendant elements:
 
      
      [bookmark: pgfId-197270]<product name="DCNM" id="9e458447-1ee6-11b2-85ed-d4ed684e9c05" version="4.0.0.0" copyright="2007". . . 
     
 
      
      [bookmark: pgfId-197271] 
     
 
     [bookmark: pgfId-197272]Step 4 Within the <components> element, remove every instance of the following <component> element:
 
      
      [bookmark: pgfId-197273]<component id="9e458484-1ee6-11b2-860c-d4ed684e9c05" version="1.0.0.0" name="InstallAnywhere VM Component" location="C:\Program Files\Cisco Systems\Cisco DCNM\jre" vendor="Cisco Systems Inc."/> 
     
 
      
      [bookmark: pgfId-197274] 
     
 
     [bookmark: pgfId-197275]Step 5 Save and close the file.
 
     [bookmark: pgfId-197276]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-197022][bookmark: 72897]Path to the Perl Binary Directory Not Found
 
     [bookmark: pgfId-209801]Check Table 19-1 for symptoms related to the Perl binary directory. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-209853]
 
      
       
        
        [bookmark: pgfId-209808]Table 19-3 Path to the Perl Binary Directory Not Found 
 
        
        
         
         	 
           
           [bookmark: pgfId-209814]Symptom 
          
  
         	 
           
           [bookmark: pgfId-209816]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-209818]Solution 
          
  
        
 
         
         	 [bookmark: pgfId-209820]An error message states that the path to the bin directory for Perl is not in the system PATH environment variable.
  
         	[bookmark: pgfId-209822]Perl is not installed on the server system.
  
         	[bookmark: pgfId-209824] 1. Install a supported version of ActivePerl. For more information about ActivePerl, see the “Prerequisites for Installing the Cisco DCNM Server” section.
 [bookmark: pgfId-210034] 2. Ensure that the system PATH environment variable includes the path to the directory that contains the Perl executable. On Microsoft Windows, the default path to the ActivePerl bin directory is C:\Perl\bin.
 [bookmark: pgfId-210101] 3. Start the DCNM server installation again.
  
        
 
         
         	[bookmark: pgfId-209828]The server system PATH environment variable does not include the path to the directory that contains the Perl executable.
  
         	[bookmark: pgfId-210331] 1. Verify that a supported version of ActivePerl is installed on the server system. If not, install a supported version of ActivePerl. For more information about ActivePerl, see the “Prerequisites for Installing the Cisco DCNM Server” section.
 [bookmark: pgfId-210335] 2. Ensure that the system PATH environment variable includes the path to the directory that contains the Perl executable. On Microsoft Windows, the default path to the ActivePerl bin directory is C:\Perl\bin.
 [bookmark: pgfId-210336] 3. Start the DCNM server installation again.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-209734][bookmark: 41397]Trouble with Starting the Cisco DCNM Server
 
    [bookmark: pgfId-182292]This section includes the following topics:
 
     
     	 [bookmark: pgfId-182342]Cisco DCNM Server Fails to Start
 
    
 
     
      [bookmark: pgfId-181040][bookmark: 87939]Cisco DCNM Server Fails to Start
 
     [bookmark: pgfId-186609]Check Table 19-4 for symptoms related to downloading the Cisco DCNM client. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-183486]
 
      
       
        
        [bookmark: pgfId-183463]Table 19-4 [bookmark: 73633]Cisco DCNM Server Fails to Start 
 
        
        
         
         	 
           
           [bookmark: pgfId-183469]Symptom 
          
  
         	 
           
           [bookmark: pgfId-183471]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-183473]Solution 
          
  
        
 
         
         	 [bookmark: pgfId-183475]Cisco DCNM server fails to start.
  
         	[bookmark: pgfId-183477]The Postgres database did not install.
  
         	[bookmark: pgfId-183479]See the “Postgres Database Installation Fails” section.
  
        
 
         
         	[bookmark: pgfId-183483]The Postgres service is not running.
  
         	[bookmark: pgfId-183604]Start the Postgres service:
 
           
           	 [bookmark: pgfId-194180]In Windows Server 2003, choose  Start > All Programs > Postgres 8.2 > Start Service .
 
           	 [bookmark: pgfId-194198]In RHEL 4 AS, use the following command:
 
          
 [bookmark: pgfId-194231]/DCNM/db/bin/DB start
  
        
 
         
         	[bookmark: pgfId-183559]The Postgres user credentials are incorrect. 
  
         	[bookmark: pgfId-183561]Correct the Postgres user credentials and restart the Cisco DCNM server. 
  
        
 
         
         	[bookmark: pgfId-183652]The ports used by the server are already in use.
  
         	[bookmark: pgfId-183654] 1. Check the server log for messages such as “Port port-number already in use”. The server log is the following file:
 [bookmark: pgfId-183765]Installation_directory\jboss-4.2.2.GA\server\DCNM\server.log
 [bookmark: pgfId-183744] 2. Determine which application is using the port and stop or reconfigure the application.
 [bookmark: pgfId-183829] 3. Restart the Cisco DCNM server.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-181031][bookmark: 16778]Trouble with the Cisco DCNM Database
 
    [bookmark: pgfId-197604]This section includes the following topics:
 
     
     	 [bookmark: pgfId-197729]Trouble with a PostgreSQL Database
 
     	 [bookmark: pgfId-197619]Trouble with an Oracle Database
 
    
 
     
      [bookmark: pgfId-197632][bookmark: 97701]Trouble with a PostgreSQL Database
 
     [bookmark: pgfId-197786]Check Table 19-5 for symptoms related to the pgAdmin III application for administering a postgreSQL database used with Cisco DCNM. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-197807]
 
      
       
        
        [bookmark: pgfId-197764]Table 19-5 [bookmark: 33978]pgAdmin III Errors 
 
        
        
         
         	 
           
           [bookmark: pgfId-197770]Symptom 
          
  
         	 
           
           [bookmark: pgfId-197772]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-197774]Solution 
          
  
        
 
         
         	[bookmark: pgfId-197776]Error message states that the Cisco DCNM database does not exist.
  
         	[bookmark: pgfId-197778]The Cisco DCNM database name may have changed during an upgrade or reinstallation of the Cisco DCNM server software.
  
         	 [bookmark: pgfId-197785]In the pgAdmin III application, perform the steps in the “Updating Cisco DCNM Database Name and Username in pgAdmin III” section.
  
        
 
         
         	[bookmark: pgfId-197889]Error message states that password authentication failed for the Cisco DCNM database username.
  
         	[bookmark: pgfId-198017]The Cisco DCNM database username may have changed during an upgrade or reinstallation of the Cisco DCNM server software.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-197664][bookmark: 37035]Updating Cisco DCNM Database Name and Username in pgAdmin III
 
     [bookmark: pgfId-199358]To update the Cisco DCNM database name and username in pgAdmin III, follow these steps:
 
     
 
     [bookmark: pgfId-198238]Step 1 Open the pgAdmin III application.
 
     [bookmark: pgfId-198270]Step 2 In the Object Browser pane, under Servers, click PostgreSQL Database Server 8.2.
 
     [bookmark: pgfId-198288]In the right-hand pane, the Properties tab appears with several other tabs.
 
     [bookmark: pgfId-198377]Step 3 On the Properties tab, double-click Maintenance database.
 
     [bookmark: pgfId-198436]A dialog box displays a Properties tab for the server.
 
     [bookmark: pgfId-198423]Step 4 If you need to change the database name, click the Maintenance DB field and type the correct Cisco DCNM database name.
 
      
       
     
 
     
 
     [bookmark: pgfId-198589]Note The database name should be the name that you specified when you most recently upgraded or reinstalled the Cisco DCNM server software.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-198630]Step 5 [bookmark: 21291]If you need to change the database username, click the Username field and type the correct Cisco DCNM database username.
 
      
       
     
 
     
 
     [bookmark: pgfId-198631]Note The database username should be the database username that you specified when you most recently upgraded or reinstalled the Cisco DCNM server software.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-198378]Step 6 Click OK.
 
     [bookmark: pgfId-198664]Step 7 In the Object Browser pane, double-click PostgreSQL Database Server 8.2.
 
     [bookmark: pgfId-198711]If you changed the username in Step 5, the Connect to Server dialog box appears.
 
     [bookmark: pgfId-198698]Step 8 If necessary, enter the password for the username that you specified in Step 5 and click OK.
 
     [bookmark: pgfId-198793]The pgAdmin III application connects to the Cisco DCNM database and displays the databases and login roles.
 
     [bookmark: pgfId-199401]If you need additional assistance, see the Help menu in the pgAdmin III application or see the pgAdmin web site at the following URL:
 
     [bookmark: pgfId-199418]http://pgadmin.org/docs/1.6/index.html
 
     [bookmark: pgfId-198379]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-197679][bookmark: 90502]Trouble with an Oracle Database
 
     [bookmark: pgfId-199182]If the Cisco DCNM server has trouble using an Oracle database, it logs the error messages in the following file:
 
     [bookmark: pgfId-199183]Installation_directory\jboss-4.2.2.GA\server\dcnm\log\server.log
 
     [bookmark: pgfId-199187]Check Table 19-6 for symptoms related using an Oracle database with Cisco DCNM. For each error message, see the possible cause and follow the corresponding solution.
 
     [bookmark: pgfId-199113]
 
      
       
        
        [bookmark: pgfId-199087]Table 19-6 [bookmark: 26571]Cisco DCNM server.log File Errors with an Oracle Database 
 
        
        
         
         	 
           
           [bookmark: pgfId-199093]Symptom 
          
  
         	 
           
           [bookmark: pgfId-199095]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-199097]Solution 
          
  
        
 
         
         	[bookmark: pgfId-199099]The following error appears in the server.log file:
 
           
           [bookmark: pgfId-202034]java.sql.SQLException: ORA-01653: unable to extend table Cisco DCNMUSER.DCMRAWEVENTTABLE by 1024 in tablespace SYSTEM 
          
  
         	[bookmark: pgfId-199101]The tablespace SYSTEM is too small.
  
         	[bookmark: pgfId-199103]Perform the steps in the “Increasing the SYSTEM Tablespace” section.
  
        
 
         
         	[bookmark: pgfId-202047]The following error appears in the server.log file:
 
           
           [bookmark: pgfId-199257][org.hibernate.util.JDBCExceptionReporter] Could not create connection; - nested throwable: 
          
 
           
           [bookmark: pgfId-199258] 
          
 
           
           [bookmark: pgfId-199259](java.sql.SQLException: Listener refused the connection with the following error: 
          
 
           
           [bookmark: pgfId-199260]ORA-12519, TNS:no appropriate service handler found 
          
  
         	[bookmark: pgfId-199110]The number of available sessions and processes is inadequate.
  
         	[bookmark: pgfId-200808]Perform the steps in the “Increasing the Number of Sessions and Processes” section.
  
        
 
         
         	[bookmark: pgfId-202055]The following error appears in the server.log file:
 
           
           [bookmark: pgfId-199278]2009-04-08 15:53:47,125 ERROR [org.hibernate.util.JDBCExceptionReporter] ORA-00604: error occurred at recursive SQL level 1 
          
 
           
           [bookmark: pgfId-199279]ORA-01000: maximum open cursors exceeded 
          
  
         	[bookmark: pgfId-199274]The number of open cursors is inadequate.
  
         	[bookmark: pgfId-200815]Perform the steps in the “Increasing the Number of Open Cursors” section.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-197741][bookmark: 22249]Information About the Oracle SQL*Plus Command-Line Tool
 
     [bookmark: pgfId-199427]The Oracle database troubleshooting procedures in this chapter require the use of the SQL*Plus command-line tool. The SQL*Plus executable is typically installed in the bin directory under the Oracle home directory. In Microsoft Windows, the default location for the SQL*Plus executable is as follows:
 
     [bookmark: pgfId-199513]C:\oraclexe\app\oracle\product\10.2.0\server\bin
 
     [bookmark: pgfId-199552]In Linux, the default location for the SQL*Plus binary file is as follows:
 
     [bookmark: pgfId-199966]/usr/lib/oracle/xe/app/oracle/product/10.2.0/server/bin
 
    
 
     
      [bookmark: pgfId-199967]Linux Environment Variables
 
     [bookmark: pgfId-199968]If you are using Linux, before you use the SQL*Plus command-line tool, ensure that the ORACLE_HOME and ORACLE_SID environment variables are set to correct values. For example, if you are using Oracle 10g on Linux, the following commands set the environment variables to the default Oracle home directory and SID if you are using a bash shell:
 
      
      [bookmark: pgfId-199694]export ORACLE_HOME=/usr/lib/oracle/xe/app/oracle/product/10.2.0/server 
     
 
      
      [bookmark: pgfId-199695]export ORACLE_SID=XE 
     
 
      
      [bookmark: pgfId-199696] 
     
 
    
 
     
      [bookmark: pgfId-199979]Logging Into Oracle
 
      
       
     
 
     
 
     [bookmark: pgfId-204543]Note Ensure that you know the database administrator username and password.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-200137]To log into the Oracle database by using the SQL*Plus command-line tool, follow these steps:
 
     
 
     [bookmark: pgfId-199996]Step 1 Run the SQL*Plus executable.
 
     [bookmark: pgfId-200042]A command prompt appears.
 
     [bookmark: pgfId-200077]Step 2 Enter the connect command.
 
     [bookmark: pgfId-200209]The Username prompt appears.
 
     [bookmark: pgfId-200210]Step 3 Enter the database administrator username.
 
     [bookmark: pgfId-200216]The Password prompt appears.
 
     [bookmark: pgfId-200226]Step 4 Enter the password for the username that you specified.
 
     [bookmark: pgfId-200304]For example, if the Oracle administrator username is system and the password is oracle, you would log in as follows:
 
      
      [bookmark: pgfId-200346]Username: sys as sysdba 
     
 
      
      [bookmark: pgfId-200374]Password: oracle 
     
 
      
      [bookmark: pgfId-200387] 
     
 
     [bookmark: pgfId-199980]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-200193]For more information about using SQL*Plus, see the documentation for the Oracle database version that you are using.
 
    
 
     
      [bookmark: pgfId-199981][bookmark: 34561]Information About the init.ora File
 
     [bookmark: pgfId-200925]The init.ora file specifies startup parameters. The default name and location of the file is platform specific, as shown in Table 19-7.
 
     [bookmark: pgfId-203239]
 
      
       
        
        [bookmark: pgfId-203204]Table 19-7 [bookmark: 25757]Name and Default Location of init.ora File 
 
        
        
         
         	 
           
           [bookmark: pgfId-203210]Oracle Version 
          
  
         	 
           
           [bookmark: pgfId-203212]Operating System 
          
  
         	 
           
           [bookmark: pgfId-203214]Content of init.ora File 
          
  
        
 
         
         	 [bookmark: pgfId-203216]10g
  
         	[bookmark: pgfId-203218]Microsoft Windows
  
         	[bookmark: pgfId-203220]C:\oraclexe\app\oracle\product\10.2.0\server\database\initXE.ora
  
        
 
         
         	[bookmark: pgfId-203224]Linux
  
         	[bookmark: pgfId-203226]/usr/lib/oracle/xe/app/oracle/product/10.2.0/server/dbs\initXE.ora
  
        
 
         
         	 [bookmark: pgfId-203228]11g
  
         	[bookmark: pgfId-203230]Microsoft Windows
  
         	[bookmark: pgfId-203232]C:\app\Administrator\product\11.1.0\db_1\dbs\initORCL.ora
  
        
 
         
         	[bookmark: pgfId-203236]Linux
  
         	[bookmark: pgfId-203238]/usr/lib/oracle/orcl/app/oracle/product/11.1.0/db_1/dbs/initORCL.ora
  
        
 
        
      
 
     
 
     [bookmark: pgfId-201172]The init.ora file should contain only one line, which is the full path of the server parameter file, as shown in Table 19-8.
 
     [bookmark: pgfId-202961]
 
      
       
        
        [bookmark: pgfId-202926]Table 19-8 [bookmark: 40948]Content of init.ora File 
 
        
        
         
         	 
           
           [bookmark: pgfId-202932]Oracle Version 
          
  
         	 
           
           [bookmark: pgfId-202934]Operating System 
          
  
         	 
           
           [bookmark: pgfId-202936]Content of init.ora File 
          
  
        
 
         
         	 [bookmark: pgfId-202938]10g
  
         	[bookmark: pgfId-202940]Microsoft Windows
  
         	[bookmark: pgfId-202942]SPFILE='C:\oraclexe\app\oracle\product\10.2.0\server\dbs\spfileXE.ora
  
        
 
         
         	[bookmark: pgfId-202946]Linux
  
         	[bookmark: pgfId-202948]SPFILE='/usr/lib/oracle/xe/app/oracle/product/10.2.0/server/dbs/spfileXE.ora'
  
        
 
         
         	 [bookmark: pgfId-202950]11g
  
         	[bookmark: pgfId-202952]Microsoft Windows
  
         	[bookmark: pgfId-202954]SPFILE='C:\oraclexe\app\oracle\product\11.1.0\server\dbs\spfileXE.ora
  
        
 
         
         	[bookmark: pgfId-202958]Linux
  
         	[bookmark: pgfId-202960]SPFILE='/usr/lib/oracle/orcl/app/oracle/product/11.1.0/db_1/dbs/spfileXE.ora
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-202375][bookmark: 57788]Increasing the SYSTEM Tablespace
 
     [bookmark: pgfId-203378]To increase the SYSTEM tablespace, follow these steps:
 
     
 
     [bookmark: pgfId-200833]Step 1 Use the SQL*Plus command-line tool to log in to the Oracle database. For more information, see the “Information About the Oracle SQL*Plus Command-Line Tool” section.
 
     [bookmark: pgfId-199911]Step 2 [bookmark: 30830]Enter the following command:
 
      
      [bookmark: pgfId-200558]select file_name, bytes, autoextensible, maxbytes 
     
 
      
      [bookmark: pgfId-200559]from dba_data_files 
     
 
      
      [bookmark: pgfId-200560]where tablespace_name='SYSTEM'; 
     
 
      
      [bookmark: pgfId-200510] 
     
 
     [bookmark: pgfId-200614]Step 3 Enter the following command:
 
      
      [bookmark: pgfId-200627]alter database datafile 'file_name' autoextend on next 100m maxsize 2000m; 
     
 
      
      [bookmark: pgfId-204590] 
     
 
     [bookmark: pgfId-204594]where file_name is the filename from the output of the select command in Step 2.
 
     [bookmark: pgfId-204595]The SYSTEM tablespace is increased.
 
     [bookmark: pgfId-200722]Step 4 Enter the exit command.
 
     [bookmark: pgfId-200746]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-200863][bookmark: 39597]Increasing the Number of Sessions and Processes
 
     [bookmark: pgfId-200864]To increase the number of sessions and processes to 150, follow these steps:
 
     
 
     [bookmark: pgfId-201426]Step 1 Ensure that the init.ora file exists and that it contains the single line that is applicable for your Oracle database installation. If there are additional lines, remove them.
 
     [bookmark: pgfId-201775]For more information, see the “Information About the init.ora File” section.
 
     [bookmark: pgfId-201430]Step 2 Stop the Cisco DCNM server. For more information, see the “Stopping the Cisco DCNM Server” section.
 
     [bookmark: pgfId-201450]Step 3 Use the SQL*Plus command-line tool to log in to the Oracle database. For more information, see the “Information About the Oracle SQL*Plus Command-Line Tool” section.
 
     [bookmark: pgfId-201454]Step 4 Enter the shutdown command. If the command fails, use the shutdown abort command.
 
     [bookmark: pgfId-201505]Step 5 Enter the following command:
 
      
      [bookmark: pgfId-200875]startup pfile='init_file_name'; 
     
 
      
      [bookmark: pgfId-200876] 
     
 
     [bookmark: pgfId-200877]where init_file_name is the init.ora filename for your Oracle database installation. For more information, see the “Information About the init.ora File” section.
 
     [bookmark: pgfId-201920]Step 6 Set the number of sessions to 150 by entering the following command:
 
      
      [bookmark: pgfId-201921]alter system set sessions = 150 scope=spfile; 
     
 
      
      [bookmark: pgfId-201922] 
     
 
     [bookmark: pgfId-201923]Step 7 Set the number of processes to 150 by entering the following command:
 
      
      [bookmark: pgfId-201924]alter system set processes = 150 scope=spfile; 
     
 
      
      [bookmark: pgfId-201925] 
     
 
     [bookmark: pgfId-201926]Step 8 Enter the shutdown command. If the command fails, use the shutdown abort command.
 
     [bookmark: pgfId-201927]Step 9 Enter the startup command.
 
     [bookmark: pgfId-201928]Step 10 Verify that the number of sessions and processes is changed to 150 by entering the following command:
 
      
      [bookmark: pgfId-201929]show parameter sessions 
     
 
      
      [bookmark: pgfId-201930] 
     
 
     [bookmark: pgfId-201931]Step 11 Enter the exit command.
 
     [bookmark: pgfId-202027]Step 12 Start the Cisco DCNM server. For more information, see the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-200880]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-200716][bookmark: 57102]Increasing the Number of Open Cursors
 
     [bookmark: pgfId-201707]To increase the number of open cursors to 1000, follow these steps:
 
     
 
     [bookmark: pgfId-201708]Step 1 Ensure that the init.ora file exists and that it contains the single line that is applicable for your Oracle database installation. If there are additional lines in the file, remove them.
 
     [bookmark: pgfId-201769]For more information, see the “Information About the init.ora File” section.
 
     [bookmark: pgfId-201714]Step 2 Shut down the Cisco DCNM server. For more information, see the “Stopping the Cisco DCNM Server” section.
 
     [bookmark: pgfId-201716]Step 3 Use the SQL*Plus command-line tool to log in to the Oracle database. For more information, see the “Information About the Oracle SQL*Plus Command-Line Tool” section.
 
     [bookmark: pgfId-201720]Step 4 Enter the shutdown command. If the command fails, use the shutdown abort command.
 
     [bookmark: pgfId-201721]Step 5 Enter the following command:
 
      
      [bookmark: pgfId-201722]startup pfile='init_file_name'; 
     
 
      
      [bookmark: pgfId-201723] 
     
 
     [bookmark: pgfId-201724]where init_file_name is the init.ora filename for your Oracle database installation. For more information, see the “Information About the init.ora File” section.
 
     [bookmark: pgfId-201882]Step 6 Set the number of open cursors to 1000 by entering the following command:
 
      
      [bookmark: pgfId-201883]alter system set open_cursors = 1000 scope=spfile; 
     
 
      
      [bookmark: pgfId-201884] 
     
 
     [bookmark: pgfId-201885]Step 7 Enter the shutdown command. If the command fails, use the shutdown abort command.
 
     [bookmark: pgfId-201886]Step 8 Enter the startup command.
 
     [bookmark: pgfId-201887]Step 9 Verify that the number of open cursors is changed to 1000 by entering the following command:
 
      
      [bookmark: pgfId-201888]show parameter open_cursors 
     
 
      
      [bookmark: pgfId-201889] 
     
 
     [bookmark: pgfId-201890]Step 10 Enter the exit command.
 
     [bookmark: pgfId-201894]Step 11 Start the Cisco DCNM server. For more information, see the “Starting the Cisco DCNM Server” section.
 
     [bookmark: pgfId-201995]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-201375][bookmark: 97197]Trouble with the Cisco DCNM Client
 
    [bookmark: pgfId-167717]This section includes the following topics:
 
     
     	 [bookmark: pgfId-177696]Cannot Download the Cisco DCNM Client from the Server
 
     	 [bookmark: pgfId-206788]Cannot Install the Cisco DCNM Client
 
     	 [bookmark: pgfId-177697]Cannot Start the Cisco DCNM Client
 
     	 [bookmark: pgfId-177701]Cannot Log into the Cisco DCNM Client
 
     	 [bookmark: pgfId-182522]Client Loses Connection to the Cisco DCNM Server
 
    
 
     
      [bookmark: pgfId-167660][bookmark: 55239]Cannot Download the Cisco DCNM Client from the Server
 
     [bookmark: pgfId-186593]Check Table 19-9 for symptoms related to downloading the Cisco DCNM client. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-168524]
 
      
       
        
        [bookmark: pgfId-184905]Table 19-9 [bookmark: 34383]Cannot Download the Cisco DCNM Client from the Server 
 
        
        
         
         	 
           
           [bookmark: pgfId-184911]Symptom 
          
  
         	 
           
           [bookmark: pgfId-184913]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-184915]Solution 
          
  
        
 
         
         	 [bookmark: pgfId-196019]Cannot download the Cisco DCNM client from the server.
  
         	[bookmark: pgfId-184919]You are using wrong URL or web server port.
  
         	[bookmark: pgfId-184921]Verify that you are using the correct URL, including the port number.
  
        
 
         
         	[bookmark: pgfId-184925]The TCP port is blocked by a gateway device.
  
         	[bookmark: pgfId-184927]Open the TCP port in your firewall. 
  
        
 
         
         	[bookmark: pgfId-206972]You are using an unsupported web browser.
  
         	[bookmark: pgfId-206974]To download the Cisco DCNM client from the Cisco DCNM server, use Microsoft Internet Explorer 7 or Mozilla Firefox 3.0.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-206698][bookmark: 21816]Cannot Install the Cisco DCNM Client
 
     [bookmark: pgfId-206702]Check Table 19-9 for symptoms related to installing the Cisco DCNM client. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-206732]
 
      
       
        
        [bookmark: pgfId-206709]Table 19-10 Cannot Install the Cisco DCNM Client 
 
        
        
         
         	 
           
           [bookmark: pgfId-206715]Symptom 
          
  
         	 
           
           [bookmark: pgfId-206717]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-206719]Solution 
          
  
        
 
         
         	 [bookmark: pgfId-206721]Installer attempts to install Java version 1.5.0_11 but fails.
  
         	[bookmark: pgfId-206723]The system does not have Internet access.
  
         	[bookmark: pgfId-206830]The Cisco DCNM client installer requires Internet access to download the Java version 1.5.0_11 JRE. If the system cannot access the Internet, use another system to download the Java installer, copy it to the system that you want to install the Cisco DCNM client on, install Java, and restart the Cisco DCNM client installation.
 [bookmark: pgfId-206936]You can download Java version 1.5.0_11 JRE from the Java[tm] Technology Products Download web site, at http://java.sun.com/products/archive. The Java version 1.5.0_11 JRE is listed as JRE 5.0 Update 11.
  
        
 
         
         	[bookmark: pgfId-206729]Your network environment requires the use of a proxy connection to access the Internet.
  
         	[bookmark: pgfId-206900]If your network environment requires a proxy connection to permit the download of the Java installer, ensure that the proxy settings are configured in Internet Options, available from the Control Panel. For more information, see http://java.sun.com/j2se/1.5.0/proxy_note.html.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-206683][bookmark: 16120]Cannot Start the Cisco DCNM Client
 
     [bookmark: pgfId-186564]Check Table 19-11 for symptoms related to starting the Cisco DCNM client. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-176340]
 
      
       
        
        [bookmark: pgfId-184461]Table 19-11 [bookmark: 30305]Cannot Start the Cisco DCNM Client 
 
        
        
         
         	 
           
           [bookmark: pgfId-184467]Symptom 
          
  
         	 
           
           [bookmark: pgfId-184469]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-184471]Solution 
          
  
        
 
         
         	[bookmark: pgfId-184473]Cannot start the Cisco DCNM client.
  
         	[bookmark: pgfId-184475]The client installation may be corrupted.
 [bookmark: pgfId-206020]The wrong version of Java may be installed.
  
         	[bookmark: pgfId-206139] 1. Uninstall the Cisco DCNM client. For more information, see the “Uninstalling the Cisco DCNM Client” section.
 [bookmark: pgfId-206411] 2. Download and install the Cisco DCNM client from the Cisco DCNM server. 
 [bookmark: pgfId-206412]During the client installation, allow Cisco DCNM to install the supported version of Java on the computer. When you download the client from the Cisco DCNM server, if the supported version of Java is not detected on the computer, Cisco DCNM asks you for permission to install the supported version of Java.
 [bookmark: pgfId-205957]Your browser may notify you that the Java installer was digitally signed by an expired certificate. To continue, confirm the installation.
 [bookmark: pgfId-206013]For more information, see the “Downloading and Launching the Cisco DCNM Client” section.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-177206][bookmark: 12956]Cannot Log into the Cisco DCNM Client
 
     [bookmark: pgfId-186545]Check Table 19-12 for symptoms related to logging into the Cisco DCNM client. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-185206]
 
      
       
        
        [bookmark: pgfId-192511]Table 19-12 [bookmark: 86215]Cannot Log into the Cisco DCNM Client 
 
        
        
         
         	 
           
           [bookmark: pgfId-192517]Symptom 
          
  
         	 
           
           [bookmark: pgfId-192519]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-192521]Solution 
          
  
        
 
         
         	 [bookmark: pgfId-192523]Cannot log into the Cisco DCNM client.
  
         	[bookmark: pgfId-192525]You forgot password.
  
         	[bookmark: pgfId-192527]Ask a Cisco DCNM administrator to reset your password.
 [bookmark: pgfId-192528]If no one has administrative access to Cisco DCNM, you can reset the local administrator account or change Cisco DCNM server authentication settings by reinstalling the Cisco DCNM server software. For more information, see the “Reinstalling the Cisco DCNM Server” section.
  
        
 
         
         	[bookmark: pgfId-192533]The Cisco DCNM server is down.
  
         	[bookmark: pgfId-192537]Restart the Cisco DCNM server. See the “Starting the Cisco DCNM Server” section.
  
        
 
         
         	[bookmark: pgfId-192542]The Cisco DCNM server is unreachable.
  
         	[bookmark: pgfId-192544]Ensure that the computer that runs the Cisco DCNM client meets the network requirements for using the Cisco DCNM client remotely. Any gateway network devices between the Cisco DCNM client and server must allow connections to the Cisco DCNM web server and to the Cisco DCNM server. By default, the Cisco DCNM web server listens to port 8080 and the Cisco DCNM server listens to port 1099; however, you can configure these ports during Cisco DCNM server installation. If you need to change either port, reinstall the server and choose the Full Reinstall option. See the “Reinstalling the Cisco DCNM Server” section. 
  
        
 
         
         	[bookmark: pgfId-194350]The Cisco DCNM server IP address changed after you installed the server.
  
         	[bookmark: pgfId-195166]Do the following:
 [bookmark: pgfId-204640] 1. Ensure that the IP address of the Cisco DCNM server is statically assigned.
 [bookmark: pgfId-195154] 2. Reinstall the Cisco DCNM server and choose the Full Reinstall option, which allows you to specify the server IP address. See the “Reinstalling the Cisco DCNM Server” section.
 [bookmark: pgfId-194393] 3. Log into the Cisco DCNM client and specify the new IP address of the Cisco DCNM server in the Cisco DCNM Server field of the login dialog box.
  
        
 
         
         	[bookmark: pgfId-194325]The wrong Cisco DCNM server port number was used in the login attempt.
  
         	[bookmark: pgfId-194327]In the Cisco DCNM client login window, click More and, in the Port field, change the port number that your Cisco DCNM server uses. See the “Restarting the Cisco DCNM Client” section.
 [bookmark: pgfId-194506]If you want to change the port that the Cisco DCNM server listens to, reinstall the Cisco DCNM server and choose the Full Reinstall option, which allows you to specify the Cisco DCNM server port. See the “Reinstalling the Cisco DCNM Server” section.
  
        
 
         
         	[bookmark: pgfId-192547]When you try to log into the Cisco DCNM client, you receive the error message “Can not resolve Cisco DCNM server hostname via DNS. Make sure that Cisco DCNM server has a valid DNS entry”.
  
         	[bookmark: pgfId-192549]You used a hostname to specify the Cisco DCNM server during the login and DNS does not have an entry for the Cisco DCNM server.
  
         	[bookmark: pgfId-192551]Ensure that DNS on your network has an entry for the Cisco DCNM server hostname.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-185208][bookmark: 10093]Client Loses Connection to the Cisco DCNM Server
 
     [bookmark: pgfId-186533]Check Table 19-13 for symptoms related to the Cisco DCNM client losing its connection with the server. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
     [bookmark: pgfId-184062]
 
      
       
        
        [bookmark: pgfId-184036]Table 19-13 [bookmark: 62414]Client Loses Connection to the Cisco DCNM Server 
 
        
        
         
         	 
           
           [bookmark: pgfId-184042]Symptoms 
          
  
         	 
           
           [bookmark: pgfId-184044]Possible Cause 
          
  
         	 
           
           [bookmark: pgfId-184046]Solution 
          
  
        
 
         
         	 
           
           	 [bookmark: pgfId-184048]Client loses connection to the server.
 
           	 [bookmark: pgfId-186192]The Cisco DCNM client window is pink.
 
          
  
         	[bookmark: pgfId-187781]The client had a failure.
  
         	[bookmark: pgfId-187783]Restart the Cisco DCNM client.
  
        
 
         
         	[bookmark: pgfId-184050]The Cisco DCNM server is down.
  
         	[bookmark: pgfId-184086]Restart the Cisco DCNM server. See the “Starting the Cisco DCNM Server” section.
  
        
 
         
         	[bookmark: pgfId-184059]The Cisco DCNM server is unreachable.
  
         	[bookmark: pgfId-185159]Investigate your network to determine if it meets the network requirements for using the Cisco DCNM client remotely. 
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-184032][bookmark: 22400]Trouble with Device Discovery or Device Status
 
    [bookmark: pgfId-186395]Check Table 19-14 for symptoms related to issues with device discovery or the device status. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
    [bookmark: pgfId-185376]
 
     
      
       
       [bookmark: pgfId-185496]Table 19-14 [bookmark: 62429]Trouble with Device Discovery or Management
 
       
       
        
        	 
          
          [bookmark: pgfId-185502]Symptoms 
         
  
        	 
          
          [bookmark: pgfId-185504]Possible Cause 
         
  
        	 
          
          [bookmark: pgfId-185506]Solution 
         
  
       
 
        
        	 
          
          	 [bookmark: pgfId-185508]A device discovery task fails.
 
          	 [bookmark: pgfId-186210]A device status changes to Unmanaged or Unreachable.
 
         
  
        	[bookmark: pgfId-185921]Incorrect device credentials were provided.
  
        	[bookmark: pgfId-185923]Reenter the username and password, and try discovering the device again.
 [bookmark: pgfId-185930]If you are attempting to discover CDP neighbors of the seed device, ensure that the credentials that you provide are valid on all devices that you want to discover.
  
       
 
        
        	[bookmark: pgfId-185510]The SSH server is disabled on the device.
  
        	[bookmark: pgfId-185512]Reenable the SSH server on the device and try discovering the device again.
  
       
 
        
        	[bookmark: pgfId-185541]The maximum number of SSH sessions that the device can support has been reached.
  
        	[bookmark: pgfId-185543]Check the number of user sessions on the device. Free at least one connection and try discovering the device again.
  
       
 
        
        	[bookmark: pgfId-186027]CDP is disabled on the device or on the device interface that the Cisco DCNM server connects to.
  
        	[bookmark: pgfId-186029]Ensure that CDP is enabled on the device globally and that it is enabled on the specific interface that the Cisco DCNM server connects to.
  
       
 
        
        	[bookmark: pgfId-186102]The device interface that the Cisco DCNM server connects to is shut down.
  
        	[bookmark: pgfId-186082]Ensure that the device interface that the Cisco DCNM server connects to is up.
  
       
 
        
        	[bookmark: pgfId-185522]The device restarted or shut down before discovery could complete.
  
        	[bookmark: pgfId-185821]Ensure that the device is running and try discovering the device again. 
  
       
 
        
        	[bookmark: pgfId-185936]The Cisco DCNM server cannot reach the device.
  
        	[bookmark: pgfId-185949]Ensure that the network requirements for device management are met. See the “Cisco NX-OS Device Configuration Requirements” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-186295][bookmark: 88740]Trouble with Device Management
 
    [bookmark: pgfId-186966]Check Table 19-11 for symptoms related to device management. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
    [bookmark: pgfId-187009]
 
     
      
       
       [bookmark: pgfId-186981]Table 19-15 Trouble with Device Management
 
       
       
        
        	 
          
          [bookmark: pgfId-186987]Symptom 
         
  
        	 
          
          [bookmark: pgfId-186989]Possible Cause 
         
  
        	 
          
          [bookmark: pgfId-186991]Solution 
         
  
       
 
        
        	[bookmark: pgfId-186994]The Cisco DCNM client shows device configuration information that is out of date.
  
        	[bookmark: pgfId-186996]The Cisco DCNM server was down. 
  
        	[bookmark: pgfId-186999]You can do either of the following:
 
          
          	 [bookmark: pgfId-187059]Rediscover the device. For more information, see the “Discovering a Device” section.
 
          	 [bookmark: pgfId-187066]Restart the Cisco DCNM server with a clean database. If the server was down for a long time, this is the recommended solution.
 
         
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-207381][bookmark: 96226]Trouble with Device OS Management
 
    [bookmark: pgfId-207405]Check Table 19-17 for symptoms related to the Device OS Management feature. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
    [bookmark: pgfId-207469]
 
     
      
       
       [bookmark: pgfId-207409]Table 19-16 Trouble with Device OS Management
 
       
       
        
        	 
          
          [bookmark: pgfId-207415]Symptom 
         
  
        	 
          
          [bookmark: pgfId-207417]Possible Cause 
         
  
        	 
          
          [bookmark: pgfId-207419]Solution 
         
  
       
 
        
        	 
          
          	 [bookmark: pgfId-207421]During a software installation job, software image file transfer between a file server and a device takes too much time.
 
         
  
        	[bookmark: pgfId-207424]The connection between the file server and the device is slow.
  
        	[bookmark: pgfId-207636]Use a file server that is on the same LAN as the devices included in the software installation job.
 [bookmark: pgfId-207684]If all of the available file servers transfer software image files too slowly, before you create the software installation job, manually copy the files to the devices that you will include the job and configure the job to use the manually copied files rather than a file server.
 [bookmark: pgfId-207715]For information about configuring a software installation job, see the “Creating or Editing a Software Installation Job” section.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-207392][bookmark: 74228]Trouble with Event Browsing
 
    [bookmark: pgfId-207385]Check Table 19-17 for symptoms related to event browsing issues. For each symptom that describes your trouble, determine which possible causes apply and follow the corresponding solutions.
 
    [bookmark: pgfId-186328]
 
     
      
       
       [bookmark: pgfId-187828]Table 19-17 [bookmark: 23676]Trouble with Event Browsing
 
       
       
        
        	 
          
          [bookmark: pgfId-187834]Symptom 
         
  
        	 
          
          [bookmark: pgfId-187836]Possible Cause 
         
  
        	 
          
          [bookmark: pgfId-187838]Solution 
         
  
       
 
        
        	 
          
          	 [bookmark: pgfId-187840]Events available on the device command line do not appear in the Cisco DCNM client.
 
          	 [bookmark: pgfId-187842]Too few events shown in Event Browser or an Events tab.
 
         
  
        	[bookmark: pgfId-187844]Logging levels on managed devices are set incorrectly.
  
        	[bookmark: pgfId-187846]Check the logging level configuration on managed devices. See the “Cisco NX-OS System-Message Logging Requirements” section.
  
       
 
        
        	[bookmark: pgfId-187851]The Cisco DCNM client fetches events that are not old enough.
  
        	[bookmark: pgfId-187853]Check the events-related setting in the Cisco DCNM client preferences. For more information, see the “Configuring the Maximum Age of Events Fetched from the Server” section.
  
       
 
        
        	 [bookmark: pgfId-187859]Too many events shown in Event Browser or on an Events tab.
  
        	[bookmark: pgfId-187862]A managed device has an issue that is generating many system log messages.
  
        	[bookmark: pgfId-187865]Temporarily unmanage the device until you resolve the issues on the device. For more information, see the “Unmanaging a Device” section.
  
       
 
        
        	[bookmark: pgfId-187903]Logging levels on managed devices are set incorrectly.
  
        	[bookmark: pgfId-187905]Check the logging level configuration on managed devices. See the “Cisco NX-OS System-Message Logging Requirements” section.
  
       
 
        
        	[bookmark: pgfId-187876]A feature Events tab does not show events that appear in the Event Browser.
  
        	[bookmark: pgfId-187878]By design, an Events tab shows only messages that apply to the currently selected feature and may show only a subset of the possible messages for the feature. For more information, see the “Events Tabs Show Fewer Events than the Event Browser” section.
  
        	[bookmark: pgfId-187883]Use the Event Browser to see status-related system messages received by Cisco DCNM. For more information, see the “Viewing the Event Browser” section.
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1031194]New and Changed Information 
      
      
 
     
 
 
    [bookmark: pgfId-1038934]This chapter provides release-specific information for each new and changed feature in the Cisco DCNM Fundamentals Configuration Guide, Release 4.x. The latest version of this document is available at the following Cisco website:
http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
    [bookmark: pgfId-1039474]To check for additional information about Cisco Data Center Network Manager (DCNM) Release 4.2, see the Cisco DCNM Release Notes, Release 4.x.
 
    [bookmark: pgfId-1039482]Table 1 summarizes the new and changed features for the Cisco DCNM Fundamentals Configuration Guide, Release 4.x and tells you where they are documented.
 
    [bookmark: pgfId-1038766]
 
     
      
       
       [bookmark: pgfId-1040790]Table 1 [bookmark: 65774]New and Changed Features for Release 4.x 
 
       
       
        
        	 
          
          [bookmark: pgfId-1040798]Feature 
         
  
        	 
          
          [bookmark: pgfId-1040800]Description 
         
  
        	 
          
          [bookmark: pgfId-1040802]Changed in Release 
         
  
        	 
          
          [bookmark: pgfId-1040804]Where Documented 
         
  
       
 
        
        	[bookmark: pgfId-1040806]NX-OS device configuration requirements
  
        	[bookmark: pgfId-1040808]Contains revised information for how to configure an NX-OS device to enable discovery, management, and monitoring by DCNM.
  
        	[bookmark: pgfId-1040810]4.0(3)
  
        	[bookmark: pgfId-1040815]Chapter 1, “Overview”
  
       
 
        
        	[bookmark: pgfId-1040817]Server installation
  
        	[bookmark: pgfId-1040819]Support was added for Oracle 10g and 11g databases.
 [bookmark: pgfId-1040820]Support was added for installing Cisco DCNM on a shared server with Cisco Fabric Manager.
  
        	[bookmark: pgfId-1040822]4.2(1)
  
        	[bookmark: pgfId-1040826]Chapter 2, “Installing and Launching the Cisco DCNM Server”
  
       
 
        
        	[bookmark: pgfId-1040829]Server installation
  
        	[bookmark: pgfId-1040831]You can specify the following during installation:
 
          
          	 [bookmark: pgfId-1040832]DCNM server IP address
 
          	 [bookmark: pgfId-1040833]DCNM server port number
 
          	 [bookmark: pgfId-1040834]DCNM web server port number
 
          	 [bookmark: pgfId-1040835]A folder to be used as an archive directory
 
         
  
        	[bookmark: pgfId-1040837]4.1(2)
  
        	[bookmark: pgfId-1040841]Chapter 2, “Installing and Launching the Cisco DCNM Server”
  
       
 
        
        	[bookmark: pgfId-1040844]Upgrading the DCNM Server Software
  
        	[bookmark: pgfId-1040846]Explains how to upgrade the DCNM server software and PostgreSQL database.
  
        	[bookmark: pgfId-1040848]4.0(2)
  
        	[bookmark: pgfId-1040852]Chapter 2, “Installing and Launching the Cisco DCNM Server”
  
       
 
        
        	[bookmark: pgfId-1040855]Windows Service 
  
        	[bookmark: pgfId-1040857]Describes how the DCNM server is run as a service in the Windows Server 2003 operating system.
  
        	[bookmark: pgfId-1040859]4.0(2)
  
        	[bookmark: pgfId-1040863]Chapter 2, “Installing and Launching the Cisco DCNM Server”
  
       
 
        
        	[bookmark: pgfId-1040866]Cisco DCNM client
  
        	[bookmark: pgfId-1040868]Support was added for exporting the summary table.
 [bookmark: pgfId-1040869]Deployment of configuration changes was clarified, to indicate that deployment is sometimes automatic and sometimes manual.
  
        	[bookmark: pgfId-1040871]4.2(1)
  
        	[bookmark: pgfId-1040875]Chapter 4, “Using the Cisco DCNM Client”
  
       
 
        
        	[bookmark: pgfId-1040878]Global Preferences dialog box
  
        	[bookmark: pgfId-1040880]Explains the purpose of the fields in the Global Preferences dialog box in the DCNM client and how to configure the fields.
  
        	[bookmark: pgfId-1040882]4.0(3)
  
        	[bookmark: pgfId-1040886]Chapter 4, “Using the Cisco DCNM Client”
  
       
 
        
        	[bookmark: pgfId-1040890]Cisco DCNM server authentication settings
  
        	[bookmark: pgfId-1040892]Support was added for RADIUS and TACACS+ authentication of Cisco DCNM server users.
  
        	[bookmark: pgfId-1040894]4.2(1)
  
        	[bookmark: pgfId-1040898]Chapter 5, “Administering DCNM Authentication Settings”
  
       
 
        
        	[bookmark: pgfId-1041058]DCNM Licensed Devices 
  
        	[bookmark: pgfId-1041060]Controls which devices you can use with licensed DCNM features.
  
        	[bookmark: pgfId-1041062]4.0(2)
  
        	[bookmark: pgfId-1041064]Chapter 8, “Administering DCNM Licensed Devices”
  
       
 
        
        	[bookmark: pgfId-1040901]Topology
  
        	[bookmark: pgfId-1040903]Support for hierarchical and grid layouts was removed.
  
        	[bookmark: pgfId-1040905]4.2(1)
  
        	[bookmark: pgfId-1040909]Chapter 9, “Working with Topology”
  
       
 
        
        	[bookmark: pgfId-1040912]Topology
  
        	[bookmark: pgfId-1040914]The topology map has new views and includes support for virtual port channels.
  
        	[bookmark: pgfId-1040916]4.1(2)
  
        	[bookmark: pgfId-1040920]Chapter 9, “Working with Topology”
  
       
 
        
        	[bookmark: pgfId-1040923]Event Browser
  
        	[bookmark: pgfId-1040925]When you apply an event filter, it is shown in a new tab.
  
        	[bookmark: pgfId-1040927]4.1(2)
  
        	[bookmark: pgfId-1040932]Chapter 10, “Managing Events”
  
       
 
        
        	[bookmark: pgfId-1041047]Event Filter 
  
        	[bookmark: pgfId-1041049]Filters events by date, time, and severity. 
  
        	[bookmark: pgfId-1041051]4.0(2)
  
        	[bookmark: pgfId-1041056]Chapter 10, “Managing Events”
  
       
 
        
        	[bookmark: pgfId-1040934]Device OS Management
  
        	[bookmark: pgfId-1040936]A new feature, it allows you to schedule and monitor the installation of operating system software on managed devices.
  
        	[bookmark: pgfId-1040938]4.1(2)
  
        	[bookmark: pgfId-1040942]Chapter 13, “Managing Device Operating Systems”
  
       
 
        
        	[bookmark: pgfId-1040945]Configuration Change
  
        	[bookmark: pgfId-1040947]A new feature, it allows you to archive the configurations of managed devices. You can also roll back the configuration on a managed device to an earlier, archived version.
  
        	[bookmark: pgfId-1040949]4.1(2)
  
        	[bookmark: pgfId-1040953]Chapter 14, “Working with Configuration Change Management”
  
       
 
        
        	[bookmark: pgfId-1040956]Auto-Synchronization with Devices
  
        	[bookmark: pgfId-1040958]Support was added for automatic purging based on severity of events.
  
        	[bookmark: pgfId-1040960]4.2(1)
  
        	[bookmark: pgfId-1040964]Chapter 15, “Administering Auto-Synchronization with Devices”
  
       
 
        
        	[bookmark: pgfId-1040967]Auto-Synchronization with Devices
  
        	[bookmark: pgfId-1040969]Updates to this feature allow you to schedule the deletion of old event data from the database.
  
        	[bookmark: pgfId-1040971]4.1(2)
  
        	[bookmark: pgfId-1040975]Chapter 15, “Administering Auto-Synchronization with Devices”
  
       
 
        
        	[bookmark: pgfId-1040978]Statistical Data Collection
  
        	[bookmark: pgfId-1040980]Updates to this feature allow you to schedule the deletion of old statistical data from the database.
  
        	[bookmark: pgfId-1040982]4.1(2)
  
        	[bookmark: pgfId-1040986]Chapter 16, “Administering Statistical Data Collection”
  
       
 
        
        	[bookmark: pgfId-1041000]Cisco DCNM database maintenance
  
        	[bookmark: pgfId-1041002]Support was added for scripts to perform database backup, restore, and cleaning.
  
        	[bookmark: pgfId-1041004]4.2(1)
  
        	[bookmark: pgfId-1041008]Chapter 18, “Maintaining the Cisco DCNM Database”
  
       
 
        
        	[bookmark: pgfId-1041082]Cisco DCNM database maintenance
  
        	[bookmark: pgfId-1041084]New chapter that describes how to maintain the DCNM database.
  
        	[bookmark: pgfId-1041086]4.1(2)
  
        	[bookmark: pgfId-1041090]Chapter 18, “Maintaining the Cisco DCNM Database”
  
       
 
        
        	[bookmark: pgfId-1041011]Troubleshooting
  
        	[bookmark: pgfId-1041013]Troubleshooting information was added for PostgreSQL and Oracle databases.
  
        	[bookmark: pgfId-1041015]4.2(1)
  
        	[bookmark: pgfId-1041019]Chapter 19, “Troubleshooting Cisco DCNM”
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1011823]
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